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Section 1: Introduction 

 

This manual explains the operation, installation, maintenance, and troubleshooting of the 

OmniSport
®
 2000 series timing system —Version 8.3.27 and beyond. (Version numbers refer 

to the date the version was released—8.3.27 was released on March 27, 2008.) For additional 

information regarding the service of this system, refer to the telephone numbers listed in 

Section 16: Daktronics Service. 

 

Figure 1 illustrates a Daktronics drawing 

label. The drawing number is located in 

the lower-right corner of a drawing. In 

the example, the drawing would be 

referred to as Drawing A-69945. 

 

Please list the model and serial number, 

and the date received in the blanks 

provided on the front page of this manual. When calling Daktronics customer service, have 

this information available to ensure the request is serviced as quickly as possible. 

 

 Section 16: contains the Daktronics Exchange Policy plus the Repair & Return Program. 

Refer to these instructions if any timing components need replacing or repairing.  

 

Connector Designations, OmniSport 2000 ............................................ Drawing A-154282 

 

Daktronics OmniSport 2000 series controller is a state-of-the-art timing and scoring system. It 

has the capability to run a variety of timing events. The timer‘s liquid crystal display (LCD) 

guides the user through the operation of the system. Refer to Drawing A-154282 for an 

overview of the OmniSport 2000 timer‘s layout and connectors.  

Safety First 
As a safety feature, this product has a three-wire, ground-type plug equipped with a third 

(grounding) pin. This plug only fits into a grounding-type power outlet. If unable to insert 

the plug into the outlet, contact a qualified electrician to replace the obsolete outlet. 

Opening Timer Packages 
When opening the timer packages, inspect for shipping damage. Verify that all equipment is 

included and itemized on the packing slip. Immediately report any deficiencies to 

Daktronics, and save all packing materials for shipping if warranty repair or exchange is 

necessary. Record the model and serial number along with the date received on the front 

cover of this manual. 

 

 
Figure 1: Daktronics Drawing Label 



 

The following terms are used to describe various mouse actions that can be used with the 

OmniSport 2000 Pro software. These instructions are based on the standard, right-handed 

mouse configuration. 

 

 

Many OmniSport 2000 timer and Pro software options can be accessed with the keyboard as 

well as the mouse. Where applicable, both mouse and keyboard actions are given to  

perform a command. Many screen buttons have labels that have a letter underlined. Press the 

key on the keyboard that correlates with the underlined letter to activate that particular 

button. To activate secondary buttons, press the underlined key while holding [Shift]. To 

activate menu bar items from the keyboard, press the underlined key while holding [Alt]. 

 

Daktronics provides OmniSport 2000 timing system users with convenient reference guides. 

Many customers keep these guides with the timing console equipment for reference before, 

during and after meets. 

 

OmniSport 2000 Swimming Quick Reference Guide 

Provides basic steps to host a swimming, diving or track meet and a water polo 

match. 

ED-13584 

OmniSport Pro Diving Quick Guide 

Explains the setup and operation of the Pro diving software. 
ED-16444 

OmniSport 2000 and Hy-TekLTD MEET MANAGER 

Explains how to connect and use the Hy-Tek software with the OmniSport 2000 

console and both numeric and matrix scoreboards. 

ED-13876 

Aquatics Interface Quick Guide DD1387596 

 

Bold Any item that requires direct action, such as clicking, pressing, selecting 

or formatting, appears in boldface.  

Italics Indicates an item visible on the screen or within a menu. No direct action 

will be taken on this item. Boldface Italics are used to reference other 

manuals, sections within this manual and figures. 

[X] Represents a keyboard key that needs to be pressed. 

―Quotes‖ Items that need to be typed, including folder and file names. 

Click Press and release the left mouse button. 

Double-click Press and release the left mouse button twice. 

Right-click Press and release the right mouse button. 

> A caret indicates to click or move to one menu item after the other, (ex. 

File > Open). 



Section 2: Timing System Setup 

Daktronics aquatics timing system setup will be unique to each pool. This manual describes a typical 

pool setting. Generally it is recommended that 2-3 people assist in the setup for a meet. Allow 2-3 

hours to complete the timing system setup for the first time. For connections to the scoring displays, 

refer to the riser diagrams in Section 2.9. 

 

The information in this section is general information only and may or may not apply to 

every pool setting. 

 

 Touchpads with 7/16  wrench to adjust brackets 

 

 Deck cabling with lane modules and lane extension cable 

 

 Horn start with start cable 

 

 OmniSport 2000 console, power pack, swimming keyboard insert and manual 

 

 Meet management computer and software with serial cable  

 

1. Before the meet, install the touchpads in the pool. With one person on each end of 

the touchpad, carefully lower the touchpad into the pool. Center the touchpad in 

the lane. Secure the supplied adjustable bracket to the pool gutter. If the pool does 

not have a gutter, secure the touchpad by running a cord through the holes on top 

of the touchpad and tying it to the starting block.  

 

2. The universal 

bracket adjusts 

to both a narrow 

or wider gutter 

lip. (Figure 2 

and Figure 3).  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2: Universal Bracket for  

Wider Gutter Lip 

 

 
Figure 3: Universal Bracket for 

Narrow Gutter Lip 
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3. Bolts on newer touchpads 

require only one 7/16

wrench (Figure 4). Use two 

7/16 wrenches to tighten 

bolts on older touchpads 

(Figure 5). Older systems 

requiring two wrenches can 

easily be updated to the new 

hardware requiring only one 

wrench. Call Daktronics to order the new hardware. 

 

4.  Connect the touchpads to the lane modules or deck plates. Read and follow 

instructions in Section 2.3 before plugging the touchpads into the deck cabling. 

 

5.  A Daktronics touchpad is designed to fill with water to 

aid in its stabilization. The touchpad seems to become a part 

of the pool wall (Figure 6). If the pool wall has obstructions 

or the gutter protrudes from the wall, use spacers (PVC 

board may be cut in strips) to create a stable support for the 

touchpad (Figure 7). Spacer size is determined by the height 

and the extra depth required. Use stainless steel fasteners to 

connect the touchpad to the spacers.   

 

Note: Daktronics does not provide these spacers. 

 

6. For more information on the care and maintenance of touchpads, refer 

 to Section 2.10 

 

Do not allow swimmers to use paddles, fins or kick boards when 

touchpads are in the pool. 

 

Note: Always place cables and equipment in areas  

of minimal traffic. Cover wires and cables with a mat 

to prevent accidents. Figure 8 illustrates an important 

detail to always remember when plugging dual 

banana connectors. The GND (ground) tab on the 

plug must line up with the black female jack for the 

timing system to work. Remember this when 

connecting all dual banana plugs. 

  

 

 

 

 

 

 

 

 

 

Figure 4: New Style Uses 

One Wrench 

 

 
Figure 5: Older Style 

Uses Two Wrenches 

 

     
Figure 6: Touchpad 

Next to Wall 

 

 
Figure 7:Touchpad 

with Spacers 

 

Figure 8: Insert GND Side to Black 

Female Jack 



 

Figure 9 illustrates a typical on-deck swimming installation.  

 

The on-deck system uses lane modules to interconnect the touchpads and backup buttons to 

the timing consoles. Lane modules are universal 

and can be used on any lane. The console knows 

which module it is by where it is connected in the 

chain. Each lane module (Figure 10) controls one 

touchpad and up to three button inputs. The lane 

modules daisy chain together, allowing another 

module to be plugged into the end to add 

another lane (Figure 11).  

 
Figure 9: On-deck Swimming Installation 

 

Figure 10: Daktronics Lane Module 
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Easy servicing is an additional benefit of on-deck 

cabling. If one lane goes bad, the whole harness does 

not have to be replaced; only that individual lane 

module needs replacing. Simply remove and replace 

with another Daktronics lane module. 

Use Maintenance Kit to Ensure Good 
Connections  
 

 Use the brush provided in the kit as 

illustrated in Figure 12 to remove any 

corrosion from the connections. 

 

 Use silicon lubricant every time the system is 

set up and taken down to protect the jacks 

and plugs. This will ensure a good connection 

and reduce corrosion. Simply squeeze silicone 

into the neck of the tube (Figure 12) and insert 

male pins of banana connectors into the neck 

to coat with silicone. 

 

 To order an OmniSport 2000 Console 

Maintenance Kit (#0A-1240-0003) call 

Daktronics at 1-877-605-1115. 

Connecting to Lane Modules  
  

Refer to Figure 13 to verify proper connection of the lane module to the touchpad, 

push buttons and next lane connection. Refer to Figure 9 for an overview of a typical 

swimming setup of lane modules with the timing system. 

 

Note: Do not connect the far end lane module 

harness into the near end lane module 

harness. Each harness system should connect 

to the OmniSport 2000 console separately. For 

more information on how to connect to the 

timing console, refer to Section 2.7.  

 

 Modules for each lane are connected through 

the jacks labeled To Next Lane. The lane cable 

will fit only one way. Position lane modules 

so that they are out of the way of the 

swimmers and are not directly submerged in water.  

 

 The lane module jack that connects to the touchpad is labeled Touchpad.  

 
Figure 11: Daisy Chain Lane Modules 

 
Figure 12: Silicone & Clean Module 

 
Figure 13: Insert Lane Module to Next 

Lane 



The push button 

connection jacks 

(marked Button 1, 

Button 2 and  

Button 3) accept 

input from backup 

buttons held by up 

to three timing 

judges per lane. As with the touchpad 

connection, match the black jack with the GND side of the plugs (Figure 14). If only 

one backup button is used, connect it to the jack marked Button 1. Figure 15 illustrates 

a lane module with all the connections made except the RTOP. 

 

The Relay Take-Off Platform connection 

plugs into Button 3, again matching the 

black jack with the GND side of the plug. If 

the system is using all three buttons per 

lane (Figure 16), the RTOP plug may be 

piggy-backed to the push button plug using 

Button 3. If the system is only using 1 or 2 

buttons per lane, plug the banana connector 

from the RTOP directly into Button 3. For 

more information on the RTOP, refer to 

Section 13:. 

 

 The Lane Extension Module (Figure 17) is 

an extension cable between the OmniSport 

2000 console and the closest lane module. 

Standard lengths of lane extension 

available are 25 , 50 , 100  and 200 . 

 

Always Remember 

 

 If some touchpads are connected backwards and some connected correctly, it will 

cause touchpads to register times when the pad has not been touched.  

 

 Watch for poor connections between plugs and jacks on the lane module. Inspect 

cabling and connectors for corrosion and damage. Use the silicone lubricant found in 

the maintenance kit to protect the jacks and plugs from corrosion. Refer to  

Figure 12 on how to clean the plugs and use the silicone before and after each use.  

Connecting to the Timer 
Connect the four-pin plug from the deck extension from the ―Near‖ end (or primary finish 

end) into J10 or the Near Lane jack on the OmniSport 2000 console. If Far End (or split end) 

touchpads are being used, connect the four-pin plug from that extension cable into J11 Far 

Lane jack on the timing console. For more information on the OmniSport 2000 timer 

connections, refer to Figure 29 in Section 2.7. 

 
Figure 14: Push Button 

 
Figure 15: Lane Module with All 

Connections Except RTOP 

 
Figure 16: RTOP Connected Piggy-back 

Style on Button 3 

 

Figure 17: Lane Extension Module 
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The in-deck cabling system is designed to eliminate most cables from the pool deck. 

Conduits, J-boxes and wall boxes embedded into the floor and walls run the cables needed to 

connect the touchpads, push buttons, RTOPs, lane speakers, horn start, back stroke speaker, 

bulkheads and timing console (Figure 18). When designing a pool, it is essential to include all 

the appropriate conduits, J-boxes and drainage. Each facility is different. If designing a 

facility, please contact Daktronics for help.  

The only cable on the pool deck will be the ones that connect a piece of equipment like a  

horn start, timing console, touchpad, etc. to a connection plate on a J-box. J-boxes mounted  

in the deck are commonly referred to as deck boxes. J-boxes mounted in or on the wall are 

referred to as wall boxes. Conduits are pipes that provide a place to run the cable between all 

of the J-boxes. 

 

 

 

 
Figure 18: Typical In-deck Installation 



Individual Lane Deck Plate 
The individual lane deck plate (Figure 19) has six sets of 

connection jacks: one touchpad, three backup push button, 

lane speaker and start. The touchpad will plug into the dual 

banana jack labeled TP. Buttons 1-3 will plug into the banana 

jacks labeled B1, B2 and B3. The RTOP will plug in the jack 

labeled B3. If the system has three push buttons, piggy-back 

the RTOP connector onto Button 3 connector.  

 

The Speaker connector is for a Daktronics individual lane 

speaker—a 45 ohm speaker. Do not substitute any other type 

of speaker without consulting Daktronics.  

 

The Start connector is used to plug a remote strobe into. In some cases, if a system does not 

have an independent start location deck plate, the horn start will be connected to the nearest 

individual lane deck plate. This will provide for the start and lane speaker connections, but 

not the Aux (Backstroke) speaker connection. 

Start Location Deck Plate 
The start location deck plate (Figure 20) is used for both the horn 

start location and the Aux (Backstroke) speaker location. Plug the 

connectors from the horn start labeled Daktronics N/O to the 

dual banana jacks labeled Start on the deck plate. Connect the 

dual banana connectors on the horn start labeled Aux Speaker to 

the jacks on the deck plate labeled Aux Speaker. Do the same for 

the jacks labeled Lane Speaker. Most pools will have one of these 

plates on both sides of the pool.  

 

If there is a second plate on the other side of the pool, connect a 

Daktronics auxiliary speaker to the dual banana jacks labeled Aux Speaker. If using a remote 

strobe for the opposite side of the pool, plug it into the dual banana jacks labeled Start.  

Bulkhead Deck Plate 
 Figure 21 illustrates a bulkhead location deck plate which combines 

the connectors from a start deck plate with the lane data from a lane 

interface in the bulkhead. Typically one of these plates is on the 

bulkhead and one on the deck. Jumper cables over 

the deck connect the two plates together.  

Wall Plates 
There are a variety of wall plates. Two of the most 

common wall plates are shown in Figures 22 and 23. 

A wall plate is typically where the timer is setup and 

connected to the system.  

 

Figure 19: Individual Lane 

Deck Plate 

 

Figure 20: Start Deck Plate 

 

Figure 21: Bulkhead  

Deck Plate Drawing 

 

Figure 22: Wall 

Plate Double-

ended Pool 

 
Figure 23: Wall Plate 

Single-ended Pool 
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Horn Start On-Deck Configuration ........................................................ Drawing A-185695 

 

For typical placement of start system components (Figure 24-26), refer to 

Figure 9 for on-deck and Figure 18 for in-deck installation. For specific  

part numbers and options available, refer to Drawing A-185695. Refer to 

ED-12935 HS-200 Operator’s Manual for additional horn start information. 

Horn Start Components 
 

 HS-200 Horn Start unit and 

microphone with coiled cord 

 

 Microphone extension 15  or optional 

wireless microphone as shown in 

Figure 26. 

 

 Power supply Start cable 30  

Always Remember 
 The HS-200 has a built-in rechargeable battery. The battery will provide 

at least 15 hours of operation when it is completely charged. The charger 

in the horn start will not overcharge the battery. After the horn start has 

been used, plug in the power supply and connect it to AC power for at 

least 24 hours before putting the horn start into storage. For longer 

battery life, DO NOT run the battery dead. Always charge the battery before storage.  

Turn the power switch off when not in use.  

Connecting the Horn Start System 
 

 Connect the lane speaker cable plug into the 

speaker jacks labeled Lane Speakers on the HS-200 

jack panel as shown in Figure 27. If an auxiliary 

speaker is used, place the speaker where desired 

and route cable from the HS-200 system to the 

speaker. Connect the cable into the speaker jack 

marked Aux Speaker. 

 

 Connect the timer output cord to the swim 

timing console. Insert the cable to the jacks 

labeled Daktronics N/O (normally open). The 

other end of this start cable is connected to the 

back of the OmniSport 2000 ―J12‖ Start Input 

(Figure 29). 

 

Note: Correct connections are crucial for the horn start to properly function. 

Improper plugging may cause damage to the OmniSport 2000 console.  

 

 

Figure 24: Lane 

Speaker 

 

Figure 25: HS-200 

Horn Start with 

Internal Speaker 

 

Figure 26: HS-200  

Horn Start with  

Wireless Microphone 

 

Figure 27: Horn Start Connections 



If using the HS-200 with an Omega® timing console, connect the start cable from the 

console to the N/C other connectors on the HS-200. 

 

If using the HS-200 with a Colorado Timing System console, connect the start cable 

from the CTS console to the N/O connectors on the HS-200. Refer to Figure 8 to 

remember to plug the GND (ground) tab to the black colored jack. 

 

 Connect the microphone into the jack labeled Mic on the horn start panel. 

 

It is important to become familiar with the connections on the back of the OmniSport 2000 

timing console (Figure 28). Make ALL connections to the OmniSport 2000 console and 

attached equipment BEFORE turning on the console‘s power switch. 

 

Equipment Connections To Use 

Single ended pool with Hy-Tek 

MEET MANAGEMENT software 

and a numeric scoreboard 

J2 or J3 –dedicated to controlling single or multi-line scoreboards, 

event/heat, score and lengths/record time modules 

J6 – Results port allows bi-directional communication with results programs 

such as Hy-Tek’s MEET MANAGER 

J10 – Near End lane harness (in-deck or on-deck) 

J12 – Start Input from horn start 

J13 - Power 

Far End (Split End) lane harness           

(in-deck or on-deck) 

J11 – Far End lane harness (in-deck or on-deck) 

OmniSport Pro software J4 – Expansion port for integrating to a PC to upgrade to the OmniSport Pro 

Windows® based software 

Matrix scoreboard J5 – RTD port for bi-directional communication with a Venus® Full Matrix
 

Controller or CTS scoreboard 

Track/rodeo push button timing J7 – external switch port 

Water polo J8 – external game clock switch port for water polo 

J9 – external shot clock switch port for water polo 

Judge console J14 – Judge console 

J15 – Judge console 

(Example: 4 judges on one side of the dive well are plugged into J14 and 3 

judges on the other side of the pool are plugged into J15 for a total of 7 

judges. A maximum of 9 judges can be plugged into either J14 or J15. 

Diving has a maximum of 9 judge consoles. Synchronized swimming has a 

maximum of 18 consoles. 

 

 
Figure 28: Back of OmniSport 2000 Console 
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1. Connecting deck harness and the horn start: 

Figure 29 shows a Near End deck 

harness connected to J10 and the 

cable from the horn start plugged 

into the J12 Start Input. Remember 

the ground (GND) tab on dual 

banana plugs line up with the black 

female connector.  

 

2. Connecting a Daktronics numeric display: 

Connect the scoreboard to J2 or J3 port as shown 

in Figure 30. Make sure that the plug is fully 

inserted into the jack on the console. 

 

3. Connecting to a computer with OmniSport 2000 

Pro software: 

Using a straight through 9-9-pin male/female 

serial cable (Daktronics part# W-1267, 6' or Radio 

Shack part #27-117), connect the end with male 

pins to J4 on the OmniSport 2000 console (Figure 

31). Connect the end with female pins to the serial 

port on the computer with the OmniSport 2000 

Pro software (Figure 32). If the computer does not 

have a built-in serial port, use a USB-to-serial 

adaptor (Figure 33 - Daktronics part# A-1801 or 

Radio Shack part #26-183). The drivers for the USB device should be found on the 

CD provided with the device, or on the manufacturer‘s web site.  

 

4. Connecting to a computer with results software  

(example: Hy-Tek’s MEET MANAGER): 

Using a straight through 9-9-pin male/female serial cable 

(Daktronics part# W-1267 - 6   or Radio Shack part #26-183),  

connect the end with male pins to J6 on the OmniSport 2000 

console (Figure 31). If the cable needs to be longer than 20 , 

contact Daktronics. Connect the end with female pins to the 

serial port on the computer with the results software (Figure 

32). If the computer does not have a built-in serial port, use a 

USB-to-serial adaptor (Figure 33- Daktronics part# A-1801 or 

Radio Shack part is #26-183). The drivers for the USB device 

should be found on the CD provided with the device, or on 

the manufacturer‘s web site.   

 

5. Connecting a matrix display: 

Different matrix displays may require different connection 

methods. A typical connection method for Venus 1500 controlled displays and some 

Venus® 7000 controlled displays  uses a 9-pin male to ¼  stereo phono cable 

(Daktronics part# A-1240-0032, 50ft). Connect the 9-pin male end to J5 on the 

OmniSport 2000 console (Figure 31).Connect the male ¼ stereo phono plug into the 

appropriate connector on the wall plate.  

Figure 29: Lane Data and Horn Start Plugs 

 
Figure 30: Numeric Scoreboard Plug 

 

 
Figure 31: Serial Cable Connection to 

Console 

 

 
Figure 32: Serial Cable 

Connection to Computer 

 

 
Figure 33: Using a USB to 

Serial Adaptor 

 



 

The OmniSport 2000 console will time swimming and diving meets without the Pro software. 

The OmniSport 2000 Pro software allows officials to run events from a desktop or laptop 

computer with all the benefits of Microsoft® Windows®. The OmniSport 2000 console  

connects to the computer and all operations of the timer can be handled through the 

computer and expands the capabilities of the operator. Refer to Section 6:, Section 9: and 

Section 10: for more information. 

 

Connect the results computer, OmniSport 2000 console, optional Pro software and numeric 

scoreboard, Venus® 1500 or Venus® 7000 controlled displays (Figures 34-36). Refer to  

ED-13876 in Appendix B: to configure Hy-Tek‘s MEET MANAGER.   

 

 

Figure 34: Connecting Numeric Scoreboard with Optional Pro Swim Software 

 

Figure 35: Connecting to a Venus 1500 Controlled Display 

 

Figure 36: Connecting to a Venus 7000 Controller and Display 
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After each meet, it is crucial to follow these basic maintenance procedures to ensure the 

longevity of the timing equipment.  

 

 Turn off the power to all equipment including the OmniSport 2000 console, HS-200 

horn start, results computer, OmniSport 2000 Pro computer, matrix computer, 

scoreboard, printers and any other equipment associated with the system. 

 

 When the system is set up for an event, 

touchpads should be removed from the 

water and inspected every 48 hours and 

allowed to dry for 6 hours. Inspect 

connections and the edge protectors around 

the perimeter on the face to ensure it is 

secure. Look at the face and top edge for 

dents. At the end of each meet, remove the 

touchpads from the pool, place them onto 

their storage cart (Figure 37) and store them 

in a room outside of the pool environment and chemicals.   

 

 Completely dry all equipment and place into appropriate tote or carrying cases for 

storage. Coat all cleaned cabling connections with silicone grease. The silicone is 

Daktronics Part# LU-1002 and is included in the maintenance kit. Place portable 

cabling equipment into a storage tote. Place all equipment not permanently installed, 

in a cool, dry storage space away from the pool environment and chemicals. 

Recommended temperatures in storage area should range between 33°F and 90° F 

(55° C and 32.2° C) with adequate fresh air circulation. 

 

Use the brush provided in the maintenance kit to remove any corrosion from the 

banana connections. After cleaning, apply silicone grease to the connectors.  

 

 

 
Figure 37: Touchpad cart 

 



Section 3: General Console Features and 
Operations (non-sport specific)  

This section introduces the user to the OmniSport
®
 2000 timing console. The console is reliable and 

easy to use for beginning operators, but has the ability to expand its capabilities to satisfy the desires 

of the most advanced operator. The OmniSport 2000 console comes programmed for swimming, 

diving, pace clock, water polo, track, and as an interface for Pro Diving and Pro Synchronized 

Swimming programs.  

 

Note when using Pro software programs: The OmniSport 2000 console capabilities are expanded 

when used with software programs available for swimming, diving and synchronized swimming. 

 

When using the OmniSport 2000 Pro Swimming Software (Section 6:), it becomes an extension of 

the console. If the computer running the OmniSport Pro Swimming program were to crash, the 

operator can finish timing the event using the OmniSport 2000 console. When using the OmniSport 

Pro Swimming software in combination with the console, some operators do all functions in the Pro 

software, some use the keypad on the console in combination with the Pro software, while other 

operators do everything on the console and only use the Pro software to monitor what is going on.  

 

When using the Pro Diving (Section 9:) or Synchronized Swimming (Section 10:) program, the 

OmniSport 2000 console becomes an interface between the computer with the Pro software and the 

judges consoles, scoreboards, log printer, results, etc.  

 

Remember that only one OmniSport 2000 Pro program should be open on the computer at a time. 

 

The OmniSport 2000 console 

has three separate two-line by 

16 character LCDs to keep the 

operator informed (Figure 38). 

Section 3.5 describes the 

readout on the LCDs when the 

console is first powered-up.  

 

Throughout the manual, keys 

are referenced with brackets and bold type—example [Enter]. 

 

The far left side of the keypad on the OmniSport 2000 console has a pocket that allows for a 

plastic insert with the names of the keys. Following is a table with the sport and the 

Daktronics part# for the insert needed. For example, the swimming insert is LL-2549. 

Slide inserts not being used may be conveniently stored in an area on the bottom of the 

console. If an insert is lost or damaged, a copy of the insert drawing (located in Appendix B:) 

can be used until a replacement is ordered. 

 

 

 

 
Figure 38: OmniSport 2000 Timing Console 



General Console Features and Operations

Sport Insert Number 

Swimming LL-2549 

Diving LL-2566 

Water Polo LL-2569 

Track LL-2573 

Pace Clock LL-2581 

 

Note: Remove the protective plastic film from the insert 

(Figure 39) before using it in the console. 

 

The keypad (Figure 40) also has a section of keys 9 (right 

side) that are used and printed permanently. These keys 

include the numbers 0-9, Clear/No, Enter/Yes and Arrow 

keys. Notice the Up and Down keys are also labeled Next 

and Last. The function of these keys will depend on 

what the LCD is prompting the operator to do. 

 

 

Daktronics OmniSport 2000 console has a convenient built-in thermal 

printer which gives results printouts in under 10 seconds.  

Correct Paper Installation 
 

1. Remove the cover from the printer by turning the knob with 

the arrow to the left ¼ turn, or until the arrow points left. 

Remove the cover by lifting up and forward on the knob 

(Figure 41).  

 

2. Remove the old roll of paper. 

 

3. Take the new roll of paper and using a scissors, cut the 

paper off to make the end of the paper square. 

 

4. Place the roll of paper into the printer compartment so 

that the paper feeds up from underneath the roll (Figure 

42 and Figure 43). If the paper is placed incorrectly, the 

printer will act like it is printing, but no text will appear 

on the paper. 

 
Figure 39: Remove Plastic Film 

 
Figure 40: OmniSport 2000 Keypad with Diving Insert 

 
Figure 41: Console 

Printer 

 
Figure 42: Correct Paper 

Feed 



5. Place the newly cut squared edge of the paper into the 

back side of the black rubber roller on the printer. The 

printer should automatically advance—pulling the 

paper through the printer.  

 

6. Place the cover back on and turn the latch to secure. 

 

The thermo printer paper can be ordered from Daktronics—

part # SF-1034. Thermo printer paper is also readily available 

at office supply stores (58mm wide and 165 ft. long). 

 

Connector Designations: OmniSport 2000 ............................................ Drawing A-154282 

 

Refer to Drawing A-154282 for a complete listing of the connectors, their printouts and 

functions of those pins.  

 

After all connections are made, turn on the OmniSport 2000 timer. Initially the LCD display 

confirms the product, the version and software identification as illustrated below. 

 

     1      2      3      4      5              6      7      8      9      10  

 

 

 

 

Within a few moments, the far right LCD changes to request  

entry of the date and time. This date and time appears on  

each event printed from the OmniSport 2000 console. Using  

the numeric keypad, enter the date in the standard format. 

Press [Enter] then enter time of day and press [Enter].  

(If the operator presses [Enter] for the date and [Enter]  

for the time without entering anything on the numeric  

keypad and the console is connected to the Pro software, the console will take the computer‘s 

date and time.)  

 

Use the Arrow keys on the console to select the desired  

sport, then press [Enter].  

 

If the timing console includes a radio, read Section 3.6.  

If the console does not, skip to Section 3.7 on how to receive software updates from 

Daktronics. For further explanations on swimming, diving and water polo timing console 

operations refer to Sections 4-10. 

 

 

 

 
Figure 43: Incorrect Paper 

Feed 

OMNISPORT 2000 
TIMING CONSOLE 

VERSION 8.3.27 
ED-12913 

DAKTRONICS, INC 
BROOKINGS, SD 

ENTER DATE; 
DATE:01/01/00 

ENTER TIME: 
TIME:00:00:00 

SELECT SPORT 
1-SWIMMING 



General Console Features and Operations

 

Channel Selection: Single Control Console, Gen IV ............................. Drawing A-180566 

Channel Selection: Single Broadcast Group, Gen IV ............................ Drawing A-180922 

Channel Selection: Multiple Broadcast Group, Gen IV ......................... Drawing A-180923 

 

This section explains the radio channels for OmniSport 2000 consoles with a built-in radio to 

communicate with a numeric scoreboard and water polo shot clocks.  

 

The radio receiver units used in scoreboards have a channel-setting switch that can be set 

from 1 through 8 (channels 0, and 9-15 are not used). A radio receiver accepts data from a 

console transmitter with the same channel (and broadcast group) setting. The drawings listed 

above show how to install the OmniSport 2000 console in order to operate one scoreboard or 

multiple scoreboards at a time. 

 

The receivers also have a jumper that can be used to select broadcast group 1, 2, 3,  

or 4. A ―Broadcast Group‖ defines a group of radio receivers that in addition to ―listening‖ to 

the channel selected on the channel switch will also ―listen‖ for data broadcast on their 

broadcast group. There are a total of four broadcast groups available. In this type of system, 

the receiver unit at the scoreboard must have the channel switch set to a specific channel. The 

operator must know which channel the board is set to, then enter that specific channel during 

console startup when prompted to do so.  

 

Each radio receiver accepts data sent from the channel of its respective broadcast group. This 

is selected by setting the transmitter radio (from the console) to the respective broadcast 

group (either 1, 2, 3, or 4). Every radio receiver accepts data sent from the ―Master Broadcast‖ 

group. This is selected when a transmitter (console) radio is set to Broadcast Group 0 (BCAST 

0) and Channel 0. The channel number and broadcast group set on the radio installed in each 

scoreboard can be verified by cycling power to the scoreboard. Approximately seven seconds 

after power up, the scoreboard will show the current broadcast group and channel in the 

scoreboard clock digits.  

 
An AXX first shows when XX is the current scoreboard address setting. This will be followed 

by BXCY where X is the current broadcast group and Y is the current channel number within 

this broadcast group. 

 

There are three different radio scenarios that can be accommodated. 

 

1. Single Controller System: 

In a single controller system, all radio receivers receive the same signal from one 

OmniSport 2000 console. The default channel and broadcast group settings on the 

receiver are not typically modified. An example of this type of system is a typical 

high school swimming installation. 

 

2. Multiple Controller System With a Single Broadcast Group: 

In a multiple controller system with a single broadcast group, there are additional 

Omni Sport 2000 controllers for controlling multiple scoreboards. An example of this 

type of system is a natatorium with multiple pools and a scoreboard and controller 

on each pool. 

 



 

3. Multiple Controller with Multiple Broadcast Groups: 

In a multiple controller with multiple broadcast (split pool operation) system, there 

are additional OmniSport controllers that can control multiple scoreboards. The 

broadcast group jumper is used to select broadcast group 1, 2, 3, or 4. By changing 

the OmniSport 2000 console settings to a broadcast group, a single OmniSport 2000 

controller can control all scoreboards or specific groups of scoreboards (defined by 

the broadcast group). One example of this scenario is split pool operation in facilities, 

where scoreboards are used to score multiple meets at once, but can be grouped 

together to score one event if necessary. Refer to the drawings listed on the previous 

page for more information. 

Basic Operation of Radio Settings 
The OmniSport console automatically detects when a radio transmitter is installed and 

prompts the user for transmitter settings.  

 

The OmniSport console will show the current radio status  

on the LCD when a code is entered along with a prompt  

to accept or modify these values. If the radio settings are  

correct, press [Enter]. If the values are incorrect, press  

[Clear]. The LCD illustration at the right is shown,  

allowing editing of the channel or broadcast group setting.  

Use the number keys to enter the desired broadcast  

group and press [Enter] to accept. If interference from a nearby Daktronics system is 

suspected, press [Clear] at the Radio Settings prompt and change the channel number. 

 

The asterisk will move to the channel setting. Use the  

number keys to edit this value and press [Enter] to accept.  

The default setting is Broadcast 1 Channel 1 as shown in  

the LCD illustration.  

 

Broadcast group and channel settings: 

 

Broadcast 

Group 
Channel Setting Control Scoreboards 

0 0 All Scoreboards 

1 0 All in BCAST Group 1 

1 1-8 Set to corresponding BCAST 1 Channel 

2 0 All in BCAST Group 2 

2 1-4 Set to corresponding BCAST 2 Channel 

3 0 All in BCAST Group 3 

3 1-8 Set to corresponding BCAST 3 Channel 

4 0 All in  BCAST Group 4 

4 1-4 Set to corresponding BCAST 4 Channel 

Single Controller Systems Channel Setting 
Typically all single controller systems use the default setting: BCAST=1, Chan= 1. For radio 

receivers with the Broadcast 1 (BCAST1) jumper set, always place the switch setting to 1. 

RADIO SETTINGS 
BCAST Y CHAN XX 

[ENTER] TO ACCEPT 
CLEAR TO MODIFY 

BCAST GROUP 1 
RADIO CHAN 01 
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Broadcast Group Setting 1 
The asterisk will move to the channel setting. Use the number keys to edit this value and 

press [Enter] to accept. The default setting is 

Broadcast 1 Channel 1 as shown in the LCD illustration.  

For all single controller system use this setting.  

Channel Setting 1-8 
Channels that may be used with broadcast channel 1. The channel switch on the receiver 

must match this value and only the Broadcast 1 (BCAST1) jumper must be installed. 

Multiple Controller with Single Broadcast Group Channel Setting 
Typically all multiple controller systems use broadcast 1 and channel 1 for the first controller 

and channels 2-8 for all remaining controllers. All radio receivers must be set with a channel 

switch setting corresponding to the console controlling the scoreboard and a Broadcast 1 

(BCAST1) jumper set. 

 

Adjust channel settings and broadcast groups using the same procedures previously 

described for basic operation of radio settings. 

Multiple Controller with Multiple Broadcast Systems Channel Setting 
Typically all multiple controller systems use Broadcast Group 1 Channel 1 for the first 

controller in Broadcast Group 1; and Broadcast Group 2 Channel 1 for the first controller  

in Broadcast Group 2. All other consoles in each group are added sequentially, using 

channels 2-8.  

 

Adjust channel settings and broadcast groups using the same procedures previously 

described for basic operation of radio settings. 

 

Equipment needed: 

 

 Computer connected to the Internet 

 

 Computer with a serial com port. The com port can be built-in or a  

USB-to-serial adapter 

 

 9-pin male-to-female cable, Daktronics part # W-1267 or Radio Shack part #27-117 

(the cable is included in the maintenance kit) 

 

 OmniSport 2000 timing console 

 

To update the OmniSport 2000 timer, complete the following instructions:  
 

1. Connect the 9-pin serial cable from the com port of the computer to the Expansion 

Port (J4) on the console.  

 

2.    Open an Internet browser and go to: 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000 

Timer/DakLoader2.exe  

BCAST GROUP 1 
RADIO CHAN 01 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000Timer/DakLoader2.exe
http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000Timer/DakLoader2.exe


A prompt will appear on the desktop to 

Run or Save the program. Select Run. 

The DakLoader2 program should open 

as shown in Figure 44. 

 

3. Open the File menu, then Hex Files and 

select Download Latest Hex Files 

option (Figure 45). 

 

4. Open the Communications menu to 

select the com port that the 9-pin serial 

cable is connected to. 

  

5. In the main screen, click on the option 

button next to Aquatics then click 

Update.  

 

6. Turn the OmniSport 2000 console OFF and then back ON to cycle power to the 

console. The console should automatically begin programming the hex file selected. 

 

7. To review DakLoader2 Instructions, click About > Help using DakLoader2. To 

confirm system status or for more information from Daktronics, click About > About 

DakLoader2.  

 

 

 

Figure 44: Open Software Update Folder 

 
Figure 45: Hex Files menu bar 





Section 4: Operating the Console in Swimming 
Mode 

Sport Insert LL-2549 

 

Insert: LL-2549 Swimming OmniSport 2000 console ................................... Drawing B-163808 

  

The sport insert drawing is located in Appendix B:. If an insert is lost or damaged, a copy of the 

insert drawing can be used until a replacement can be ordered. Refer to Section 3: for information in 

starting the timer and for instructions on using the sport insert. This section familiarizes the user with 

the OmniSport 2000 console operation in swimming mode. 

 

The swimming mode of the OmniSport 2000 timer will perform automatic timing and 

judging for up to ten lanes with two touchpads per lane (one touchpad at each end of pool 

for near and far end splits; Relay Take-Off Platforms; and one, two or three backup buttons 

per lane. Races of up to 66 splits can be accommodated with all split times and final times 

logged on the printer as they occur. All near and far split times, final times and backup times 

are also recorded in memory and are available for additional printouts as needed. 

 

The OmniSport 2000 timer can be set up to record split times from both ends of the pool. 

Near-end cabling is connected to the near end connector on the back of the timer (J10).  

Far-end cabling is connected to the far end connector on back of the timer (J11). Refer to  

Section 2.7 for more information. 

 

The OmniSport 2000 timer can store approximately 50 races depending on the number of 

lanes in the pool and the length of the races. The OmniSport 2000 timer will automatically 

clear the oldest events. This ensures that old races will not be confused with new ones by the 

operator. If the Omnisport Pro Swimming software is connected to the console, the stored 

races in the console will be transferred to the computer and erased in the console. After that 

point, the results can be found in the Pro software. 

 

The always-ready-start feature is another operator aid that allows correct times to be 

recorded in the event of certain operator errors or equipment problems. These features are 

described fully in Section 4.9. 

 

Figure 46 shows the right LCD display. The top 

line shows the running time (RT). The bottom line 

displays the event number (E), the heat (H), the 

current round (R), and the total number of lengths 

to be completed (L). The current round shows 

whether the race is a standard timed event (blank), 

a preliminary (P), a semifinal (S), or a final (F). The 

current round (R) only appears when the selected 

event is found in the programmed event order. 

 
Figure 46: Swimming LCD Display 
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The (R) disappears if an event is selected that is not programmed. To set the Event Order, 

refer to Section 4.3. 

 

While other race information is shown on the right 

LCD, the two left LCD screens show lane status and 

current length. The top line is lane status and the 

bottom line is the length counter. Figure 47 shows a left 

LCD screen before race data has been entered. The table 

below explains the lane status symbols that may appear 

on the left screens during a race. This can be changed if 

using touchpads at one or both ends of the pool Refer to 

Section 4.7 for more information on Near End and Far End touchpad status during a race. 

 

 

 

 

 

Lane Status 

Symbols 
Represents 

- Lane is turned on but unarmed 

NN Arming delay (NN represents a number from 1-99 that is counting down to 0) 

+ Lane armed for a split time 

* Lane armed for a finish time 

o Lane has finished the race 

? No lane module present or fault 

A An overly active input—likely a bad connection or faulty button 

R A faulty RTOP—replace the batteries in the RTOP 

 

The keys permanently printed on the right side of the keypad are discussed in Section 3.2. 

This section will define the keys on the sport insert for swimming, part# LL-2549, as 

illustrated in Figure 48. Section 3.2 explains how to install or remove the sport insert.   

 

The keys highlighted are grouped together and shaded by lane. Lane 1 keys line-up vertically 

with Lane 1 on the LCD, Lane 2 keys with Lane 2 and on through Lane 10.  

 

 

 
Figure 47: Left LCD Screen 

 

Figure 48: Swimming Insert LL-2549 

 0     4    +    *    -      
 4     2    0    2    2      



Lane ON/OFF for Each Individual Lane 
At the start of a race, the time automatically turns every lane on. It is up to the operator to 

turn them off if needed.  

 

For each lane that is empty (no swimmer in that lane), press [Lane ON/OFF] to tell the timer 

to not expect any data from that lane. A second use of the key is to temporarily disable a lane 

and then turn it back on. For example, this is useful during a relay event. If the arming delay 

on a lane is about to expire and the athlete has not climbed out of the pool, the operator can 

press [Lane ON/OFF] for that lane and prevent a false touch from the touchpad. After the 

athlete is out of the pool, the operator then presses [Lane ON/OFF] again to turn the lane on 

and prepare for the next valid input from the touchpad.  

Finish Arm for Each Individual Lane and Finish Arm All 
The timer receives split times and finish times. What is unique about a finish time is that it is 

the end of the race and the timer compares the final time to the back-up time (push buttons). 

The final time is what is used to place that lane into the final results. The Finish Arm key for 

each individual lane is used to force that lane to be ready for a finish time. Typically when 

the timer has a pre-programmed event order and the operator selects a particular event, the 

timer knows how many split times to receive before it is expecting a finish time. The Finish 

Arm key is used in the event a swimmer is on his/her final leg and the timer is not ready to 

receive the finish time. Pressing [Finish Arm] will set the status of that lane to Lane armed for a 

finish time and the length count will be adjusted accordingly.  

 

Examples of when to use Finish Arm: 

 

 A missed touchpad time and the timer was still expecting a split time 

 

 Timer received an extra touchpad time caused by a swimmer reaching over the top 

of the pad 

 

 A swimmer not climbing out before the arming delay expired on a relay 

 

  Touchpad malfunction 

 

 Wrong event number used and incorrect length of the race—typically this would be 

corrected with a [Finish Arm All] 

 

 Operator is not using a pre-programmed event order and the incorrect number of 

lengths was entered. Typically this would be corrected with a [Finish Arm All] 

 

 Arming Delay programmed too long and the lane not armed to receive the finish 

time 

Split Arm for Each Individual Lane and Split Arm All 
When the timer is armed for a split, it only receives times from the touchpad input and if it is 

a relay exchange, the Relay Take-Off Platform (RTOP). If the arming delay is counting down 

for a particular lane, and the swimmer is about to press the touchpad for a split time, the 

operator can press [Split Arm] for the desired lane and the timer will immediately decrement 

the length count by one and set the lane status to Lane armed for a split time. If the lane is 

already armed for a split time, finish time or finished, ignore Split Arm. 
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Examples when to use Split Arm:  

 

 During a relay, the arming delay for the touchpad was too short because a swimmer 

from one of the first three legs was still in the water and triggered the touchpad 

before climbing out. 

 

 Another swimmer reached over the top of a touchpad and triggered the pad. 

 

 A malfunctioning touchpad. 

 

 If the arming delay was set too long and all lanes need to be armed for a split, press 

[Split Arm All]. 

 

 If there were a start system failure, press [Start] then [Split Arm All] and [Enter]. 

The timer records the finish order of the race. The time will be incorrect, but the 

finish order will be correct. 

 

The swimming insert (Figure 48) has additional keys on the fourth row along with keys on 

the right side of the insert which are used regularly during a meet. The remaining keys are 

not lane specific, but are equally important in operating the timer. 

Start 
In most cases, there is a horn start connected to the timing console to signal the start of the 

race. Under unique circumstances, the operator has the option to start the timer counting by 

pressing [Start]. The printer will label the results with the source of the start. If the keypad 

was used it would be labeled—Source: Keyboard. If the start was from the horn start it would 

be labeled—Source: External. 

 

Examples when to use Start: 

 

 Test the timing system or scoreboard 

 

 If there were a start system failure, press [Start] then [Split Arm All] and [Enter]. 

The timer records at least the finish order of the race. The time will be incorrect, but 

some data is better than no data. 

Store Print 
Press [Store Print] to tell the timer to store the race results for that heat up to that moment. In 

addition to storing the results, the timer will print whatever printouts are configured in the 

settings menu for the printer (refer to Section 5.4). If using the OmniSport 2000 Pro 

Swimming software, the operator may view/edit the settings from that program (refer to 

Section 6.6). If [Store Print] was pressed before the race was complete, it is essential that it be 

pressed again when the race is complete in order to save and print the complete results. If 

not, any changes/additions will be lost.  

 

 

 

 

 

 



Examples when to use Store Print: 

 

 To verify the results before the console is reset. This might be to look at the tolerances 

between the touchpad and back-up times to see if the back-up push buttons should 

be used instead of the touchpad 

 

 To produce more than one set of printouts. Press [Store Print] more than once and 

each time will create a printout 

Paper Feed 
Press [Paper Feed] to have the printer advance the paper. The printer will not print on the 

advanced lines.   

Next Event  
The Next Event, Heat +1, Heat -1 and Event/Heat keys tell the timer which event/heat is 

going to be swam next. When an event order is pre-configured, the timing console knows the 

length of the event and the record time for that event.  

 

Having a programmed Event Order makes operating the timing system during a meet much 

easier. There are three methods of setting up an Event Order. 

 

1. Download from a results program like Hy-Tek‘s MEET MANAGER.  

See ED-13876 page 5. 

 

2. Using the OmniSport 2000 Pro software, pick the Event Order from one previously 

saved, or program a new one. 

 

3. Manually program it in the OmniSport 2000 console. 

 

Event Order downloaded from Hy-tek or  

OmniSport 2000 Pro software 

Includes: Event Number, Round, Distance, 

Gender, Age Group, Stroke, Heat Title and 

Record Time  

 

Event Order edited in the  

OmniSport 2000 console 

Includes: Only basic information needed to set the 

timer—Event Number, Round, Distance and 

Record Time 

 

When an Event Order is downloaded, it does not include information like the start lists, or the 

number of heats. One thing that many operators worry about is re-downloading, if the 

seeding or the number of heats change. This is not necessary. The OmniSport 2000 console 

gets that information using the Event Order. When the operator selects the event, the timing 

console asks the results computer for the current start list for that event, round and heat.  

 

An Event Order has room for up to 500 different pre-programmed events numbered 1-999 

with or without an A-Z designator following the event number. The Events do not need to be 

in numerical order. They should be programmed in the order that the events occur. 

 

The Event Number can be from 1 to 999.  Following the event number there is a position to set 

an alpha character used to distinguish between varsity and junior varsity, or different levels 

of swimmers when ―A‖ swimmers must compete against each other and ―B‖ against ―B‖. 
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The Round can be left Blank, set to Preliminary, Semi-Final or Final. The Round allows the 

results program to distinguish between Heat 1 of prelims versus Heat 1 of finals. The 

printouts will also be designated with a round. 

 

The Distance is the distance of the event to be swam. The console has the length of the pool 

configured. If the console was configured to a 25 yard pool and a distance of 200 was set, the 

console would do the math and automatically set the number of lengths for that event to 8. 

Additional Settings Only Available in the Pro Software 
The Type can be left Blank, set to Girls, Boys, Womens, Mens or Mixed. This puts the correct title 

for that event on the printout from the Pro software and the event title on a matrix display. 

 

The Age can be set to whatever is selected for the meet. This enters the correct title for that 

event on the printout from the Pro software and the event title on a matrix display. 

 

The Stroke can be left blank, set to Free Style, Back Stroke, Breast Stroke, Butterfly, Individual 

Medley, Freestyle Relay, Medley Relay, Backstroke Relay, Breaststroke Relay, Butterfly Relay, 1 Meter 

Diving, 3 Meter Diving or Platform. When the timing console sees a relay event, and relay 

platforms are connected, it will utilize them in its timing. During individual events, the 

OmniSport 2000 console will ignore platforms for everything except the start reaction. 

Remember, there will be no start reactions for events that start in the water like Backstroke 

and Medleys. When the timing console opens to a diving event, it will prompt the operator to 

switch to diving, either YES or NO. 

 

The Heat can be left blank, set to Final, Consolation, Bonus Final or Timed Final. This serves no 

other purpose than to put the correct title for that event on the printout from the Pro software 

and the event title on a matrix display. 

 

The Record Time is for display on the record time auxiliary module. When an event order is 

downloaded from Hy-Tek software and the record time is entered into the Hy-Tek program, 

the event order will be included. 

Lengths  
If the operator has not configured the console with an event order, it is pertinent that the 

correct number of lengths be set for the race being timed. Press [Lengths] followed by the 

number of lengths to be completed using [0-9]>[Enter]. Every time the swimmer goes from 

one end of the pool to the other is a length. To figure out the correct number of lengths, 

divide the distance of the race by the length of the pool. Example: a 200 yard race in a 25 yard 

pool (200/25=8), Lengths = 8. The maximum number of lengths that the OmniSport 2000 

console will time is 66.  

Reset 
When a race is complete, the operator presses [Reset]>[Enter] to reset the timer.  

 

Note: If the operator has not pressed Store Print before resetting the timer, pressing [Reset] 

will store the race and print the results in addition to resetting the clock.  

 

If the timer was not reset before the start of the next race, see Section 4.9, Always  

Ready Start.  



Menu 
Press [Menu] to access additional 

functions and settings in the console 

(Figure 49). Section 5: describes the menus 

in swimming and how to navigate them.  

+Touch and -Touch  
Press [+ Touch] and [- Touch] during a 

race to adjust lengths count for a lane. 

This keeps the timer‘s internal length 

count correct if there is a missed split time 

or an accidental touch. To make the 

changes to the desired lane, press  

[+ Touch] or [– Touch] followed by the 

specific Lane ON/OFF key (or the lane number on the numeric keypad) and press [Enter].  

 

Examples of when to use +Touch and –Touch: 

 

Missed touchpad on a split—press [+Touch]>[Lane ON/OFF] for the desired lane. 

 

Swimmer in the water got out late during a relay and triggered the touchpad. If the 

operator caught it right away, Split Arm would have been pressed. If the arming 

delay has counted down and the lane is armed for the next touch, press  

[-Touch]>[Lane ON/OFF] for the desired lane.  

Edit 
The function of [Edit] depends on whether or not the time is reset, or if the clock is counting.  

If the Timer is Reset 
With the timer reset, press [Edit] to bring up the Edit Start  

Menu on the right LCD. The Time of Day for the last start  

received will be displayed. Verify that is the correct start  

time and press [Enter], or use the numeric keypad to input  

the correct Time of Day and press [Enter].  

 

Examples of when to use Edit when the console is Reset 

 

 If the console was reset accidently and the race was still going on.  

 If two OmniSport 2000 consoles are being used in parallel and one timer either 

missed the start, or it was accidently turned off, a start Time of Day could be read 

from the printout on the other console.  

If the Clock Is Still Counting 
When the running time is counting, press [Edit] to make corrections to the times in the 

current race memory. Use [Edit] to insert a backup or a stopwatch time if there was a 

problem with a touchpad. Distinguished from touchpad times on the LCD screen and 

printouts, edited times indicate an ―E‖ if manually entered or a ―B‖ if it is a backup time. 

 

 

 
Figure 49: Keypad Navigation 

START EDIT 
02:23:14.500    * 
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1        2       3        4        5           6       7        8       9      10 

 

 

 

 

The top line of the two left LCD screen display the current lane status. An arrow by the lane 

also indicates which lane is currently selected for editing. The following table defines what 

each symbol means. 

 

Symbol Definition 

▪ There is an error in the lane and the data needs to be edited. 

DQ Indicates the person in the lane has been disqualified. 

E Indicates an edited time. 

 - -  Lane has been turned off. 

OK All data is correct. 

 

The bottom line of the left LCD screen shows the lane and time, and the center LCD shows 

the backup time. The right LCD shows the options available for editing the lane times. Press 

[1] to skip to the next lane. Press [2] to use the backup time. Press [3] to edit the lanes time. 

Press [4] to turn the lane ON/OFF. 

Disqualification (DQ) 
Before the meet, the timing operator should clarify with the meet referee if he/she wants the 

swimmers to be disqualified on the timer. Clarification of this is important for results to be 

properly ranked on the printouts and meet management software which will show as a DQ 

on the scoreboard.  

 

Press [DQ] (disqualification) and [Lane ON/OFF] for the desired lane (or press the lane 

number on the numeric keypad) and press [Enter]. The DQ operation is normally done at the 

conclusion of the race, after the officials have ruled on the situation that caused the swimmer 

to be disqualified. On exit from the DQ command, the scoreboard  

is automatically updated and any subsequent printouts will show  

the revised placing. The DQ operation shown on the right LCD  

screen as illustrated, can be done at any point in the race and  

does not affect arming or recording of times for the lane. Press the same lane number  

again while in the DQ command to re-qualify the swimmer and the original status  

indicator is returned. 

 

 

 

 

 

 

 

 

 

OK   OK   00 - -   E 
LN 6 0.00* 

▪ ← OK OK   E   OK 

BACKUP  -- 00:00.00 

1 – SKIP  2 – BACKUP 
3 – EDIT  4 – ON/OFF 

DISQUALIFY (DQ) 
LANE NUMBER:10 



 

The normal single-line display of timing information is completely automatic and does not 

require any operator input. The following information is for normal (automatic) operation. 

Figure 50 shows the sequence of information paging through a scoreboard during a race.   

Start of Race 
The running time counts up from 0.0. 

Split Times 
The scoreboard will display the first place split time with the lane. The split time will hold for 

however many seconds as is set in the setup 

scoreboard menu of the OmniSport 2000 

console (default=15 seconds).  

 

The display will continue showing the 

running time. 

Finish Times 
At the end of the race, the scoreboard will 

scroll through the results in the order that 

they finish. Each finish time will hold at least 

the amount of time it is set to hold in the 

setup scoreboard menu in the OmniSport 

2000 console (default=5 seconds).  

Timer Reset 
The scoreboard scrolls through the results of 

the last race until the start of the next race.  

 

 
Figure 50: Scoreboard Sequence 
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Multiple-line scoreboards are any LANE, PLACE and TIME digit board that will display two 

or more lanes of results at one time. If the scoreboard is big enough to show all of the lanes in 

the pool at the same time, the console can be configured to show the results in lane order or 

place order.  

 

If there are more lanes in the pool then 

the scoreboard can show, the console will 

display the results in place order by 

scrolling through the results one page at 

a time. To configure how the OmniSport 

2000 console should display information 

on the scoreboard, see Section 5.7.  

 

The normal multi-line display of timing 

information is completely automatic and 

does not require any operator input. 

Figure 51 illustrates a three-line 

scoreboard with a 6-lane pool. Figure 52 

illustrates a six-line scoreboard with a  

6-lane pool. 

Start of Race 
The scoreboard shows the running time 

on the top line of the scoreboard and 

blanks the remaining lines. The running 

time counts up from 0.0. If the number of 

lines on the scoreboard equals the 

number of lanes in the pool, the operator 

can select lane order or finish order. If 

the number of scoreboard lines is less 

than the number of lanes in the pool, the results are forced to place 

order.  

Split Times 
Split times are shown in lane order (default) for each lane on the corresponding scoreboard 

line. Split times are held for fifteen seconds (default). If the number of lines on the scoreboard 

is less than lanes in the pool, only the first place split is displayed. Final times will page 

according to the number of lines set. These functions are configured in the Setup-Numeric 

Scoreboard menu (refer to Section 5.7).  

Final Time 
Final times are displayed on the scoreboard until the next race begins. 

Timer Reset 
The scoreboard shows last race data until the start of the next race. 

 

Figure 51: Sequence of a 

3-Line Scoreboard with a 

6-Lane Pool. 

 
Figure 52: Sequence of a 6-

Line Scoreboard 



 

Before the race begins the operator must set and confirm that the OmniSport 2000 console is 

ready to record the correct event.  

Verify the Console is Reset 
Confirm the console is reset and that RT shows 00:00.0 

(Figure 53). Set the correct Event, Heat and Length in the 

OmniSport 2000 console. In Figure 53 the timer is about 

to record Event number 2 for the first Heat in the Finals. 

The length is 2, which means it is likely either a 50-meter 

race in a 25-meter pool or a 100-meter race in a 50-meter pool. 

 

Press [Next Event]>[Heat +1 or Heat-1] or simply press [Event Heat] to enter the correct 

Event and Heat. Confirm the correct number of lengths (can be up to 66) for the current 

event. If the number of lengths needs to be changed, press [Lengths], the appropriate  

[1-9]>[Enter].   

 

During the race, the operator watches the meet officials, lane status indicators on the 

console‘s LCD screen and swimmers in their lanes.  

Check for Unused Lanes 
The timer operator should turn off any unused lanes after visually verifying any open lanes 

in the pool. Press [Lane ON/OFF] for the appropriate lane. 

Watch Lane Status LCDs  
The operator watches the lane status indicators on the two left LCD displays to confirm that 

all touches are recorded by the touchpads. With touchpads at the near end only, the lane 

status is shown on the top line of the LCDs. Line two shows the lengths completed. Refer to 

Section 4.2 to review the symbols and their interpretation. 

  

An example of the LCD screen on a typical Near End Only configuration is shown below.  

1       2        3        4        5           6       7      8      9      10 

 

 

  

 

Line 2 shows the lengths completed. The symbol   denotes this information. The timer 

operator uses the information on completed lengths to confirm if a swimmer has missed a 

touch or an extra touch has occurred—requiring subsequent use of Split Arm, Finish Arm,   

+ Touch or – Touch. Refer to Section 4.3 for more information on using those keys.  

 

If both pool ends have touchpads, the LCDs show both ends lane status and lengths 

completed. Press any [↑] [↓] to cycle through 3 lane status views shown below.  

 

Note: In these other view modes, the near end status is on the top line of the LCD with the 

lengths completed status on the bottom, or the far end status is on the bottom with lengths 

completed on the top. 

 
Figure 53: Set Running Time 

*   1    +   *   * 
2   2    O   2         

1   *   6   *    + 
2   2   2   2      
O 

   RT:   00:52.5 
E: 012 H:02 R: P L: 
04 

L

 

  
 

L 

L 
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Near End and Far End Touchpad Status   

 

 

 

 

Near End Touchpad Status and Lengths Completed 

 

 

 

 

Lengths Completed and Far End Touchpad Status 

Watch for Accurate Lane Status 
Watch swimmers as they touch for splits or finish a race to verify that the correct lane status 

is showing. Refer to Section 4.2 to interpret the symbols on the LCD windows.  

Manual Touch Commands  
If necessary, add or subtract touches if swimmers miss the touchpad or have extra touches. 

Press [+ Touch] or [- Touch] then [Lane ON/OFF] at any time during a race to adjust the 

length count for an individual lane. Another method is to press [+ Touch] or [- Touch], and 

use the numeric keypad to input the lane number followed by [Enter]. This would normally 

be done to keep the timer‘s internal length count correct if a split time was missed. Press 

[Clear] to cancel the action any time. 

 

Note: Manual times are marked with a +/- on printouts to distinguish them from normal 

touchpad times. 

Start 
The timer operator watches running time to verify start was received. The timer starts 

automatically when the horn start triggers the start of the race. Be prepared to manually start 

by pressing [Start] if the timer does not start automatically with the horn start‘s flash and 

tone. If this occurs, the timer operator must notify the meet starter and the meet referee. 

 

The timer will start any time a start impulse is received. Pressing [Start] may also be used to 

start the timer. The printer notes if the start is External or Keyboard. 

 

The OmniSport 2000 console has an internal time-of-day clock that continually runs when the 

timer is turned on which allows the always-ready-start feature. The internal clock runs even 

when the race clock is stopped.  

When a Start is Missed 
If a start was missed because the timer was not reset (race clock was still running from the 

previous race), the start impulse is logged in the memory and on the printer. To prompt the 

operator that a start has occurred, reset the timer. If the operator chooses to use the received 

+   7   +   *   * 
5   4   4   4   3  
 

4   5   +    6    2 
4   4   2    5    1 

3    7    *   *   + 
2    *    *   *   * 

       RT: 01:37.6 
E:011 H: 03 R:5 L:08 

3   4   3  5   7    
4   +   2  *   O   

5  4   4   4   3    
*  +   +   +   + 
 L 

 

         RT:01:37.6 
E:011 H:03 R:5 L:08 

+   4   +   *   * 
3   4   3   6   7  
 

L L 

      RT: 01:37.6 
E:011 H:03 R:5 L:08 

L  L 



start signal, the timer will automatically start timing the event by calculating the correct 

running time. If the timer has already been reset, press [Edit] to retrieve the start impulse 

used for the last race.  

 

After the race the operator saves and prints the results, makes corrections if necessary and 

disqualifies a swimmer if the meet referee requests it. (Review the Edit and Disqualification 

in Section 4.3.)  

Store/Print 
Refer to pg. 26-27 to keep the race data for later use and print the results for verification.  

 

If an error is observed on the printout, press [Edit]. Press [Store/Print] to verify the 

correction. After all corrections are made, press [Reset]>[Enter]. 

 

The timer is now ready to begin the next event. Advance to the next event or heat and 

continue. Follow the steps in Sections 4.6 and 4.7 through each race.  

Reading and Editing the Printout 
The OmniSport 2000 printer uses the following symbols in its printouts to label data.  

 

Symbol Definition 

+ Plus touch 

- Minus touch 

B(1-3) Buttons 1 through 3 

R Relay Take-Off Platform trigger 

* Discrepancy between touchpad and backup 

B or BK Backup time 

E Edited time 

M Manual time 

F Early Relay exchange 

R(1-3) Relay exchange 1 through 3 

 

 

Always Ready Start 
The Always Ready Start feature is based on the fact that the OmniSport 2000 timer has an 

internal time-of-day clock that continually runs when the timer is turned on and even when 

the race clock has been stopped. The feature is used when: the timer was not reset, a start was 

missed, or the timer was accidentally reset after a valid start. Every start signal is recorded on 

the race log and in the timer. It is extremely helpful to know how to reset the timer if a start  

is missed because the timer was not reset. Refer to Section 4.3 to follow the steps to reset  

the timer.  
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Arming Delay 
The Arming Delay is the time after a start or split that the timer ignores the touchpad. It is 

primarily used in relay races to allow the athlete time to exit the pool without adding a touch. 

The OmniSport 2000 console has an arming delay count for each lane after every start and 

touch. This feature is set when configuring the console before the race. Refer to Section 4.3 for 

more information.  

 

This section illustrates typical printouts from the 

OmniSport 2000 console. To create a printout from the 

console‘s built-in printer, refer to Section 5.4. 

Pool Configurations 
It is important to save the printout (Figure 54) for system 

settings to reuse in the competition pool. The basis of the 

settings is letting the console know how the physical pool 

and timer are configured. Sections 5.5 - 5.8 describe either 

the numeric or matrix scoreboard configurations. RTD 

and Port configurations are explained in Section 5.9 while 

Section 5.10 explains the printer configurations.  

 

 

 

 

 

 

 

 

 

 

 

 

 

  
Figure 54: Pool Configurations 



Swimming Printouts 
Figure 55 illustrates a typical printout 

for a 10-lane race log. The right 

printout shows the heat results with 

backups (the times entered by the 

officials with backup buttons).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In Lane and In Place Order 
Printouts 
A typical Lane Order (left) and Place 

Order (right) for an 8-lane race are 

illustrated in Figure 56.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 55: Swimming Printout 

 
Figure 56: In Lane/In Place Order Printouts 
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Relay Exchange 
Printout 
An abbreviated Relay 

Exchange printout is illustrated 

in Figure 57. The OmniSport 

2000 console printout shows a 

(+) or (-) by each swimmer‘s 

exchange. The left column 

printout is an example of each 

lane‘s results.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Splits Printouts 
When requesting subtractive or 

cumulative splits, Figure 58 

illustrates typical information 

recorded on the OmniSport 

2000 console printouts.  

 

 

 

 

 

 

 

 

 

 

 
Figure 57: Relay Exchange Printout 

 
Figure 58: Subtractive and Cumulative Splits Printout 



 

Following is a list of typical expectations of the aquatics operator before and during a meet:  

 

 Get the schedule of events and times and arrive an hour or more ahead of start times 

 Perform a timing system check before the start of the meet on the following: 

 

Touchpads             Horn start            Buttons           Scoreboard 

 Confirm timing console is communicating to the display 

 All touchpads are centered in their pool lane 

 Download latest meet information from Hy-Tek software 

 Avoid distractions during the meet and carefully pay attention to details: example – 

length count can be wrong if a touchpad does not activate or the warm-up swimmer 

hits it accidently 

 Adjust Arm Delay correctly 

 Store Print and Reset after each race 

 Make sure timer is on correct Event and Heat for the next race 

 Turn off the equipment between sessions 

 Follow the progress of the race closely – maintain correct length counts 

 

The main dialog tabs contain the Stored Race tab as indicated in Figure 59. Figure 59: Stored 

Race tab 

The Stored Race tab allows the user to view, print and edit stored events. Using the upper 

area drop down combo boxes, choose the event desired. Click the arrow next to the field, and 

then select the setting. Name, Affiliation, and Time are all editable fields. To edit one of these 

fields, select the field desired and click Edit or double-click in the selected field. Print sends 

the stored race data to the printer, and Save sends the edited data to a file.  

 

For another option, right-click (Figure 60) on a field and choose an option 

from the following menu displays. 

 

 Edit allows the operator to change the field. 

 DQ initiates the disqualification flag for that lane.  

 Use Backup sets the backup-time as the lane time.  

 Lane Log opens the lane log file. 

 

Figure 59: Stored Race tab 

 
Figure 60: Right 

click menu 





Section 5: The Console’s Swimming Menus and 
Settings 

The console saves the settings and does not need to be re-configured once it is set. The quickest 

way to confirm settings is press [Menu] then ―33‖ and [Enter]. Re-confirm the settings before each 

meet by saving the printout from the previous meet.  

 

Console start up 

Turn the console on with the switch on the back left side.  

Use [0-9] to enter the appropriate date then press [Enter]. 

Do the same to enter the appropriate time. Press [Enter]. 

 

 

 

 

Press [↓] or [↑] to select the swimming. (Other sports are: 2-diving; 3-pace clock; 4-water polo;  

5- synchro swim; 6-track.) Press [Enter] to accept.  

 

The right LCD screen will flash PAPER if the printer paper 

is not in place. Refer to Section 3.3 to review correct paper 

placement. Review the explanation of the other information 

on the screen in Section 4.6. Press [Menu] and choose from  

the five menu items as illustrated below.  

 

 

 

 

 

Console menu navigation 

Users may navigate through the menus by using the 

arrow keys or by pressing the number that precedes the 

menu title.  

 

 Press [↑] or [↓] to scroll through the menus. 

When a selection is made, press [Enter] to 

accept the menu displayed on the right LCD 

screen. Pressing an arrow is equivalent to using 

a number when in menu mode. To return to the 

main menu (1-SCBD MENU) at any time, press 

[Menu] twice.  

 

 The second method uses numbers to go 

directly to a desired menu choice. Press [Menu] 

twice for the main menu screen followed by the 

number sequence from the list in Appendix C: 

Swimming Menu Navigation. Example 

pressing [4]>[2]>[5] from the main menu, prompts the operator to enter a new 

 
Figure 61: Swimming Menu Navigation 

MENU-MAIN 
1-SCBD MENU 

ENTER DATE: 
DATE 01/01/00 * 

ENTER TIME: 
TIME 00:00:02 * 

SELECT SPORT 
1-SWIMMING 

PAPER  RT:00:00.0 
E:008 H:01 R:P L:16 

MENU-MAIN 
2-EDIT MENU 

MENU-MAIN 
3-PRINT MENU 

MENU-MAIN 
4-SETUP MENU 

MENU-MAIN 
5-TEST MENU 

Main Menu screen 
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Arming Delay. Daktronics provides a laminated copy of the OmniSport 2000 

Swimming Quick Reference (ED13584). Keep it conveniently next to the console 

during a meet (Figure 61).  

 

Each operator will find his/her own method that works best. Remember that when using 

either navigation method, pressing [Clear] at any time will return the console to the previous 

function or menu. 

 

Note: In this manual, LCD screen illustrations aligned to the right indicate menu location 

while the set-up actions are shown on the screens to the left. Each step is illustrated as the 

console‘s right LCD screen prompts. The keystrokes to get to the menu shown are indicated 

below that menu. 

 

The Scoreboard Menu is where the operator can turn the  

scoreboard output ON or OFF, set the dimming level for  

Multi-drop displays and display Time-of-Day on the scoreboard. 

Scoreboard ON/OFF 
This menu is used to toggle the scoreboard output ON/OFF. 

 

 

 

 

  

If the setting is ON, it sends data to a scoreboard. If this setting is OFF, the scoreboard will be 

blank until either the start of the next race, or the scoreboard is turned back ON in the menu.  

 

When to use this: 

 

 The scoreboard is displaying false information due to equipment or operator error 

and needs to be blanked. 

 The error is corrected and the scoreboard output can be turned back on.  

 

Note: Pressing [YES] and [NO] keys are the same as [Enter] and [Clear]. 

Dimming  
This menu is used to adjust the dimming level on scoreboards 

that receive Multi-drop protocol.   

 

 

 

 

 

Use the numeric keypad to select one of the values of 0-9  

shown in the table to the right, or use the Arrow keys to toggle  

through the levels. To save the setting, press [Enter]. To return  

to the Dimming Menu without saving, press [Clear].  

 

MENU-SCOREBOARD 
1=SCBD ON/OFF 

SCBD IS OFF 
SET ON?  Y/N 

Dimming levels: 

0 = none (full bright) 

1 = 90% 

2 = 80% 

3 = 70%  

…each number 

represents 10% to…  

9 = 10% (dimmest) 

MENU-SCOREBOARD 
2-DIMMING 

SCBD DIMMING 
LEVEL 0-9: NONE 

SCBD IS ON 
SET OFF?  Y/N 

SCBD DIMMING 
LEVEL 0-9: 70% 

From Main Menu - [1] or [Enter] 

From Main Menu – [1]> [1] or from SCBD ON/OFF Menu [1] or [Enter] 

From SCBD ON/OFF Menu 

From Main Menu [1]>[2] or from SCBD 2-DIMMING [Enter]  



When to use this: 

 

 In low light conditions the scoreboard may be too bright. 

 

 In direct sunlight the scoreboard may need to be turned to full bright. 

Time-of-Day  
This menu is used to display Time-of-Day on the scoreboard.  

Press [YES] to clear the scoreboard and show Time-of-Day.  

Press [NO] to do nothing and return to the Time-of-Day menu. 

 

 

 

 

The running time must be reset before the console will display Time-of-Day on  

the scoreboard. Press Arrow keys to toggle between 12 and 24 hour setting.  

 

Time-of-Day will remain on the scoreboard until: 

 

1. The start of the next race. 

2. The operator presses [Reset] a second time to re-display the current results on the 

scoreboard. 

3. It is toggled off in the menu. When it is toggled off, the current results will go back 

on the scoreboard.  

 

When to use this: 

 

 Anytime the console is reset and the operator wants to display Time-of-Day on the 

scoreboard. This might be during a break in the meet. 

 

The Edit Menu allows the operator to manually edit the team  

scores for display on auxiliary team score scoreboards and  

edit the basic event order. Remember that the operator has  

three options to manage the event order (refer to Section 4.3).  

Edit Team Score 
This menu is used to manually edit up to 4 team scores for  

display on auxiliary team score scoreboards. The * identifies  

which team score is being edited.  

 

 

 

 

Enter a score of 0 to 999 using the [0]-[9] keys. The * indicates which score is ready to enter. 

Press [Enter] on the last score to post the scores to the scoreboard and advance to the Edit – 

Event Order Menu. If the operator is in the Edit–Team Score Menu and wants to exit without 

saving the data, press [Clear]. This will exit the menu and return to the 1-Team Score Menu. 

 

MENU-SCOREBOARD 
3-TIME OF DAY 

MENU-SCOREBOARD 
DISPLAY TOD? 

MENU-MAIN 
2-EDIT MENU 

MENU-EDIT 
1-TEAM SCORE 

H   000 * G1   000 
G2  000   G3   000 

MENU-SCOREBOARD 
FORMAT: 12 HOUR* 

H   089   G1   085 
G2  000*   G3   000 

From Main Menu [1]>[3] or from SCBD 3-TIME OF DAY [Enter]  

From Edit Menu [Enter] or [2] 

From SCBD 2-DIMMING Menu 

From Main Menu [↓]  

From 1-TEAM SCORE [Enter] or from Main Menu [2]>[1] 
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Some operators will use the four scores (H, G1, G2 & G3) as HOME and GUEST for men and 

women or HOME and GUEST for varsity and junior varsity. Another option is to post the 

men‘s scores when a men‘s event is finished, and the women‘s scores when a women‘s event 

is finished.  

 

If the console is connected to Hy-Tek‘s MEET MANAGER, it is possible to automatically 

update the team scores in the console when the team scores in MEET MANAGER are 

updated (refer to ED-13876 OmniSport 2000 and Hy-Tek Software Quick Guide pg. 4). 

 

When to use this: 

 

 Typically team scores are updated on the scoreboard after each event is finished  

and scored. 

Edit Event Order  
The Event Order menu is where the operator can choose one of  

the menus described below to edit the event order, insert an  

event into the event order, delete an event in the event order 

or clear the event order entirely. (For more information on how  

to use the event orders, see Section 4.3. 

Edit Order 
This group of menus is used to manually enter a basic event  

order in the OmniSport 2000 timing console.  

 

 

 

 

 

The OmniSport 2000 timer holds up to 500 events in numbered locations. The locations allow 

the events to be entered in any order (example: event 001, 012, 035). An alpha character (A-Z) 

may also be added—001A. Event locations have been numbered from 1 to 500. The asterisk 

indicates OK to press [Enter] and begin to edit this event location. Press [↑] [↓] to select the 

event location number. Press [Enter] when the location number to be edited is shown. Press 

[Clear] to return to the menu selection.  

 

Note: Continue through the Event Order’s settings by pressing [Enter] after each set-up. 

Use [0-9] to change the event number. Press [←] [→] to set the event‘s alpha designator and 

press [Enter] to accept. Press [←] [→] to change the round type (final, semi-final, prelim, 

blank), then press [Enter] to accept. 

 

 

 

Using the keypad, enter a distance for the event number and press [Enter]. If desired, enter a 

record time and press [Enter] or bypass by pressing [Enter] again. Entering a distance of [0] 

will insert a diving event. Instead of asking for a record time, it will show the dive order (A, 

B, C, or D set for that event).  

 

  

 

MENU-EDIT 
2-EVENT ORDER 

MENU-EVENT ORDER 
1-EDIT ORDER 

EDIT EVENT ORDER  
#001* E: 001 R:F 

#001 = EVT:  1* 
RND = PRELIM 

#001 = EVT: 8 
RND = FINAL* 

#001 = EVT: 001 
DISTANCE = ▪ 100* 

#001 = EVT: 001 
REC: ▪ 1:35.27* 

From Main Menu – [2]>[2]>[1] or 
from 1-EDIT ORDER - [Enter] 

From Main Menu – [2]>[2] 

From Main Menu – [2]>[↓] 



When to use this: 

 

 If the console is not connected to a results program that downloads the event order. 

 

 If the console is not connected to a computer running the OmniSport Pro Swimming 

software. 

Insert Event  
This group of menus is used to insert an event into the event  

order.  

 

 

 

 

Press [Enter] and use [↑] [↓] to move the cursor to choose the event location number where 

the new event will be inserted. Press [Enter] when the location number is shown.  

 

 

 

 

Press [0-9] to change the Event Number. Press [←] [→] to change the events alpha designator 

and press [Enter] to accept. Press [←] [→] to change the round type (final, semi-final, prelim, 

or blank) and press [Enter] to accept. Subsequent events shift to new locations. 

 

 

 

To enter a new distance for this event # press [Enter]. Press [←] [→] to change the selection 

and press [Enter] to accept. Now using the keypad, enter a new record time and press [Enter] 

to accept.  

 

 (Entering a distance of [0] will insert a diving event. Instead of asking for a record time, it 

will show the dive order—A, B, C, or D set for that event.)  

 

 

 

 

When to use this: 

 

 If an event was missed and not programmed into the original event order. 

 

 An additional event was added, like a time trial, and needs to be placed into the 

event order.  

Delete Event 
This menu is used to remove an event from the  

event order list.  

 

 

 

 

#001 = EVT: 001* 
RND = (BLANK) 

MENU-EVENT ORDER 
2-INSERT EVENT 

MENU-EVENT ORDER 
3-DELETE EVENT 

DELETE INDEX 
#001* E: 001  R: S 

INSERT BEFORE 
#001*  E: 004 R:P 

#001 = EVT:  4 
RND = PRELIM* 

#001 = EVT: 001 
REC: ▪ 1:35.27* 

#001 = EVT: 001 
DISTANCE - 0* 

#0013= EVT: 004 
DIVE ORDER= B 

From Main Menu-[2]>[2]>[↓]>[↓] 

From Main Menu-[2]>[2]> [↓]  

From Main Menu-[2]>[2]>[3] 
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Use [↓] [↑] to select the event location number to be deleted. Press [Enter] to delete the 

location number shown. 

 

When to use this: 

 

 If an extra event was programmed into the original event order. 

Clear Order  
This menu is used to completely erase the entire event order  

stored in the OmniSport 2000 console. Use this with caution.  

 

 

 

 

This is one of the menus that uses the [YES] and [NO] keys—they are the same as [Clear] and 

[Enter]. Press [YES] to clear the entire event order and exit the menu. Press [NO] to exit the 

menu and leave the event order as is.  

 

When to use this: 

 

 If the existing event order needs to be completely erased from memory in the 

OmniSport 2000 console so a new event order can be programmed from scratch. 

 

Note: Remember the operator may scroll through the sub-menus using the Arrows and 

Enter/Clear to select the setup location. From this point on, the manual uses the number 

sequence to navigate through the menus.  

 

The Print Menu is where the operator can print a specific  

race result, the current event order in the OmniSport 2000  

console, or the settings for the current console configuration.  

Print Race Results  
This menu is used to print races that are stored in the  

OmniSport 2000 console‘s revolving race memory. See  

Section 4.12 for more information about the revolving  

race memory. Each time the console times a race, that race  

is assigned a race number. The race number increments by one each time a new race is 

started and counts up from 1 to 999. When the console gets to race number 999, it rolls over 

and the next race number is 1. The console has enough memory to store approximately the 

last 50 races. If the memory in the console is full and a new race needs to be stored, the 

console deletes the oldest race in its memory. The other time that races are deleted from 

memory is when the Pro Swimming software is connected to the console. All of the races 

stored in the console are transferred to the computer running the Pro software and erased 

from memory in the console.  

  

 

MENU-EVENT ORDER 
4-CLEAR ORDER 

MENU-EVENT ORDER 
CLEAR ORDER?  Y/N 

MENU-MAIN 
3-PRINT MENU 

MENU-PRINT 
1-RACE RESULTS 

From Main Menu-[2]>[2]>[↓]>[↓]>[↓] 

From Main Menu-[2]>[2]>[4] 

From Main Menu-[3] 



 

 

 

 

To print a stored race, press [0]-[9] to 

enter the desired race number and press 

[Enter]. The LCD screen will then 

prompt the operator to verify the entered 

race number. Press [YES] to print the 

selected results (Figure 62). Check 

Section 4.10 for more printout samples. 

Press [NO] to ignore the selection and 

return to the Print Menu.  

 

 

 

If the desired race has been deleted from 

the console‘s memory, the LCD screen 

will flash Race Not Found. 

 

 

 

 

When to use this: 

 

 Use this when a race result is 

needed to be re-printed on the console‘s built-in thermal printer. 

Print Event Order  
This menu is used to print the event order on the console‘s  

built-in thermal printer.  

 

 

 

 

Press [YES] to print the event order. Press [NO] to exit the menu without printing. 

 

When to use this: 

 

 It is a good idea to print out an event order before starting each session to verify that 

the console is expecting to time the events in the desired order.  

Print Settings  
This menu is used to send the console‘s configuration  

to the thermal printer inside the console.  

 

 

 

 

Press [YES] to print the settings. Press [NO] to exit the menu without printing. 

 
Figure 62: Race Printout Sample 

MENU-PRINT 
2-EVENT ORDER 

MENU-PRINT 
PRINT ORDER?   Y/N 

MENU-PRINT 
3-SETTINGS 

MENU-PRINT 
PRINT SETTINGS? 

PRINT RESULTS 
PRINT #103   Y/N 

PRINT RESULTS 
RACE NOT FOUND 
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When to use this: 

 

 Print the settings after the console has been set up and verified that all is functioning 

correctly. Keep this printout for future reference. It will be valuable if the console is 

loaned out to someone else, unknowingly a change was made in the console, or if the 

console was returned to or exchanged by Daktronics for service. 

 It is a good idea to pull out the known good settings and verify them to a new 

printout when the equipment is being set up for a meet.  

 

The pool settings let the console know how the physical pool 

is configured. The console will retain these configurations  

when it is powered up the next time.  

Number of Lanes  
This setting tells the OmniSport 2000 console how many lanes 

are in the pool. The console can be set to time from 1 to 10 lanes. 

 

 

 

 

Press [0]–[9] to enter the number of lanes from 1 to 10. When the correct number of lanes is 

shown on the LCD screen, press [Enter] to save. The default number is 6.  

Lane Order  
This setting tells the OmniSport 2000 console the order  

data is received from the lane modules/lane interface 

on J10 and J11.  

 

 

 

 

If the cabling is in-deck and using a lane interface, set this to NRM (normal). 

 

When using on deck cabling (lane modules and deck extension), in some situations, the 

OmniSport 2000 console will be set up closest to Lane 1 and in others, it will be set up closest 

to the last lane (Lane 6 in a six-lane pool). If Lane 1 is closest to the timer, the console should 

be set to NRM (normal). If the console is set up on the same side of the pool as the last lane, 

the console should be set to REV (reversed). The operator will quickly know if the settings 

are incorrect because when Lane 1 results are displayed, it will show up in the last lane. 

 

Press [←] [→] to toggle the setting from NRM to REV and then press [Enter] to save.   

Length  
The console can be configured to time 25-yard,  

25-meter, or 50-meter pools. The length of the  

pool setting is used to calculate the number of lengths.  

When the console has a defined event order, it takes the distance of the event, divides it  

 

MENU-SETUP 
1-POOL 

MENU-POOL 
1-# OF LANES 

MENU-POOL 
1# OF LANES: ▪6* 

MENU-POOL 
2-LANE ORDER 

MENU-POOL 
LANE ORDER: NRM* 

MENU-POOL 
3-LENGTH 
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by the length of the pool to calculate the number of lengths for each event. Knowing the 

number of lengths in an event is important so that the console arms itself for a split or  

finish accordingly.  

 

 

 

 

 Press [←] [→] to toggle the setting between 25Y, 25M, or 50M and then press [Enter] to save. 

Lane Label  
This menu labels the lanes either 1-10 or 0-9. 

 

 

 

 

 

Some facilities have ten lanes, but only want to utilize the center 8 lanes for a particular event 

or only for finals. By setting the label 0-9, the center 8 lanes are automatically numbered 1-8.  

 

The only thing that needs to be reviewed is the numbers on the blocks.  

 

Press [←] [→] to toggle the setting from 1-10 or 0-9 and then press [Enter] to save.   

 

This menu contains the settings that tell the console  

which inputs to use, how to read those inputs and  

what to do with those inputs.  

Start In  
The console can be configured to receive inputs from  

different starting devices. Some start devices are an  

open switch that closes (Normally Open) and others are  

a closed switch that opens (Normally Closed).   

 

 

 

 

Typically, plug the start cable into the Daktronics N/O connectors on the HS-200 horn start 

and plug the other end of the start cable into J12 (start input) on the OmniSport 2000 console. 

When this connection is used, verify that the OmniSport 2000 console is set to N.O. (Normally 

Open). The advantage of using N.O. is that two HS-200 horn starts, one on the near end of the 

pool and one on the far end of the pool can both be connected in parallel to the OmniSport 

2000 console‘s start input. This eliminates the need to move the horn start during the middle 

of the event. 

 

Press [←] [→] to toggle the setting from N.O. to N.C. and then press [Enter] to save. 

 

 

 

MENU-POOL 
LENGTH: 25M 

MENU-POOL 
4-LANE LABEL 

MENU-POOL 
LANE LABEL: 1-10* 

MENU-SETUP 
2-TIMER 

MENU-TIMER 
1-START IN 

MENU-TIMER 
START IN: N.O.* 
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Manufacturers of Horn Starts Type of Output(s) 

Daktronics HS-200 N.O. and N.C. 

Colorado Timing Systems N.O. 

Omega N.C. 

Lane Module Input  
This menu tells the console if there are touchpads at  

the near end only, or both ends of the pool.  

 

 

 

 

 

If there are no touchpads at the far end of the pool, or if they are not plugged into the deck 

cabling, this setting should be set to NEAR.  If there are touchpads at both ends of the pool 

and they are plugged into a deck plate or lane module, this should be set to BOTH. 

 

Press [←] [→] to toggle the setting from NEAR to BOTH and then press [Enter] to save.  

Primary Time  
This menu will configure the console for which timing  

input(s) to use as the primary time.  

 

 

 

 

 

The console can be set to use the TOUCHPAD, BTNS, or BTNS 1-3. If the console is set to use 

the buttons as the primary time:  

 

 There is no back-up time. 

 

  If the console is set to BTNS 1, that is the time. 

 

 If the console is set to BTNS 1-3, the console will use and display the time when the 

second button is received.  

 

Press [←] [→] to toggle the setting between TOUCHPAD, BTNS1, or BTNS 1-3 and then press 

[Enter] to save. 

 

 

 

 

 

 

 

 

 

 

 

MENU-TIMER 
2-LM INPUT 

MENU-TIMER 
LM INPUT: NEAR* 

MENU-TIMER 
3-PRIMARY TIME 

MENU-TIMER 
INPUT: TOUCHPAD* 
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Flag Time  
This menu determines the time (Flag Time) used when  

the touchpad is compared to the back-up time.  

 

 

 

 

If the discrepancy exceeds the flag time, the timer places an asterisk (*) next to that touchpad 

time on the final results. Most rules say that if the touchpad time and the back-up time are 

more than .3 seconds, they need to be reviewed. The flag time can be set from 0.0 to 0.9 

seconds. If it is set to 0.0, the console will not flag discrepancies.  

 

Press [0]-[9] to enter the flag time and then press [Enter] to save. 

Arming Delay  
This menu determines the length of time (Arming Delay)  

which the touchpad will be inactive following a split time.  

 

 

 

 

This function is extremely useful during relay exchanges to provide enough time for the 

athlete to exit the pool. The delay can be set from 1 to 99 seconds. Fifteen to 20 seconds is a 

typical setting, depending on the caliber of the athlete and the length of the pool.  

 

Press [0]-[9] to enter the arming delay time and then press [Enter] to save.  

Precision  
The OmniSport 2000 console is an extremely accurate  

timing device. This menu tells the timer if it should  

report and display the times to one hundredth (1/100) or  

one thousandth (1/1000) of a second. All of the rule books say that the system should time to 

1/100 of a second.  

 

 

 

 

Press [←] [→] to toggle the setting between 1/100 to 1/1000 and then press [Enter] to save. 

Relay Take-Off  
This group of menus will configure if Relay Take-Off  

Platforms are connected to the console, which brand  

the platforms are, or if only push buttons are being used. 

 

If the console is set to use platforms or a button, the console will also ask which button input 

they will be plugged into on the lane module or deck plate and the arm time that configures 

how long the console is comparing the touchpad to the platform. For more information about 

Relay Take-Off Platforms, refer to Section 13: Relay Take-Off Platform. 

 

MENU-TIMER 
4-FLAG TIMER 

MENU-TIMER 
FLAG TIME: 0.3* 

MENU-TIMER 
5-ARMING DELAY 

MENU-TIMER 
ARMING DELAY: 15* 

MENU TIMER 
6-PRECISION 

MENU-TIMER 
PREC: 1/100* 

MENU-TIMER 
7-RELAY TAKE-OFF 
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The console can be set to NONE, BTN/DAKTRONICS  

or OMEGA PLATFORM. NONE tells the timer that there  

are no platforms connected. BTN/DAKTRONICS tells the  

timer that either a push button, or a Daktronics RTOP is 

 connected. OMEGA PLATFORM tells the timer that an Omega platform is being used. The 

console will use these inputs to print and display start reaction times for races that start on 

the block and relay exchanges for events configured as relays. 

 

Press [←] [→] keys to toggle the setting between NONE, BTN/DAKTRONICS or OMEGA 

PLATFORM and then press [Enter] to save. If the console was set to NONE, this function is 

completed. If either of the other two settings is picked, the console will prompt the operator 

for the information below:  

  

 

 

Since relay exchanges are only used during the splits and back-up buttons are only needed 

on the final time, the timer uses the same inputs for platforms as it does for buttons. The 

platform can be plugged into Button 1, 2 or 3 input on the lane module or deck plate. 

Typically Button 3 input is used.  

 

Press [←] [→] keys to toggle the setting between 1, 2 and 3 and then press [Enter] to save it 

and advance to the next setting:  

 

 

 

The relay take-off arm time is the amount of time that the console will look for an input from 

the platform, after it has received a touchpad. This is used to filter out any garbage data in 

case of team mates inadvertently bumping or slapping the top of the platform. The arming 

time can be set from 0.1 to 9.9 seconds. A setting of .8 seconds works the best. 

 

Note: Even with a correct arm time setting, it is very important that no one, except the 

competitor in the event, touch the platform during relay events. The console does not  

know the difference between the correct athlete, a team mate, or an official leaning  

against the block.  

 

Press [0]-[9] to enter the time and then press [Enter] to save. 

 

This menu configures how the console will display data  

on a Lane, Place and Time numeric scoreboard. 

Number of Lines  
This menu sets the number of lines (1-10) of lane data that  

the scoreboard will display. If the number of active lanes in the pool is greater than the value 

set, the timer will automatically page the information in place order. The default is 10. 

 

 

 

 

Press [0]-[9] to enter the number of lines and then press [Enter] to save.  

RELAY TAKE-OFF 
BTN/DAKTRONICS  * 

RELAY TAKE-OFF 
INPUT USED:  3* 

MENU-SCOREBOARD 
1-NUMERIC 

MENU-NUMERIC 
1-# OF LINES 

# OF LINES 
LINES= ▪8 

RELAY TAKE-OFF  
ARM TIME:  .8SEC * 
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Split Hold Time  
Select Split Hold Time to configure how long the split  

times remain on the scoreboard. The Split Hold Time can be  

set from 1-99 seconds. The default time is 15 seconds.  

 

 

 

 

Press [0]-[9] to enter the number of seconds split times will be displayed. When the correct 

time is shown on the LCD screen, press [Enter] to save.  

 

Note: If the number of lanes in the pool is greater than the number of lines, the timer will 

automatically page the information in place order. For splits—only the first place split will 

display and hold for the amount of time set in the Split Hold Time menu. Finish Times will 

page according to the amount of time set in the Finish Page Time menu.  

Finish Page Time  
This menu configures how long (up to 99 seconds) each page  

of the Finish Times will hold on the scoreboard.  

 

 

 

 

The default time is 5 seconds. Press [0]-[9] to enter the number of seconds each page will be 

displayed and then press [Enter] to save. 

 

When to use this: 

 

 Use this feature when the number of Lane, Place and Time lines is less than the 

number of lanes in the pool.  

Results Order  
This menu configures the console to display results  

on the scoreboard in either Lane Order or Place Order. If the  

number of lanes in the pool is greater than the number of lines  

that the scoreboard will display, the timer will display the 

information in place order regardless of this setting. The default is Lane Order.  

 

 

 

 

Press [←] or [→] to select either Lane or Place and then press [Enter] to save. 

 

When to use this: 

 

 Select Lane to display the results in the order of the lane in which the swimmers 

finished. 

 Select Place to display the results in the order of which the swimmers placed.  

 

MENU-NUMERIC 
2-SPLT HOLD TIME 

SPLT HOLD TIME 
TIME=  ▪4* 

MENU-NUMERIC 
3-FIN PAGE TIME 

FINISH PAGE TIME 
TIME: ▪0* 

MENU-NUMERIC 
4-RESULTS ORDER 

MENU-NUMERIC 
ORDER-LANE* 

MENU-NUMERIC 
ORDER-PLACE* 
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Subtractive Splits  
This setting configures the console to display only the 

cumulative split or the first  subtractive split followed by the  

cumulative split on the scoreboard. The default is NO.  

 

 

 

 

Press [←] or [→] to select YES or NO. If the timer is set at YES, the scoreboard shows 

subtractive splits then shows the cumulative splits.  

 

Note: It is important for the timer operator to explain this to coaches before the meet begins.  

Show DQ 
This menu configures what will show on a numeric  

scoreboard when there is a DQ. 

 

 

 

 

Press [←] or [→] to select the desired choice. Press [Enter] to save.  

Show Start 
This menu tells the console whether to display, or not display  

the start reaction (if RTOP‘s are used) on a numeric scoreboard. 

 

 

 

 

Press [←] or [→] to select NO to not show the start reaction time or YES to show the start 

reaction time. Press [Enter] to save.  

 

Number of Lines  
This menu sets the # of Lines of lane data being sent to   

the matrix scoreboard. If the number of lanes in the pool is  

greater than the value set, the timer will automatically  

page the information in place order. The default is 10.  

 

 

 

 

Press [0]-[9] to enter the number of lines appropriate to the facility‘s display and then press 

[Enter] to save.  

Split Hold Time  
Select Split Hold Time to configure how long the split  

times remain on the scoreboard. The Split Hold Time can  

MENU-NUMERIC 
5-SUBTRACTIVE 

SUBTRACTIVE 
SHOW = NO* 

MENU-SCOREBOARD 
2-RTD/MATRIX 

MENU-RTD/MATRIX 
1-# OF LINES 

# OF LINES 
LINES: 10* 

MENU-RTD/MATRIX 
2-SPLT HOLD TIME 

SUBTRACTIVE 
SHOW = YES 
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be set from 1-99 seconds. The default time is 15 seconds.  

 

 

 

 

Press [0]-[9] to enter the number of seconds and then press [Enter] to save.  

 

Note: For splits—only the first place split will display and hold for the amount of time set in 

the Split Hold Time menu. Finish Times will page according to the amount of time set in the 

Finish Page Time menu.  

Finish Page Time  
Select Finish Page Time to configure the length of time that  

finish times remain on the display. 

 

 

 

 

The default time is 5 seconds. Press [0]-[9] to enter the appropriate length of time the finish 

time will appear on the display and then press [Enter] to save.  

Results Order  
This menu configures the console to display results  

in either Lane Order (default)or Place Order. If the number  

of lanes in the pool is greater than the number of lines configured for the display, the  

timer will display the information in place order regardless of this setting.  

 

 

 

 

Press [←] or [→] to select either Lane or Place and then press [Enter] to save. 

 

When to use this: 

 

 Select Lane to display the results in the order of the lane in which the swimmers 

finished.  

 Select Place to display the results in the order of which the swimmers placed.  

Subtractive Splits  
This setting configures the console to display only the 

 cumulative split or the first subtractive split followed by the  

cumulative split on the scoreboard. The default is NO.  

 

 

 

 

Press [←] or [→] to select YES or NO. If the timer is set at YES, the scoreboard shows 

subtractive splits then shows the cumulative splits.  

 

Note: It is important for the timer operator to explain this to coaches before the meet begins.  

SPLT HOLD TIME 
TIME= ▪5* 

MENU-RTD/MATRIX 
3-FIN PAGE TIME 

FIN PAGE TIME 
TIME= ▪5* 

MENU-RTD/MATRIX 
4-RESULTS ORDER 

RESULT ORDER 
ORDER:  LANE* 

SUBTRACTIVE 
SHOW:  NO* 

RESULT ORDER 
ORDER:  PLACE 

SUBTRACTIVE 
SHOW:  YES 

MENU-RTD/MATRIX 
5-SUBTRACTIVE 
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Show DQ 
This menu selects the DQ information to display. 

 
 

 

Press [←] or [→] to select only to display the DQ on the time field or to display the DQ in the 

place field and the time in the time field.  

Show Start 
This menu determines if the start reaction time is displayed. 

 
 

 

Press [←] or [→] to select YES or NO. If the console is set at YES, the scoreboard shows the 

start reaction time.  

Show Place 
This menu determines whether or not to display split time. 

 

 

 

 

Press [←] or [→] to select YES or NO. If the console is set at YES, the scoreboard shows the 

swimmer‘s place and split time.  

RTD Offset 
This menu will add 0K, 5K, 10K, or 15K to the RTD data being 

sent to the matrix display. 

 

 

 

 

Use the [↑] or [↓] to toggle through the RTD offset settings (0K, 5K, 10K or 15K). 0K is no 

offset and 5K adds 5000 to the item numbers. To save the setting, press [Enter]. 

 

When to use this: 

 

 If data from more than one pool/OS2000 is going to one display. 

 If using a Daktronics Venus 1500 M2 or M3 controlled display, this menu allows 

multiple RTD input directly into the display.  

 

The following Comm Ports menus select the protocol used for  

transmitting data to the display and communicating with a  

results program. 

MENU-SETUP 
4-COMM PORTS 

MENU-RTD/MATRIX 
9-RTD/OFFSET 
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Scoreboard Outputs  
Select Scoreboard Outputs to assign a protocol  

used to transmit data in outputs (J2 and J3). 

 

 

 

 

Press [←] or [→] to select Multicast, Multidrop, Multiline or Omega protocol, depending on  

the type of display used and then press [Enter] to save.  

 

When to use this: 

 

 The OmniSport 2000 supports several generations of displays.  Currently there are 

three different types of Daktronics protocols. Multicast, Multidrop, and Multi-line.  

 The newest generation of display for aquatics is the SW-5000 series. This series of 

display will auto-detect the protocol being sent by the OmniSport 2000 console. In 

most cases the console should be set to Multicast. 

 The previous generation of displays for aquatics was the SW-2000 series. This 

generation required a protocol plug to determine which protocol it was receiving. To 

test which protocol is configured, unplug the signal to the display from the back of 

the console. Cycle power to the display. When it powers up, the display will show 

either P0 or P1 on the left two digits. 

P0 – console to Multidrop 

P1 – console to Multi-line.   

 An OmniSport 2000 cannot run a Daktronics glow cube display directly. A glow cube 

display will require an interface in order to be controlled by an OmniSport 2000 

console. When using a glow cube interface, set the OmniSport 2000 console  

to Multidrop. 

 If the display is one manufactured by Omega, set the console to Omega. 

RTD Configurations  
The RTD Port is used to select the protocol (RTD or CTS)  

to transmit out of the J5 RTD port on the OmniSport 2000  

console. RTD means Real Time Data. CTS means Colorado  

Timing System. The default is RTD.  

 

 

 

 

Press [←] or [→] to select RTD to send information to a Venus® controller or CTS to send to a 

numeric CTS scoreboard. Press [Enter] to accept the setting.  

Results Port 
The Results Port configures which protocol  

(OmniSport 2000 or 6000 console, or a CTS console) will be  

used to communicate with the meet management software. 

 

 

 

 

MENU-COMM PORTS 
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MENU-COMM PORTS 
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MENU-COMM PORTS 
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The OmniSport 2000 (default) and the OmniSport 6000 are bi-directional protocols. The CTS 

console is unidirectional protocol, utilizing the standard CTS scoreboard information.  

 

Press [Enter] and press [←] or [→] to select OmniSport 2000, OmniSport 6000 or CTS protocol, 

depending on what the meet management software is expecting to receive and then press 

[Enter] to save. 

 

Note: If using an older version of Hy-Tek Meet Management, it may require configuring  

this port to the OmniSport 6000 data. Selecting Omni 6000 transmits Omni 6000 RTD item 

numbers on the RTD output.  

 

This menu configures which printouts will be printed on the  

built-in printer in the console as well as the intensity of the print on those printouts.   

Race Log  
The Race Log allows the logging to be turned ON/OFF.  

Typically the Race Log is set ON. 

 

 

 

 

Press [←] or [→] to toggle between ON/OFF and then press [Enter] to save.  

 

When to use this: 

 

 Using the Race Log is the most thorough way to identify issues with the system. 

Daktronics recommends that the Race Log is always turned on. 

Results  
The Results Menu selects printouts by LANE or PLACE order. 

The Results printout format is usually determined by  

preference of the person handling the meet management  

program and is used for verification. 

 

 

 

 

Press [←] or [→] to toggle between ON/OFF and then press [Enter] to save.  

Backups  
This menu configures if backup times will be printed  

with the race results. Printing Backup Times usually is  

determined by the preference of the person handling the meet management program.  

 

 

 

 

Press [←] or [→] to toggle between YES/NO and then press [Enter] to save.  

MENU-SETUP 
5-PRINTER 

MENU-PRINTER 
1-RACE LOG 

MENU-PRINTER 
RACE LOG: ON* 

MENU-PRINTER 
2-RESULTS 

MENU-PRINTER 
RSLTS BY: LANE* 

MENU-BACKUP 
3-BACKUPS 

MENU-PRINTER 
BACKUPS: YES* 

From Main Menu – [4]>[5] 

From Main Menu – [4]>[5]>[1] 

From Main Menu – [4]>[5]>[2] 

From Main Menu – [4]>[5]>[3] 



Splits  
This menu configures if split times will be printed  

with the race results.  

 

 

 

 

Press [←] or [→] to select NONE, SUBTRACTIVE, or CUMULATIVE. Choosing SUBTR prints 

only subtractive splits. Choosing CUMUL prints only cumulative splits. Press [Enter] to save.  

Intensity  
This menu sets the printer‘s depth of contrast  

for easy readability. The typical level is 5. 

 

  

 

 

Press [Enter]>[1-5] to select a new intensity and then press [Enter] to save.  

 

This menu is used to set the console‘s date and time. 

 

 

 

 

Press [0-9] to enter the correct date and time and then press [Enter] to accept the setting. 

Press [Clear] twice to exit without saving and retain the previous time and date.  

 

The OmniSport 2000 timer is equipped with features that test  

battery level, the lane modules and the numeric scoreboard.  

The following submenus explain how to use each of these tests. It is important to run through 

these tests before the meet begins to prevent problems from occurring during the meet. 

Battery Test  
This menu checks the battery power level. 

 

 

 

 

The battery level will show as CHARGED or LOW. Press [Enter] to exit the menu.  

Lane Module Test  
This menu tests the lane module inputs. 

 

 

MENU-PRINTER 
4-SPLITS 

MENU-PRINTER 
SPLITS: NONE* 

MENU-PRINTER 
5-INTENSITY 

PRINT INTENSITY 
LEVEL 1-5:  5* 

MENU-SETUP 
6-TIME OF DAY 

DATE MM/DD/YY 
TOD HH:MM:SS* 

MENU-MAIN 
5-TEST MENU 

MENU-TEST 
1-BATTERY 

BATTERY TEST 
LEVEL: CHARGED 

MENU-TEST 
2-LANE MODULES ←NEAR END DATA 

←FAR END DATA 

MENU-PRINTER 
SPLITS: SUBTR 

MENU-PRINTER 
SPLITS: CUMUL 

BATTERY TEST 
LEVEL: LOW 

From Main Menu – [4]>[6] 

From Main Menu – [4]>[5]>[5] 

From Main Menu – [5] 

From Main Menu – [5]>[2] 

From Main Menu – [5]>[1] 

From Main Menu – [4]>[5]>[4] 



The Console’s Swimming Menus and Settings

 

The two left LCD screens will show the lane module input  

status by lane. Figures 63-64 show feedback for the 

for the first and third buttons in Lane 3. Figure 65 

shows a sample feedback from activating the 

touchpad in Lane 3. All devices should be tested 

before every session. 

Scoreboard Test  

These menus check the numeric scoreboard drivers.  

Cycle ON/OFF  
This menu checks the signal to the scoreboard. 

 

 

 

 

Press [1] to toggle the scoreboard ON and OFF. When this menu is selected, an all ON signal 

is sent at intervals of approximately 3 seconds. This will continue to cycle ON and OFF until 

pressing [Enter] to continue.  

Driver Address  
This menu shows which addresses each of the drivers on 

the scoreboard are set to. The address plugs were inserted  

when the display was installed.  

 

 

 

 

Press [2] to display the driver addresses. This will remain on the display until [Enter]  

is pressed.  

Digit Number  
This menu displays the digit designation. 

 

 

 

 

 

Press [3] to display a digit number. The number or letter will show which output on the 

driver that digit is plugged into. This will remain on the display until [Enter] is pressed.  

 

 
Figure 63: Button  

One Feedback  
Figure 64: 

Button Three 

Feedback 

 

Figure 65: 

Touchpad 

Feedback 

MENU-TEST 
3- SCOREBOARDS 

SB TEST MENU 
1-CYCLE ON/OFF 

DISPLAY ALL ON 
ENTER TO EXIT 

SB TEST MENU 
2-DRIVER ADDRESS 

SHOWING ADDRESS 
ENTER TO EXIT 

SB TEST MENU 
3-DIGIT NUMBER 

SHOWING DIGIT # 
ENTER TO EXIT 

From Main Menu – [5]>[3]>[1] 

From Main Menu – [5]>[3] 

From Main Menu – [5]>[3]>[2] 

From Main Menu – [5]>[3]>[3] 



Section 6: OmniSport 2000 Pro Swimming 
Software 

The OmniSport 2000 Pro Swimming software interfaces with the OmniSport 2000 timer and allows 

timing officials to control the competition through an easy-to-use, reliable and convenient Windows
®
 

based user interface installed on a Windows compatible computer system. 

 

This section describes how to install, configure and use this software system, Version 1.1.18. 

 

The OmniSport 2000 Pro Swimming software was designed to operate on a Windows 

compatible personal computer. In most circumstances, the computer used by the software 

will be purchased through Daktronics. This ensures the software requirements will be met.  

If a computer is not purchased through Daktronics, the following list describes the 

requirements for the OmniSport 2000 Pro software. 

 

 OmniSport 2000 timing console 

 Internet Explorer® 5.0 or higher 

  400 MHz or higher CPU 

 Windows 98 operating system or higher 

 Minimum 64 MB of RAM 

 Standard keyboard and mouse 

 One open serial port for connection to the OmniSport 2000 timer (COM port) or USB 

port and adapter 

 

The OmniSport 2000 Pro software is a computer interface to the OmniSport 2000 timer. There 

must be a serial connection for the timing operations to be controlled by the Pro software. 

The OmniSport 2000 timer must also be connected properly to all competition equipment and 

accessories if using a display or judge‘s consoles. Refer to Section 2 for more information 

pertaining to the hardware installation of the OmniSport 2000 timer. 

 

To install the Pro Swim software from the Internet: 

 

1. Open an Internet browser to: 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/

Pro/Swimming   

 

2. Click the ―OmniPROSwimmingInstall.exe‖ file, and then click Run to begin the 

installation procedure. 

Note: Click Run again if a security warning appears. 

 

3. Follow the onscreen instructions to complete the installation. 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/Pro/Swimming
http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/Pro/Swimming
http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/Pro/Swimming/OmniPROSwimmingInstall.exe
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To install the Pro Swimming software from a CD: 

 

1. Insert the software CD into the computer‘s CD-

Rom drive. If the auto-run program does not 

start, click the Windows Start menu. 

 

2. Select Run to open the dialog box shown in 

Figure 66.Type the address of the CD-Rom 

drive (usually D:) and click OK. 

 

3. Select OmniSport Pro.exe as shown on the 

InstallShield Wizard dialog box (Figure 67). 

  

4. Click [Next] to continue. 

 

5. In the Select Features Dialog box (Figure 68) 

choose the programs to install. Check the 

programs to install and click Next to begin. 

Program files are automatically installed to a 

default directory, C:\Program 

Files\Daktronics\OmniSport 2000 Pro,  

on the computer‘s hard drive.  

 

To initiate the program, double-click the OmniSport 

2000 Pro Swimming icon on the desktop (Figure 69). 

The InstallShield Wizard will automatically install this 

icon after installation is complete. If there is not an icon 

present, locate the OmniSport Pro Swimming file and 

double-click OS2000int.exe. The folder should be 

located under Program Files on the local disk (usually 

C:) in the computer. 

 

On initial startup, the registration dialog allows the 

user to either register or click [Continue] to bypass registration. If choosing to 

not register, the user has access to the demo version, which has all the same 

functions as the registered version, for up to 30 days. If the user is not 

registered by this time, the software will lock. The registration code must then 

be entered to continue running the software. Refer to Figure 70. 

Registering 
Daktronics allows potential users to test the full version of the software before purchasing. 

When the registration code has not been entered, the 30 days remaining dialog on startup of 

the program is visible, and the software will not run after that period expires. To purchase 

the software after testing it, simply contact Daktronics at 1-800-325-8766 for pricing and 

information. Upon proof of purchase the unlock code will be given which allows unlimited 

use of the software. 

 
Figure 66: Run Dialog Box 

 

Figure 67: OmniSport 2000 Pro Software 

Installation 

 
Figure 68: Select Features Box 

 
Figure 69: 

Swimming Icon 



The Standard Console Control level of registration allows the 

complete use of the software except the use of the race log 

files and the results printouts. The Race Log and Results 

Printouts level is the full version of the software. It is not 

possible to unlock only the Race Log and Results Printouts 

level. 

 

To register the software, follow these steps: 

 

1.  Start the program. Request the Registration Code 

from Daktronics and enter the code in the field as 

illustrated in Figure 70.  

 

2. Click Register. 

 

Note: If the user registers the OmniSport software on a computer, the Registration Code 

pertains only to that workstation. Reloading the software on a different computer requires  

a new Registration Code.  

Serial Port 
Once the hardware and software have been installed and the software is running, the 

OmniSport 2000 Pro system should synchronize with the timer. A message box may display 

requesting which configuration settings are preferred. If the message box says, Cannot Detect 

Console, then the wrong COM Port is configured. To establish a proper connection: 

 

1. Ensure the cable is connected to a COM Port on the back of the computer and to the 

expansion port on the OmniSport 2000 timer.  

 

2. Start the Pro software. Open the Configure dialog in the options menu and select the 

tab that reads Com Ports, and then click [Configure] in the Interface Com Port area.  

 

3. A dialog box appears (Figure 71) with all of the current 

Com Ports. Select a port and click OK. 

  

4. Click Monitor. If the computer is receiving data in the 

top half of the monitor window, the connection was 

made properly and the correct port was selected.  

Data on the bottom half is the data being sent by  

the Pro software. 

 

5. If the computer is not receiving data, go back to step 3 

and select a different port. Do this until data is received through the selected port. 

 

Note: Some computers purchased with this software will have a Rocket® port installed with 

the system. The port labeled Port 0 will be normally set as COM port 5 in the computer 

system. The next port would then be COM 6, then COM 7, and finally COM 8 for a four-port 

Rocket port. The OmniSport 2000 Pro software recognizes these ports no matter what port 

number has been assigned to them. 

 

 

Figure 70: Registration Dialog 

  
Figure 71: Select Com Port 
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New Event Order 
When the Pro software is started, the OmniSport 2000 timer sends the event order data. If a 

file has not yet been created for this event order, the software will inquire whether or not a 

new file should be created. Rename this file and click OK to create a new file.  

 

This is an excellent way to store old event orders and use them again. The OmniSport 2000 

timer is only able to store 500 different events. The Pro software can store several of these 

event lists, each with 500 different events. Those lists can be edited and reused. Refer to Pro 

Configuration information in Section 6.6 for more information on editing the event order. 

Synchronization with the Timer 
Once the hardware and software have been installed and the software is running, the 

OmniSport 2000 Pro system should synchronize with the timer.  

 

If the OmniSport Pro software is unable to detect the console, ensure the cable is connected to 

a COM port on the back of the computer and to the expansion port on the OmniSport 2000 

timer. If they are, set the COM port properties in the Options > Configure > Comm Portsand 

clicking the Configure button. 

 

Note: If the cables are connected properly the Comm status icon on the main application 

screen (Figure 72) is green—flashes green when receiving data and red when not connected  

 

Once the OmniSport 2000 Pro system is synchronized and configured, event management  

is quick and simple. The Horn Start 200 start system starts the timer. The touchpads, backup 

buttons and lane modules obtain split and final times. In addition, this system sends  

data to output devices, including matrix displays, numeric scoreboards and paper printouts. 

 

This section describes the operational buttons, lane icons and indicators, and operations of 

the OmniSport 2000 Pro system. The main application screen is illustrated in Figure 72. 

 
Figure 72: Main Application Screen  



Lane Indicators, Buttons and Icons 
The lane indicators, buttons, and icons relay event information to the user. This information 

should be used to determine timing discrepancies and event results. It is also editable from 

the main application screen of the software system. 

Figure 73 shows the lane information. Each area displays 

information editable on each lane.  

 

 Lane On/Off area is a toggle that turns that lane on 

or off. If the lane is OFF, no data will be received 

for this lane. Turn the lane off if no swimmer is 

using it during the current event. 

 

Note: [F1] toggles Lane 1 On/Off, [F2] toggles 

Lane 2 On/Off, etc. 

 

 Current Lengths can be changed by clicking [↑↓] 

keys on the right side of this area. Use this to 

subtract an accidental touch or to add a missed touch. The current length will not go 

beyond the maximum lengths set for the current event.  

 

 Near/Far Lane Indicator displays the current arming state of the lane. The table 

below describes each icon and what it represents. 

 

 Arming Buttons are used to change the lane arming status during an event. There 

may be a time when a swimmer's touch is not registered by the touchpad. When this 

happens, use these buttons to change the arming of the lane. 

 

Split Armed. When this is showing, this lane is armed to take a split time. 

Finish Armed. When this is showing, this lane is armed for a finish time. 

Finished. This indicates the lane is finished timing. 

Arming Delay. This is the amount of time left until the touchpad is active. 

A number from 1-99 will display decrementing by one every second. 

Lane Problem. This indicates a problem has occurred within the lane. 

Overly active input. This typically results from a bad connection or push 

button. 

Replace the batteries in the RTOP for that lane. 

 

 
Figure 73: Lane Information 
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Event Data 
The top area of the 

main application 

screen displays 

current event details 

and options as 

shown in (Figure 74). The elapsed time is displayed to the right of the Daktronics logo. The 

Event, Heat, Length, and Round are set by the event order file, but may be selected by clicking 

the [↑↓] keys to the right of the data fields. The operator must manually increment the event 

number, heat number, and round at the end of an event or heat. To change the event order 

file, refer to Section 6.6. 

 

Note: Though editing may be done, the data will not be saved in the event order file. 

 

 Clicking Store/Print will store the current event data into an event file and print the 

results according to the configurations.  

 

 Clicking Reset will reset the time and begin a new event. Reset also stores the 

current event data into an event file and prints the data according to the 

configurations set in the Configurations dialog if Store/Print was not clicked 

 

The upper left area of the main application screen contains five buttons (Figure 75) used 

before and during events.  

 

The buttons are described below from left to right:  

 

 Edit Start Time allows the user to change the start 

time of any event. This is not enabled during 

events (mainly used when a start input is missed). 

 

 Disqualify toggles a swimmer‘s disqualification flag. Click this button and select the 

lanes to be disqualified. 

 

 Split Arm All arms all touchpads to take split times. 

 

 Finish Arm All arms all touchpads to take finish times. 

 

 Race Log File opens the race log file for the current race. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 74: Event Data Area 

 
Figure 75: Five buttons 



Main Application Screen Tabs 
The main application screen contains four tabs (Figure 76). Click on the tab to switch between 

the different functions. The user may change the name and affiliation during the race at any 

time without changing the names in Hy-Tek. 
 

 

 Name, Affiliation and Time are all editable fields. To edit these fields, click on a desired 

field and click Edit, or simply double-click in the selected field.  

 

 To disqualify a lane, select the lane row and click DQ.  

 

 Click Split Arm All or Finish Arm All to arm the touchpads for split times or finish 

times, respectively.  

 

 Press Start to initiate the timing system and press Store Print to send the current 

event data to the printers and save the data into a file. Clicking Start shows the start 

source on printout results as a keyboard, designating an unofficial start of the race. 

Stored Races 
The Stored Race tab allows the user to view, print, and edit stored events (Figure 77). 
 

 Select the appropriate Database File, Title, Race, Event, Heat, Length, and Date/Time.  

 

 The Name, Affiliation, and Time are all editable. To edit these fields, click on a desired 

field and click Edit or double-click in the selected field.  

 

 Press Print to send the stored race data to the printer, and click Save to store the 

edited data to a file.  

 
Figure 76: Current Race Tab 

 

Figure 77: Stored Race Tab 
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Another editing option for the user is to right-click on a field  

(Figure 78) and select an option from the following menu: 

 

 Edit allows the user to change the field. 

 

 DQ initiates the disqualification flag for that lane. 

  

 Use Backup sets the backup time as the lane time.  

 

 Lane Log opens the lane log file. 

Scoreboard 
The Scoreboard tab (Figure 79) is used to control what is on the display. 

 

 The Display to Matrix 

area contains options 

for displaying data 

on a matrix display. 

Select the desired 

event and 

information type and 

click Request > Set 

Display Off button to turn the display off.  

 

 Use the slider to adjust the display Dimming.  

 

 Pressing Show Time of Day shows the time-of-day on the display.  

 

 The Team Scores text boxes show what the current team scores are.  

Test 
The Test tab (Figure 80) is used to test the battery, display, lane modules, and touchpads. 

 

 The Battery field 

displays the power 

source and the 

power level of that 

supply.  

 

 The Lane Modules 

field displays 

which touchpad or 

backup buttons is 

being activated. An X indicates the lane being tested if the equipment is working 

properly. It is possible to enable and disable certain devices and lanes by clicking the 

appropriately labeled buttons. This test procedure requires at least two people; one 

to monitor the system and another to activate the input devices. 

 

 

Figure 78: Right-Click  

Menu 

 
Figure 79: Scoreboard Tab 

 
Figure 80: Test Tab 



If there is only one person available, click Lane Module Test Mode, then turn the 

computer monitor so it can be seen from the touchpads and lane modules. Go to the 

input devices and active them. The monitor will display the activated device so that 

it can be seen from the poolside. 

 

 The Scoreboard section contains three buttons for testing the scoreboard: 

 

 Cycle On/Off: Click to send an all on signal to the scoreboard approximately 

every 3 seconds until deselected. 

 Show Address: Click to display the driver addresses. The number or letter will 

show which output on the driver that digit is plugged into. 

 Show Digit: Click to confirm the digits are operational and properly plugged at 

the time of installation and if the system needs debugging.  

 

Configuring the OmniSport 2000 Pro software is an important for managing swimming 

events. To access the Pro configuration, go to Options > Configure on the main application 

screen. 

 

This information pertains to both the OmniSport 2000 Pro software and the OmniSport 2000 

console. For information on programming the console settings listed in this section, refer to 

Section 5: The Console’s Swimming Menus and Settings. 

Pool 
The Pool tab (Figure 81) 

configures the OmniSport 

2000 Pro software to the pool 

being used.  

 

 Select the Number of 

Lanes from 1 to 10.  

 

 Lane Order is 

determined by how 

the lane modules are connected to the timing console. If the lane connected to the 

console is the first lane, then select Normal option button. If it is not, select Reversed. 

 

 Lane Label is used to accommodate pools with lane numbering of 1-10 or 0-9. Select 

the appropriate option button.  

 

 Lane Length should be set to the length that matches the pool being used, either  

25 yards, 25 meters, or 50 meters. The lane length is used with the race length to 

calculate how many lengths or touches the timer should expect for that race.  

 

Click OK to save the data.  

 

 

 

 

 
Figure 81: Pool Configuration 
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Timer 
The Timer tab (Figure 82) configures the inputs and precision of the timer. 

 

 The Arming Delay is the length of time that the touchpad will be inactive following a 

split time. This is extremely useful for relay exchanges to provide enough time for 

the swimmers to exit the pool. Typically 15 to 20 seconds is set. 

 

 The Flag Time determines the time used to compare the touchpad time to the backup 

time. If the discrepancy exceeds the flag time, the timer puts an asterisk (*) next to 

that touchpad time on the final results. 

 

 The Start Input configures the start signals to receive Normally Open (N.O.) or 

Normally Closed (N.C.). NO is used if the Daktronics Horn Start 100 or 200 is used at 

the facility. NC is used if the start system is not produced by Daktronics. 

 

 Primary Time option buttons tell the timer to use the touchpad, button 1, or buttons 1-

3 for primary event split and finish times. The touchpad is the typical selection. 

 

 Lane Module Input option buttons configure the timer for touchpads and push buttons 

at the Near end only, or both Near/Far ends of the pool.  

 

 Precision option buttons set the timer to store and print times depending on whether 

times are displayed to 1/100 or 1/1000 of a second.  

 

Note: 1/100 will show two decimal places, while 1/1000 will show three. 

 

 Relay Takeoff Sensors allows the operator to select the Type of sensors from 

Button/Daktronics or Omega Platform and the Input (Button 1-3) used for relay 

exchanges. It‘s also possible to select the Arm Time of the input from 0.1-9.9 seconds. 

 

Click OK to save the data.  

 
Figure 82: Timer Configuration 



Console Printer 
The Console Printer 

tab Figure 83 

configures the printer 

settings for the printer 

built into the timing 

console.  

 

Each setting‘s option 

buttons are described 

below: 

 

 Print Results enables the console printer to print the results of the event. 

 

 Race Log enables the console printer to print the race log of the event. 

 

 Results determines how the results will be printed: by Lane or by Place. 

 

 Print Backups enables the console printer to print the backup times of the event. 

 

 Print Splits enables the console printer to print splits of the event.  

 Select No to disable this option.  

 Select Cumulative to print the split times as a cumulative time.  

(Lap1 0:58.32, Lap2 1:57.68, Lap3 2:57.39).  

 Select Subtractive to print the split times as single lap times  

(Lap1 0:58.32, Lap2 0:59.36, Lap3 0:59.71). 

 

 Select the Number of Copies to print up to 5. 

 

Click OK to save the data.  

Pro Printer 
The Pro Printer tab 

(Figure 84) configures 

the printouts for the 

printer attached to the 

computer running the 

pro software. 

 

The Printout Format 

drop-down list boxes 

allow the user to set 

which printouts will 

be printed and the 

order in which they are printed.  

 

Note: Printouts must be unlocked (registered) before this configuration tab will work. 

 

 

 

 

 
Figure 83: Console Printer Configurations 

 
Figure 84: Pro Printer Configuration 
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 Finish by Lane prints the results of the event by lane. 

 

 Finish by Place prints the results of the event by place. 

 

 Cumulative Splits prints the split times as a cumulative time. 

 

 Subtractive Splits prints the split times as single lap times. 

 

 All Splits prints the split times. 

 

 Finish by Lane and Place prints the results by both Lane and Place. 

 

 Finish by Lane w/ Backup prints the results of the event by Lane with backup times. 

 

 Finish by Place w/ Backup prints the results of the event by Place with backup times. 

 

 Cumulative Splits w/Backup prints the split times as a cumulative time along with 

backup times. 

 

 Subtractive Splits w/Backup prints the split times as single lap times along with 

backup times. 

 

 All Splits w/ Backup prints the split times with backup times. 

 

 Finish by Lane and Place w/ Backup prints the results by both Lane and Place with 

backup times. 

 

 Finish by Place w/ Exchanges prints the results of the event by Place and shows the 

times of the relay exchanges. 

 

 (Page Break) places the following printout on the next page. 

 

 (None) means no reports will print. 

 

 To print the Race Log, select On. To turn the race log printout off, select Off. 

 

Type in a descriptive Print Header for the printouts, and then click OK to save the data. 

 

Notes: 

No event may have more than ten print formats. If all formats are set to None and the race log 

is set to Off, reports will not print. Otherwise, all printouts can be sent to the console printer.  

 

The race log can be printed to a full size printer attached to the Pro computer. Printouts are 

sent to the computer‘s default printer.  

 

 

 

 

 

 

 



SCBD 
The SCBD tab  

(Figure 85) configures 

the output for both a 

numeric scoreboard 

and a matrix display. 

The drop down list 

boxes set the 

appropriate lines and 

times and the option 

buttons select the 

order results are 

displayed. 

 

Numeric (Fixed Digit): 

This field configures data for use on numeric scoreboards.  

 

 Number of Lines designates how many lines there are on the display.  

 

 Split Hold Times sets the amount of time the split times remain on the display.  

(Default=5 seconds). Enter a value from 1-99 seconds. 

 

 Finish Page Times configures the time that finish times will hold on a scoreboard 

(Default=5 seconds). Enter a value from 1-99 seconds. 

 

 Results sets whether the results are displayed by Lane Order or by Place Order. 

 

 DQ Status allows users to display that a swimmer was DQ Only or display both the 

DQ and Time the swimmer finished. 

 

 Select Show Subtractive Splits to display split times as single lap times. 

 

 Select Show Start Reaction Time to show the time it took from the sound of the horn 

to when the swimmer left the starting blocks. 

 

RTD/Matrix: This field configures data for use on matrix displays. The same options are 

available as described above under Numeric/Fixed Digit plus: 

 

 Select Show Place for Intermediate Splits to display places with split times.  

 

 Use RTD Offset to add 0K, 5K, 10K, or 15K to the RTD in cases where there is more 

than one pool (and accompanying OmniSport and Pro software) with data from both 

setups going to a single display.  

 

Click OK to save the data. 

 

 

 
Figure 85: SCBD Configuration 
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Results 
The Results tab (Figure 86) is 

disabled. Currently, only a 

serial connection is available 

until future expansion of the 

software. 

Event Order 
The Event Order tab  

(Figure 87) displays the 

current event order and 

allows the user to edit an 

event list and change the active list if more than one list has been created.  
 

 Click Set Active File 

to choose which 

event file is to be 

used. 

 

 Click View Event 

File to view any 

event file created 

and stored in the 

current OmniSport 

2000 Pro computer 

system. 

 

 Click Edit Event File to edit or create a new event file. 

Comm Ports 
The Comm Ports tab (Figure 

88) allows the user to select 

the input/output port types. 

 

The Timer Port Configurations 

area configures the ports for 

the correct output device 

used with this system.  

 

 Meet Manager Port 

drop down box 

selects which 

protocol (Omni2000, Omni 6000, or CTS) will be used to communicate with the meet 

management software. 

 

 RTD Port drop down box determines which protocol (RTD or CTS) will be 

transmitted out of the RTD port (J5) connector on the OmniSport 2000 timer. 

 

 Scoreboard Port drop down box selects which protocol (Multidrop, Multiline 

Multicast, or Omega) will be transmitted out of the scoreboard outputs (J2 and J3). 

 

 
Figure 86: Results Configuration 

 
Figure 87: Event Order Configuration 

 
Figure 88: Comm Port Configure 



The Interface Comm Port area configures which port is used to interface the OmniSport  

2000 timing console to the OmniSport 2000 Pro computer.  

 

 Click Configure to change the port number to the desired port.  

 

 Click Monitor to ensure data is flowing between the two systems.  

 

If no data is flowing, make sure the OmniSport 2000 console is powered on and in the 

swimming mode. Verify that the cable is connected between the COM port selected and J4 on 

the console. Also be sure that another program is not open and already configured to the 

selected COM port.  

 

This section details the operational procedures used before a meet, and during and  

after each event. 

Before the meet 
Before each meet, three things must be done:  

Verify the Configurations 
Open the Configurations menu (Figure 81) and go through each tab to make sure all the 

configurations are set to the necessary settings. The system will maintain the setting that it 

used during the last time it was operated. If any configuration setting was changed while the 

timer and software were not connected, the system will request that the configuration be 

synchronized upon reconnection. 

 

Though the configuration will not change unless the user changes them, it is recommended 

to print the configuration settings so that they can be reentered if there is a sudden loss of 

power or damage to any equipment that may cause a loss of memory. This can be done from 

the timer. Press [Menu]>[3]>[3]>[3]>[Enter] on the keypad of the OmniSport 2000 console. 

Test the System 
The OmniSport 2000 console and Pro system must be operating properly for a meet to run 

smoothly. Test the system by following the steps below: 

 

1. Test the start input device by pressing Start. The tone should sound, the strobe 

should flash, and the time should begin counting on both the timer and the software. 

If not, ensure the cables are properly connected. 

 

2. On the main application screen, select the Test tab. Test each lane input device by 

pressing the backup buttons and touching the touchpads. Refer to Subsection Main 

Application Screen Tabs for more information on this operation. 

 

If using a display, test run an event to ensure the display shows what is expected. 
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Set Up Event Order 
Open the event order file by selecting the Event Order tab on the Configure window. From 

here, a new file can be downloaded or an old file can be opened. Make any adjustments to 

this file by clicking Edit. Refer to Subsection Pro Configuration for more details on editing 

and downloading event order files. 

Before a Race 
Though the event order file establishes the event order, there may be situations where an 

event changes or combines with another event. All events can be edited during a race from 

the main application screen.  

 

Three things must be remembered when doing this: 

Verify Console Settings 
The OmniSport 2000 timer must be set to the correct race in order for the system to function 

accurately. Press [Edit] on the console to change the event order, insert an event, delete an 

event, or clear the event order as shown in Section 4.3 of this manual. Verify that the correct 

information is shown for the current event.  

 

To edit current race information using the Pro software, select the Current Race tab on the 

main application screen, which shows information pertaining to the current swimmers and 

event. Name, Affiliation, and Time are all editable fields. To edit one of these fields, select the 

field desired and click Edit or double-click in the selected field and a cursor flashes in the 

active text box. To disqualify a lane, select the lane row and click DQ. Click Split Arm All or 

[Finish Arm All] to arm the touchpads for split times or finish times respectively. Click 

[Store Print] to send the current event data to the printers and save the data into a file. 

Verify the Lengths 
Once the console settings have been verified, the lengths of the pool must be set correctly. To 

do this, select the Options>Configure>Pool.  

 

Lane Length should be set to the length that matches the pool being used. The lane length is 

used in conjunction with the race length to calculate how many lengths or touches the timer 

should expect for that race. Choose from the following three sizes: 25 yards, 25 meters, or  

50 meters and then click OK. 

Always Ready Start 
The Always Ready Start feature functions because the OmniSport 2000 timer has an internal 

time-of-day clock that continually runs when the timer is turned on. The internal clock 

continues to run even when the race clock has been stopped.  

 

If a start was missed because the timer was not reset (race clock was still running from the 

previous race), the start impulse is logged in the memory and on the printer. To use the 

missed start, first reset the timer. If the operator chooses to use the received start signal, the 

timer will automatically start timing the event by calculating the correct running time.  

Edit can also be used to retrieve the start impulse used for the last race. 

 



If two independent OmniSport 2000 timers are being used in parallel for an especially critical 

application and one timer misses a start impulse completely because of a technical problem, a 

start time may be manually entered when read from the printout of the other timer. 

 

Example: Editing a Start - If a start is missed because the timer was not reset before the start: 

 

 The time-of-day of the start impulse will be logged on the printer. 

 

 The OmniSport will inform the operator of the start after the timer is reset. 

 

Procedure: 

 

1. Reset the timer.  

 

a.  Click Reset > YES to reset the time to 

zero. The message in Figure 89 displays 

on the screen at this time. 

b. Accept the missed start by clicking YES and the timer will start from the  

missed start time. If the missed start is to be ignored, press NO and the 

timer will be reset. 

 

2. If the start time needed was not on the LCD, click the Edit Start Time 

button on the OmniSport 2000 Pro menu, shown at right (on the upper 

left-hand corner of the main application screen). 

 

a. With the timer reset, press Edit Start Time. This reveals the time-of-day of 

the last start impulse on the LCD. 

b. Confirm that the time-of-day shown on the LCD is the correct time for the 

start of the race. The start time may be edited using the number keys. 

c. Click OK to complete the editing operation. The race clock will start and 

the running time will be correct based on the entered start time. 

During a Race 
During a race, the lane status may be changed using three editable areas: Lane On/Off, Current 

Lengths, and the Arming Buttons. The user may monitor the lane status by viewing the 

Near/Far Lane Indicator, also located on the main application screen of the Pro software. 

Lane Status 
During the race, verify the lane status using the editable areas listed below. 

 

 Lane On/Off area is a toggle that turns that lane on or off. If the lane is off, no  

data will be received for this lane. Turn the lane off if no one is using that lane  

during the current event. 

 

 Current Lengths can be changed by clicking the up or down arrows on the right  

side of this area. The current length will not go beyond the maximum lengths set  

for the current event. 

 

 
Figure 89: Always Ready Start 

Dialog Box 
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 Arming Buttons are used to change the lane arming status during an event.  

There may be a time when a swimmer's touch is not registered by the touchpad.  

When this happens, use these buttons to change the arming of the lane. 

 

To verify the current arming state of a lane, refer to the Near/Far Lane Indicator on the main 

application screen of the Pro software. Section 6.6 of this manual provides a description of 

each icon the indicator uses and what it represents. 

After a Race 
After a race is finished, the following actions must be completed:  

Store/Print 
Click Store/Print to store the current event data into an event file and print the results 

according to the configurations set in the Configure window. Refer to Section 6.6. 

Reset 
Clicking Reset will reset the time and begin a new event. Reset also stores the current event 

data into an event file and prints the data according to the configurations set in the Configure 

window. If Store/Print was not clicked, refer to Section 6.6. 

Advance Event/Heat to Next Race 
The Event, Heat, Length and Round are set by the event order file, but can be edited from 

the main application screen by clicking [↑↓] to the right of the data fields at the top of the 

screen. At the end of an event or heat, the user must manually increment the event number, 

heat number and round.
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Section 7: OmniSport 2000 Console for Diving 

Sport Insert LL-2566 

 
Reference Drawings: 

Insert; Diving; Omni 2000 ...................................................................... Drawing B-180044 

 

The sport insert drawing is located in Appendix B:. If an insert is lost or damaged, a copy of the 

insert drawing can be used until a replacement can be ordered. 

 

Refer to Section 3: General Console Features and Operations (non-sport specific) for 

information on starting the timer and for instructions on using the sport insert.  

 

 

The OmniSport 2000 console includes a diving program that is useful for smaller dive meets. 

If the meet requirements exceed the functionality of the program built into the console, check 

out Section 9: OmniSport 2000 Pro Diving Software. 

 

 Up to four separate dive orders (events) labeled A, B, C and D 

 

 Up to 25 divers per dive order 

 

 Up to 13 rounds per diver 

 

 Uses 2, 3, 5, 7 or 9 judge‘s scores to calculate the award 

 

 Three methods of entering dive sheets: 

 

a. Manually before the event 

b. While the event is running 

c. Download from a results program like E-dive or DiveMeets.com 

 

 Dive sheets contain the four digit dive number, position and degree of difficulty  

for each dive 

 

 Ability to cut divers 

 

 Log and results printouts 

 

 Judges‘ scores can be entered: 

 

a. By the Omnisport 2000 console operator using the keypad  

b. By individual judge consoles (optional) 

 

 



Three things to remember about the OmniSport 2000 diving program: 

 

 Divers‘ names or affiliation are not entered into the console and do not appear on  

the display or printouts. 

 

 Judges‘ scores and round scores are not stored in the console. 

 

 The console does not have a pre-programmed dive list with the Degree of Difficulty 

(DD) for each dive. The operator will need to enter a DD for each dive. 

  

The three LCD screens on the OmniSport 2000 keep the operator informed during all 

operations. Note the following layout of the LCDs shown in the diving mode. 

 

                 1       2       3       4       5           6       7       8       9       10  

 

 

 

The left LCD screen shows the diver number, round and diver rank. The middle screen 

displays the current diver‘s dive type, position, degree of difficulty and total score for that 

round. The right screen shows the selected dive order and the event number. 

 

There are several different key types on the diving insert, LL-2566. Each key has a specific 

use. When looking at the keys (Figure 90), notice that some of them have been grouped 

together by location and others have been grouped with a border. The keys with borders are 

used together or perform similar operations as described in the following section:  

                                                          Judges’ Score Keys 

Judges’ Score Keys 
The numbers along the top of the insert are the scoring keys. These keys contain numbers 

ranging from zero to ten at intervals of 0.5 (0, 0.5, 1.0, 1.5…). The keys with borders are used 

to enter the judges‘ scores. The console then calculates the awarded score using the formula 

selected and the degree of difficulty.  

 

Note: Do not confuse the scoring keys with the permanent number keypad at  

the right side of the console. The number keypad is used to enter in all of the editable 

 

Figure 90: Diving Insert LL-2566 

DIVER #  01 
ROUND:01  RANK: -- 

DIVE 5152A     003.2 
TOTAL:  0.00 

   EVENT:   2 
DIVE ORDER - A 
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information such as menu selections, round and diver edits. The scoring keys are only  

used to enter scores.  

Round Key 
The diving program in the console scores up to 13 rounds. To view which round the console 

is currently scoring, look at the left second line of the LCD. To change the current round, 

press [ROUND ] then use [0]-[9]>[Enter] to input the desired round #.  

 

Pressing [↑] or [↓] is another method to increment or decrement the current round number. 

Diver Key 
The diving program in the console manages up to 25 divers per event. To view which diver is 

the current diver, look at the left first line of the LCD. To change the current diver, press 

[DIVER] then use [0]-[9]>[Enter] to input the diver‘s #.  

 

Pressing [↑] or [↓] is another method to increment or decrement the current diver number. 

Current Total 
Judges scores and round scores are not stored in the console. Each diver has current total 

score—the cumulative score of all rounds for that diver. To change the cumulative score, 

press [CURRENT TOTAL ▪] then use [0]-[9]>[Enter] to input the correct cumulative score. 

 

When to use this: 

 

 If the total score in the console is different than the actual total because the console 

has an incorrect D of D or judge‘s score.  

 

Note: This is the only way to edit the total score. If the operator returned to the diver with  

the incorrect total score and reentered the information and pressed [Accept], those points  

will be added onto the current total score. The console does not automatically remove the 

incorrect score.  

Select Order 
See A/S, B/P, C/T and D/F section below.  

A/S, B/P, C/T and D/F Keys 
These keys are used in two different functions in the diving system. 

 

The first function is to pick which Dive Order is currently being scored on the console. Press 

[Select Order] followed by the desired key: [A], [B], [C] or [D].Line two of the right LCD 

screen displays the Dive Order currently selected.  

 

 

 

 

 

  

 



The second function is to select the Dive Position when entering each dive. The table below 

outlines those positions. 

 

Dive Position OmniSport 2000 Letter 

Straight A/S 

Pike B/P 

Tuck C/T 

Free D/F 

Print Key 
At any time in the meet, the operator may print the Dive Results, Individual Dive List or the 

All Dive List to the console‘s built-in printer. Press [Print]>[1, 2 or 3]>[Enter] for the desired 

printout:  

[1]=Dive Results 

[2]=Individual Dive List 

[3]=All Dive List   

Paper Feed 
Press [Paper Feed] to have the printer advance the paper. The printer will not print on the 

advanced lines.  

Score Abort and Edit 
See Section 7.4 for a description of when to use. 

In order for the console to calculate a score for the dive, the following 

data is needed:  

 

 Dive # 

 Position 

 Degree of Difficult 

  Judges‘ scores  

 

When pressing [Score] (Figure 91)the console will determine if a dive 

#, Dive Position and Degree of Difficulty (D of D) have been pre-programmed, or if it still 

needs that information. If the console has this information, it prompts the operator to either 

manually enter the judges‘ scores, or the judges‘ scores will be filled in by the judge consoles. 

After all the judges‘ scores are displayed, press [Score] again to calculate the award for that 

round and add it on to the total for that dive.  

 

If the console did not have the Dive #, Dive Position or D of D for that diver and that round, 

the console will first prompt the operator to input that information before allowing the 

judges‘ scores to be entered. 

 

 Press [Abort] anytime after pressing [Score] to back out of the Score function without 

affecting the Total Score.  

 

Press [Edit] to enter the dive information ahead of time, or to change the dive information 

entered for the current diver and round.  

  

Figure 91: Right side of 

Dive Insert 
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Fail and Balk 
Fail and Balk keys are only used when the score operation is active. If an official determines 

that a diver balked on the dive or failed to perform the dive properly, the judges are notified 

and the scores will be determined based on this. Pressing [Balk] subtracts two points from 

each judges‘ score. Pressing [Fail] sets the awarded score to 0. 

 

Note: The Balk and Fail keys are only available after [Score] has been pressed the first time 

and the judges‘ scores are being entered. The center LCD shows Fail or Balk if this button has 

been pressed for the current diver.  

Cut 
When a diver is cut, that athlete will not be executing any dives in any future rounds. The 

individual cut will be skipped when the console gets to that point in the Dive Order. The 

results will show that individual‘s score, up to the point  

of being cut. Press [Cut] to toggle the cut setting from  

OFF/ON or ON/OFF. Verify a diver‘s cut status by looking  

at the left first line of the LCD, next to the Diver #. If a diver is  

active, the LCD will be blank next to the Diver #. If the diver is  

cut, the LCD will show (Cut).  

Next Event, Prev Event and Event/Heat 
The OmniSport 2000 console has the capability of pre-programming an Event Order  

(see Section 5.3).  

 

Press [Next Event] to advance the console to the next event in the Event Order. [Prev Event] 

returns the console back to the previous event in the Event Order. [Event/Heat] sets the 

console to whatever Event/Heat was entered. If that event  

is swimming it will prompt the user Event is Swim Switch Y/N.   

If the event is a diving event, it will set the console to that  

Dive Order.  

 

Clearing the Order 
Before a new diving competition or event can be performed, the Dive Order must be set. 

Clear any old information from the Dive Orders to eliminate any confusion that may arise. 

Complete the following steps to clear the orders.  
 

1. Press [Select Order]>[A] to set the current Dive Order to A. 

 

2. Press [Menu]>[2]>[3]>[Enter] to clear out Dive Order A. 

 

3. Repeat this step selecting [B], [C] and [D] to clear the remaining Dive Orders. 

 

 

 

 

 

DIVER# 05   
ROUND: 03  RANK: 

EVENT IS SWIM 
SWITCH    Y/N-- 
 

DIVER# 05 (CUT) 
ROUND: 03  RANK: 
 



Entering Dive Lists (Optional) 
Each diver must perform certain dives during an event. The Dive List of each diver can be 

stored in the Dive Orders. To enter the Dive List for each of the divers in Dive Order A, 

follow the steps below: 
 

1. Press [Select Order]>[A] to set the current Diver Order to A. 

 

2. Verify on the left LCD that the Diver # and Round are both set to 01. 

 

3. Enter the first diver‘s dive list by pressing [Menu]>[2]>[4]>[Enter]. 

 

4. The LCD will prompt the user to enter the dive and position. Use the numeric 

keypad to enter the four-digit dive number and the letter keys to select the position. 

Press [Enter] to accept the dive and position. Use the numeric keypad to enter the 

DD for the dive selected. Press [Enter] to accept the DD and increment the round by 

one. Repeat this sequence to enter the dive, position, and DD for each additional 

round for the selected diver. 
 

Note: When in the Editing Order menu, press [←] to decrement the round by one, 

[→] to increment the round by one, [↑] to decrement the diver by one and [↓] to 

increment the diver by one.  
 

5. After the first diver‘s dive list is entered, press [↓] to increment the diver by one. 

Press [←] as many times as necessary to decrement the round to one. Now repeat the 

above instructions for each diver‘s dive list. 

 

6. Press [Print]>[3]>[Enter] to print the dive list for all the divers in the selected  

Dive Order. 

 

7. Repeat this step selecting [B], [C], and [D] to pre-program each of the Dive Orders. 

Configure Number of Judges 
The correct number of judges is a critical part of scoring an event. To set the number of 

judges, press [Menu]>[4]>[1] and select 2, 3, 5, 7 or 9 for the correct number of judges.  

If 7 or 9 judges are selected, the LCD screen prompts the user for the correct formula.   

 

Selecting the Order 
At the beginning of a diving event, the correct Dive Order must be selected by pressing 

[Select Order] and the correct letter key. Verify on the left LCD that the Diver # and  

Round # are both set to 01.  

Entering Scores 
Entering the scores is the most important part of a diving event. The following image 

represents what the LCD should look like if scores with nine judges were entered. The top 

row of the two left-hand LCDs displays the judges‘ scores. The bottom row of those two 

LCDs show the dive number, position, degree of difficulty, total points awarded and the 

round. If a diver fails a dive or balks on a dive, AWARD is replaced with FAIL or BALK. 
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                 1      2      3      4      5          6      7     8     9      10  

 

 

 

To start entering scores, first select a diver, dive, position and DD. The two methods to enter 

scores are as follows:  

 
When the Dive Order is pre-programmed: (Refer to Section 7.3.) 

 

1. Verify on the center LCD that the correct dive, position, and DD is programmed. 

 

2. If not, press [Edit] and correct any mistakes. 

 

3. Press [Score] and the left two LCDs will request the judges scores. 
 

When the Dive Order is not pre-programmed: 
 

1. Press [Score] and the left two LCDs will prompt the user to enter dive and position. 

Use the numeric keypad to enter the three or four digit dive number and the A, B, C 

and D keys for the position. Press [Enter] to accept the dive and position.  

 

2. Use the number pad to enter the DD for the dive selected, then press [Enter]. The left 

two LCDs prompt the user for the judges‘ scores. 
 

Use the  [0]-[10] insert buttons to fill in the judges‘ scores. Press [Fail] or [Balk] if they apply. 

When the correct judges‘ scores have been filled in, press [Score] to accept the  

awarded score and advance to the next diver in that round. Repeat for each dive. 

 

If that was the last diver for that round, press [→] to increment the round by one. Next, press 

[DIVER ]>[1]>[Enter]. Repeat the above steps until all dives and rounds are completed. 

  5 5½ -   - -  
DIVE  51528 003.2 

-  -  -   -  RND 
AWARD: 00.00  01 

DIVER# 05 RANK:-- 
TOTAL:  0:00 



 

There are two methods of navigating through the 

menus in the OmniSport 2000 console. 

 

Refer to the OmniSport 2000 Quick Reference Guide 

ED-13584 (Figure 92) or Appendix C: in this manual 

for the diving menu navigation list. 

 

Note: Refer to Section 5.1 to review how to start and 

navigate through the menus. If the console is set in 

the swimming mode and the operator wants to 

change to diving,  either turn the console off and 

restart to select the new sport or select an event in the 

Event Order that is configured for a diving event.   

 

 

 

 

 

This menu is where the user can turn the scoreboard 

output ON or OFF, set the dimming level for  

Multi-drop/Multicast displays and show Time-of-Day  

on the scoreboard. 

 

Press [Menu]>[1] to open the scoreboard menus. Each step is illustrated as shown by the 

console‘s right LCD screen.  

Scoreboard ON/OFF 
This menu toggles the scoreboard between blank and  

displaying the current data.  
 

 
 

 

 

If the scoreboard is blank, the setting is OFF and it will remain blank until the next diver. 

 

When to use this: 

 

 The scoreboard is displaying false information due to equipment or operator  

error and needs to be blanked. 

 

 The error is corrected and the scoreboard output can be turned back on. 

 

Note: This is a menu that uses the YES/NO keys which are the same as Enter/Clear. 

 

 

 
Figure 92: Diving Menu Navigation - 

ED13584 

MENU-MAIN 
1-SCBD MENU 

MENU-SCOREBOARD 
1-SCBD ON/OFF 

SCBD IS ON 
SET OFF? Y/N 

From Main Menu – [1] 

From Main Menu – [1]>[1] 

SELECT-SPORT 
2 - DIVING 
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Dimming 
Dimming adjusts the dimming level of the scoreboards 

that are configured to receive Multi-drop protocol. 

 

 

 

 

Use the numeric keypad to select one of the values between 

 0-9 shown in the table to the right, or use the arrow keys to  

toggle through the settings. Press [Enter] to save the setting.  

Press [Clear] to return to the Dimming Menu without saving  

the setting.  

 

When to use this: 

 

 In low light conditions the scoreboard may be too bright. 

 

 In direct sunlight the scoreboard may need to be turned to full bright. 

Time-of-Day 
This menu is used to display the TOD on the scoreboard. 

 

 

 

 

Press [YES] to clear the scoreboard and show Time-of-Day. Press [NO] to do nothing and 

return to the TOD menu. The running time must be [Reset] before the console will display 

TOD on the scoreboard.  

 

Time-of-Day will remain on the scoreboard until: 

 

1. The start of the next event. 

 

2. The operator presses [Reset] a second time to re-display the current results  

on the scoreboard. 

 

3. It is toggled off in the menu. When it is toggled off, the current results will   

display on the scoreboard.  

 

When to use this: 

 

 Anytime the console is reset and the operator wants to display TOD on the 

scoreboard. This might be during a break in the meet. 

 

This menu lets the user manually edit the team scores to display  

on auxiliary team score scoreboards and edit the basic Event Order. 

Remember the operator has three options to manage the Event Order (Section 4.3).  

MENU-SCOREBOARD 
2-DIMMING 

SCBD DIMMING 
LEVEL 0-9: NONE 

MENU-SCOREBOARD 
DISPLAY TOD? 

MENU-MAIN 
2-EDIT MENU 

Dimming levels: 

0 = none (full bright) 

1 = 90% 

2 = 80% 

3 = 70%  

…each number 

represents 10% to…  

9 = 10% (dimmest) 

From Main Menu – [1]>[2] 

From Main Menu – [1]>[3] 

MENU-SCOREBOARD 
3-TIME OF DAY 



Team Score 
This menu is used to manually edit up to four team scores for  

display on auxiliary team score scoreboards. The * identifies  

which team score is being edited. 

 

 

 

 

Enter a score of 0 to 999 using [0]-[9]. Press [Enter] after the last score and post the scores to 

the scoreboard. The menu advances to the Edit-Event Order Menu. If the user is in the Edit-

Team Score Menu and wants to exit without saving the data, press [Clear]. This exits the menu 

and returns to the 1-Team Score Menu. 
 

Some operators will use the four scores (H, G1, G2 & G3) as HOME and GUEST for men and 

women or HOME and GUEST for varsity and junior varsity. Another option is to post the 

men‘s scores when a men‘s event is finished, and the women‘s scores when a women‘s  

event is finished.  

 

 

If the console is connected to Hy-Tek‘s MEET MANAGER, it is possible to automatically 

update the team scores in the console when the team scores in MEET MANAGER are 

updated (refer to ED-13876 OmniSport 2000 and Hy-Tek MEET MANAGER, p. 6). 

 

When to use this: 

 

 Typically team scores are updated on the scoreboard after each event is finished  

and scored. 

Event Order 
This menu is where the operator can edit, insert, or delete an  

event and to clear the event order entirely. For more  

information on Event Orders see Section 5.3.  

Edit Order 
This group of menus is used to manually enter a basic event  

order in the OmniSport 2000 timing console.  

 

 

 

 

The OmniSport 2000 timer can hold up to 500 events and some events may carry the same 

number but have an alpha character (example: event 001 and 001A), event locations have 

been numbered from 1 to 500. The asterisk indicates OK to press [Enter] and begin to edit  

this event location. Use [↑][↑] to move the cursor to select the event location number. Press 

[Enter] when the location number to be edited is shown. Press [Clear] to return to the  

menu selection.  

 

Use [0]-[9] to change the event number. Press [←] or [→] to set the events alpha designator 

and press [Enter] to accept. Press [←] or [→] to change the round type (final, semi-final, 

prelim, blank) then press [Enter] to accept. 

MENU-EDIT 
1-TEAM SCORE 

H   000*  G1  000 
G2  000   G3  000 

MENU-EDIT 
2-EVENT ORDER 

MENU-EVENT ORDER 
1 - EDIT ORDER 

EDIT EVENT ORDER 
#001*  E: 001  R: F 

From Main Menu – [2] 

From Main Menu – [2>[1] 

From Main Menu – [2>[2] 

From Main Menu – [2>[2]>[1] 
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Entering a [0] inserts a diving event and displays the dive order (A, B, C, or D) set for that 

event.  

 

 

 

 

When to use this: 

 

 If the console is not connected to a results program that can download the event 

order. 

 

 If the console is not connected to a computer running the OmniSport Pro Diving 

software.  

Insert Event 
This group of menus is used to insert an event into the  

event order. 

 

 

 
 

 

Press [↑][↓] to move the cursor to choose the event location number where the new event will 

be inserted. Press [Enter] when the location number is shown. Press [←] or [→] to change the 

round type (final, semi-final, prelim, blank) then press [Enter] to accept. Subsequent events 

shift to new locations.  

 

 

 

 

Press [0]-[9] to change the Event Number. Press [←] or [→] to change the events alpha 

designator and press [Enter] to accept. Press [←] or [→] to change the round type  

(final, semi-final, prelim, blank) and press [Enter]. 

 

 

 

Pressing a [0] will insert a diving event and displays dive order (A, B, C, or D) set for that 

event.  

 

When to use this: 

 

 If an event was missed and not programmed into the original event order. 

 

 An additional event was added, like a prelim, and needs to be placed into the event 

order.  

#001 = EVT: 000* 
RND = (BLANK) 

MENU-EVENT ORDER 
2-INSERT EVENT 

INSERT BEFORE 
#001* E: 004  R: 

#008 = EVT: 001* 
RND = (BLANK) 

#001 = EVT: 001 
DISTANCE = ·000* 

#001 = EVT: 001 
DIVE ODER= A 

#001 = EVT: 002 
DISTANCE = ·▪▪▪0* 

#001 = EVT: 002 
DIVE ORDER= * 

From Main Menu – [2>[2]>[2] 



Delete Event 
This menu is used to delete an event from the event order list. 
 
 
 
 
 
 

Press [↑][↓] to move the cursor to select the event location number to be deleted. Press [Enter] 

to delete the location number shown.  

 

When to use this: 

 

 If an extra event was programmed into the original event order.  

Clear Order 
This menu is used to completely erase the entire event order  

stored in the OmniSport 2000 console. Use this with caution. 

 

 

 

 

This is one of the menus that use [YES] and [NO]. Remember they are the same as [Clear] 

and [Enter]. Press [YES] to clear the entire event order and exit the menu. Press [NO] to exit 

the menu and leave the event order as is.  

 

When to use this: 

 

 If a new event order is needed to be built in the OmniSport 2000 console. 

Clear Order A (A-D) 
This menu is used to clear one of the four dive orders (A, B, C or D).The specific dive order to 

be cleared must be selected before entering the menu. Refer to Select Order in Section 7.4. 

 

 

 

 

Press [YES] to clear the order. Press [NO] to leave order as is and return to the main menu. 

Remember pressing [Menu] twice always returns the console to the main menu. 

 

When to use this: 

 

 Refer to Before-Each-Event Operations (Section 7.3) and During the Event  

Operations Section 7.4. 

Diver Order 
This menu is used to edit one of the four dive order. The specific dive order to be edited must 

be selected before entering the menu. To do this, refer to Select Order in Section 7.4. 

 

 

 

MENU-EVENT ORDER 
3-DELETE EVENT 

DELETE INDEX 
#001* E: 001  R: 
5 

MENU-EVENT ORDER 
4-CLEAR ORDER 

MENU-EVENT ORDER 
CLEAR ORDER? Y/N 

MENU-EDIT 
3-CLEAR ORDER A 

CLEAR OUT DIVE 
ORDER - A  Y/N 

MENU-EDIT 
EDITING ORDER A 

From Main Menu – [2>[2]>[4] 

From Main Menu – [2>[2]>[3] 

From Main Menu – [2>[3] 

From Main Menu – [2>[4] 
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Verify on the left LCD that the diver # and round are both set to 01. Use the numeric keypad 

to enter the four-digit dive number and the letter keys to select the position. Press [Enter] to 

accept the dive and position. Use the numeric keypad to enter the DD for the dive selected. 

Press [Enter] to accept the DD and increment the round by one. Repeat this sequence to enter 

the dive, position and DD for each additional round for the selected diver. 

 

Use [←] to decrement the round by one, [→] to increment the round by one, [↑] to decrement 

the diver by one and [↓] to increment the diver by one.  

 

Press [Clear] to return to the Main menu. 

 

When to use this: 

 

 Refer to Entering Dive Lists in Section 7.3.  

Clear Totals 
This menu is used to clear one of the four dive order‘s scores. The Dive Order to be cleared 

must be selected before entering the menu. To do this, refer to Select Order in Section 7.4. 

 

 

 

 

Press [YES] to clear the totals. Press [NO] to leave the totals as is and return to the  

Main menu.  

 

When to use this: 

 

 If the Dive Order has been pre-entered and due to testing or for whatever reason, the 

divers have points awarded to them, the function will set all of the stats for the 

selected Dive Order to 0.00. 

Diver Totals 
This menu is used to edit the total scores for each diver in the  

selected Dive Order. The Event Order to be edited must be  

selected before entering the menu. To do this, refer to  

Event Order in Section 7.7.  

 

 

 

 

Press [Enter] to select a diver to edit. Use the number keypad to edit the totals of a diver. 

Press [Enter] to accept the changes. The arrow keys increment and decrement the diver 

number by one. Press [Clear] to leave the menu and return to the Edit menu. 

When to use this: 

 

 One example of when to use this might be if the divers are carrying a score from a 

previous round like from prelims to finals. 

CLEAR OUT DIVER 
TOTALS - A  Y/N 

MENU-EDIT 
6-DIVER TOTALS 

EVENT A TOTALS 
#01   TOT:  0:00 

From Main Menu – [2>[5] 

From Main Menu – [2>[6] 



 

When choosing this menu, the operator can print a specific 

event result, the current event order in the OmniSport 2000  

console, or the settings for the current console configuration.  

Print Dive Results 
This menu is used to print results from the Dive Order 

currently selected. Figure 93 is an example of a dive  

results printout.  

 

 

 

 

To print a stored race, use [0]-[9] to enter the  

desired event number and press [Enter]. The LCD screen will 

then prompt the operator to verify the entered event number. 

Press [YES] to print the selected results (Figure 94). Press [NO] 

to ignore the selection and return to the Print Menu.  

 

When to use this: 

 

 Use this when the event results are needed  

to be re-printed onto the console‘s built-in  

thermal printer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 93: Dive Results Printout 

 
Figure 94: Dive Event Results 

MENU-MAIN 
3-PRINT MENU 

MENU-PRINT 
1-DIVE RESULTS 

MENU-PRINT 
PRINT RESULTS? 

From Main Menu – [3] 

From Main Menu – [3]>[1] 
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Print Event Order 
This menu is used to print the event order to the  

console‘s built-in thermal printer. 

 

 

 

 

Press [YES] to print the event order (Figure 95).  

Press [NO] to exit the menu without printing. 

 

When to use this:  

 

 It is a good idea to print out an event order  

before starting to time each session to verify 

 that the console is expecting to time the  

events in the desired order.  

Print Settings 
This menu is used to print the console‘s configuration 

to the thermal printer inside the console (Figure 96). 

 

 

 

 

Press [YES] to print the event order.  

Press [NO] to exit the menu without printing. 

 

When to use this: 

 

 Print the settings after the console has been set 

up and verified that all is functioning correctly. 

Keep this printout for future reference. It will 

be valuable if the console is loaned out to 

someone else, unknowingly a change was 

made in the console, or if the console was 

returned to or exchanged by Daktronics for 

service.  

 

 It is a good idea to pull out the known good 

settings and verify them to a new printout 

when the equipment is being set up for a meet. 

 
Figure 95: Event Order Printout 

 
Figure 96: Settings Printout 

MENU-PRINT 
2-EVENT ORDER 

MENU-PRINT 
PRINT ORDER? Y/N 

MENU-PRINT 
3-SETTINGS 

MENU-PRINT 
PRINT SETTINGS? 

From Main Menu – [3]>[2] 

From Main Menu – [3]>[3] 



Print Individual Dive List 
This menu is used to print the  

dive order of the current diver. 

 

 

 

 

Press [YES] to print the Dive Order. Press [NO] to exit the   

menu without printing.  

 

When to use this: 

 

 If the operator needs to print an active order for an  

individual diver (Figure 97). 

Print All Dive List 
This menu prints the dive  

list for all divers in the  

current dive order. 

 

 

 
 
 

Press [YES] to print the Dive Order. Press [NO] to exit the 

menu without printing. 

 

When to use this: 

 

 If the operator needs to print the Dive Order for 

all divers in that event. 

 

Timer Menu 

This menu contains the settings that tell the console how  

many judges will score the events and what designators 

they will use for the positions.  

Number of Judges 
This menu configures the number of judges (2, 3, 4, 5, 7 and 9) 

used to score an event.   

 

 

 

 

Press [0]-[9] to input the number of judges used for the event. Press [Enter] to accept the  

selection. If seven or nine judges are selected, the console prompts the user for a formula 

selection. Use [←][←]  to toggle to the correct formula and press [Enter] to accept or [Clear] 

to exit the judges‘ menu. 

 
Figure 97: Individual Dive List 

 

MENU-PRINT 
4-IND DIVE LIST 

MENU-PRINT 
PRINT IND LIST? 

MENU-PRINT 
5-ALL DIVE LIST 

MENU-PRINT 
PRINT ALL LIST? 

MENU-TIMER 
1-NUMBER JUDGES 

SCORING FORMULA 
DROP  3HI & 3LO * 

Menu - Main 
4 - Setup Menu 

From Main Menu – [3]>[4] 

From Main Menu – [4]>[1] 

From Main Menu – [3]>[5] 

MENU-TIMER 
# OF JUDGES: ▪3* 

Screen prompt when selecting 9 judges From Main Menu – [4]>[1]>[1] 
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Position Code 
This is a user preference setting to identify if the Dive Positions 

are going to be labeled A, B, C, D or S, P, T, F. 

 

 

 

 

Use [←][→]  to toggle to the desired selection and press [Enter] to save.  

Setup Numeric Scoreboard 
This menu is where the output data for the numeric display is configured. 

Number of Lines 
This menu sets the number of lines (1-10) that the scoreboard 

displays. The default is 10. 

 

 

 

 

Press [0]-[9] to enter the number of lines and then press [Enter] to save.  

Lead Diver 
This menu determines whether or not the diver with 

the most points is displayed.  

 

 

 
 

Press [↑][↓] to select YES/NO and press [Enter] to save. 

Multisport Scbd 
This menu determines whether or not the display in use at 

the facility is a multisport scoreboard. 
 
 
 
 
 
 

Press [↑][↓] to select YES/NO and press [Enter] to save. 

Comm Ports 
The following Comm (Communication) Ports menus select the protocol used for transmitting 

data to the display. 

Scbd Outputs 
Select Scoreboard Outputs to assign a protocol (Multicast,  

Multidrop or Multiline) to be used to transmit data  

on outputs (J2 and J3).  

 

MENU-SCOREBOARD 
1-NUMERIC 

MENU-NUMERIC 
1-# OF LINES: 

MENU-NUMERIC 
2-LEAD DIVER 

DISPLAY LEAD 
DIVER-YES * 

MENU-NUMERIC 
3-MULTISPORT SB 

MULTISPORT 
SCOREBOARD - YES* 

MENU-COMM PORTS 
1-SCBD OUTPUTS 

MENU-TIMER 
2-POSITION CODE 

DIVE POSITION 
CODE-ABCD* 

From Main Menu – [4]>[1]>[2] 

From Main Menu – [4]>[2] 

From Main Menu – [4]>[2]>[1] 

From Main Menu – [4]>[2]>[2] 

From Main Menu – [4]>[2]>[3] 

From Main Menu – [4]>[3] 

DIVE POSITION 
CODE-SPTF* 

# OF LINES 
LINES= ▪1* 



 

 

 
 

Press [←][→] to choose Multicast, Multidrop or Multiline protocol, depending on which type 

of display is used and then press [Enter] to save. 

 

When to use this: 

 

 The OmniSport 2000 supports many different types of displays. Multicast,  

Multidrop, and Multiline are protocols that Daktronics has incorporated into its 

displays. The newest generation of displays is the SW-5000 series. This series of 

display will auto-detect the protocol being sent to it. In most cases the console 

should be set to Multicast. 

 

 The previous generation of displays for swimming was the SW-2000 series. This 

generation required a protocol plug to know which protocol it was receiving. To test 

which protocol is used, unplug the signal to the display from the back of the console. 

Connect power to the display. When it powers up, it will display either a P0 or P1 on 

the left two digits:  

P0 – set the console to Multidrop 

P1 – set the console to Multiline. 

 

 If the display is one manufactured by Omega, set the console to Omega. 

RTD Port 
This menu configures which protocol (RTD or CTS) will be  

transmitted out of the RTD port (J5) connector on the  

OmniSport 2000 timer. RTD means ―Real Time Data‖ that is  

used for communication to a matrix scoreboard and CTS is for Colorado Timing System 

scoreboards. 

 

 
 
 
 

Select RTD to send information to a Daktronics Venus 7000 or 1500 display controller. Select 

CTS to send information to a numeric CTS scoreboard. Press [Enter] to accept the setting.  

Results Port 
The Results Port is used to configure which protocol 

(Omni 2000, Omni 6000, or CTS) will be used to  

communicate with the meet management software. 
 

 

 

 

Press [←][→] to select between OmniSport 2000 and 6000 consoles, or CTS console. 

OmniSport consoles are bi-directional protocols. The CTS console is a unidirectional  

protocol, utilizing the standard CTS scoreboard information.  

 

MENU-COMM PORTS 
SCBD: MULTIDROP* 

MENU-COMM PORTS 
2-RTD PORT 

MENU-COMM PORTS 
RTD PORT: RTD* 

MENU-COMM PORTS 
3-RESULTS PORT 

MENU-COMM PORTS 
RSLT: OMNI 2000* 

From Main Menu – [4]>[3]>[1] 

From Main Menu – [4]>[3]>[2] 

From Main Menu – [4]>[3]>[3] 
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Note: Selecting Omni 6000 tells the timer to transmit Omni 6000 RTD item numbers  

on the RTD output. 

 

This menu offers the following submenus to set the type of printouts desired. 

Dive Log 
This menu allows logging to be turned ON/OFF. Typically  

the Dive Log is ON. 

 

 

 
 

Press [←][←] to toggle between ON/OFF and then press [Enter] to save.  

 

When to use this: 

 

 Using the Dive Log is the most thorough way to identify issues with the system. 

Daktronics recommends that the Dive Log is always turned on. 

Intensity 
This menu sets the printer‘s depth of contrast for easy 

readability. The default level is 5. 

 

 

 
 

Press [1]-[5] to select a new intensity and then press [Enter] to save.  

 

This menu is used to set the console‘s date and time. 

 

 

 

 

Press [0]-[9] to enter the correct date and time and then press [Enter] to save. Press [Clear] 

twice to exit without saving and retain the previous time and date.  

 

The OmniSport 2000 timer is equipped with test features that can be used to test battery level 

and the numeric scoreboard. The following submenus explain how to use each of these tests. 

Battery 
This menu checks the battery power level. 

 

 
 
 

MENU-PRINTER 
1-DIVE LOG 

MENU-PRINTER 
DIVE LOG: ON* 

MENU - PRINTER 
2 - INTENSITY 

PRINT INTENSITY 
LEVEL 1-5: 4* 

MENU - SETUP 
5 - TIME OF DAY 

DATE 01/01/00  * 
TOD  01:55:11 

MENU - TEST 
1-BATTERY 

BATTERY TEST 
LEVEL:  CHARGED 

From Main Menu – [4]>[4] 

From Main Menu – [4]>[4]>[1] 

From Main Menu – [4]>[4]>[2] 

From Main Menu – [4]>[5] 

From Main Menu – [5]>[1] 

From Main Menu – [5] 



 

The battery level will show as CHARGED or LOW. Press [Enter] to exit the menu.  

Scoreboard 
These menus test the scoreboard drivers. 

Cycle ON/OFF 
This menu checks the signal to the scoreboard. 

 

 

 

 

Press [1] to toggle the scoreboard ON and OFF. When this menu is selected, an all ON signal 

is sent at intervals of approximately 3 seconds. This will continue to cycle ON and OFF until 

pressing [Enter] to continue.  

Driver Address 
This menu shows which drivers control the digits.  

 

 

 

 

Press [3] to display the driver addresses. The number or letter will show which output on the 

driver that digit is plugged into. This will remain on the display until [Enter] is pressed. 

Digit Number 
This menu confirms the digits are operational and  

properly plugged at the time of installation and if the 

system needs debugging. Call Daktronics for service.  

 

 

 

 

Press [Enter] to exit.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SB TEST MENU 
1-CYCLE ON/OFF 

DISPLAY ALL ON 
ENTER TO EXIT 

SHOWING ADDRESS 
ENTER TO EXIT 

From Main Menu – [5]>[2]>[1] 

From Main Menu – [5]>[2]>[3] 

SHOWING DIGIT # 
ENTER TO EXIT 

From Main Menu – [5]>[2]>[2] 

SB TEST MENU 
3-DIGIT NUMBER 
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This menu tests whether or not the judge consoles 

are connected to and communicating with the  

OmniSport 2000 timing console. 

 

 

 

 

The right LCD screen alternates between the above messages.  

 

    1      2       3       4      5          6       7      8      9     10 

 

 

 

The two left screens LCD indicate where a judge console is connected in the rear of the 

OmniSport 2000 console:  

 

 N = Near jack (J14) 

 F = Far jack (J15) 

 ? = No connection 

 

The LCD screens also indicate that judge consoles One and Six are currently operational—

judge  console One is plugged into J14 and judge‘s console Six is plugged into J15. The 

numbers on the bottom row correspond to the key recently pressed on the judge console, to 

help verify correct 2-way communication. Note the data on the judges console LCD screens 

also verify the data. Test each judge console being used. Press [Enter] to exit. 

 

For more information on judges consoles, refer to Section 8 in this manual. 

 

 

JUDGE CONSOLE 
TESTING MODE 

N=NEAR F=FAR 
?=NOT CONNECTED 

MENU-TEST 
3-JUDGE CONSOLES 

From Main Menu – [5]>[3] 

N   ?   ?   ?   ? 
2 

F   ?   ?   ? 
3 





Section 8: Judge Consoles 

Reference Drawings: 

System Riser, RC-100, Rodeo/Diving/Sync Swimming ......................... Drawing A-230608 

 

Judge consoles are used to enter scores during diving and synchronized swimming events. The 

OmniSport 2000 console can be setup to operate with two, three, five, seven or nine judge's 

consoles. The consoles are connected to the ―J14‖ or ―J15‖ ports on the back of the console. If 

wireless judge's consoles are used, the wireless base station is connected to the ―J14‖ or ―J15‖ ports 

on the back of the OmniSport console. Refer to Drawing B-220003 for connection details. 

 

Besides the appearance and physical connections, the only difference between a JC-100 console 

and a RC-100 console is the turn on (power up) of the RC-100 console. For more information on the 

RC-100 console, refer to ED-15133 Remote Control System RC-100.  

 

 

The first time a judge console (Figure 98) is connected  

to the OmniSport timer it will prompt the user  

to enter a judge number.  

 

The LCD screen on the judge console prompts the user to  

enter a number from one to the maximum number of  

judge's consoles the OmniSport 2000 console has been  

configured to use. If a number is entered that has already  

been used by another judge or is higher than the number  

of judges configured, the console will beep and wait for a  

new number to be entered.  

 

 

 

 

Once a judge number has been set for the judge‘s console, it will appear on the LCD display. 

This information is the same for both the JC-100 console and the RC-100 console. 

 

The request for scores will show on the judge consoles  

when the OmniSport 2000 console has entered scoring mode  

for the dive. The dive number and degree-of-difficulty (DD)  

will also be displayed.  

 

One or two panels of judges can score a synchronized swimming event. If there is one panel 

of judges, the judge numbers on the consoles are entered as one through the number of 

judges configured for the event. If there are two panels of judges, the second panel would be 

entered as the next set of judge numbers available after the first panel. If there are two panels 

of five, the second panel is entered as judge numbers 6-10. There can be up to 2 panels of 9 

judges or 18 total judges per OmniSport 2000 console. 

 

 
Figure 98: JC-100 Console 

ENTER JUDGE # 
   -- * 

      JUDGE  1: 
 

   JUDGE  1::  ● . ●* 
DIVE 101A   DD1.4   
 



If there is only one panel of judges, they enter both sets of scores for the event. When there 

are two panels of judges, each panel enters a separate set of scores.  

 

Enter the score for the current dive, then press [Enter] to accept. When the score has been 

entered, OK appears to the left of the JUDGE number.  

Score Editing 
After a score has been entered it may be changed by pressing [Edit]. This puts the console 

back into score entering mode to allow the score to be re-entered. The score cannot be edited 

if the OmniSport 2000 console operator has already accepted the judge‘s scores.  

 

The judge consoles used to enter scores during synchronized diving events are grouped  

by their entry function. The OmniSport Pro Synchronized Diving program can be set to use  

7 or 9 judge‘s consoles. Refer to the following table to set the appropriate program: 

1-3 Dive synchronization 1-5 Diver synchronization 

4-5 Diver #1 execution 4-5 Diver #1 execution 

6-7 Diver #2 execution 6-7 Diver #2 execution 

 

 

One or two panels of judges can score a synchronized swimming event. If there is one panel 

of judges the judge numbers on the consoles are entered as one through the number of judges 

configured for the event. If there are two panels of judges, the second panel would be entered 

as the next set of judge numbers available after the first panel. If there are two panels of five, 

the second panel is entered as judge numbers 6-10. There can be up to 2 panels of 9 judges or 

18 total judges per OmniSport 2000 console. 

 

If there is only one panel of judges, they enter both sets of scores for the event. When there 

are two panels of judges, each panel enters a separate set of scores. The operations for one 

and two panels are detailed in the sections that follow.  

One Judge Panel Operation 
When there is one panel of judges, all judges are responsible for entering both sets of scores 

for the routine. The prompts are shown below: 

Technical Routine Operation 
The first score to enter for the technical routine is for  

execution of the routine. 

 

The second score to enter for the technical routine is for  

the overall impression of the routine.  

 

 

 

 JUDGE  1  
EXECUTION :   5.0  
 

 JUDGE  1  
OVERALL :   6.0   
 

 JUDGE  1     
E:  5.0   O1:  
6.0   
 



The LCD screen will then show the two scores and an OK after they have been entered. 

Free Routine Operation 
The first score to enter for the free routine is for the  

technical merit portion of the routine. 

 

The second score to enter for the free routine is for the  

artistic impression portion of the routine. 

 

 

 

The LCD screen will then show the two scores and an OK after they have been entered. 

Two Judge Panel Operation 
When there are two panels of judges the first panel enters the first set of scores and the 

second panel enters the second set of scores for the routine. The prompts are shown below. 

Technical Routine Operation 
In a technical routine the first panel of judges enters  

the score for the execution of the routine. 

 

 

 

The OK will display by the judge‘s number after the score is entered. 

 

The second panel of judges enters the score for the  

overall impression of the routine. 

 

 

 

The OK will display by the judge number after the score is entered. 

Free Routine Operation 
In a free routine the first panel of judges enters the score  

for the technical merit portion of the routine.  

 

 

 

The OK will display by the judge number after the score is entered. In a free routine the 

second panel of judges enters the score for the artistic  

impression portion of the routine.  

 

 

 

Score Editing 
After a score has been entered it may be changed by pressing [Edit]. This puts the console 

back into score entering mode allowing the score to be re-entered. The score cannot be edited 

if the OmniSport 2000 operator has already accepted the judge's scores. 

  JUDGE 1      OK 
 TECHNICAL :  5.0 

 JUDGE  1  
TECHNICAL : 5.0 
 

 JUDGE  1  
ARTISTIC :   7.0   
  JUDGE  1  

TM:   5.0  A1: 
7.0 
 

  JUDGE 1    OK 
 EXECUTION :  5.0 

  JUDGE 6 
 OVERALL :  5.5 

  JUDGE 6    OK 
 OVERALL :  5.5 

  JUDGE 1 
 TECHNICAL :  5.0 

  JUDGE 1 
 EXECUTION :  5.0 

  JUDGE 6 
 ARTISTIC :  5.5 

  JUDGE 6  OK 
 ARTISTIC :  5.5 





Section 9: OmniSport 2000 Pro Diving Software 

The OmniSport 2000 Pro Diving software interfaces with the OmniSport 2000 console to receive 

scores via judge consoles and also uses the OmniSport 2000 console to interface with scoreboards 

and displays. The software can handle multiple meets with multiple events in each meet. Each event 

in turn can have unlimited divers in up to 99 rounds. Other features include synchronized diving and 

the ability to import and export to third party results programs such as DiveMeets.com and E-dive. 

Daktronics Pro Diving software does not verify dive sheets, but it does almost all other functions 

required to score an event. 

 

This section describes how to install, configure, and operate the Daktronics OmniSport 2000 Pro 

Diving software system, Version 2.0.4. 

 

The OmniSport 2000 Pro software operates on a Windows® based computer. The following 

list describes the requirements for the OmniSport 2000 Pro software. 

 

 Internet Explorer 6.0 or higher  

 1.6 GHz CPU or higher  

 Windows XP operating system or better 

 Minimum 1GB of RAM 

 Standard keyboard and mouse 

 

The following list describes the optional equipment that may be used with the Pro software:  

 

 One open serial (COM) port for connection to the OmniSport 2000 timing console 

 OmniSport 2000 timing console 

 2-9 RC-100 wireless (or JC-100 wired) judges consoles 

 

The OmniSport 2000 Pro software is a computer interface to the OmniSport 2000 timing 

console. The software can be used to judge a diving event without the timing console, but 

there must be a console present to send the data to a scoreboard or to interface with the 

handheld judge consoles. The OmniSport 2000 timer must be connected properly to all 

competition equipment and accessories if using a display or judge consoles. Refer to  

Section 2 for more information on hardware installation of the OmniSport 2000 timer.  

 

To install the Pro Diving software from the Internet: 

 

1. Open an Internet browser to: 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport 

2000/Pro/Diving/   

 

2. Click the ―OmniSport Pro Diving 2.0 (Web).exe‖ file, and then click Run to begin 

the installation.   

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/Pro/Diving/
http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/Pro/Diving/


Note: Click Run again if a security warning appears. 

 

3. Follow the onscreen instructions to complete the installation. 

 

To install the Pro Diving software from a CD: 

 

4. Insert the software CD into the CD-Rom drive, and it should run automatically.  

 

5. If the auto run program does not start, navigate to the CD-Rom drive that contains 

the installation disk (usually ―D:‖).  

 

6. Double-click the ―DivingInstallation.msi‖ file. 

 

7. Follow the onscreen instructions to complete the installation.  

 

To open the application: 

 

 Double-click the OmniSport 2000 Pro Diving icon on the desktop. 

 

 Click the Start menu and navigate to All Programs > Daktronics > OmniSport Pro > 

Pro Diving 2. 
 

To exit the application: 

 

 Click the exit button in the upper right corner of the window. 

 

 Left- or right-click the icon in the upper left corner of the window and click Close. 

 

 Click the Daktronics ‗D‘ in the upper left corner and click Close or Exit. 

 

On initial startup, the registration window is displayed (Figure 99). The software may be 

registered online or by phone/email. The user will be able to receive an unlock code once the 

software is purchased.  

 

Note: Users may temporarily bypass registration by clicking Evaluate, and the software will 

run for up to 30 days before registration is required. To continue using the software after the 

trial period has ended, the user must register. 

Online Registration 
 

1. Enter the Customer ID and Password for the online registration account. This 

information will be provided after purchasing the software online.  

 



2. Click Register Online. 

 

3. Click OK in the registration 

confirmation box (Figure 99).  

 

Note: Online registration offers 

up to 3 unlocks and may be used 

on any internet connected 

computer.  

Manual Registration 
 

1. Call 1-888-325-7828 or  

email DakStats@daktronics.com. 

 

2. Give the Serial Number to Daktronics. 

 

3. Type in the Code from Daktronics to unlock 

the software and receive confirmation 

(Figure 100). 

 

Note: Installing the software on a separate computer requires a new  

registration code.  

 

The Pro Diving splash screen (Figure 101) appears after the registration screen. This is a 

central hub for setting up the software, launching meets, and viewing completed, present, 

and upcoming meets. News and tips for the software are visible here as well. Below are 

descriptions of the available features and tasks that can be performed on the splash screen.  

 

 

 

Figure 99: Registration Window 

 

Figure 100: Registration Confirmation 

  

Figure 101: Splash Screen 

mailto:DakStats@daktronics.com


Splash Screen Features 
 

 Schedule shows Current, Past, and Future Meets for the preceding and following 30 

days, depending on the selected date on the calendar in the upper left hand corner.  

 

 Recently Opened Meets lists the Meet Name and Date for recently created/opened 

meets. Double-click a meet to quickly resume it.  

 

 Tips offers short suggestions for operating and configuring the software. Click 

Previous Tip and Next Tip to see more helpful hints.  

 

 News displays important notices and information about software releases and 

provides links to users so they always have the most up-to-date version of the 

software. 

 

 Common Tasks provides frequently used functions within the software. All of these 

tasks are also available from within the main application. 

Splash Screen Tasks 
 

1. Click Resume Last Meet to instantly open the 

last opened meet. If no meets have been 

created, clicking this button will open the main 

application screen (see Section ). 

 

2. Click Open A Meet to select a previously 

created meet to open (Figure 102).  

 

 Choose the meet name from the  

drop-down list. 

 

 Click OK and the meet will open within 

the main application screen.  

 

3. Click Create A Meet to begin a setup wizard to 

add new meets (Figure 103).  

 

 Type in a descriptive Meet Name.  

 

 Choose a date on the calendar if different 

from the current date, and then click Next. 

 

 On the following screen (Figure 104), users 

can add, delete, and edit all of the events 

for the meet. To skip this step for now and 

add events at another time, click Finish.  

 

 

 

 

 
Figure 102: Open Meet Window 

 
Figure 103: Create\Edit Meet Window - 

Set Name and Date 

 
Figure 104: Create\Edit Meet Window- 

Add Events 



4. Click Add Event to insert a new event to the meet (Figure 105). 

  

 Type in a descriptive Title for the event. 

 Select the number of Rounds,  

from 1-13. 

 Select a Gender, Male or Female. 

 

Note: Change the External settings 

(Number, Section, and Alpha) if 

necessary, to match those of the 

third-party Hy-TekLTD MEET 

MANAGER software. 

 

5. Click Next to continue. 

 

 On the next screen (Figure 106), first 

set whether the event is 

Synchronized by checking the box. 

 Select the number of Judges from  

2, 3, 5, 7, or 9. Synchronized events 

may select from 7, 9, or 11 judges. 

 Select the Formula for calculating the 

scores (only applicable for 7 or 9 

Judges in non-synchronized events). 

 Select the Type of board: 1M 

Springboard, 3M Springboard, or 

Platform. 

 Select the how the dive Position will 

be annotated, either A-D or S-F. 

 Select the DD Table if different from 

FINA (Figure 135).  

 

6. Click Next to continue. 

 

 On the next screen (Figure 107), 

users may assign the diving roster. 

 Fill in the information for the 

diver(s), and then click Add, or 

simply click Finish now to add 

divers later.  

 Add or Remove divers from the 

roster as needed, and then click 

Finish. 

 

7. Continue to click Add Event as needed, 

or edit or delete existing events.  

 

8. Click Finish when all events are set up. 

 

 

 

 
Figure 105: Create\Edit Meet Window -  

Set up Events 

 
Figure 106: Create\Edit Meet Window  

- Set up Judges 

 
Figure 107: Creating Rosters 



Run Reports 
Click Run Reports from the splash screen to configure reports and printouts. This screen 

(Figure 108) has numerous options for printouts that can be used before or after the meet.  

Select a Meet 
Choose one or more events within the meet. 

Printouts 
Under Printouts, choose one or more of the following options:  

 

 Event Results - Overall: Select to show basic meet results arranged By Rank or By 

Dive Order. 

 

 Event Results - Detailed: Select to show more complete meet results arranged By 

Round or By Dive Order. 

 

 Dive Sheets: Select to print dive sheets for all divers. Choose Hide scores to prevent 

scores and rankings from appearing on the dive sheets. 

 

 Dive Orders: Select to print the dive order.  

 

 Announcer Script: Select to print diver/dive order information that can be read by an 

announcer at the meet.  

 

 DD Table: Select to print a DD table.  

 

 Print Options: Set the appearance options of the printouts.  

 

 Select Show Border to separate each cell of information with a gray border, or 

select Alternating Row Color to show a row of information in white followed by 

a colored row. Change the row Color if applicable.  

 

 

 
Figure 108: Create Reports Window 



Path & Generate Buttons 
Click Path to select a different folder in which to save the printouts.  

 

After selecting all of the desired printout settings, click Generate. Reports open as HTML 

files in the default Internet browser. Users may then make hardcopy printouts, typically by 

going to File > Print within the Internet browser. 

 

Note: With DD Table selected, as soon as Generate is clicked, a new window will appear 

telling the user to select a DD table. Find the appropriate DD table from the drop-down 

list, and then click OK to continue generating the printout(s).  

Import A Meet 
Click Import A Meet to import a meeting file from an external location. See Import for more 

information. 

Export A Meet 
Click Export A Meet to export a meeting file to an external location. See Export for more 

information. 

Configure Scoreboard 
Click Configure Scoreboard to adjust the display settings for matrix displays or scoreboards 

and other display options. See Section 9.7 for more information.  

View Manual 
Click View Manual to open the PDF version of the software user manual.  

Connect to OmniSport 
Click Connect to OmniSport to choose the serial (COM) port to communicate with an 

OmniSport control console. See Section 9.7 for more information. 

 

Before creating meets, some initial communication and display options must be configured.  

 

Note: Users may skip this section if the software will not be used with an OmniSport console 

to send data to a display or to interface with handheld judge‘s consoles.  

Communication Configuration 
If the Pro Diving software is unable to detect the console, ensure the cable is connected to a 

serial (COM) port on the computer and to the expansion port on the OmniSport 2000 console. 

If they are, check the COM port settings in the Configure Communications menu.  

 

1. From the splash screen, click Connect to 

OmniSport. 

2. In the Select Com Port window (Figure 109), select 

the proper serial port that is connected to the 

OmniSport console.  

3. Click OK. 
 

Figure 109: Com Port 



Note: If the cables are connected properly, the connection 

indicator in the main application will be green (Figure 110). 

If there is a problem with the connection, it will remain red.  

 

Additionally, judge consoles that are not connected will 

have a red box beneath their number (Figure 111). When 

properly connected, no box will appear. 

 

Once the hardware and software are installed and the 

software is running, the OmniSport 2000 Pro system should 

synchronize with the timing console. The console‘s LCD 

screen will then display Controlled by Pro Diving. 

Display Configuration 
The Configure Settings window (Figure 112) contains options 

for outputting meet information and results to scoreboards 

and displays.  

 

Matrix Display Settings 

 

 Diver Name allows the 

operator to select how 

the divers will be listed: 

First Last; Last, First; 

Last, Abbr., or Last. 

 

 Determine how to 

display the Affiliation 

by selecting Full Name 

or Abbreviation.  

 

 Select a number (2-10) 

of Leaderboard Lines  

to display.  

 

Numeric (Fixed Digit) Display Settings 

 

 Click the Yes/No buttons if using a Multisport display and whether to Show Lead.  

 Set the number (1-10) of Lines the board can display.  

 Select from 12 Hour or 24 Hour for the Display Time. 

 Set the Dimming Level in increments of 10%. 

 

Timer Port Configurations 

 

 Under Meet Manager Port, use the drop-down box to select the correct timing console 

being used: Omni 2000, Omni 6000 or CTS. 

 Under RTD Port, select RTD or CTS for the type of Real Time Data output.  

 Under Scoreboard Port, select Multiline, Multidrop, Omega, or Multicast, depending 

on the particular model of scoreboard in use.  

 Use the RTD Offset setting when multiple timers are in use. Select from 5,000; 10,000; 

or 15,000 to ensure the data from all timers is accessible. 

 
Figure 110: Green Connection 

Indicator 

 
Figure 111: Judges Consoles 

Not Connected 

 
Figure 112: Configure Settings Window 



Other Settings 

 Under Importing Dive Orders, select whether to Keep Dives or Replace Dives after 

importing a meet file.  

 Enabling the Console Printer Logging option will use the OmniSport 2000 console‘s 

built-in printer to automatically print dive information at the end of each round.  

 Turn the software Tooltips On or Off. 

 

Diving meets take place 

within the main application 

screen (Figure 113). Here 

users follow the action of 

meets and record the scores 

for each diver in every 

event. Users may also 

create and edit meets, print 

reports, adjust the software 

settings, and perform all of 

the tasks that are available 

on the splash screen and 

more. This section 

discusses each area of the 

main application screen 

and how it is used.   

Events 
Use the drop-down box to quickly switch between meet events.  

Current Diver 
View the Name, Affiliation, Dive Desc(ription), Dive #, Order, and DD for the current diver(s). 

Next Diver 
View the Name, Dive #, DD, and Board for the upcoming diver(s). 

Judge Scores 
This area of the main application screen (Figure 114) includes a list of all the assigned judges 

with buttons for the user to accept/enter scores or to balk/fail the diver(s).  

 

1. After a diver/team has been made active (Figure 

116), click Next to begin accepting scores. If the 

judges are equipped with properly configured 

consoles, their scores will populate automatically. 

Otherwise, type in each judges‘ score(s). 

 

2. Click Accept when all of the scores have been entered correctly. 

 

Note: If a diver fails to dive, click Fail followed by Yes to confirm. Similarly, if the 

diver balked before or during the dive, click Balk, and then click Yes. 

 
Figure 113: Main Application Screen 

 

 
Figure 114: Judge Scores 



 

3. Click Next when it is time to allow scores to be entered for the next diver(s), and 

continue to do so until every round of the event is complete.  

Diver Statistics 
Use the three drop-down lists to select Score to take place X, where X would represent a 

place other than where the active diver/team currently sits. The software calculates how 

many points are needed to take the selected place (Figure 115). The number of places 

available to select is determined by the number of divers/teams in the event. 

Event Order 
Users assign the active diver(s) and make changes to the diving roster. Pro Diving offers 

several ways to perform the same tasks based on user preference. 

Making Divers Active 
Before scores may be entered for a diver or diving team, 

they must be made active. To do so, simply right-click a 

diver/team from the Event Order list, and select Make 

Active (Figure 116).  

Adding/Removing Divers 
To Add Divers: 

 

 Click Add Diver, or right-click the 

Event Order list and select Add 

Diver. This places a new diver/team 

at the bottom of the roster. 

 Select a diver/team from the Event 

Order list, and then click Insert 

Diver, or right-click the Event Order 

list and select Insert Diver. This 

places a new diver/team before the 

selected diver(s). 

 

Note: Whether the user chooses to add or insert a diver, the same window will 

appear (Figure 117). Fill in the appropriate diver information, then click Add. If it is a 

synchronized event, the user will have to enter two divers to continue. 

 

To Remove Divers: 

 

 Select a diver/team in the Event Order list, and click Remove Diver or right-click a 

diver(s) and select Remove Diver. 

 Click Yes to confirm the diver deletion. 

 
Figure 115: Diver Statistics 

 
Figure 116: Making a Diver Active 

 
Figure 117: Add or Insert Diver 



Editing Scores 
 

1. Select a diver/team 

from the Event Order 

list, and then click Edit 

Scores, or right-click a 

diver/team, and then 

select Edit Scores.  

2. In the Edit Diver Scores window (Figure 118), type in the scores for each judge. 

3. Click Accept to apply the scoring changes. 

Editing Diver Information 
To edit the information for a diver/team, right-

click them in the Event Order list, and then 

select Edit Name or Edit Affiliation. Either 

choice will open the Edit Diver window (Figure 

119), where the Diver information may be 

changed.  

 

Editing Dive List 
To change the dives a diver performed or will 

be performing, right-click the diver/team and 

click Edit Dive List, or select the diver/team 

and click the Edit List button. In the Edit Dive 

List window (Figure 120), type in an acceptable 

dive number from the DD Table for each round, 

and then click OK. Use the Previous and Next 

buttons to switch between the other divers‘ and 

teams‘ dive lists. 

 

Editing Dives  
Double-click a diver/team in the Event Order list 

to edit the  dive number and position (Figure 

121). If no dive number was entered, this 

window appears before the user can accept 

scores. 

Rearranging Divers 
 

 Select a diver/team from the Event Order 

list and click Move Up or Move Down 

to move them one position at a time.  

 To move a diver/team many positions at once, simply click and drag them to the 

desired location in the roster.  

 
Figure 118: Edit Diver Scores Window 

 
Figure 119: Edit Diver Window 

 
Figure 120: Edit Dive List Window 

 
Figure 121: Edit Dive Window 



Cutting/Uncutting Divers 
To skip the turn of a diver/team in the roster, right-click them and select Cut Diver. This 

removes the diver/team from the competition as well as the finals. Right-click them again 

and select Uncut Diver to return to the diving rotation.  

Round 
After all divers/teams have been scored for a particular round, 

the next round will begin automatically. Users can switch to 

previous or upcoming rounds by clicking the small up and down 

arrows in the bottom right corner of the Event Order tab (Figure 

122).  

Ranking 
Click the Ranking tab 

(Figure 123) to view 

competitors in order from 

highest to lowest score. 

Right-click a diver/team 

to perform the following 

commands: 

 

Cut this score and below 

Click to skip a selected diver/team and every diver/team below that score. 

 

Cut this diver only 

Click to skip over the turn of a specific diver/team in the roster. 

 

Uncut this score and above 

Click to restore a cut diver/team as well as all those above back into the roster. 

 

Uncut all divers 

Click to restore every cut diver/team back into the roster. 

 

Uncut this diver only 

Click to restore a cut diver/team back into the roster. 

 

The OmniSport Pro Diving software includes an expandable ribbon menu bar with several 

tabs across the top. Click a tab to see all of the available commands. Below is an explanation 

of each tab and its commands.  

Manage Meets 
The Manage Meets tab 

contains commands for 

creating and managing 

meets, divers, and 

events (Figure 124). 

 
Figure 122: Switch Rounds 

 
Figure 123: Ranking Tab 

 
Figure 124: Manage Meets Tab 



Meets 
Create 

Click to create a new meet. This is the same process as described in (Figure 101) on the splash 

screen Common Tasks. 

 

Open 

Click to open a meet. This is the same process as described in (Figure 102) on the splash 

screen Common Tasks. 

 

Edit 

Click to edit the currently opened meet. This is the same process as creating a meet except 

that previously entered information is already available for edit. 

 

Delete 

Click to delete a whole meet. 

 

1. Select the meet to delete from the drop-down 

list (Figure 125). 

2. Click OK. 

3. Click Yes to confirm the deletion.  

 

Copy 

Click to copy some or all components of an 

existing meet.  

 

1. Select the meet to be copied from 

the drop-down list (Figure 126). 

2. Select the event(s) to copy from the 

meet. 

3. Select whether to 

 

 Copy Divers: The copied meet 

will include the same divers as 

the original. 

 Copy Dive Lists: The copied meet will include the same dive numbers and DD 

table as the original. 

 Copy Scores: The divers in the copied meet will retain the same awards, totals, 

and ranks as the original divers.  
 

4. Select whether to:  

 

 Create Finals: The copied meet will include only uncut divers. 

 Keep Scores: The copied uncut divers will start with the same final scores. 

 
Note: Users may select Copy Divers or Create Finals, but not both at the same 
time. 

 

5. Type in a descriptive New Meet Name. 

 

6. Select a New Date if necessary. 

 

 
Figure 125: Delete Meet Window 

 
Figure 126: Copy A Meet Window 



7. Click Create, and then click Yes to make a copy of the meet. Click Yes once  

more to immediately open the meet if desired, otherwise click No to stay in the 

current meet.  

 

Note: If using combined events, users are given the option to reorder the events 

before the copy is completed. 

Divers 
Add/Insert/Delete 

Click each button to respectively add, insert, or delete divers. See Adding/Removing Divers.  

Events 
Add 

Click to make a new event for the currently opened meet. See (Figure 103) for more 

information about adding events to new meets.  

 

Edit 

Click to edit the currently opened event. This is the same process as creating a meet except 

that previously entered information for the current meet is available for edit. 

 

Remove 

Click to delete the currently opened event. Click Yes to confirm the deletion. 

 

Combined 

Click to create a combined event. Typically events move from round to round automatically, 

and when one event ends, the user must manually switch to the next event in the meet. With 

a combined event, when the first round of the first event ends, the first round of the second 

event will begin and continue on through the first round of every event before moving on to 

the second round.  

 

1.  Click the cell below the Order 

column to type in the order of the 

event within the combined event 

(Figure 127).  

 

Note: For any event that will not 

be included in the combined 

event, enter ―0‖.  

 

2. Repeat step 1 until all the events 

are properly ordered.  

 

3. Click OK when finished.  

 

Finals 

See Copy (Figure 126) for an explanation of creating a finals meet.  

 
Figure 127: Order Events Window 



In Meet 
The In Meet tab contains 

commands for adjusting 

the dive order, handling 

scores and leaderboards, 

and adding/deleting 

divers during meets 

(Figure 128). 

Dive Order 
Up 

Select a diver/team in the Events Order list and click Up to move them one position higher in 

the roster.  

 

Down 

Select a diver/team in the Events Order list and click Down to move them one position lower 

in the roster. 

Scoring 
Edit 

Select a diver/team in the Events Order list and click Edit to change their scores (Figure 118).  

 

Clear 

Click to completely erase all scores for every diver/team in each round of an event. Click Yes 

to confirm the deletion.  

Leaderboard 
Show 

Click to view the current leaderboard (Figure 129). The 

number of divers per page and total pages available is 

determined by the Display Settings or the Configure 

Leaderboard window.  

 

Configure 

Click to set up how many lines to show per page in the 

leaderboard (Figure 130).  

Dive Order 
Add 

Click to add a new diver/team to the bottom of the 

roster. 

 

Remove 

Click to remove a selected diver/team. 

 

Insert 

Click to insert a new diver/team before a selected diver/team. 

 

 

 
Figure 128: In Meet Tab 

 
Figure 129: Current Leaderboard 

Window 

 
Figure 130: Configure Leaderboard 

Window 



Cut 

Click to remove a selected diver/team from the roster. 

 

Uncut 

Click to return a selected diver/team to the roster. 

 

Active 

Click to make a selected diver/team active. 

Reports 
The Reports tab contains commands for generating and configuring various reports and 

printouts (Figure 131). After users select a report, it will open as an HTML file in the default 

Internet browser. Go to File > Print within the browser to print a hard copy. 

 

Note: All reports 

apply to the currently 

opened event only. 

Users should set the 

Options before 

generating Reports or Event Results.  

 

Announcer 

Click to print diver and dive order information that can be read by an announcer at the meet. 

 

DD 

Click to print the DD table that is being used for the current event. 

 

Orders 

Use this menu to print the dive order. After clicking Orders, users are given two choices for 

printing reports. 

 

Sheets 

Use this menu to print dive sheets for every diver in the event. After clicking Sheets, users 

are given two choices for printing reports. 

 

 With Scores: Shows scores and rankings on the dive sheets. 

 Without Scores: Prevents scores and rankings from appearing on the dive sheets. 

 

Judging 

Click to show how many times each judge was the high or low score per round. 

Event Results 
Standard 

Select to show basic meet results By Rank or By Dive Order. 

 

Detailed 

Select to show more complete meet results broken down By Rank or By Diver. 

 

 

 
Figure 131: After Meet Tab 



Options 
These settings pertain to the appearance of the reports.  

 

 Select Border to separate each cell of information with a gray border. 

 Select Row Colors to show a row of information in white followed by a colored row. 

Click Change Color to select a different row color, if applicable.  

 Click Path to select a different folder in which to save the printouts.  

Share 
The Share tab includes commands for 

importing and exporting meets, DD tables, 

and rosters for use with third-party meet 

management software and other Pro 

Diving software users (Figure 132).  

Meets 
Import 

Click to import a meet.  

 

1. Navigate to the XML file of the meet to import, and then click Open.  

2. Click OK on the Import successful window. 

 

 Note: If the Replace meet? window appears, click Yes to replace the current meet,  

 or press No to import the meet as a new meet.  

 

Export 

Click to export a meet. 

 

1. Type in a descriptive name for the XML meet file, and then click Save.  

2. Click OK on the Export successful window.  

DD Tables 
Import 

Click to import a DD table.  

 

1. Navigate to the XML file of the DD table to import, and then click Open.  

2. Click OK on the Import completed window. 

 

Export 

Click to export a DD table. 

 

1. Type in a descriptive name for the XML DD table file, and then click Save.  

2. Click OK on the DD Table exported successfully window. 

Rosters 
Import 

Click to import a roster.  

 

1. Navigate to the XML file of the roster to import, and then click Open.  

 
Figure 132: Share Tab 



2. On the Replace? window, click Yes to replace the current rosters, or click No to add 

the imported roster together with the current roster. 

 

 Note: Importing rosters will not insert divers into any events.  

 

Export 

Click to export a roster. 

 

1. Type in a descriptive name for the XML roster file, and then click Save.  

2. Click OK on the Rosters exported successfully window. 

Setup 
The Setup tab includes various 

program options  

(Figure 133). 

OmniSport Console 
Connect 

Click to connect to the OmniSport console. Select an open serial (COM) port that goes to the 

OmniSport console, and then click OK (see Section 9.7). 

 

Monitor 

Click to view the Bidirectional Monitor (Figure 134). This 

window shows the data Received through and Transmitted 

from the selected serial (COM) port. The Monitor is 

primarily used for troubleshooting connectivity issues. 

  

 Click Clear to remove the Received and 

Transmitted data from the monitor. 

 Click Save to save either the Received or 

Transmitted data. 

 Click Text/Hex to view the data as text or in 

hexadecimal code.  

Display 
Settings 

See Section 9.7 for more information on Display Settings.  

 
Figure 133: Setup Tab 

 
Figure 134: Bidirectional Monitor 



DD Table 
Edit 

Click to view, create, and edit DD tables and 

dives (Figure 135).  

 

Note: The default FINA table cannot be 

deleted. While still possible to edit the table, it 

is recommended that users create a copy of 

the table with the desired changes instead.  

 

Creating new DD Tables 

 

1. Click New Table 

2. Type in a descriptive name for the 

new table, then click OK.  

 

Copying DD Tables 

 

1. Under Choose Table, select an existing 

DD table.  

2. Click Copy Table. 

3. Type in a descriptive name for the 

copied table, and then click OK. 

 

Deleting DD Tables 

 

1. Under Choose Table, select an existing DD table.  

2. Click Delete Table, and then click Yes to confirm the deletion. 

 

Editing Dives 

 

1. Select a DD table, and then select a 

specific dive from the list.  

2. Click Edit Dive to adjust the settings  

for scoring the dive.  
 
 Note: Quickly edit dives by simply 

double-clicking them in the list. 
 

3. In the Edit Degree of Difficulty window  

(Figure 136), users may change the Dive 

Number, Description, and the Degree of 

Difficulty for each platform and 

position. Highlight a current value to 

type in the new degree of difficulty. 

4. Click OK to save the dive changes. 

 

 

 

 

 

 
Figure 135: Edit Degree of Difficulty Table 

Window 

 
Figure 136: Edit Degree of Difficulty Window 



Adding Dives 

Select a DD table.  

1. Click Add Dive to create a new dive.  

2. Use the window that appears to fill in all the necessary dive/scoring information.  

3. Click OK to save the new dive. 

 

Deleting Dives 

1. Select a DD table, and then select a specific dive from the list.  

2. Click Delete Dive. 

3. Click OK to confirm the deletion of the selected dive number.   

Speech 
Configure 

Click to set up the speech function (Figure 137). 

  

1. Under Diver Information, click Speak to 

enable or disable the voice. Individually 

select whether or not to have the voice 

read aloud the Diver Order, First Name, 

Last Name, Affiliation, Dive #, D.D., or 

Start of Round.  

2. Under Scores, click Speak to enable or 

disable the voice. Individually select 

whether or not to have the voice read 

aloud the Judge Scores, Award, or Total Score.  

3. Under Voice, select a voice from the list of voices that are installed on the system. 

4. Use the slider bar to adjust the speech Rate. 

5. Click Test under either Diver Information or Scores to listen to the selected voice read 

the selected information. 

6. Click Save to retain the speech options or Cancel to discard the changes. 

Web 
Configure 

Click to configure the settings to broadcast live 

diving scores over the Internet with the 

Daktronics NetBoard program (Figure 138).  

 

1. Click Enable. 

2. Under Access, enter the User Name, 

Password, and Web Address. 

3. Under Transmission, select FTP or 

HTTP, type in an appropriate File Name, 

and select a Speed for the number of 

seconds between data transmissions. 

4. Click OK to retain the web settings or 

Cancel to discard the changes. 

Color Scheme 
Select from a light gray, black, or blue color scheme for the software windows. 

 

 
Figure 137: Configure Voice Options 

 
Figure 138: Configure Web Settings 



Help 
The Help menu bar includes commands for 

registering, viewing user guides, and 

viewing information about the software 

(Figure 139). 

Register 
Online 

Click to register the software online (Figure 140).  

See Section 9.5 for more information about registering  

the software. 

 

Serial 

Click to register the software using a registration code  

(Figure 141). See Section 9.5 for more information about 

registering the software.  

Guides 
Quickstart (currently inactive) 

Click to view a small guide for basic program installation 

and operation. 

 

Manual 

Click to view a complete user manual containing detailed 

instruction on program setup and functionality.  

About 
About 

Click to view the End User License Agreement (EULA) and software version information 

OmniSport Start Button 
Click the OmniSport Start Button (the Daktronics ‗D‘ logo) 

in the upper left hand corner to view more of the most 

commonly used functions within the program (Figure 142).  

New Meet 
Click to create a new meet. This is the same process as 

described in (Figure 103) on the splash screen Common 

Tasks. 

Open Meet 
Click to open a meet. This is the same process as described 

in (Figure 102) on the splash screen Common Tasks. 

Edit Meet 
Click to edit the currently opened meet. This is the same process as creating a meet except 

that previously entered information is already available for edit. 

 
Figure 139: Help Menu Bar 

 
Figure 140: Online Registration 

Window 

 
Figure 141: Enter Registration 

Code Window 

 
Figure 142: Daktronics Menu 



Share 
Go to Share > Import Meet or Export Meet to share meet files. Importing and exporting 

meets are discussed in the Share menu bar section. 

Print 
Click to generate Standard Event Results listed By Rank as an HTML file in the default 

Internet browser. Go to File > Print within the browser to print a hard copy. 

Close 
Click to exit the Pro Diving software. Click Yes to confirm. 

Splash Screen 
Click to exit the main application screen (Figure 113) and return to splash screen (Figure 101). 

Options 
Click to view the Configure Settings window which contains options for outputting meet 

information and results to scoreboards and displays. See Section 9.7 for more information on 

the Display Configuration. 

Exit 
Click to exit the Pro Diving software. Click Yes to confirm. 

Recent Meets 
This area displays recently opened/created meets. Click a meet name in the list to open. 

Quick Access Toolbar 
Users may customize the layout of the menu bar 

with the Quick Access Toolbar. Click the  

small arrow button next to the OmniSport Start 

Button to open the Customize Quick Access 

Toolbar menu (Figure 143). 

Customize Quick Access Toolbar 
Click to open the Customize Quick Access Toolbar window (Figure 144).  

 

1. Under Choose commands from, select a 

general category of commands in the 

drop-down list. 

2. In the left white box, select a specific 

command. 

3. Click Add to place this command on the 

Quick Access Toolbar.  

4. Repeat steps 1-3 to add up to 20 

additional buttons to the toolbar. 

5. To remove any buttons, click the 

command in the right white box, and 

then click Remove.  

 
Figure 143: Customize Quick Access Toolbar Menu 

 
Figure 144: Customize Quick Access Toolbar 

Window 



6. Click and drag the commands in the 

right white box to arrange them in 

any order.  

7. Click Place Quick Access Toolbar 

below the ribbon if desired. 

8. Click OK to save the Quick Access 

Toolbar buttons (Figure 145).  

Maximize/Minimize the Ribbon (currently inactive) 
Click to permanently expand the ribbon menu bar. Click again to allow the ribbon menu bar 

to collapse when not in use.  

Keyboard Shortcuts 
In addition to buttons and menus, the Pro Diving software includes keyboard shortcuts for 

certain commands for quicker access.  

 

[Ctrl] + 0-9 Switch between events, with [0] for event 10 

[Ctrl] + A Add a new diver/team 

[Ctrl] + T Make a diver/team active (after selecting one) 

[Ctrl] + I Insert a new diver/team (after selecting one) 

[Ctrl] + R Remove a diver/team (after selecting one) 

[Ctrl] + S Edit scores (after selecting a diver/team) 

[Ctrl] + N Edit name (after selecting a diver/team) 

[Ctrl] + L  Edit dive list (after selecting a diver/team) 

[Ctrl] + C Cut a diver/team (after selecting one) 

[Ctrl] + U Uncut a diver/team (after selecting one) 

 

 
Figure 145: Quick Access Toolbar with Buttons 





Section 10: OmniSport 2000 Pro Synchronized 
Swimming Software 

The OmniSport 2000 Pro software interfaces with the OmniSport 2000 timer and allows officials to 

control the competition through a Windows-based user interface. Synchronized swimming is only 

available with the OmniSport Pro software; the timer by itself cannot score synchronized swimming. 

 

This section describes how to install, configure, and operate the Daktronics OmniSport 2000 Pro 

Synchronized Swimming software system, Version 1.0.1.1. 

 

The OmniSport 2000 Pro software operates on a Windows-based computer. In most 

circumstances, the computer used by the software will be purchased through Daktronics. 

This ensures the software hardware requirements will be met. If a computer is not purchased 

through Daktronics, the following list describes the requirements for the software: 

 

 Internet Explorer 5.0 or higher 

 400 MHz CPU or higher 

 Windows 98 operating system or better 

 Minimum 32 MB of RAM 

 Standard keyboard and mouse 

 

The OmniSport 2000 Pro software is a computer interface to the OmniSport 2000 timing 

console. Judging a synchronized swimming event can be completed without the timing 

console, but there must be a console present to send the data to a display or to interface with 

the judge consoles. The OmniSport 2000 timer must be connected properly to all competition 

equipment and accessories if using a display or judge consoles.  

 

To install the Pro Diving software from the internet: 

 

1. Open an Internet browser to 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/

Pro/Synchro  

 

2. Click the ‖OmniSport Pro Synchro.exe‖  file, and then click Run to begin the 

installation procedure. 

 

Note: Click Run again if a security warning appears. 

 

3. Follow the onscreen instructions to complete the installation.  

 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/Pro/Synchro
http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/Pro/Synchro


To install the Pro Diving software from a CD: 

 

1. Insert the software CD into the CD-Rom drive. 

  

2. If the auto run program does not start, click on the 

Windows Start menu, select Run and the dialog 

box shown in Figure 146 should appear. Type the 

CD-Rom drive address (usually D:) and click OK. 

This will display the files on the OmniSport 2000 

Pro CD.  

 

3. Select OmniSport ProSynchro.exe as shown in  

the InstallShield Wizard dialog box (Figure 147).  

 

4. Click Next to continue. 

 

5. Follow the on-screen instructions to complete the 

installation.   

 

To open the application:  

 

 Double-click the OmniSport 2000 Pro Synchronized Swimming icon on the desktop 

(Figure 148). If no icon is present, locate the OmniSport Pro Synchro file and double-

click OSPSS.exe. The folder should be located under Program 

Files on the local disk (usually C:) of the computer.  

 Click the Start menu and navigate to  

All Programs > Daktronics > OmniSport Pro > Pro Synchro. 

 

To exit the application: 

 

 Click the exit button in the upper right corner of the window. 

 Left- or right-click the icon in the upper left corner of the window and click Close. 

 Go to File > Exit.  

 

On initial setup, the registration window appears 

(Figure 149). Register the software online or by phone/email. 

The user will be able to receive an unlock code once the 

software is purchased. To buy the full version,  

call 1-877-605-1115. 

 

Either register or click Continue to bypass registration. Not 

registering allows access to the demo version, which has all the 

same functions as the registered version for up to 30 days.  

 

After 30 days the software will lock if it has not been 

registered. The registration code must then be entered to  

 

 
Figure 146: Run Dialog Box 

 
Figure 1: OmniSport 2000 Pro Software Installation 

 

 

 

 

 
Figure 147: OmniSport Pro Software  

Installation 

 
Figure 148:Synchronized  

Swimming Icon 

 
Figure 149: Registration Dialog 



continue running the software. Upon proof of purchase the operator receives the unlock code 

which allows unlimited use of the software. To register the software, follow these steps: 

 

1. Start the program. 

2. Enter the ―Registration Code‖ received from Daktronics. 

3. Click Register. 

 

Note: Installing the software on a separate computer requires a new registration code  

Using the Software Without the Console 
The OmniSport 2000 Pro Synchronized Swimming software may be used independently. It 

does not depend on the console for calculating judges‘ scores or printing reports. A complete 

synchronized swimming competition can be recorded with only the Pro software and by 

manually entering the individual judge‘s scores. 

 

If a video display or a scoreboard is used with the software, the OmniSport 2000 timer must 

be present and connected. The timing console only acts as an interface in this configuration 

and handles no operational functions. The timer must also be used to interlink the judge 

consoles with the Pro software. The following table describes the equipment needed to 

perform different levels of competition recording. 

 

Scoring 

Devices 
Scoring Display Type Equipment 

Pro Software Paper Score Pin-Up OmniSport 2000 Pro Computer; printer 

Pro Software  

and Judge 

Consoles 

Numeric Display 
OmniSport 2000 Pro Computer; Printer; OmniSport 

2000 timer; Judge Consoles 

Pro Software  

and Judge 

Consoles 

Matrix Display 
OmniSport 2000 Pro Computer; Printer; OmniSport 

2000 timer; Judge Consoles; Venus
®
 7000 Computer 

Synchronization with Timer 
Once the hardware and software have been installed and the software is running, the 

OmniSport 2000 Pro system should synchronize with the timer. 

 

If the OmniSport Pro software is unable to detect the console, ensure the cable is connected to 

a COM port on the back of the computer and to the EXPANSION port on the OmniSport 

2000 timer. Set the COM port properties by going to Options > Communications > Setup.  

 

Note: If the cables are connected properly the 

connection icon on the main dialog will be green. It 

will flash green when receiving data, and will be red 

when it is not connected (Figure 150). 

 

A message box will display requesting which 

configuration settings are preferred, when 

differences are found in the configurations stored on the timer and the Pro software. Once a 

selection has been made, both system configurations will be exactly the same. Any change 

made to the configuration operating on one system will be recorded on the other as long as 

 
Figure 150: Connection Indicator 



the serial connections are operating properly. Console detection is continual; others only 

come across when changed.  

 

When connected and operating properly the LCD on the timer will read, "Controlled by Pro."  

 

Note: Some computers purchased with this software will have a Rocket® port installed with 

the system. The port labeled "Port 0" will be normally set as COM 5 in the computer system. 

The next port would then be COM 6, then COM 7, and finally COM 8 for a four-port Rocket 

port. The OmniSport 2000 Pro software recognizes these ports regardless of which port 

number has been assigned to them. 

 

Once the OmniSport 2000 Pro Synchronized Swimming system is synchronized and 

configured, event management is quick and simple. The main synchronized swimming 

application screen (Figure 151) sends the data to output devices, such as matrix displays,  

numeric scoreboards and paper printouts.  

 

This section describes the operation of the buttons and indicators for the OmniSport 2000 Pro 

Synchronized Swimming software.  

 

Event Routine 

These buttons (Figure 152) allow the operator to switch 

between Technical and Free routines if configured for the 

current event.  

 

 

 
Figure 151: Main Synchronized Swimming Dialog 

 
Figure 152: Event Routine 



Competitor Information 

This section of the main 

application screen (Figure 153) 

displays the current swimmer's 

name and affiliation, the 

competition, and how many 

swimmers are left in the event. 

 

Judges Scores  

Individual technical and artistic 

judges‘ scores and the total 

scores are shown in (Figure 154). 

 

Results  

This section shows the final calculated results for each swimmer  

(Figure 155). 

 

Connection/Timers  

This section displays a Connection icon (Figure 150) that  flashes green 

when the OmniSport 2000 console is connected, red if not connected. 

Routine, Deck and Team timers are also displayed. 

 

Penalties  

The drop down menus shown in Figure 156 are used to calculate a 

swimmer‘s score minus penalties. Penalties automatically appear 

when the associated timer indicates a penalty. 

 

Scoreboard Control 

These buttons (Figure 157) allow  

the operator to choose what information 

is displayed on the scoreboard 

(Technical/Execution scores, Artistic/Overall 

Impression scores, Total scores, or Blank - 

no information). 

 

To create a new event, go to Event > New 

Event located on the main menu. The Event 

Setup window appears (Figure 158). In the 

Event Setup section, enter the appropriate 

Event Name, Event Type, Event Date and 

Event Time. Next, if there is more than one 

age group competing, designate the 

different Age Groups participating in the 

competition.  

 

 

 

 
Figure 153: Competitor Information 

 

Figure 154: Judges' Scores 

 
Figure 155: 

Results 

 
Figure 156: Penalties  

 
Figure 157: Scoreboard Control Buttons 

 
Figure 158: Event Setup Window 



The Percentages section allows the operator to set up which percentages of the Figures, 

Technical and Free scores drop-down list box used to calculate the final score. Click Next 

when completed.  

 

The Technical Routine Time Limits 

window (Figure 159) allows the operator to 

enter the appropriate time limit and 

penalty in each field, as well as the number 

of judges and panels for this portion of the 

event. Click Next when completed. 

 

The Free Routine Time Limits window is 

exactly the same as the technical routines, 

but is used for free routines. After setting 

the appropriate data in each field, click 

Finish. 

 

Note: Technical and Free Routines cannot 

be configured (grayed out) if their percentage is set to NONE. Refer to Figure 158. 

 

Opening Events 

To open an event, go to Event > Open Event.  Select an event from the list and click Open. 

Then enter competitor names and affiliations in the Rosters and Affiliations tabs.  

 

Editing Events 

To edit an event, go to Event > Edit Event. Select the event to edit and click Edit. 

 

Copying Events 

To copy an event, go to Event > Copy Event. Select the event to copy of and click Copy.  

This uses a previously created event as a template for a new event if there are only a few 

differences between events. 

 

Deleting Events 

To delete an event, go to Event > Delete Event. Select the event to delete and click Delete. 

 

The main application screen  

contains five tabs (Figure 160). 

Click on each tab to view a 

different function of the 

system.  

 

Event Order 

The Event Order tab shows 

information pertaining to the 

current swimmers and event. The name of the current swimmer is highlighted in yellow or 

green depending on the mode of scoring. 

 

 

 

 
Figure 159: Technical Routine Time Window 

 
Figure 160: Main Application Screen 



Select a swimmer's name and Click Up/Dn to change the order of the swimmers shown on 

the event order tab. 

Right-click in the Event Order tab for other options. Refer to 

the pop-up menu as illustrated in Figure 161. 

 

Add/Insert/Remove Swimmer 

Click Add Swimmer from the pop-up menu, and Add/Insert 

Swimmer window appears (Figure 162). Use the drop-down 

list box to choose swimmers previously entered in other 

events, or manually enter new swimmers. Follow the same 

procedure to Insert or Remove swimmers.   

 

Change Swimmer Order 

Right-click the name of the swimmer to move  

then click Move Up or Move Down. This can also be done 

using Up/Dn located on the event order tab. 

 

Back to Next 

Click Back to Next so another swimmer can be selected as 

current. This function allows the operator to abort a score 

entry in the Accept mode. The operator must be in the Next 

mode to use the Make Current option. When in Accept mode, 

the judge's scores can be entered but the swimmer's scores 

and order cannot be edited. 

 

Note: Determine the mode (Next or Accept)  

by looking at the button located  

next to the penalties box on the 

main menu (Figure 163). 

 

Edit Options 

To edit a swimmer‘s score, right- 

click that swimmer and select Edit 

Score from the pop-up menu. 

Click the type of score to update. 

In the Edit Score window (Figure 

164), enter the proper scores and 

click Accept.  

 
Figure 161: Pop-up 

Menu Options 

 
Figure 162: Add/Insert 

Swimmer Window 

 

Figure 163: Next/Accept Mode 

 
Figure 164: Edit Score Window 



To edit a swimmer‘s age group, draw number or name, right 

click on that swimmer and select the information to edit. The 

appropriate information may be edited; the rest of the options 

in the box will be locked to prevent accidental changes (Figure 

165). Click OK when finished. 

 

Rank 

The Rank tab shows the swimmer ranks in order from first to 

last for the current event selected (Figure 166).  

 

Note: The scores shown under the rank tab take into account 

the pre-configured percentages for Figures, Technical and Free 

scores. 

 

Roster 

The Roster tab  

(Figure 167) is used to enter 

new swimmers names and 

assign them to the correct 

affiliations. To add 

swimmers to the correct 

affiliations, first select the 

Affiliation in the drop down 

list, and then click New 

Swimmer. Enter the First 

Name, Last Name and Event 

Type. Click Save.  

 

To edit a swimmer, select 

the swimmer in the roster 

list on the left side of the tab 

and simply change the 

diver's data to the right. Click Save when complete or Undo to replace the original data. 

Click Delete Diver to remove the diver from the roster. 

 

Affiliations 

The Affiliations tab  

(Figure 168) is used to create 

and edit affiliations. To add 

affiliations, click Add Team. 

Enter the Team Name and 

Team Abbreviation and click 

Save. To edit the affiliation, 

select the team in the list on 

the left side of the tab and change the team's data on the right. Click Save when complete or 

Undo to replace the original data. Click Delete Team to remove it from the list. 

 

Test 

This tab is currently disabled  

  
Figure 165: Edit Age Group Window 

 
Figure 166: Rank Tab 

 
  Figure 167: Roster Tab 

 
Figure 168: Affiliation Tab 



 

Timer Configuration 
Configuring the OmniSport 2000  

Pro Synchronized Swimming 

software is an important part of 

managing  events efficiently and 

completely. Once running the 

software, go to  Options > Timer 

Configurations. The Timer window  

includes (Figure 169) the following 

functions:  

 

 Number of Lines tells the 

software how many lines 

are on the numeric 

scoreboard. 

 

 TOD Mode (time-of-day mode) sets how the time-of-day will be displayed. 

 

 MultiSport Display sets whether or not a multisport module is in use. 

 

 Show Lead Swimmer sets whether or not the lead swimmer will be displayed. 

 

 Printer Logging turns on/off printing from the timer thermal printer. 

 

 Brightness adjusts the light intensity of the display. 

 

 Meet Manager Port configures which protocol (Omni2000, Omni6000 or CTS) 

communicates with the meet management software out of the Results port (J6) of the 

OmniSport timer. 

 

 RTD Port configures which protocol (RTD or CTS) will be transmitted out of the 

RTD port (J5) connector on the OmniSport 2000 timer. 

 

 Scoreboard Port configures which protocol (Multidrop or Multiline) will be 

transmitted out of the scoreboard outputs (J2 and J3). 

Setup Configurations 
The Communication Configurations area sets which port interfaces the OmniSport 2000 

timing console to the OmniSport 2000 Pro computer. To enter this area, go to Options > 

Communications > Setup.  

 
Figure 169: Timer Configuration 



General Configurations 
The General field configures the settings common to 

all stream types (Figure 170).  

 

 Enable:  Should always be checked. 

 Type: COM Port 

 Name: Should be a descriptive name for the 

port. 

 Encrypt: Should never be checked 

 Key: Enter password in the text box. 

 After entering the correct data, click Com 

Settings. 

Com Settings Configurations 
This area configures the serial COM port settings 

(Figure 171). 

 

 Port: Com # (Use the port # to which the 

serial cable is connected) 

 Baud: 38400 (Default – do not change) 

 Data Bits: 8 (Default – do not change) 

 Parity: None (Default – do not change) 

 After entering the correct data, click  

Protocol List. 

Protocol List Configurations 
Verify the following check boxes in the Protocol List 

(Figure 172):  

 

 HTTP: Should never be checked. 

 Standard/Enhanced RTD: Should never be 

checked. 

 After verifying the correct settings,, click 

Finish. 

Monitor Data Flow 
Go to Options > Communications > Monitor  

to ensure data is flowing from the timer to the Pro 

software (Figure 173). The top section shows 

incoming data and the bottom shows outgoing data. 

 

 

 

 

 

 

 

 

 
Figure 170: DL Streams Wizard; General 

 
Figure 171: DL Stream Wizard, Com 

Settings 

 
Figure 172: DL Stream Wizard, Protocol 

Settings 

 
Figure 173: DL Stream Monitoring Screen 



 

This section deals with the operational procedures used before a meet and during and  

after each event. 

Before the Meet 
Before each meet, three things must be done: 

 

1. Verify the configurations.  

2. Test the system. 

3. Setup event and swim order. 

Verify the Configurations 
Once the system is tested, open the Configurations dialog. Go through each setting  

(Figure 169 and 170) and make sure all the configurations are set correctly. The system will 

maintain the settings that it used during the last time it was operated. If any configuration 

setting were changed while the timer and software were not connected, the system will 

request that the configuration be synchronized upon reconnection. 

 

Though the configurations remain the same unless the operator changes them, it is 

recommended to print the configuration settings so that they can re-entered if there is a 

sudden loss of power or damage to equipment that may cause a loss of memory. Press 

[Menu]>[3]>[3]>[Enter] on the keypad of the OmniSport 2000 console. 

Test the System 
The OmniSport 2000 timer and Pro system must be operating properly for a meet to run 

smoothly. Turn on the system and ensure the cables are properly connected. Once the 

software is running, it should detect the OmniSport 2000 timer. If not, reconfigure the Comm 

Port. Test the system by following the steps below:  

 

1. Test the peripheral devices such as the judge's consoles. Using a test event and swim 

order, enter the judges' scores on each console. If the scores do not appear on the 

software score area, check the cables on the rear of the OmniSport 2000 timer. 

 

Note: If the judge's consoles are connected properly the bars under each judge's score 

will be green. If not connected properly they will be red. 

 

2. If using a display, test run an event to ensure the display shows what is expected. 

During an Event 
During a synchronized swimming competition, judges must make decisions on the quality of 

the performances. These judgments affect the swimmers‘ final scores. This subsection details 

what must be done in order to score a competition successfully. 



There are two ways scores are entered into the OmniSport 2000 

Pro Synchronized Swimming software: manually with the 

software or through peripheral judge consoles. Once entered, 

the software calculates the awarded score by using the formula 

set. Ensure the correct percentages are selected before the event. 

 

Once a swimmer has been awarded his or her points, click 

Accept to move on to the next swimmer. 

After an Event 
After the event is finished, print the reports by going to  

Reports > View Reports. The results available for print are: 

Starting Lists, Figure Results, Technical Results (by Draw), 

Technical Results (by Rank), Free Results (by Draw), Free 

Results (by Rank) and Total Results. Refer to Figure 174. 

 

Click Create to print the results to an HTML file, which can be 

sent to a printer or published on a web site.  

 

Once the competition is officially completed, turn off and store 

all equipment in a safe location. 

 

 

 

Figure 174: Results Reports 



Section 11: OmniSport 2000 Console for 
Water Polo 

Sport Insert LL-2569 
 
Reference Drawings: 

 Insert, LL-2569; Water Polo, OmniSport2000 .................................................. Drawing B-182350 

 

The sport insert drawing is located in Appendix B:. If an insert is lost or damaged, a copy of the 

insert drawing can be used until a replacement can be ordered. 

 

Refer to Section 3: General Console Features and Operations for information on starting the timer, 

selecting water polo sport mode and for instructions on using the sport insert. 

 

When starting the OmniSport 2000 console, set the console  

to the water polo mode. Refer to Section 3.5 and press  

[Enter] when the right LCD screen shows 4-WATER POLO.  

 

The water polo mode of the OmniSport 2000 timer will perform timing and scoring 

operations for water polo events. It can store period, shot, timeout, and penalty times as well 

as each team‘s scores.  

 

The three LCD screens on the OmniSport 2000 keep the operator informed during all 

operations. Note the following layout of the LCDs shown in the water polo mode. 

 

 1 2 3  4   5    6   7      8    9      10 

 

 

 

 

The first two screens show the home and guest team information respectively. Both teams‘ 

LCD screens display the same information for each team. The first area under the HOME or 

GST caption shows the score. The number under the TOL caption shows the number of time 

outs left. PL shows the player‘s number who has the penalty. The # caption shows the 

number of penalties that player has; the final area shows the amount of time remaining in the 

penalty.  

 

The caption above the penalty time remaining (P1 in this example) shows which of the three 

available penalties is currently being viewed. Up to three players‘ penalties can be entered. 

Press [↑], [↓], [→], or [←] to cycle through the penalties to select the desired one. The scoring 

system may be configured to display all three penalties for both teams at the same time. 

 

The right screen displays the game time, shot time and period. The h after the game time 

designates that the automatic horn has been enabled. The TIME caption will show REST 

when in a rest period. 

 

HOME TOL PL #  P1 
 3   2   4  1  18 

GST TOL P  #  P1 
 0   3    

TIME    01:59   h 
SHOT 35 PERIOD  1 

SELECT SPORT 
4-WATER POLO 



 

The Water Polo keypad insert is LL-2569 (included in Appendix B:). Refer to (Figure 175) in 

the following pages which describe the functions of each key. Notice that some of them have 

been grouped together by location and others have been grouped with a border. The keys 

with borders are used together or perform similar operations.  

Auto Horn▪  
When [Auto Horn▪] is turned on and the game clock reaches zero, the OmniSport 2000 

console will signal the horn to sound. An “h” will display in the upper right corner of the 

right LCD screen when Auto Horn is enabled.  

Manual Horn 
Pressing [Horn] will sound the horn. This key can be pressed at any time whether or not the 

clock is counting.  

Game Time Keys 
The keys in the Game Time section control the main clock. This clock can be set to count the 

period time, rest time, or overtime. One more setting to be aware of is the Horn Control 

setting. This can be set so that the main clock horn and the shot time horn are either tied 

together so that if either one sounds, they both sound, or they can be independent.  

Set Time▪ 
Set Time is used to set the time on the main clock. Pressing [Set Time▪] more than once 

accesses the preset times. While pressing the Set Time key, read the right LCD to view the 

value the clock is being set to. During any step, press [Clear] to exit without changing the 

main clock.   

 

Note: The main clock must first be stopped otherwise the Set Time key will be ignored.  

 

Press [Set Time▪] once to set the current time on the clock. Use the numeric keypad to input 

the desired time and then press [Enter] to set the main clock to that value.  

 

Press [Set Time▪] twice to set the default period time. Press [Enter] to set the main clock to 

that value. Use the numeric keypad to change the main clock to the desired default period  

 
Figure 175: Water Polo Keypad Insert 



 

time, then press [Enter]. This sets the main clock to the new period time and it changes the 

default period time in the console‘s stored memory.  

 

Press [Set Time▪] three times to set the Rest 1 time—typically the rest period between 

quarters 1 and 2 or quarters 3 and 4. Press [Enter] to set the main clock to that value. Use the 

numeric keypad to change the default Rest 1 time, then press [Enter]. This sets the new Rest 1 

time in the main clock and the default time in the console‘s stored memory.  

 

Press [Set Time▪] four times to set the Rest 2 time—typically the rest period for half time and 

before overtime, if the match goes into overtime. Press [Enter] to set the main clock to that 

value. Use the numeric keypad to change the default Rest 2 time, then press [Enter]. This sets 

the new Rest 2 time in the main clock and the default time in the console‘s stored memory. 

 

Press [Set Time▪] five times to set the default overtime. Press [Enter] to set the main clock to 

that value. To change the default overtime, use the numeric keypad to input the desired 

default overtime and then press [Enter]. This sets the main clock to the new overtime and it 

changes the default overtime in the console‘s stored memory.  

Start 
Press [Start] to start the clock counting. 

Stop 
Press [Stop] to stop the clock. 

Reset 
Press [Reset] followed by [Enter] to set the main clock to the default period time value. To 

cancel resetting the clock, press [Clear]. The clock must be stopped otherwise the Reset key 

will be ignored. 

Shot Time Keys 
The keys in the Shot Time section control the shot clock.  

Set Time▪ 
Press [Set time▪] to set a specific value onto the shot clock. One use would be if the official 

wanted to put 5 seconds back onto the shot clock. 

Reset Time 
Press [Reset] to reset the shot clock time to the default value. Reset can be pressed while the 

clock is running or stopped. 

Recall Shot Time▪ 
Press [Recall Shot Time▪] to set the shot clock back to the time that was on the clock before 

Reset was pressed. This is helpful if Reset was accidentally pressed, or if a turnover was 

nullified by an official‘s ruling. 



Start 
Press [Start] to start the clock counting. If the main clock is not counting, the shot clock will 

start counting when the main clock is started.  

Stop  
Press [Stop] to stop the clock. 

Home and Guest Keys 
The keys in the Home and Guest sections work the same for their respective team. The keys 

in the Home section effect the home team only and Guest keys effect only the guest team.  

Score +1 
Press [Score +1] to add a point to that team. 

Score▪ 
Press [Score▪] and then use the numeric keypad followed by [Enter] to input a specific score 

for that team. 

Score -1 
Press [Score -1] to subtract a point from that team. 

Timeout▪ 
Press [Timeout▪] use the numeric keypad followed by [Enter] to input the number of Full 

timeouts for that team. Next the right LCD prompts the user for the number of Partial 

timeouts. Use the numeric keypad followed by [Enter] to input the number of Partial 

timeouts for that team.  

Timeout -1 
Press [Timeout -1] once followed by [Enter] to decrement a full timeout from that team and 

start the timeout counting on the main clock. Press [Timeout -1] twice followed by [Enter] to 

decrement a partial timeout from that team and start the timeout counting on the main clock. 

If no timeouts are available for that team, the right LCD shows No Timeouts Left. 

Player Penalty +1 
Press [Player Penalty +1] followed by the player number that committed the penalty using 

the numeric keypad followed by [Enter]. There can be a maximum of three different penalty 

timers counting per team and each player can have a max of three penalties per game.  

Edit Player▪ 
Press [Edit Player▪] to adjust the number of penalties that have been assigned to a player. 

Input the player number to adjust and press [Enter]. The player and their current number of 

penalties will be displayed on the right LCD. Use the numeric keypad to input the correct 

number of penalties for that player and press [Enter]. 

 

 

 



Delete Penalty▪ 
Press [Delete Penalty▪] and the LCD for that team will show a (→) next to the penalty time. If 

there is more than one penalty time counting for that team, use [↑] and [↓] to select which 

penalty needs to be deleted. Press [Enter] to delete the penalty or press [Clear] to exit 

without deleting the penalty. 

Clear All Penalties▪ 
Press [Clear All Penalties▪]>[Enter] to remove all penalties that are currently being counted 

for that team. 

Settings to Note 
The Horn Control setting can be set so that the main clock horn and the shot time horn are 

either tied together so that when one sounds, they both sound, or they can be independent. 

 

The Shot=0 Control setting is set to On and the shot clock counts down to 0 second, the game 

clock stops. If the Shot=0 Control setting is set to Off, the game time will not stop when the 

shot time reaches 0 seconds. Refer to Section 11.10 to review or change this setting. 

 

Complete the following steps before each game. Review Section 3: General Console Features 

and Operations thoroughly before beginning operations.  

 

1. Set up and test the system. Turn on the timer. Enter the correct date and time. Then 

select the proper sport operation. 

2. Printout the consoles settings [Menu]>[2]>[2]>[Enter] and verify they are correct. 

Specifically review:  

 

 Horn Control (Section 11.13 )  

 Shot=0Control ( Section 11.10)  

 Default Time Set (Section 11.3) 

 Auto Sequence (Section 11.9) is on or off. If the Auto Sequence is set to ON, the 

console will: 

 

a. Count Period 1 time down to zero. 

b. Switch to Rest 1 time and start counting. Count down to zero. 

c. Switch to Period 2 and reset time to period time. Wait for start. 

d. Operator presses [Start]. 

e. Count Period 2 time down to zero. 

f. Switch to Rest 2 time and start counting down to zero. 

g. Switch to Period 3 and reset time to period time. Wait for start. 

h. Operator presses [Start]. 

i. Count Period 3 time down to zero. 

j. Switch to Rest 1 time and start counting down to zero. 

k. Switch to Period 4 and reset to period time. Wait for start.  



l. Operator presses [Start]. 

m. Count Period 4 time down to zero. 

n. Switch to Rest 2 time and start counting. Count down to zero. 

o. Switch to Period 5 and reset to overtime. Wait for start. 

 

The functions during a match should be available through one of the keys on the keypad. 

Thoroughly review these keys in Section 11.2.  

Enable/Disable Penalty Timer Keys 
Press [Enable Penalty Timer] and [Disable Penalty Timer] to enable or disable the penalty 

times respectively.  

Period Keys 
To increment the period, press [Period+1]. To edit the period directly, press [Period▪]. 

Time Out ON/OFF 
The Time Out ON/OFF key toggles the timeout clock. If the timeout clock is on it will turn it 

off, if off it will allow for selection of a full or partial timeout without it being assigned to 

either team. Each press of the key will select the next type available. Press [Enter] to start the 

type shown on the LCD.  

 

There are two methods of navigating through the  

menus. Refer to Section 5.1 to review how to start 

and navigate through the menus. If the console is 

set in the swimming or diving mode, turn the 

console off and restart to select water polo. 

 

Refer to the OmniSport 2000 Quick Reference 

Guide ED-13584 (Figure 177) or Appendix C: for the 

water polo navigation list.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 176: Water Polo Menu Navigation 

ED13584 



 

The Scoreboard Menu is where the operator can turn  

the scoreboard output ON or OFF, set the dimming level  

for Multi-drop displays and display Time-of-Day on  

the scoreboard. 

Scoreboard On/Off 
Scoreboard On/Off toggles the scoreboard between blank and showing the current game data. 

 

 

 

 

If the setting is ON, it will be displaying data on the scoreboard. If this setting is OFF, the 

scoreboard will be blank until either:  

 

 The start of the next game 

 The scoreboard is turned back ON in the menu. 

 

When to use this: 

 

 The scoreboard is displaying false information due to equipment or operator error 

and needs to be blanked. 

 The error is corrected and the scoreboard output can be turned back on.  

 

Note: This uses the [YES] and [NO] keys, which are the same as [Enter] and [Clear]. 

Scoreboard Dimming  
This menu is used to adjust the diming level on scoreboards 

that receive Multi-drop protocol.  

 

 

 

 

Use the numeric keypad to select one of the values (0-9) shown in  

the table to the right, or use an [↑] or [↓] to toggle through the  

settings. To save the setting, press [Enter]. To return to the  

Dimming Menu without saving, press [Clear].  

 

When to use this: 

 

 In low light conditions the scoreboard may be too bright. 

 In direct sunlight the scoreboard may need to be turned to  

 full bright.  

Display Time-of-Day  
This menu is used to display Time-of-Day on the scoreboard.  

Press [Yes] to clear the scoreboard and show Time-of-Day. Press  

[No] to do nothing and return to the Time-of-Day menu. 

 

MENU - SCOREBOARD 
1 - SCBD ON/OFF 

SCBD IS OFF 
SET ON?  Y/N 

MENU - SCOREBOARD 
2-DIMMING 

SCBD DIMMING 
LEVEL 0-3: NONE 

MENU-SCOREBOARD 
3-TIME OF DAY 

From Main Menu – [1] 

From Main Menu – [1]>[1] 

From Main Menu – [1]>[2] 

Dimming levels: 

0 = none (full bright) 

1 = 90% 

2 = 80% 

3 = 70%  

…each number 

represents 10% to…  

9 = 10% (dimmest) 

SCBD IS ON 
SET ON?  Y/N 



 

 

 

 

The running time must be reset before the console will display Time-of-Day on the 

scoreboard.  

 

Time-of-Day will remain on the scoreboard until:  

 

1. The start of the next game when the operator presses [Reset] a second time to re-

display the current results on the scoreboard. 

2. It is toggled off in the menu. When it is toggled off, the current results will go back 

on the scoreboard. 

 

When to use this: 

Anytime the console is reset and the operator wants to display Time of Day on the 

scoreboard. This might be during a break in the game. 

 

This will advance the paper one line (the same as pressing  

the paper feed button in swimming mode, Section 4.3).  

 

 

 

Print Settings 
This menu is used to print the console‘s configuration  

to the thermal printer inside the console. 

 

 

 

 

Press [YES] to print the settings. Press [NO] to exit the menu without printing. 

 

The Setup Menu contains all of the user configurations in  

the OmniSport 2000 console. When the console is powered  

off, it will retain these configurations.  

 

Selecting this menu offers the following submenus: 

 

 Timer is for configuring the timer settings. 

 Numeric SCBD is used to select the type of scoreboard. 

 Comm Ports allows selection of communication ports. 

 Time-of-day allows the setting of the time and day. 

 

 

MENU-SCOREBOARD 
DISPLAY TOD? 

MENU-MAIN 
2-PRINT MENU 

From Main Menu – [2] 

From Main Menu – [1]>[3] 

MENU-MAIN 
3-SETUP MENU 

MENU-PRINT 
1-PAPER FEED 

From Main Menu – [2]>[1] 

MENU-PRINT 
2-SETTINGS 

MENU-PRINT 
PRINT SETTINGS 

From Main Menu – [2]>[2] 



Timer 
The following is a more detailed look at timer  

configurations. 

Set Times 
These menus establish the times used while playing  

the game from overtime minutes to the number of  

timeouts allowed for each team.  

 

Note: For each of the following menus, set the time length pressing [0]-[9]>[Enter]. Press 

[Clear] twice to leave this setting as is and exit to the Timer menu. 

Period Time  
This menu sets the period time for the game. 

 

 

 

 

Overtime 
This menu sets the minutes to be played during overtime.  

 

 

 

 

Rest Time 
This menu set the rest period values. 

 

 

 

 

Warning Time 
This menu sets the warning time. 

 

 

 

 

Shot Time 
This menu sets the shot clock time. 

 

 

 

 

 

MENU SETUP 
1 TIMER 

MENU TIMER 
SET TIMES 

MENU SET TIME 
1-PERIOD TIME 

MENU SET TIME 
PERIOD:  04;22* 

MENU SET TIME 
OVER: 03:00* 

MENU SET TIME 
REST 1: 02:00* 

MENU SET TIME 
REST 2: 05:00* 

MENU SET TIME 
WARNING: 00:20* 

MENU SET TIME 
5-SHOT TIME 

MENU SET TIME 
SHOT: 00:35* 

From Main Menu – [3] 

From Main Menu – [3]>[1] 

From Main Menu – [3]>[1]>[1]>[1] 

From Main Menu – [3]>[1]>[1]>[2] 

From Main Menu – [3]>[1]>[1]>[3] 

From Main Menu – [3]>[1]>[1]>[4] 

MENU SET TIME 
3-REST TIME 

MENU SET TIME 
2-OVER TIME 

MENU SET TIME 
4-WARNING TIME 

From Main Menu – [3]>[1]>[1]>[5] 



Timeout Time  
This menu sets the Timeout time. 

 

 

 

 

Penalty Time 
This menu sets the time for each penalty. 

 

 

 

 

 

When the Auto Sequence menu is turned ON, the console will 

Advance to the next time that needs to be counted. For example, 

Period 1→Reset Time→Period 2→Rest Time, etc. See Section 11.3 for a complete description. 

 

 

 

 

If the right LCD reads: AUTO SEQ IS OFF, SET ON? Y/N, press [Yes] to turn it ON, or press 

[No] to leave it set to OFF. Press [Yes] to set the Auto Run OFF, or [No] to leave ON.  

 

The Shot=0 Control sets whether the game clock stops when  

the shot time reaches zero or if the two clocks run independently  

of the each other.  

 

 

 

 

If the right LCD reads: =0 STOPS CLK-OFF, SET ON? Y/N, press [Yes] to turn it ON, or press 

[No] to leave it set to OFF. 

 

The Max Penalty menu sets the maximum number of penalties  

allowed for a player before being removed from the pool. 

 

 

 

 

Press [0]-[9] to set the maximum number of penalties and press [Enter].  

 

The operator may choose to reset the shot clock after a penalty by selecting [Yes]. 

Press [Clear] twice to leave this setting as is and go to the Reset Shot selection. 

MENU SET TIME 
6-TIMEOUT TIME MENU SET TIME 

TO FULL: 01:00* 

MENU SET TIME 
7-PENALTY TIME 

MENU SET TIME 
PENALTY: 00:20* 

MENU-TIMER 
2-AUTO SEQUENCE 

AUTO SEQ IS OFF 
SET ON? Y/N 
penalty: mn:mn* 

MENU-TIMER 
3-SHOT =0 CONTROL 

=0 STOPS CLK-OFF 
SET ON? Y/N 

MENU-TIMER 
4-PENALTIES 

MENU-PENALTIES 
MAX PENALTY  3* 

RESET SHOT-OFF 
SET ON?   Y/N 

From Main Menu – [3]>[1]>[1]>[6] 

From Main Menu – [3]>[1]>[1]>[7] 

MENU SET TIME 
TO PART: 00:20* 

From Main Menu – [3]>[1]>[3] 

From Main Menu – [3]>[1]>[2] 

From Main Menu – [3]>[1]>[4] 



 

The Timeouts menu sets the maximum number of timeouts  

allowed for each team. 

 

 

 

 

Press [0]-[9] to set the maximum number of full timeouts allowed for each team and  

press [Enter].  

 

Follow the same steps to set the number of partial timeouts.  

 

Press [Clear] twice to leave this setting as is and return to the Timer menu. 

 

The game clock horn and the shot clock horn can be set  

to operate independently or together. 

 

 

 

 

Press [Yes] or [No] to make the shot clock and game clock horn sound together 

(COMBINED) or separately (INDEPENDENT). 

 

The following menus explain how to set up the  

scoreboard configurations: 

Number of Lines 
This menu sets the number of lines (1-10) that the 

scoreboard will display. If the number of active lanes in  

the pool is greater than the value set, the timer automatically pages the information in place 

order according to the time set in the FIN PAGE TIME. The default is 10.  

 

 

 

 

Press [0]-[9] to enter the number of lines. When the correct setting is shown on the LCD 

screen, press [Enter] to save.  

Score Module 
This menu tells the console whether it will be displaying 

team scores on a separate team score module on the  

numeric scoreboard, or if the console‘s scores will display  

on the Lane, Place, Time portion of the numeric scoreboard.  

 

  

MENU-TIMER 
5-TIMEOUTS 

MENU-TIMER 
# FULL T.O.   3* 

MENU-TIMER 
# PART T.O.  1* 

MENU-TIMER 
6-HORN CONTROL 

MENU-SCOREBOARD 
1 # OF LINES 

1-# OF LINES 
LINES=   ▪8* 

MENU-SCOREBOARD 
2-SCORE MODULE  

From Main Menu – [3]>[1]>[5] 

HORN-COMBINED  
SET IND?  Y/N 

From Main Menu – [3]>[1]>[6] 

MENU-SCOREBOARD 
1-NUMERIC 

From Main Menu – [3]>[2] 

From Main Menu – [3]>[2]>[1]>[1] 

HORN-INDEPENDENT  
SET COMB?  Y/N 



 

 

 

 

Press [Yes] if a module is used  and [No] if no nodule will be used. 

 

RTD Offset 
This menu will add 0K, 5K, 10K, or 15K to the RTD data  

being sent to the matrix display. 

 

 

 

 

Use a [↑] or [↓] to toggle through the RTD offset # settings (0K, 5K, 10K or 15K). 0K uses no 

offset and 5K adds 5000 to the item #. To save the setting, press [Enter]. 

 

When to use this: 

 

 If using a Daktronics Venus 1500 M2 or M3 controlled display, this menu allows 

multiple RTD input directly into the display.  

 If data from more than one OmniSport console is going to one display. 

 

The following Comm (Communication) Ports menus select  

the protocol used for transmitting data to the display. 

Scoreboard Outputs 
Select Scoreboard Outputs to assign a protocol (Multidrop or  

Multiline) used to transmit data in outputs (J2and J3). 

 

 

 

 

Press [←] or [→] to select Multicast, Multidrop, Multiline or Omega protocol, depending on  

the type of display used, and then press [Enter] to save.  

 

When to use this: 

 

 The OmniSport 2000 supports many different types of displays. Multicast, Multidrop, 

and Multiline are protocols that Daktronics has incorporated into its displays. The  

newest generation of displays is the SW-5000 series. This series of display will  

auto-detect the protocol being sent to it. In most cases the console should be  

set to Multicast. 

 

 The previous generation of displays for swimming was the SW-2000 series. This 

generation required a protocol plug to know which protocol it was receiving. To test  

 

SCORE MODULE-Y 
USED?  Y/N  

MENU-SETUP 
3-COMM PORTS  

MENU-COMM PORTS 
1-SCBD OUTPUTS  

MENU-COMM PORTS 
SCBD; MULTIDROP*   

From Main Menu – [3]>[3]>[1] 

From Main Menu – [3]>[2]>[1]>[2] 

From Main Menu – [3]>[3] 

MENU-RTD/MATRIX 
1-RTD OFFSET  

MENU-RTD/MATRIX 
RTD OFFSET: 0K*  

From Main Menu – [3]>[2]>[2] 

From Main Menu – [3]>[2]>[2]>[1] 

MENU-RTD/MATRIX 
RTD OFFSET: 5K*  



which protocol is used, unplug the signal to the display from the back of the console. 

Connect power to the display. When it powers up, it will display either a P0 or P1 on 

the left two digits:  

P0 – set the console to Multidrop 

P1 – set the console to Multiline. 

 

 If the display is one manufactured by Omega, set the console to Omega. 

RTD Port 
The RTD Port is used to select the protocol (RTD or CTS)  

to transmit out of the J5 RTD port on the OmniSport 2000  

console. RTD means Real Time Data. CTS means Colorado  

Timing System. The default is RTD.  

 

 

 

 

Press [←] or [→] to select RTD to send information to a Daktronics Venus® 7000 or 1500 

controller or CTS to send to a numeric CTS scoreboard., and then press [Enter] to save.  

Results Port 
The Results Port configures which protocol (OmniSport 2000  

or 6000 console, or a CTS console)will be used to  

communicate with the meet management software.  

 

 

 

 

The OmniSport 2000 (default) and the OmniSport 6000 are bi-directional protocols. 

The CTS console is unidirectional protocol, utilizing the standard CTS scoreboard 

information. 

 

Press [Enter]> [←] or [→] to select OmniSport 2000, OmniSport 6000 or CTS protocol, 

depending on what the meet management software is expecting to receive, and then press 

[Enter] to save. 

 

Note: If using an older version of Hy-Tek Meet Management, it may require configuring this 

port to the OmniSport 6000 data. Selecting Omni 6000 transmits Omni 6000 RTD item 

numbers on the RTD output. 

 

Game Log  
This menu is used to turn the game log printout ON or OFF. 

 

 

 

 

 

 

MENU-COMM PORTS 
RTD PORT: RTD* 

MENU-COMM PORTS 
CTS PORT: CTS 

MENU-COMM PORTS 
2-RTD PORT 

MENU-COMM PORTS 
RSLT: OMNI 2000* 

MENU-COMM PORTS 
3-RESULTS PORT 

MENU-PRINTER 
1-GAME LOG 

From Main Menu – [3]>[3]>[2] 

From Main Menu – [3]>[3]>[3] 

MENU-PRINTER  
GAME LOG:  OFF* 

From Main Menu-[3]>[4] 

MENU-SETUP 
4-PRINTER 

From Main Menu-[3]>[4]>[1] 



If the Game Log is turned on, each time a clock is started, stopped, score +1, score -1, player 

penalties, etc., the printout shows the time-of-day the action occurred. Press [←] or [→ ] to set 

the Game Log ON or OFF, and then press [Enter] to save. 

Intensity 
This menu sets the printer‘s depth of contrast for easy 

readability. The typical level is set at 5. 

 

 

 

 

Press [Enter]>[1-5] to select a new intensity, and then press [Enter] to save.  

Time-of-Day 
This menu is used to set the console‘s date and time. 

 

 

 

 

Press [0-9] to enter the correct date and time, and then press [Enter] to save. Press [Clear] 

twice to exit without saving and retain the previous time and date.  

 

The OmniSport 2000 timer is equipped with features  

that test battery level and the numeric scoreboard. It is  

important to run through these tests before the game begins to prevent problems from 

occurring during the game. 

Battery 
This menu checks the battery power level. 

 

 

 

 

The battery level will show as CHARGED or LOW. Press [Enter] to exit the menu.  

Scoreboard 
These menus check the numeric scoreboard drivers.  

Cycle ON/OFF  
This menu checks the signal to the scoreboard. 

 

 

 

 

Press [1] to toggle the scoreboard ON and OFF. When this menu is selected, an all ON signal 

is sent at intervals of approximately 3 seconds. This will continue to cycle ON and OFF until 

pressing [Enter] to continue.  

MENU-MAIN 
4-TEST MENU 

DATE 01/01/00 
TOD  01:18:37 

MENU-TEST 
1-BATTERY 

BATTERY TEST 
LEVEL: CHARGED 

BATTERY TEST 
LEVEL: LOW 

MENU-TEST 
2-SCOREBOARD 

SB TEST MENU 
1-CYCLE ON/OFF DISPLAY ALL ON 

ENTER TO EXIT 

MENU-SETUP 
5 – TIME OF DAY 

From Main Menu-[3]>[5] 

From Main Menu-[4] 

From Main Menu-[4]>[2]>[1] 

From Main Menu-[4]>[1] 

PRINT INTENSITY 
LEVEL 1-5:  4* 

MENU-PRINTER 
2-INTENSITY 

From Main Menu-[3]>[4]>[2] 



Driver Address  
This menu shows which drivers control the digits.  

 

 

 

 

Press [2] to display the driver addresses. This will remain on the display until [Enter]  

is pressed.  

Digit Number  
This menu displays the digit designation. 

 

 

 

 

Press [3] to display a digit number. The number or letter will show which output on the 

driver that digit is plugged into. This will remain on the display until [Enter] is pressed.   

SB TEST MENU 
2-DRIVER ADDRESS SHOWING ADDRESS 

ENTER TO EXIT 

SB TEST MENU 
3-DIGIT NUMBER 

SHOWING DIGIT # 
ENTER TO EXIT 

From Main Menu-[4]>[2]>[2] 

From Main Menu-[4]>[2]>[3] 





Section 12: OmniSport 2000 for Pace Clock 

 

Reference Drawings: 

Insert, Omni 2000, Pace Clock ............................................................. Drawing B–188395 

 

The pace clock mode, available through the OmniSport 2000 console, serves as a workout manager.  

 

The sport insert drawing is located in Appendix B:. If an insert is lost or damaged, a copy of the 

insert drawing can be used until a replacement can be ordered. Refer to Section 2: for information on 

starting the timer and for instructions on using the sport insert. 

 

When starting the OmniSport 2000 console, set the console  

to the pace clock mode. Refer to Section 3.5 and press  

[Enter] when the right LCD screen shows 3-PACE CLOCK.  

 

There are two methods of navigating through the  

menus. Refer to Section 5.1 to review how to start and  

navigate through the menus. If the console is set in the  

swimming or diving mode, turn the console off and restart  

to select pace clock. 

 

Refer to the OmniSport 2000 Quick Reference Guide 

ED-13584 (Figure 178) or Appendix C: for the pace clock 

navigation list.  

 

The Keypad 
The Pace Clock keypad insert is LL-2581 (included in 

Appendix B:). Refer to (Figure 179) in the following pages which describe the functions of 

each key. Notice the grouping by lanes 1-10 allowing the operator to perform the four basic 

functions by individual lane or to start, stop or reset ALL by using the keys on the right.  

 
Figure 177: Pace Clock Menu 

Navigation 

 
Figure 178: Pace Clock Keypad Insert 

SELECT SPORT 
3-PACE CLOCK 
 



LCD Screens 
The pace clock can manage up to ten different simultaneous workouts. Each workout will 

display consecutively on the scoreboard‘s lane 1-10. The pace clock also works with a 

downloaded workout from Hy-Tek Workout Manager. The Results Port (6) is used to 

download the workout. The OmniSport will accept 50 steps of the workout for each lane.  

      1      2      3       4       5           6      7      8      9      10 

 

 

 

 

The three LCD displays on the console keeps the operator informed during all operations. 

The two left screens contain information for lanes 1-10 while the right LCD screen displays 

detailed information for a specific lane plus editing information when in the editing mode. 

The following table describes each symbol and function. 

 

Function Location and Definition 

Lane # (# above left & middle screens) Clearly identifies the lane. 

Step # (top row # in left screen [far left – ex. 3]) Displays which step a specific swimmer is 

performing. Up to 50 steps for each lane may be entered. 

Lane Activity (bottom row * and - in left screen and middle screens) The – indicates the timer is 

stopped and the flashing * indicates the timer for that lane is running. 

Step Type 

 

Lane details 

are contained 

in the right 

LCD. For 

example the 

lane and step 

numbers 

currently 

shown are 

identified on 

the top row.  

(bottom row word on right screen [ex. PACE]) Following is a list of possible steps: 

 Beg Circuit –– for a workout, enter a combination of desired steps: swim, 

rest, pace and stop. Repeat a certain number of times. Basically, this is a 

workout within the whole workout. Press [Enter] to select this step. The 

prompt requests entering the number of times this circuit will repeat. Adding 

different steps within this circuit is the same as adding steps to the whole 

workout.  

 End Circuit –– ends the circuit that was entered within the BEG CIRCUIT 

option. When ending a circuit, steps may still be added before finishing the 

total workout.  

 Swim –– selects the amount of time athletes will swim within one step. 

 Rest –– within a workout, enter the amount of time for the swimmers’ rest 

within one step.  

 Pace –– overrides the rest of the workout (or circuit if a pace step is entered 

within one) and continue to count up to the entered time, return to 0:00 and 

start counting again. It can repeat this step indefinitely.  

 Stop –– identifies where to end or "Stop" the workout.  

Timer (bottom row on right screen center) Counts up during the swimming and pace steps 

or down during the rest step. 

Repeat Count 

# 

 

(bottom row on right screen [far right ex. #3]) Displays which repetition the swimmer 

is currently on.  

For example, the step was programmed to repeat 5 times. Swimmer in Lane 1 is 

currently completing that step's third repetition. 

Note: When the repeat count number is "0," the swimmer has not started. 

LANE 1  STEP  1 
PACE 00:09  # 3 
 

1   1   1   1   1 
-   -   -   -   - 
 

3   1   2   1   1 
*   -   *   -   - 
 



 

Selecting the Scoreboard Menu is where the operator can turn  

the scoreboard output ON or OFF, set the dimming level 

for Multi-drop displays and display Time-of-Day on  

the scoreboard.  

Scoreboard On/Off 
 

 

 

 

If the setting is ON, it will be displaying data on the scoreboard. If this setting is OFF, the 

scoreboard will be blank until either the start of the next race, or the scoreboard is turned 

back ON in the menu.  

 

When to use this: 

 

 The scoreboard is displaying false information due to equipment or operator error 

and needs to be blanked. 

 The error is corrected and the scoreboard output can be turned back on.  

 

Note: This menu uses the [YES] and [NO] keys, which are the same as [Enter] and [Clear]. 

Dimming 
This menu is used to adjust the dimming level on scoreboards 

that receive Multi-drop protocol.  

 
 

  

Use the numeric keypad to select one of the values of 0-9  

shown in the table to the right, or use the Arrow keys to toggle  

through the levels. To save the setting, press [Enter]. To return  

to the Dimming Menu without saving, press [Clear].  

 

When to use this: 

 

 In low light conditions the scoreboard may be too bright. 

 In direct sunlight the scoreboard may need to be turned to full bright. 

Time-of-Day 
This menu is used to display Time-of-Day on the scoreboard.  

Press [YES] to clear the scoreboard and show Time-of-Day.  

Press [NO] to do nothing and return to the Time-of-Day menu. 

 

 

 

 

MENU - MAIN 
1 - SCBD MENU  

MENU - SCOREBOARD 
1 - SCBD  ON/OFF  

SCBD IS ON 
SET OFF?   Y/N 
 

MENU-SCOREBOARD 
2-DIMMING  

SCBD DIMMING 
LEVEL 0-9: 70% 
 

MENU - SCOREBOARD 
3 - TIME OF DAY 

From Main Menu – [1]>[1] 

From Main Menu – [1]>[2] 

Dimming levels: 

0 = none (full bright) 

1 = 90% 

2 = 80% 

3 = 70%  

…each number 

represents 10% to…  

9 = 10% (dimmest) 

From Main Menu – [1] 



 

 

 

 

 

The running time must be reset before the console will display Time-of-Day on the 

scoreboard. Press the Arrow keys to toggle between 12 and 24 hour setting.  

 

Time-of-Day will remain on the scoreboard until: 

 

 The start of the next race. 

 The operator presses [Reset] a second time to re-display the current results on the 

scoreboard. 

 It is toggled off in the menu. When it is toggled off, the current results will go back 

on the scoreboard. 

 

When to use this: 

 

 Anytime the console is reset and the operator wants to display Time of Day on the 

scoreboard. This might be during a break in the workout. 

 

The Edit Menu allows the operator to manually edit  

the workout for each lane (1-10). 

Edit Workout 

 
 

 

Press [Enter] to edit a workout. After selecting to edit a workout, select a lane. Use [0]-[9] to 

enter the lane number. Press [Enter] to begin editing that lane.  

Edit Step 
 

 

 

 

After selecting a lane, press [Enter] twice then select the step number by pressing an 

[Arrow]>[Enter] or by entering the step number and pressing [Enter].  

 

 

 

 

 

 

 

 

MENU-SCOREBOARD 
DISPLAY TOD? 
 

MENU-EDIT 
1-EDIT WORKOUT 

MENU-EDIT 
LANE #  1* 
 

MENU-LANE  1 
1-EDIT STEP  

EDIT 1     STEP 1* 
REST # 5 
 

EDIT 1     STEP 1* 
END CIRCUIT 

From Main Menu – [1]>[3] 

MENU-SCOREBOARD 
FORMAT:  24 HOUR*  
 

From Main Menu [2]>[1]  

From Main Menu [2]>[1]>[Lane #]>[Enter]  

From Main Menu – [2] 



Within the selected step choose from the following six modes: 

 

 1=STOP 

 2=BEG CIRCUIT (has a repeat count) 

 3=END CIRCUIT 

 4= SWIM (has a repeat count) 

 5=REST 

 6=PACE 

 

For example selecting mode 4 (Swim) the following LCD screens appear: 

 
 

 

 Enter in the desired amount of time and press [Enter].  

 Enter the number of times to repeat this step and press [Enter].  

The LCD will automatically display the next step for the selected lane to edit.  

 To insert another step, press [Enter]. To return to the main menu, press [Menu] 

twice. 

Insert Step 

 
 

 

To insert a step into the workout order, press [Enter]. 

First enter the step number to insert a step into by either using the arrow keys or by entering 

the lane number and pressing [Enter]. For example, to insert resting as Step 3, enter 3 and 

press [Enter]. 

Delete Step 
 

 

 

 

To delete a step from the workout order for a specific lane, press [Enter]. Enter the  

step number to delete by either using the arrow keys or by entering the lane number and 

then press [Enter]. 

Copy Workout 

 
 

 

To copy a workout from one lane to another, press [Enter].  

 

Enter the lane number to copy the workout to and press [Enter]. In this example, the workout 

is being copied from Lane 1 to Lane 2. 

EDIT 1     STEP 1 
SWIM  00:20  

EDIT 1     STEP 1 
SWIM  00:30   .0* 
 

EDIT 1     STEP 2* 
BEG CIRCUIT   #32 

MENU-LANE   1 
2 - INSERT STEP  

INSERT @STEP     1* 
SWIM 00:20         
#1 
 

MENU-LINE   1 
3 - DELETE STEP  

DELETE STEP     1* 
SWIM    00:05   # 
5 
 

MENU-LANE    1 
4 - COPY WORKOUT  

COPY LANE     1 
WORKOUT TO  2* 
 

From Main Menu [2]>[1]>[Lane #]>[Enter]>[2] 

From Main Menu [2]>[1]>[Lane #]>[Enter]>[3]  

From Main Menu [2]>[1]>[Lane #]>[Enter]>[4]  



Clear Workout  

 
 

 

To clear the entire workout that has been set up for a specific lane press [Enter].  

Press [Yes] to clear the entire workout or press [No] to go back to the menu selection. 

 

The Print Menu is where the operator can print a specific  

workout result.  

Individual Workout 

 
 

 

This menu prints the results of an individual workout in a specific lane. Enter the lane number 

for the workout to print and press [Enter]. The LCD displays a prompt verifying the workout 

to be printed. Press [Enter] to print or press [Clear] to return to the Print Menu. 

All Workouts 

 
 

 

This menu prints the workouts for every lane. Press [Enter] to print all workouts or press 

[Clear] to return to the Print menu. 

Settings 

 
 

 

This menu configures settings to be printed. Press [Enter] to allow the settings to print or 

press [Clear] to return to the Print menu. 

 

This menu contains the settings that tell the console which 

inputs to use, how to read then and what to do with them. 

Timer 
This feature is not activated. Press [Enter] and the display  

automatically proceeds to choice number two under the Setup menu.  

MENU-LANE     1 
5 - CLEAR WORKOUT  

CLEAR WORKOUT 
LANE    1  Y/N? 
 

MENU-MAIN 
3-PRINT MENU  

MENU-PRINT 
1-IND WORKOUT  

MENU-PRINT 
LANE # 1* 
 

MENU-PRINT 
PRINT WORKOUT? 

MENU-PRINT 
2-ALL WORKOUTS  MENU-PRINT 

PRINT ALL?  Y/N 
 

MENU-PRINT 
3-SETTINGS  MENU-PRINT 

PRINT SETTINGS? 
 

MENU-MAIN 
4-SETUP MENU  

MENU-SETUP 
1-TIMER  

From Main Menu [2]>[1]>[Lane #]>[Enter]>[5]  

From Main Menu [3] 

From Main Menu [3]>[2] 

From Main Menu [3]>[3] 

From Main Menu [4] 

From Main Menu [3]>[1] 



Numeric Scoreboard Menu 
This menu configures the numeric scoreboard.  

Press [Enter] to select the number of lines on  

the display.  

 

 

 
Use [0]-[9] to enter desired lines then press [Enter]. If the number of active lanes in the pool is 

greater than the value set, the timer will automatically page the information in place order 

according to the time set in the FIN PAGE TIME (Default=10). 

Matrix Scoreboard Menu 
This menu will add 0K, 5K, 10K, or 15K to the RTD data  

being sent to the matrix display. 

 

 

 

 

Use a [↑] or [↓] to toggle through the RTD offset # settings (0K, 5K, 10K or 15K). 0K uses no 

offset and 5K adds 5000 to the item #. To save the setting, press [Enter]. 

 

When to use this: 

 

 If using a Daktronics Venus 1500 M2 or M3 controlled display, this menu allows 

multiple RTD input directly into the display.  

 If data from more than one OmniSport console is going to one display. 

Comm Ports 
The following Comm (Communication) Ports menu sets 

the protocol used for transmitting data to the display  

and communicating with a results program. 

Scoreboard Outputs 

 
 

 

This menu selects which protocol (Multidrop, Multiline, Multicast, or Omega) will be 

transmitted out of the scoreboard outputs (J2 and J3). Use the arrow keys to select the output 

then press [Enter].  

 

Note: To identify a display as either Multiline or Multidrop, power up the scoreboard with 

the signal disconnected. If the Lane and Place digits show P0, the scoreboard is a Multidrop 

display. If the digits show P1, the scoreboard is Multiline. 

 

MENU-SETUP 
2-SCOREBOARD  

MENU-NUMERIC 
1-# OF LINES  

# OF LINES 
LINES = 4* 
 

MENU-SETUP 
3-COMM PORTS  

MENU-COMM PORTS 
1-SCBD OUTPUTS  

MENU-COMM PORTS 
SCBD: MULTILINE* 
 

From Main Menu [4]>[1] 

From Main Menu [4]>[3]>[1] 

MENU-SCOREBOARD 
1-NUMERIC  

From Main Menu [4]>[2]>[2] 

MENU-RTD/MATRIX 
1-RTD OFFSET  

MENU-RTD/MATRIX 
RTD OFFSET:  5K*  

MENU-RTD/MATRIX 
RTD OFFSET:  5K*  

From Main Menu [4]>[2]>[1] 
From Main Menu [4]>[2] 

From Main Menu [4]>[3] 



RTD Port 
 

 

 

 

This menu configures which protocol (RTD or CTS) will be transmitted out of the RTD port 

(J5) connector on the OmniSport 2000 timer. Select RTD to send information to a Venus 

controller. Select CTS to send information to a numeric CTS Scoreboard (Default = RTD).  

 

Use [↑] [↓] to choose between RTD and CTS ports. Press [Enter] to accept the selection.  

Results Port 
This menu configures which protocol (Omni2000, Omni 6000,  

or CTS) will be used to communicate with the meet  

management software.  

 

 

 

 

Use the arrow keys to choose between OMNI 2000, OMNI 6000 and CTS TIMER then press 

[Enter]. Omni 2000 and Omni 6000 are bi-directional protocols. CTS is a unidirectional 

protocol that uses the standard CTS scoreboard information (Default = Omni 2000).  

 

Note: Selecting Omni 6000 will tell the timer to transmit Omni 6000 RTD item numbers on 

the RTD output. 

Printer  
This menu configures the intensity of the print on printouts. 

Intensity 
 

 

 

 

Press [1]-[5] to select a new intensity. Press [Enter] or [Clear] to return to the Printer menu.  

Time-of-Day  
This menu is used to set the console‘s date and time.  

 

 

 

 

Use [0]-[9] to enter the correct date and time. Press [Enter] to accept and continue. Press 

[Clear] to clear the time and date, and press it again to exit without saving and retain the  

previous time and date.  

MENU-COMM PORTS 
2-RTD PORT  

MENU-COMM PORTS 
RTD PORT: RTD* 
 

MENU-COMM PORTS 
3-RESULTS PORT  

MENU-COMM PORTS 
RSLT:  OMNI 2000* 
 

MENU-SETUP 
5-PRINTER  

MENU-PRINTER 
4-INTENSITY  

PRINT INTENSITY 
LEVEL 1-5: 4* 
 

MENU-SETUP 
5-TIME OF DAY  

DATE 01/01/00 
TOD   00:25:09* 
 

From Main Menu [4]>[3]>[2] 

From Main Menu [4]>[3]>[3] 

From Main Menu [4]>[4]>[1] 

From Main Menu [4]>[5]>[1] 

From Main Menu [4]>[4] 

From Main Menu [4]>[5] 

DATE ▪▪/▪▪/▪▪  * 
TOD   00:25:09 
 



 

The OmniSport 2000 timer is equipped with features that test 

battery level and the numeric scoreboard. 

Battery 
 

 

 

 

The battery level will show as CHARGED or LOW. Press [Enter] to exit the menu. 

Scoreboard 
These menus check the numeric scoreboard drivers.  

Cycle On/Off 
 

 

 

 

Press [1] to cycle scoreboards ON and OFF. When this menu is selected, an ALL ON signal is 

sent at intervals of approximately three seconds apart. This will continue to cycle on and off 

until pressing [Enter].  

Driver Address 
 

 

 

 

Press [2] to display driver addresses. All digits on the display will be showing which driver 

controls this digit. This will remain on the display until pressing [Enter].  

Digit Number 
 

 

 

 

 

Press [3] to display the digit designation (digit number) for all digits on the display. This will 

remain on the display until pressing [Enter].  

MAIN MENU 
5-TEST MENU  

MENU-TEST 
1-BATTERY  

BATTERY TEST 
LEVEL= CHARGED 
 

MENU - TEST 
2 - SCOREBOARDS  

SB TEST MENU 
1 - CYCLE ON/OFF  DISPLAY ALL ON 

ENTER TO EXIT 
 

SB TEST MENU 
2 - DRIVER 
ADDRESS  

SHOWING ADDRESS 
ENTER TO EXIT 
 

SB TEST MENU 
3 - DIGIT NUMBER  

SHOWING DIGIT # 
ENTER TO EXIT 
 

From Main Menu [5] 

From Main Menu [5]>[2]>[2] 

From Main Menu [5]>[2] 

From Main Menu [5]>[2]>[3]>[Enter] 

From Main Menu [5]>[1] 

From Main Menu [5]>[2]>[1] 





Section 13: Relay Take-Off Platform 

The Relay Take-Off Platform (RTOP) triggers the OmniSport 2000 console when a swimmer leaves 

the start block. The touchpad time is also fed to the console where it is compared to the time when 

the swimmer left the RTOP. The difference between these two times is either positive or negative. A 

positive time is a legal exchange while a negative time indicates that there was an early exchange. 

The RTOP senses human contact and not pressure or force. It is not affected by loose, vibrating 

blocks, weight of the swimmer, or hop starts. There is NO manufacturer’s tolerance to set on 

Daktronics RTOPs.  

 

The RTOP also plays an important part in training. When used with a Daktronics touchpad, horn start 

and pace clock, it allows athletes to perfect their relay exchange time and reaction times. When the 

platform and touchpad are connected to a pace clock, it will display the relay exchange time of the 

athletes. When the platform is used in conjunction with the horn start and pace clock, it determines 

the reaction time from when the start tone sounds and when the athlete leaves the platform. 

 

 

Mounting, Relay Take-Off Platform ................................................. Drawing A-268945 

 

The lightweight plastic construction of the RTOP allows for easy setup and removal of the 

platform. Follow the steps below each time the RTOP is used. 

Before Securing the RTOP 
 

 Before placing the RTOP on the block with 

the platform bend towards the pool, 

inspect the sides, back and front for cracks 

or breaks.  

 Inspect the gray electronics box for cracks 

(Figure 179). Also check that the sticker 

covering the red LED on the end is not 

peeling or torn, plus verify that the cable 

strain reliefs are secure and not broken, 

loose or missing. 

 

a. Loosen the four screws on the gray electronics box cover to remove the cover. Do 

not completely remove the screws.  

 

b. Do not allow the inside of the box to get wet when the cover is loose or removed 

for inspection and replacement of batteries. 

 

c. Check the inside of the box for any indication of water. Next inspect the gasket 

that seals the cover of the box for any tears, kinks or anything that may cause the 

box to no longer be waterproof. 

 

 
Figure 179: RTOP 



d. The RTOP uses two AA batteries inside the  

electronics box. These batteries should be  

replaced before the meet, whenever  

the LED indicator shows a constant solid  

light, or the light is off when plugged into the 

deck cabling and the timing console is  

powered on.  

 

Typically the batteries need replacing every two 

days of competition or 20 hours of use. Verify 

that the batteries are installed so that the springs 

are pressing on the negative end of the batteries. 

 

The console‘s two left LCD screens can indicate 

weak or dead batteries. The letter ―R‖ appears on 

the screen in the lane where the RTOP‘s batteries 

are low. When the batteries are completely dead, 

the R will not display on the screen (Figure 180).  

 

e. Return the cover squarely onto the box. Start the screws and tighten until they 

are snug and then twist them ¼ turn more. If any of these screws are missing, the 

cover will leak and the RTOP may have problems.  

 

 Examine the cable for cuts or exposed wires between the electronics box and 

platform and between the electronics box and the dual banana cable. 

 Remove any corrosion on the dual banana plug with the maintenance kit included 

with the OmniSport 2000 console. 

 Loosen the strap so each end is free. Verify that the straps securing the RTOP to the 

starting block are not cut/frayed and that the buckles are in place. 

Attach and Connect the RTOP  
 

 Attach both straps on each side by  

placing the loose end into the end 

with the cam buckle. Once inserted 

into the cam buckle, pull loose end 

until platform is snug on the block. 

Make sure there are no twists in the 

strap and that the electronics box is 

flat against the bottom of the starting 

block. Tie the excess strap up so that 

it is not hanging in the water that 

splashes up on the pool deck (Figure 

182). Refer to Drawing A-268945 to 

correctly mount the RTOP.  

 

 

 

 

 

 
Figure 180: Batteries and LCD 

Indicator 

 
Figure 181: Wrap Excess Strap 



 The dual banana cord attached to the gray electronics box will be plugged into either 

the lane module for an on-deck system or a deck plate for an in-deck system. 

Typically the RTOP is plugged into 

the Button 3 input (Figure 183). 

The push button and RTOP cables 

are stackable connectors. If all 

three push buttons are in use, 

piggy-back the RTOP plug on one 

of the button plugs. For more 

information refer to Section 2.4. 

 

Tip: Usually swim meets use one 

or two backup buttons leaving Button 3 empty. Dedicate Button 3 for the RTOP. This 

way the configuration for the OmniSport 2000 console can stay on input 3.  

Test the RTOP 
 

When using the OmniSport 2000 console: 

 

 Plug the RTOP into a button input on the deck cabling, typically Button 3 input. 

Configure the OmniSport 2000 console for that button (Section 5.6).  

 The red LED on the RTOP‘s gray electronics box should be flashing.  

 Place hand flat on the RTOP, hold for two seconds. Remove hand quickly. The red 

LED should turn on solid for approximately 1 sec then begin flashing again. 

 Verify that the times are appearing on OmniSport printouts. Times should also 

appear in Pro Swim computer if using that software. 

 

Note: The OnmiSport 2000 console must be configured for a relay event in order to 

see Exchange times.  

 

When using the pace clock: 

 

 Set the pace clock to Program 11. 

 Connect the RTOP cord into the pace clock jack 

labeled ―Platform‖ (Figure 183).  

 Place hand on the RTOP, hold for 2 seconds and 

quickly pull away. The top colon on the pace 

clock will quickly flash on and off if there is 

proper connection.  

 

The Relay Take-Off Platform‘s main function is for  

relay exchanges during competitive events. When  

used in conjunction with a complete Daktronics timing  

system it can be used to detect relay exchanges to  

1/100th of a second. Daktronics RTOPs will only work  

with an OmniSport 2000 timer or a Daktronics pace 

clock. Coaches can use the RTOP in practices with the pace clock to improve start reaction 

times. Figure 184 shows a negative exchange when the swimmer left the platform early. 

 
Figure 182: Plug RTOP into Lane Module 

 
Figure 183: Connecting to Pace 

Clock 

 
Figure 184: Pace Clock Showing 

Negative Exchange 



Operating with OmniSport 2000 Console Only 
When operating the OmniSport 2000 timing console with the RTOPs, users need to configure 

the timer 

correctly. The configuration is done in the Swimming Menu option (Section 4:). Press 

[Menu]>[4]>[2]>[7] to edit the following right screen information:  

 

 BTN / DAKTRONICS: For Daktronics Relay  

Take-Off Platform. Press [Enter]. 

 

 RELAY TAKE-OFF INPUT USED: This is the button 

 input that the platform is plugged into. Use [1-3] to 

to select the button # the RTOP is plugged into then  

press [Enter]. 

 

 RELAY TAKE-OFF ARM TIME: This is the duration  

window between touchpad time and RTOP time  

(0.8sec suggested). Use [0-9] to select the desired arm time 

then press [Enter] to save. Return to the main menu by clicking [Menu] once.  

 

Notes: The relay race printout shows a positive or negative time on the paper. For a 

sample printout, refer to Figure 57.The results section shows the times for each relay 

exchange at the end of the race. 

 

The OmniSport 2000 timing console needs to be Version 8.3.27 or newer to properly 

operate the RTOP. The console‘s version should display in the middle LCD screen 

when first powered up. Refer to Section 3.7 for more information on updating the 

software.  

Operating with OmniSport Pro Swimming Software 
When OmniSport Pro 

Swimming is connected to the 

console, the RTOP settings 

can be configured in the 

software itself. From the Pro 

Swim software go to Options 

> Configuration > Timer 

(Figure 185). 

 

Note: Pro Swim requires a 

version 1.1.18 or newer. 

This will be displayed in the 

top header of the software. 

 

 
Figure 185: RTOP Configured in Software 

RELAY TAKE-OFF 
BTN/DAKTRONICS * 
 

RELAY TAKE-OFF 
INPUT USED: 3* 
 

RELAY TAKE-OFF 
ARM TIME: 0.8SEC* 
 



 

When storing the platform: 

 

 Store in a dry location. 

 Daktronics cart is the preferred method  

   (Figure 186). 

 Make sure cord is not pinched or torn. 

 Keep the surface free from debris. 

 Avoid storing the RTOP on platform lip. 

 

If the RTOP is not working:  

 

 Replace batteries 

 Inspect cable 

 Inspect and clean banana jack 

 Try a different lane module or deck plate 

 Call technical Help Desk at 800-843-5843 

 

 

Q: What if the swimmer does a hop start? 

The RTOP tells the timing console each and every time that the swimmer left the 

block. The console then compares the last input from the RTOP to the touchpad time. 

 

Q: Is the RTOP affected by block vibrations? 

No. The RTOP does not sense movement, it senses the human contact. 

 

Q: What if the swimmer places a towel on the block? 

That is not recommended. The RTOP may trigger early if there is something between 

the swimmer‘s skin and the RTOP. 

 

Q: Is the RTOP affected by the weight of the athlete? 

No. The RTOP senses human contact and not pressure or force to activate it. 

 

Q: What is a safe exchange time and what is a DQ? 

0.0 seconds or higher is safe and -.01 or lower is a DQ. 

 

Q: Is the equipment approved by the sanctioning body? 

Organizations like the NCAA and FINA do not approve equipment. They do write 

the rule books that outline what the equipment needs to do. The RTOP meets and 

exceeds all requirements of the NCAA, USA Swimming, FINA and NFHS. 

 

 
Figure 186: RTOP Storage Cart 





Section 14: Operating the Console in Track Mode 

Sport Insert LL-2573 

 
Reference Drawing: 

Insert, LL-2573; OmniSport 2000 Console Track Timing ...................... Drawing B-184685 

 

The sport insert drawing is located in Appendix B:. If an insert is lost or damaged, a copy of the 

insert drawing can be used until a replacement can be ordered. Refer to Section 3: for information on 

starting the timer and for instructions on using the sport insert. This section familiarizes the user with 

the OmniSport 2000 console operation in track mode. 

 

The normal display of timing information on a single-line or multi-line scoreboard is 

completely automatic and does not require any operator input. The following information is 

for normal (automatic) operation. Also included are some special actions that can be done 

with operator input. 

Single-line Scoreboards  
 

 Timer Reset: The scoreboard shows last race data. 

 Start of Race: The scoreboard shows running time. 

 Final Time: The first place final time is held on the scoreboard for at least five 

seconds (default). The page time (time for the scoreboard to page) can be configured 

in the Setup-Numeric Scoreboard menu. All of the subsequent final times are then 

automatically sequenced on the scoreboard as they finish. When all of the active 

lanes have completed the race, the system displays all of the final times in sequence 

from first place to last place and repeats the sequence until the next race is started. 

Multi-line Scoreboards 
 

 Timer Reset: The scoreboard shows last race. 

 Start of Race: The scoreboard shows the running time on line one of the scoreboard 

and blanks the remaining lines. 

 Final Time: Final times are displayed on the scoreboard until the next race begins. 

 

Figure 187 shows the right LCD screen when 

starting the OmniSport 2000 console in the track 

mode. The top line shows the running time (RT). 

The bottom line displays the event number (E), the 

heat (H) and the timed Lane.   

 

 

 
 

Figure 187: Track LCD Screen 



Lane Status 
The two left LCD screens show lane status symbols that may appear on the left screens 

during a race. The following symbols are used to show the lane status. 

 

Lane Status 

Symbols 
Represents 

(Blank) Lane is off 

– Timer has been reset 

NN Arming delay (NN represents a number from 1-2 that is counting down to 0) 

* Lane armed for a final time 

O Lane has finished the race 

? There is a problem with the button interface 

An example of the LCD is shown below. (All possible lane status symbols are shown, though 

it is unlikely it would appear like this in an actual meet setting.) The top line shows each lane 

status. Use the table above to determine what each symbol represents. 

 

                1       2       3       4       5            6       7       8      9      10  

 

 
 

 

This section defines the keys on the sport insert for track, part # LL-2573, as illustrated in 

Figure 188. Section 3.2 explains how to install or remove the sport insert.  

Lane On/Off for Each Individual Lane  
At the start of a race, the timer automatically turns every lane on. It is up to the operator to 

turn them off if needed. Use these keys to disable the empty lanes after the start of a race. 

 

For each lane that is empty (no athlete in that lane), press [Lane ON/OFF] to tell the timer to 

not expect any data from that lane. A second use of the key is to temporarily disable a lane 

and then turn it back on.  

 

 
Figure 188: Track Insert LL-2573 

*     2       ?    * *   1    o   *    RT:  00:19.5 
E: 013  H: 01 LANE 



Start 
The operator has the option to start the timer counting by pressing [Start]. The printer will 

label the results with the source of the start. If the keypad was used it would be labeled 

Source: Keyboard. If the start was from the horn start it would be labeled Source: External. 

 

Examples when to use Start: 

 

 Test the timing system or scoreboard 

 

 If there were a start system failure, press [Start] then [Split Arm All] and [Enter]. 

The timer will at least record the finish order of the race. The time will be incorrect, 

but some data is better than no data.  

Store Print  
The [Store Print] key stores the race data for later use and prints the results for verification. 

When pressed, the event data is stored up to its current status. It then performs the printer 

commands set up in the Setup-Printer menu. To print information from a previous race, go 

to the Print Stored Data Menu. Refer to Section 15.4 for further information. 

 

If an error is observed on the printout, use the [Edit] key to make corrections. Press  

[Store Print] to verify the correction. After all corrections have been completed, press  

[Reset]>[Enter]. The timer is now ready to begin the next event.  

 

The OmniSport 2000 printer uses the following symbols on its printouts to label data. 

 

Symbol Definition 

B (1-3) Buttons 1 through 3 

B or BK Backup time 

E Edited time 

M Manual time 

Edit 
When the running time is counting, the [Edit] key allows corrections to be made to times in 

the current race memory. Press [Edit] then the desired lane number key. Enter the new time 

with the numeric keypad then press [Enter]. [Edit] is disabled during non-lane timing. 

Paper Feed 
Press [Paper Feed] to have the printer advance the paper. The printer will not print on the 

advanced lines.   

Event Heat  
 

 Event +1: This function increments the event number by one. 

 Heat +1: This function increments the heat number by one.  

 Heat -1: This function decrements the heat number by one. 

 Event Heat: Press [Event Heat] to enter a particular event and heat number. 



Place/Lane/Non-Lane Timing 
 

 Lane Timing: Pressing [Lane Timing] enables all lanes and buttons configured in the 

system. When this is enabled, each lane has one to three buttons that will record 

when a racer finishes the race. 

 Place Timing: Pressing [Place Timing] enables all places and buttons configured in 

the system. When this is enabled, each place has one to three buttons that will record 

when a racer finishes the race. 

 

 Non-Lane Timing: Pressing [Non-Lane Timing] disables all of the buttons except 

Lane 1, Button 1. The official should press the button for every competitor finishing 

the race.  

 Non-Lane Split Enable: [Non-Lane Split Enable] uses the next button recorded to 

calculate the cumulative and subtractive split for that last lap. The split time will be 

printed and displayed on the scoreboard. The [Non-Lane Split Enable] key only 

works if the [Non-Lane Timing] key has been pressed. 

Reset 
The timer is automatically reset when first turned on. The timer may be reset any time the 

race clock is running by pressing [Reset]>[Enter]. 

 

When a race is complete, the operator presses [Reset]>[Enter] to reset the timer.  

 

Note: If the operator has not pressed [Store Print] before resetting the timer, pressing [Reset] 

will store the race and print the results in addition to resetting the clock.  

 

If the timer was not reset before the start of the next race, see Section 14.6 Always Ready Start.  

Menu 
Press [Menu] to access additional functions and setting in the console. Section 15: describes 

the menus in track mode and how to navigate them. 

Disqualification (DQ) 
The DQ (disqualification) flag can be used to disqualify a racer with subsequent re-ranking 

on printouts and on the scoreboard. 

 

Typical operation: Press [DQ] and [Lane On/Off] key for the desired lane or enter the lane 

number on the number keypad and press [Enter]. Doing this sets the DQ flag for that lane.  

The DQ operation should normally be done at the conclusion of the race, after the officials 

have ruled on the situation that caused the athlete to be disqualified. On exit from the DQ 

command, the scoreboard is automatically updated and any subsequent printouts will show 

the revised placing. The DQ operation can be done at any point in the race and does not affect 

arming or recording of times for the lane. By pressing the same lane number again while in 

the DQ command, the lane is ―re-qualified‖ and the original status indicator is returned 

Before the meet, the timing operator should clarify with the meet referee if he/she wants the 

athletes to be disqualified on the timer. Clarification of this is important for results to be 

properly ranked on the printouts and meet management software which will show as a DQ 

on the scoreboard.  



 

The Event/Heat Number and Home/Guest Scores can be displayed on the appropriate 

scoreboard module if it is included in the system. 

 

When the Event/Heat module is present, the event and heat numbers will automatically be 

displayed whenever they are changed with the [Event/Heat] key. 

 

When the Home/Guest or Guest/Guest modules are present, the home, guest 1, guest 2 and 

guest 3 scores will automatically be displayed after being entered in the Edit-Team Score 

menu. 

 

When the Record Time module is present, record data for the corresponding event will be 

displayed at the start of the race. One record can be pre-entered for each event in the Edit-

Event Order menu (refer to Section 15.3).   

 

Printer Setup  
Before the start of the first race, the printer should be set up to print the desired information. 

Refer to Section 15.9 to configure the printer.  

Verify the Console is Reset 
Confirm the console is reset and that RT shows 00:00.0 (Figure 187). Set the correct Event 

Heat and Lane. Press [Next Event]>[Heat +1 or Heat-1] or simply press [Event Heat] to enter 

the correct Event and Heat. 

 

During the race, the operator watches the meet officials, lane status indicators on the 

console‘s LCD screen and athletes in their lanes. This section describes operations that must 

take place during an event. Doing these operations will increase the effectiveness and 

accuracy of the timer, and help ease the flow of running a track meet.  

Start Operations  
The timer will start any time a start impulse is received and the timer is reset (clock shows 

00:00.00). As a backup operation or for testing, press [Start] to start the timer. The printer will 

note if the start is External or Keyboard. 

Check for Unused Lanes 
The timer operator should turn off any unused lanes after visually verifying any open lanes 

on the track. Press [Lane ON/OFF] for the appropriate lane. 

Watch Lane Status LCDs  
The operator watches the lane status indicators on the two left LCD displays to confirm that 

all times are recorded. 



Always Ready Start 
The Always Ready Start feature is based on the fact that the OmniSport 2000 timer has an 

internal time-of-day clock that continually runs when the timer is turned on. The internal 

clock continues to run even when the race clock has been stopped.  

 

If a start was missed because the timer was not reset (race clock was still running from the 

previous race), the start impulse is logged in the memory and on the printer. To prompt the 

operator that a start has occurred, reset the timer. If the operator chooses to use the received 

start signal, the timer will automatically start timing the event by calculating the correct 

running time. Press [Edit] to retrieve the start impulse used for the last race. 

 

If two independent OmniSport 2000 timers are being used in parallel for an especially critical 

application and one timer misses a start impulse completely because of a technical problem, a 

start time may be manually entered when read from the printout of the other timer. 

 

Example: Editing a Start - If a start is missed because the timer was not reset before the start: 

 

 The time-of-day of the start impulse will be logged on the printer. 

 The OmniSport will inform the operator of the start after the timer is reset. 

 
Procedure: 

1.  To reset the timer: 

 

 Press [Reset], then [Enter]. 

 The following message displays on the screen: 

 Accept the missed start by pressing [Enter] and the timer will start from the 

missed start time. If the missed start is to be ignored, simply press the [Clear] key 

and the timer will be reset only. 

 

2.      If the start time was not on the LCD screen, use the Edit-Start menu: 

 

 With the timer reset, press [Edit]. This reveals the Edit-Start menu and puts the 

time-of-day of the last start impulse on the LCD. 

 Confirm that the time-of-day shown on the LCD is the correct time for the start of 

the race. The start time may be edited using the number keys. 

 Press [Enter]. This completes the editing operation. The race clock will start and 

the running time will be correct based on the entered start time. 

 

This section describes operations that must take place after an event has completed. Doing 

these operations will increase the effectiveness of accurate timing and help ease the flow of 

running a large track meet.  

Store Print 
If an error is observed on the printout, press [Edit]. Press [Store Print] to verify the 

correction. After all corrections are made, press [Reset]>[Enter]. Refer to Section 15.4   

The timer is now ready to begin the next event. Advance to the next event or heat and 

continue. Follow the steps in Sections 14.5 and 14.6 through each race.  

USE MISSED START: 
02:23:14.50 Y/N 



 

This section illustrates typical printouts from the OmniSport 

2000 console. To create a printout from the console‘s built-in 

printer, refer to Section 15.4. 

Track Configurations 
It is important to save the printout (Figure 189) for system 

settings to reuse for future meets. The basis of the settings is 

letting the console know how the physical track and timer 

are configured.  

Results Printouts 
Figure 190 illustrates a typical printout for an eight-lane 

track showing Lane and Place results for two heats. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 189: Typical Track Settings 

 
Figure 190: Typical Track Results Printout 





Section 15: The Console’s Track Menus and 
Settings 

 

System Riser; FB/Track SCBD w/ Omni 2000, in Field .......................... Drawing A-186535 

System Riser; Track SCBD w/ Omni 2000, in Field ................................ Drawing A-186548 

 

The system riser diagrams are located in Appendix A:. Refer to Section 2: for information on starting 

the OmniSport 2000 timer and Section 14: for instructions on using the sport insert.  

 

The track mode of the OmniSport 2000 console has three different timing modes: by lane, by 

place and non-lane. By lane and by place are typically used to time events that run in lanes 

(sprints). The OmniSport 2000 console can time up to ten lanes with 1-3 buttons per lane. 

 

Non-lane mode uses a single push button to press each time a runner crosses the finish line in 

a distance event. 

 

The three LCD screens on the OmniSport 2000 keep the operator informed during all 

operations. Note the following layout of the LCDs shown in the track mode. 

                 1       2       3       4       5            6      7      8      9      10  

 

 

 

 

The lane status is shown on the first two LCD screens and other race information is shown on 

the right screen. During a race, the top line of the right LCD screen shows the race time (RT). 

The bottom line displays the event number (E), the heat (H), and whether it is in LANE or 

NON-LANE timing mode. 

Console menu navigation 
There are two methods of navigating through the 

menus in the OmniSport 2000 console. 

 

Refer to the list in Appendix C: Track Menu 

Navigation. Daktronics provides a laminated copy 

(Figure 191) of the Quick Reference OmniSport 2000 

Timing Console (ED13584). 

 

Note: Turn the console on with the switch on the 

back left side. Refer to Section 5.1 to review how to 

start and navigate through the menus.  

 

 

 

 

 
Figure 191: Track Menu Navigation 

-   -    -   -   - -   -   -   -   -        RT:00:00.0 
E:001 H:01    LANE 

SELECT-SPORT 
6-TRACK 



 

The Scoreboard Menu is where the operator can turn the  

scoreboard output ON or OFF, set the dimming level for  

Multi-drop displays and display Time-of-Day on the scoreboard. 

Scoreboard ON/OFF 
This menu is used to toggle the scoreboard output ON/OFF. 

 

 

 

 

If the setting is ON, it will be displaying data on the scoreboard. If this setting is OFF, the 

scoreboard will be blank until either the start of the next race, or the scoreboard is turned 

back ON in the menu. 

 

When to use this: 

 

 The scoreboard is displaying false information due to equipment or operator error 

and needs to be blanked.  

 The error is corrected and the scoreboard output can be turned back on.  

 

Note: This menu uses the [YES] and [NO] keys which are the same as [Enter] and [Clear]. 

Dimming 
This menu is used to adjust the dimming level on scoreboards 

that receive Multi-drop protocol.  

 

 

 

 

Use the numeric keypad to select one of the values of 0-9  

shown in the table to the right, or use the Arrow keys to toggle  

through the levels. To save the setting, press [Enter]. To return  

to the Dimming Menu without saving, press [Clear].  

 

When to use this: 

 

 In low light conditions the scoreboard may be too bright. 

 

 In direct sunlight the scoreboard may need to be turned to full bright. 

Time-of-Day 
This menu is used to display Time-of-Day on the scoreboard.  

Press [YES] to clear the scoreboard and show Time-of-Day.  

Press [NO] to do nothing and return to the Time-of-Day menu. 

 

 

 

 

MENU-SCOREBOARD 
2-DIMMING 

SCBD DIMMING 
LEVEL 0-9:  70% 

MENU-MAIN 
1-SCBD MENU 

MENU-SCOREBOARD 
1-SCBD ON/OFF 

SCBD IS ON 
SET OFF? Y/N 

From Main Menu - [1]>[1]  

From Main Menu - [1]>[2]  

Dimming levels: 

0 = none (full bright) 

1 = 90% 

2 = 80% 

3 = 70%  

…each number 

represents 10% to…  

9 = 10% (dimmest) 

MENU-SCOREBOARD 
3-TIME OF DAY 

From Main Menu - [1]  



 

 

 

 

 

The running time must be reset before the console will display Time-of-Day on the 

scoreboard. Press Arrow keys to toggle between 12 and 24 hour setting, and then press 

[Enter]to save.  

 

Time-of-Day will remain on the scoreboard until:  

 

 The start of the next race. 

 The operator presses [Reset] a second time to re-display the current results on the 

scoreboard. 

 It is toggled off in the menu. When it is toggled off, the current results will go back 

on the scoreboard. 

 

When to use this: 

 

 Anytime the console is reset and the operator wants to display Time of Day on the 

scoreboard. This might be during a break in the meet. 

 

The Edit Menu allows the operator to manually edit the team  

scores for display on auxiliary team score scoreboards and  

edit the basic event order. 

Edit Team Score 
This menu is used to manually edit up to 4 team scores for  

display on auxiliary team score scoreboards. The * identifies  

which team score is being edited.  

 

 

 

 

Enter a score of 0 to 999 using the [0]-[9] keys. The * indicates which score is ready to enter. 

Press [Enter] on the last score to post the scores to the scoreboard and advance to the Edit – 

Event Order Menu. If the operator is in the Edit – Team Score Menu and wants to exit without 

saving the data, press [Clear]. This will exit the menu and return to the 1-Team Score Menu. 

 

Some operators will use the four scores (H, G1, G2 & G3) as HOME and GUEST for men and 

women or HOME and GUEST for varsity and junior varsity. Another option is to post the 

men‘s scores when a men‘s event is finished, and the women‘s scores when a women‘s event 

is finished.  

 

When to use this: 

 

 Typically team scores are updated on the scoreboard after each event is finished  

and scored. 

MENU-SCOREBOARD 
FORMAT: 24 HOUR* 

MENU-SCOREBOARD 
DISPLAY TOD? 

MENU-MAIN 
2-EDIT MENU 

MENU-EDIT 
1-TEAM SCORE 

H   000   G1   000 
G2  000    G3   000 

From Main Menu – [1]>[3] 

From Main Menu – [2]  

From Edit Menu – [2]>[1] 



Record Time 
This menu is used to set an event‘s record time to  

be displayed. 

 

 

 

 

Enter a record time with the keypad and press [Enter]. Press [Clear] twice to leave this 

unchanged and return to the Edit menu. 

 

The Print Menu is where the operator can print a specific  

race result, the current event order in the OmniSport 2000 

console, or the settings for the current console configuration. 

Print Race Results 
This menu is used to print races that are stored in the  

OmniSport 2000 console‘s revolving race memory. See 

Section 4.12 for more information about the revolving race  

memory. Each time the console times a race, that race is assigned a race number. The race 

number increments by one each time a new race is started and counts up from 1 to 999. When 

the console gets to race number 999, it rolls over and the next race number is 1. The console 

has enough memory to store approximately the last 50 races. If the memory in the console is 

full and a new race needs to be stored, the console deletes the oldest race in its memory.  

 

 

 

 

To print a stored race, press [0]-[9] to enter the desired race number and press [Enter]. The 

LCD screen will then prompt the operator to verify the entered race number. Press [YES] to 

print the selected results. Though Section 4.10 refers to swimming, refer to that section for 

more information and printout samples. Press [NO] to ignore the selection and return to the 

Print Menu.  

 

 

 

 

If the desired race has been deleted from the console‘s memory, the LCD screen will flash 

Race Not Found. 

 

When to use this: 

 

 Use this when a race result is needed to be re-printed on the console‘s built-in 

thermal printer. 

Print Settings 
This menu is used to print the console‘s configuration  

to the thermal printer inside the console.  

 

MENU-EDIT 
2-RECORD TIME 

EDIT TIME 
REC: ▪▪:▪▪.▪ 
 

MENU-MAIN 
3-PRINT MENU 

MENU-PRINT 
1-RACE RESULTS 

PRINT RESULTS 
RACE NUMBER 772* 

MENU-PRINT 
2-SETTINGS 

From Edit Menu – [2]>[2]>[2] 

From Main Menu – [3] 

PRINT RESULTS 
RACE NOT FOUND 

From Main Menu – [3]>[1] 



 

 

 

 

Press [YES] to print the settings. Press [NO] to exit the menu without printing. 

 

When to use this: 

 

 Print the settings after the console has been set up and verified that all is functioning 

correctly. Keep this printout for future reference. It will be valuable if the console is 

loaned out to someone else, unknowingly a change was made in the console, or if the 

console was returned to or exchanged by Daktronics for service. 

 It is a good idea to pull out the known good settings and verify them to a new 

printout when the equipment is being set up for a meet. 

 

This menu lets the console know how the track is used, which  

inputs to use, how to read those inputs and what to do with  

those inputs. The console will retain these configurations when it is powered up again.  

Timer 
This menu configures the track settings. 

Number of Lanes 
The console can be configured to time the number of lanes used. 

 

 

 

 

Press [0]-[9] to select the number (1-10) of lanes on the track, and then [Enter] to save. 

Start In 
The console can be configured to receive inputs from  

different starting devices. Some start devices are an  

open switch that closes (Normally Open) and others are  

a closed switch that opens (Normally Closed).  

 

 

 

 

The Start Input can be configured to receive normally open or normally closed start signals. 

Select ―N.O.‖ for normally open type start inputs. Select ―N.C.‖ for normally closed-type 

start inputs (Default=N.O.).  

 

Press [←] [→] to toggle the setting from N.O. to N.C., and then press [Enter] to save.  

 

Note: Normally Open (N.O.) is the standard setting for Daktronics timing accessories with 

the OmniSport 2000 timer. 

MENU-PRINT 
PRINT SETTINGS? 

MENU-MAIN 
4-SETUP MENU 

MENU-SETUP 
1-TIMER 

MENU-TIMER 
1-# OF LANES 

MENU-TIMER 
# OF LANES: 8  

MENU-TIMER 
2-START IN 

MENU-TIMER 
START IN: N.O.* 

From Main Menu-[3>[2] 

From Main Menu-[4] 

From Main Menu-[4]>[1] 

From Main Menu - [4]>[1]>[2]  



Primary Time: 
This menu will configure the console for which timing  

input(s) to use as the primary time.  

 

 

 

 

Primary Time is used to tell the timer to use J7 and 1 button per lane for up to 8 lanes,  

or to use J10 1, 2, or 3 buttons for up to 10 lanes. Press [←] [→] to toggle between  

J7 or J10 settings.   

 

 Input: J7 - 1 button 

 Input: J10 - 1 button, 2 buttons, or 3 buttons 
 

Press [Enter] to save or press [Clear] to exit without saving. 

 

Note: When three buttons are used, final times are printed when the middle time is received. 

If two buttons are being used, the time of the second button is printed after both buttons are 

pressed. If one button is used, that is the time. In non-lane events, only one button for lane 

one is used for all racers. 

Precision 
The OmniSport 2000 console is an extremely accurate  

timing device. This menu tells the timer if it should  

report and display the times to one hundredth (1/100) or  

one thousandth (1/1000) of a second.  

 

 

 

 

Use [←][←] to select between 1/100 or 1/1000 of a second, and then press [Enter] to save. 

 

This menu configures how the console will display data  

on a Lane, Place and Time numeric scoreboard. 

Number of Lines 
This menu sets the number of lines (1-10) of lane data that the 

scoreboard will display. If the number of active lanes in the  

track is greater than the value set, the timer will automatically  

page the information in place order. The default is 10. 

 

 

 

 

Press [0]-[9] to enter the number of lines, and then press [Enter] to save.  

 

MENU-TIMER 
3-PRIMARY TIME MENU-TIMER 

IMPUT = J7 1BTN* 

MENU-TIMER 
4-PRECISION 

MENU-TIMER 
PREC: 1/100* 

MENU-SETUP 
2-SCOREBOARD 

MENU-SCOREBOARD 
1-NUMERIC 

MENU-NUMERIC 
1 - # OF LINES 
 

# OF LINES 
LINES:  ▪4* 

From Main Menu – [4]>[1]>[3]  

MENU-TIMER 
IMPUT = J10 3BTN* 

From Main Menu – [4]>[2] 

From Main Menu – [4]>[1]>[4]  

From Main Menu – [4]>[2]>[1]>[1]  



Finish Page Time 
This menu configures how long each page of the  

Finish Times will hold on the scoreboard.  

 

 

 

 

The typical time is set at 5 seconds. Press [0]-[9] to enter the appropriate length of time the 

finish time will appear on the display, and then press [Enter] to save.  

Results Order 
This menu configures the console to display results on the  

scoreboard in either Lane Order or Place Order. If the number  

of lanes on the track is greater than the number of lines  

that the scoreboard will display, the timer will display the information in place order 

regardless of this setting. The default is Lane Order. 

 

 

 

 

 

Press [←] or [→] to select either Lane or Place, and then press [Enter] to save.  

 

When to use this: 

 

 Select Lane to display the results in the order of the lane in which the runners 

finished.  

 

 Select Place to display the results in the order of which the runners placed.  

Show DQ 
This menu configures what will show on a numeric scoreboard  

when there is a disqualification (DQ).  

 

 

 

 

Press [←] or [→] to display either DQ Time or DQ Only, and then press [Enter] to save. 

Football SCBD  
This setting determines if Event/Heat or Guest 2/3 will be  

displayed on the TO GO and BALL ON digits on the bottom  

of a on the bottom of a Football/Track scoreboard. 

 

 

 

 

Press [←] or [→] to display either Event/Heat data or Guest 2/3 scores, and then press [Enter] 

to save. 

MENU-NUMERIC 
2-FIN PAGE TIME FIN PAGE TIME 

TIME=  ▪0* 

MENU-NUMERIC 
3-RESULTS ORDER 

RESULTS ORDER 
ORDER: LANE* 

MENU-NUMERIC 
5-FOOTBALL SCBD 

FOOTBALL SCBD 
SHOW-EVENT/HEAT* 

From Main Menu – [4]>[2]>[1]>[3]  

From Main Menu – [4]>[2]>[1]>[2]  

MENU-NUMERIC 
4-SHOW DQ 

SHOW DQ 
STATUS=DQ/TIME* 

SHOW DQ 
STATUS=DQ ONLY* 

From Main Menu – [4]>[2]>[1]>[4]  

FOOTBALL SCBD 
SHOW-GUEST 2/3 * 

From Main Menu – [4]>[2]>[1]>[5]  



Running Time 
This menu sets what data is displayed on a single line  

numeric scoreboard.  

 

 

 

 

 

Press [←] or [→] to display either Continuous running data or the Finish scores, and then 

press [Enter] to save. 

 

This menu sets the output data configuration for the specific  

matrix display in use.  

Number of Lines 
This menu sets the # of Lines of lane data being sent to   

the matrix scoreboard. If the number of lanes on the track  

is greater than the value set, the timer will automatically  

page the information in place order. The default is 10.  

 

 

 

 

 

Press [0]-[9] to enter the number of lines appropriate to the facility‘s display, and then press 

[Enter] to save.  

 

Note: If the number of lanes on the track is greater than the number of lines set, the timer will 

automatically page the information in place order. For splits—only the first place split will 

display and hold for the amount of time set in the Split Hold Time menu. Finish Times will 

page according to the amount of time set in the Finish Page Time menu.  

Finish Page Time 
Select Finish Page Time to configure the length of time that  

finish times remain on the scoreboard. 

 

 

 

 

The typical time is set at 5 seconds. Press [0]- [9] to enter the appropriate length of time the 

finish time will appear on the display, and then press [Enter] to save.  

Results Order 
This menu configures the console to display results  

on the scoreboard in either Lane Order or Place Order. If the  

number of lanes on the track is greater than the number of  

 

MENU-SCOREBOARD 
2-RTD/MATRIX 
 

# OF LINES 
LINES:  10* 

MENU-RTD/MATRIX 
2-FIN PAGE TIME 

FIN PAGE TIME 
TIME: NN * 

From Main Menu – [4]>[2]>[1]>[6]  

MENU-RTD/MATRIX 
1-# OF LINES 

From Main Menu – [4]>[3]>[2]>[1] 

From Main Menu – [4]>[3]>[2] 

From Main Menu – [4]>[3]>[2]>[2]  

MENU-NUMERIC 
6-RUNNING TIME 

SING LINE DISP 
RT= CONTINUOUS* 

SING LINE DISP 
RT= FINISH 

MENU-RTD/MATRIX 
3-RESULTS ORDER 



lines that the scoreboard will display, the timer will display the information in place order 

regardless of this setting. The default is Lane Order. 

 

 

 

 

 

Press [←] or [→] to select either Lane or Place. Press [Enter] to save. 

 

When to use this: 

 

 Select Lane to display the results in the order of the lane in which the athletes 

finished.  

 

 Select Place to display the results in the order of which the athletes placed.  

 

The following Comm (Communication) Ports menus select  

the protocol used for transmitting data to the display and 

communicating with a results program. 

Scoreboard Outputs 
Select Scoreboard Outputs to assign a protocol  

used to transmit data in outputs (J2and J3). 

 

 

 

 

 

Press [←] or [→] to select Multicast, Multidrop, Multiline or Omega protocol, depending on  

the type of display used, and then press [Enter] to save.  

 

When to use this: 

 

 The OmniSport 2000 supports several generations of displays.  Currently there are 

three different types of Daktronics protocols. Multicast, Multidrop, and Multi-line.  

 

 The newest generation of display for aquatics is the SW-5000 series. This series of 

display will auto-detect the protocol being sent by the OmniSport 2000 console. In 

most cases the console should be set to Multicast. 

 

 The previous generation of displays for aquatics was the SW-2000 series. This 

generation required a protocol plug to determine which protocol it was receiving. To 

test which protocol is configured, unplug the signal to the display from the back of 

the console. Cycle power to the display. When it powers up, the display will show 

either P0 or P1 on the left two digits. 

P0 – console to Multidrop 

P1 – console to Multi-line.   

 

MENU-SETUP 
3-COMM PORTS 

MENU-COMM PORTS 
1-SCBD OUTPUTS 

MENU-COMM PORTS 
SCBD: MULTIDROP* 

From Main Menu – [4]>[3]>[1] 

From Main Menu – [4]>[3] 

RESULTS ORDER 
ORDER-LANE* 

RESULTS ORDER 
ORDER-PLACE* 

From Main Menu – [4]>[3]>[2]>[3]  



 An OmniSport 2000 cannot run a Daktronics glow cube display directly. A glow cube 

display will require an interface in order to be controlled by an OmniSport 2000 

console. When using a glow cube interface, set the OmniSport 2000 console to 

Multidrop. 

 

 If the display is one manufactured by Omega, set the console to Omega. 

RTD Configurations 
The RTD Port is used to select the protocol (RTD or CTS)  

to transmit out of the J5 RTD port on the OmniSport 2000  

console. RTD means Real Time Data. CTS means Colorado  

Timing System. The default is RTD.  

 

 

 

 

Press [←] or [→] to select RTD to send information to a Daktronics Venus 7000 or 1500 

display controller or CTS to send to a numeric CTS scoreboard, and then press [Enter]  

to save. 

Results Port 
The Results Port configures which protocol  

(OmniSport 2000 or 6000 console, or a CTS console) will be  

used to communicate with the meet management software. 

 

 

 

 

 

The OmniSport 2000 (default) and the OmniSport 6000 are bi-directional protocols.The CTS 

console is unidirectional protocol, utilizing the standard CTS scoreboard information. 

 

Press [Enter] and press [←] or [→] to select OmniSport 2000, OmniSport 6000 or CTS protocol, 

depending on what the meet management software is expecting to receive, and then press 

[Enter] to save.  

 

Note: If using an older version of Hy-Tek Meet Management, it may require configuring  

this port to the OmniSport 6000 data. Selecting Omni 6000 transmits Omni 6000 RTD item 

numbers on the RTD output 

 

This menu configures which printouts will be printed on the  

built-in printer in the console as well as the intensity of the  

print on those printouts.  

 

 

 

  

MENU-COMM PORTS 
2-RTD PORT 

MENU-COMM PORTS 
RTD PORT: RTD* 

MENU-COMM PORTS 
3-RESULTS PORT 

MENU-COMM PORTS 
RSLT: OMNI 2000* 

MENU-SETUP 
4-PRINTER 

From Main Menu – [4]>[3]>[3] 

From Main Menu – [4]>[3]>[2] 



Race Log 
The Race Log allows the logging to be turned ON/OFF.  

Typically the Race Log is set ON. 

 

 

 

 

Press [←] or [→] to toggle between ON/OFF, and then press [Enter] to save.  

 

When to use this: 

 

 Using the Race Log is the most thorough way to identify issues with the system. 

Daktronics recommends that the Race Log is always turned on. 

Results 
The Results Menu selects printouts by LANE or PLACE order. 

The Results printout format is usually determined by preference  

of the person handling the meet management program and is  

used for verification. 

 

 

 

  

Press [←] or [→] to toggle between ON/OFF, and then press [Enter] to save.  

Backups 
This menu configures if backup times will be printed  

with the race results. Printing Backup Times usually is  

determined by the preference of the person handling the  

meet management program.  

 

 

 

 

Press [←] or [→] to toggle between YES/NO, and then press [Enter] to save.  

Intensity 
This menu sets the printer‘s depth of contrast  

for easy readability. The typical level is set at 5. 

 

 

 

 

Press [Enter]>[1-5] to select a new intensity, and then press [Enter] to save.  

 

 

 

MENU-PRINTER 
1-RACE LOG 
 

MENU-PRINTER 
RACE LOG: ON* 

MENU-PRINTER 
2-RESULTS 
 

MENU-PRINTER 
RSLTS BY: LANE* 

MENU-PRINTER 
3-BACKUPS 

MENU-PRINTER 
BACKUPS: YES* 

MENU-PRINTER 
4-INTENSITY 

PRINT INTENSITY 
LEVEL 1-5:  5* 

From Main Menu – [4]>[4]>[1] 

From Main Menu – [4]>[4] 

From Main Menu – [4]>[4]>[2] 

From Main Menu – [4]>[4]>[3] 

From Main Menu – [4]>[4]>[4] 



 

This menu is used to set the console‘s date and time. 

 

 

 

 

Press [0-9] to enter the correct date and time. Press [Enter] to accept the setting. Press [Clear] 

twice to exit without saving and retain the previous time and date.  

 

The OmniSport 2000 timer is equipped with features that  

test battery level, the lane modules and the numeric  

scoreboard. The following submenus explain how to use  

each of these tests. It is important to run through these tests before the meet begins to prevent 

problems from occurring during the meet. 

Battery 
This menu checks the battery power level. 

 

 

 

 

The battery level will show as CHARGED or LOW. Press [Enter] to exit the menu.  

Lane Modules 
This menu tests the lane module inputs. 

 

 

 

 

The two left LCDs will show the lane module input status by lane. Press [Enter] to exit  

the menu. 

Scoreboard 
These menus check the numeric scoreboard drivers.  

Cycle On/Off 
This menu checks the signal to the scoreboard. 

 

 

 

 

Press [1] to toggle the scoreboard ON and OFF. When this menu is selected, an all ON signal 

is sent at intervals of approximately 3 seconds. This will continue to cycle ON and OFF until 

pressing [Enter] to continue.  

MENU-SETUP 
5-TIME OF DAY DATE 01/01/00 * 

TOD  04:11:23  

MAIN MENU 
5-TEST MENU 

BATTERY TEST 
LEVEL: CHARGED 

MENU-TEST 
2-LANE MODULES 

 NEAR END DATA 
 FAR END DATA 

MENU-TEST 
3-SCOREBOARDS 

DISPLAY ALL ON 
ENTER TO EXIT 

From Main Menu – [4]>[5] 

MENU-TEST 
1-BATTERY 

From Main Menu – [5>[1]] 

From Main Menu – [5]>[2] 

SB TEST MENU 
1-CYCLE ON/OFF 

From Main Menu – [5]>[3>[1] 

From Main Menu – [5] 

From Main Menu – [5]>[3] 



Driver Address 
This menu shows which addresses each of the drivers on 

the scoreboard are set to. The address plugs were inserted  

when the display was installed.  

 

 

 

 

Press [2] to display the driver addresses. This will remain on the display until [Enter]  

is pressed.  

Digit Number 
This menu displays the digit designation. 

 

 

 

 

Press [3] to display a digit number. The number or letter will show which output on the 

driver that digit is plugged into. This will remain on the display until [Enter] is pressed.  

Switch 
This menu checks the lane buttons port on the rear of  

the console. 

    1      2      3      4      5           6       7     8      9       10 

 

 

 

 

When pressing one of the push buttons that is plugged into the Track Button Interface, a ―C‖ 

will display in that lane on one of the left two LCD screens.  

 

SB TEST MENU 
2-DRIVER ADDRESS 

SHOWING ADDRESS 
ENTER TO EXIT 

SB TEST MENU 
3 - DIGIT NUMBER SHOWING DIGIT # 

ENTER TO EXIT 

MENU - TEST 
4 - SWITCH 

C   O   O   O   O 

From Main Menu – [5]>[3]>[2] 

From Main Menu – [5]>[3]>[3] 

From Main Menu – [5]>[4] 

O   O   O     
 

TEST - SWITCH 
C-CLOSED O-OPEN 





Section 16: Daktronics Exchange and Repair & 
Return Programs 

To serve customers’ repair and maintenance needs, Daktronics offers both an exchange program 

and a repair & return program. 

 

Daktronics unique Exchange Program is a quick service for replacing key parts in need of 

repair. If a part requires repair or replacement, Daktronics sends the customer a replacement 

and the customer sends the defective part to Daktronics. 

Before Contacting Daktronics 
Identify these important part numbers: 

 

Console Serial Number: _____________________________________________________________  

Model Number: ___________________________________________________________________  

Contract Number: _________________________________________________________________  

Date Installed: _____________________________________________________________________  

Daktronics Customer ID Number: ____________________________________________________  

Exchange Program 
To participate in the Exchange Program, follow these steps: 

Call Daktronics customer service. 

 

Schools (primary through community/junior colleges), religious 

organizations, municipal clubs, and community c[Enter]s 

877-605-1115 

Universities and professional sporting events, live events for auditoriums, 

and arenas 

866-343-6018 

 

When the new exchange part is received, mail the old part to Daktronics. 

If the replacement part fixes the problem, send in the problem part which is being replaced. 

 

a. Package the old part in the same shipping materials in which the replacement 

part arrived. 

b. Fill out and attach the enclosed UPS shipping document. 

c. Ship the part to Daktronics. In most circumstances, the replacement part will be 

invoiced at the time it is shipped. 

 

If, after the exchange is made the equipment is still defective, please contact Customer 

Service immediately. Daktronics expects immediate return of an exchange part if it does not 

solve the problem. The company also reserves the right to refuse parts that have been 

damaged due to acts of nature or causes other than normal wear and tear. 



 

For items not subject to exchange, Daktronics offers a Repair & Return Program. To send a 

part for repair, follow these steps:  

 

 Call or fax Daktronics Customer Service:  

Refer to the appropriate market number in the chart listed on the previous page. 

Fax: 605-697-4444 

 

 Receive a Return Materials Authorization (RMA) number before shipping. 

This expedites repair of the part. 

 

 Package and pad the item carefully to prevent damage during shipment. 

Electronic components, such as printed circuit boards, should be placed in an 

antistatic bag before boxing. Daktronics does not recommend packing peanuts  

for packaging. 

 

 Enclose: 

 

a. Contact name 

b. Address 

c. Phone number 

d. The RMA number 

e. Clear description of symptoms 

Shipping Address 
Daktronics Customer Service 

PO Box 5128 

331 32nd Ave 

Brookings, SD 57006 

Daktronics Warranty and Limitation of Liability 
The Daktronics Warranty and Limitation of Liability is located in Appendix F. The Warranty 

is independent of Extended Service agreements and is the authority in matters of service, 

repair, and display operation.  
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Appendix A: Drawings 

The Daktronics drawing number is located in the bottom right corner of the drawing. Refer to Section 

1.1 for information regarding how to read the drawing number.  

 

The following drawings are filed in alphanumerical order. 

A Drawings 
OmniSport 2000 Connector Designations .................................................... Drawing A-154282 

Channel Selection; Single Control Console, Gen IV .................................... Drawing A-180566 

Channel Selection; Single Broadcast Group, Gen IV ................................... Drawing A-180922 

Channel Selection; Multiple Broadcast Group, Gen IV ................................ Drawing A-180923 

HS-200 Horn Start; On-Deck Configuration ................................................. Drawing A-185695 

System Riser; FB/Track Scbd W/Omni 2000, Track Side ............................ Drawing A-186535 

System Riser; Track Scbd W/Omni 2000, Track Side.................................. Drawing A-186548 

System Riser; RC-100, Rodeo/Diving/Sync Swimming ............................... Drawing A-230608 

Mounting, Relay Take-Off Platform .............................................................. Drawing A-268945 

B Drawings 
Insert: OmniSport 2000 Swimming ............................................................... Drawing B-163808 

Insert: OmniSport 2000 Diving ..................................................................... Drawing B-180044 

Insert: OmniSport 2000 Water Polo ............................................................. Drawing B-182350 

Insert: OmniSport 2000 Track ...................................................................... Drawing B-184685 

Insert: OmniSport 2000 Pace Clock ............................................................. Drawing B-188395 
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Appendix B: Quick Reference 

This section includes: 

OmniSport 2000 Swimming Quick Reference ....................................................... ED13584.pdf 

OmniSport 2000 and Hy-Tek MEET MANAGER Quick Guide ............................. ED13876.pdf 

OmniSport 200 Pro Diving Quick Start Guide ....................................................... ED16444.pdf 
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Special Timer Operations Action 

Always Ready Start 
 If a start was missed because the timer was not reset, or if the 

timer was reset following a valid start you can still recover the 
race. It is important that this is completed before the timer 
receives the first touches. 

After the timer has been reset, press [EDIT]. The timer prompts 
you for the time of day that the start was received. The time 
displayed on the LCD will be the time of day from the last start 
received. If this is not the desired start time, you will find all of the 
start times received printed on the log printout. Type in the 
correct start time of day and press [ENTER]. 

Setting the arming delay 
 The arming delay is the amount of time after a start or split that 

the timer will ignore touchpad presses.  This is primarily used in 
relays to allow a finished athlete time to exit the pool without 
adding a touch to the timer.  The arming delay for each 
touchpad is displayed on the LCD’s under the appropriate lane 
number. 

Press [MENU]>[4]>[2]>[5] and then use the numeric keypad to 
enter an arming delay of 0-99 seconds followed by [ENTER]. To 
return to the main swimming screen, press [MENU]. 

Test screen for the lane modules. 
Press [MENU]>[5> [2] to show the lane module test screen. To 
return to the main swimming screen press [MENU]. 

Entering Home, Guest 1, Guest 2, and Guest 3 scores. 
Press [MENU]>[2]>[1] and then enter in the team scores using the 
numeric keypad followed by [ENTER]. To return to the main 
swimming screen, press [MENU]. 

Printing an Event Order. 
Press [MENU]>[3]>[2], [ENTER]. To return to the main swimming 
screen, press [MENU]. 

Printer Paper Specifications 
The OmniSport 2000 uses standard thermal calculator rolls of 
paper. They are 2-

1
/4" x 155'. Some rolls are 165' long; just tear 

off 10' and throw it away. 

OMNISPORT
®
 2000 SWIMMING QUICK REFERENCE 

 
1. Confirm that the timer is reset. 

Look at the right LCD, line 1. If the running time is not 
00:00.0, press [RESET]>[ENTER]. 

Before  
Race 

2. Set the timer to the correct event and heat. The right LCD,  
line 2 displays E:(event) H:(heat) R:(round) L:(total lengths). 

Press [EVENT/HEAT] and type in the correct event and heat 
numbers. If using a programmed event order, press [NEXT 

EVENT], [HEAT +1] or [HEAT –1] 

 3. Verify the  correct number of lengths for the current event and 
heat. 

Look on the right LCD, line 2. If not correct, press 
[LENGTHS] and type in the correct number. 

 
1. Timer Starts. 

Typically started automatically from the horn start.  
(Optional: [START] for manual start).  

During  
Race 

2. Turn off any unused lanes. 
Press [LANE ON/OFF] to turn the desired lanes off.  Press 
again to turn on. 

 3. Watch the lengths complete counter and lane status for each 
individual lane. 
 With touchpads at the near end only, the timer will show the 

lane status on line 1 of the left two LCDs and line 2 will show 
the lengths completed for that lane. 

 With touchpads at both ends, press [] and [] to scroll forward 
or backward through these three views: 

Page 1 Near end status on line 1 and far-end status on line 2. 
Page 2 Near end status on line 1 with lengths complete on line 2. 
Page 3 Lengths complete on line 1 with far-end status on line 2. 

If a lane has an extra touch and the arming delay is 
counting for that lane, press [SPLIT ARM (1-10)]. This 
removes the last touch and arm the lane for the next split. 

 If a lane has an extra 
displays, press [TOUCH], [(1-10)]>[ENTER] 

 If a lane is missing a touch, press [+touch]>[(1-
10)]> [ENTER] 

If the finish of the race is about to happen and the lane 
status is not “*”, either press [FINISH ARM (1-10)] for the 
appropriate lane(s), or [FINISH ARM ALL]>[ENTER]. 

 
1. Confirm that all lanes with an athlete have finished. 

Look at the left two LCD’s to verify that the final touch has 
been received. 

After 
Race 

2. DQ any disqualified athletes. Press [DQ], [(1-10)] and [ENTER] for each appropriate lane. 

 3. Print out the results with backup times. Press [STORE/PRINT] and review the printout. 

 
4. Edit the race results (for advanced operators only). 

Press [EDIT] to get into this function. See the OmniSport 
2000 operator’s manual for complete instructions. 

 5. If any of the results were modified, print out the results again. Press [STORE/PRINT]. 

 
6. Reset the timer and get ready for the next event. 

Press [RESET]>[ENTER]. The scoreboard will continue to 
display the results of the last race until the start of  
the next race. 

Lane Status Indicators: 

(Blank) Lane is Off. 

Timer is Reset. 

99-1 
(counting 

down) 

Arming delay. When there are numbers 
counting down, the timer will ignore any 
touchpad presses. 

Lane is armed for split time. 

Lane is armed for finish (last length). 

o Race is over for this lane. 

? There is a problem with the lane module. 

Printout Time Label Descriptions 

Plus touch 

Minus touch 

B (1-3) Buttons 1 through 3 

R Relay take-off platform trigger 

Discrepancy between touchpad and backup 

B or BK Backup time 

E Edited time 

M Manual time 

F Early relay exchange 

R (1-3) Relay exchange 1 through 3 
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[1] SCBD MENU 
 [11] SCBD ON/OFF 
 [12] DIMMING 
 [13] TIME OF DAY 
[2] EDIT MENU 
 [21] TEAM SCORE 
 [22] EVENT ORDER 
  [221] EDIT ORDER 
  [222] INSERT EVENT 
  [223] DELETE EVENT 
  [224] CLEAR ORDER 
[3] PRINT MENU 
 [31] RACE RESULTS 
 [32] EVENT ORDER 
 [33] SETTINGS 
[4] SETUP MENU 
 [41] POOL 
  [411] # OF LANES 
  [412] LANE ORDER 
  [413] LENGTH 
  [414] LANE LABEL 

 

[42] TIMER 
 [421] START IN 
 [422] LM INPUT 
 [423] PRIMARY TIME 
 [424] FLAG TIME 
 [425] ARMING DELAY 
 [426] PRECISION 
 [427] RELAY TAKE-OFF 
[43] SCOREBOARD 
 [431] NUMERIC 
  [4311] # OF LINES 
  [4312] SPLIT HOLD TIME 
  [4313] FIN PAGE TIME 

[4314] RESULTS ORDER 
[4315] SUBTRACTIVE 
[4316] SHOW DQ 
[4317] SHOW START 

[432] RTD/MATRIX 
  [4321] # OF LINES 
  [4322] SPLIT HOLD TIME 
  [4323] FIN PAGE TIME 

[4324] RESULTS ORDER 
[4325] SUBTRACTIVE 
[4326] SHOW DQ 

 

[4327] SHOW START 
[4328] SHOW PLACE 
[4329] RTD OFFSET 

[44] COMM PORTS 
[441] SCBD OUTPUTS 
[442] RTD PORT 
[443] RESULTS PORT 

[45] PRINTER 
[451] RACE LOG 
[452] RESULTS  
[453] BACKUPS 
[454] SPLITS 
[455] INTENSITY 

[46] TIME OF DAY 
[5] TEST MENU 
 [51] BATTERY 
 [52] LANE MODULES 
 [53] SCOREBOARD 
  [531] CYCLE ON/OFF 
  [532] DRIVER ADDRESS 

[533] DIGIT NUMBER 

 

PREMEET SET-UP 

1. Place touchpads into the pool. Verify that the brackets are adjusted correctly. 

2. Horn start Place the horn start in the desired start location. 

3. Speakers Mount the lane and auxiliary speakers in their desired locations. 

4. OmniSport 2000 Place the OmniSport 2000 on the timing table (do not plug power in at this time). 

5. Lay out the deck cabling. 
Inspect the cabling and connectors for corrosion and damage. Clean with the brush provided in 
the maintenance kit as needed. 

6. Connect the deck cabling: 
includes start cables, speaker 
cables, lane modules (on-
deck), deck extensions  
(on-deck), cables to wall plates  
(in-deck), push buttons and 
touchpads. 

Squeeze a small amount of silicone, supplied in the maintenance kit, up into the neck of the 
silicone tube. Insert the male pins of the banana connectors into the neck of the tube to coat the 
connectors with a small amount of silicone. Connect the cables together. For the dual banana 
cables, make sure the GND tab on the male plug lines up with the black connector on the 
female jack. It is not necessary to silicone the connectors that plug directly into the horn start or 
the OmniSport 2000. 

7. Connect the scoreboard. 
Verify that power is turned on to the scoreboard and that signal is connected to the OmniSport 
2000 J2 port. 

8. Connect the results computer. 
Connect the results computer to the OmniSport 2000 J6 port using a straight through 9 pin male  
DB to 9 pin female DB cable. 

9. Connect power to console. Plug the transformer into AC power and into the back of the OmniSport 2000 J13 port. 

10. Turn on the OmniSport 2000. Turn the power switch on the OmniSport 2000 on. Enter the date and time. 

11. Print the timer settings. 
Print the timer settings by pressing [MENU]>[3]>[3]>[ENTER]. Verify that the timer is configured 
correctly for the upcoming meet and pool set-up. 

12. Test the system. 
Run the system through at least one test race by starting with the horn start and finishing with 
all of the push buttons and touchpads. Also verify that all of the speakers are functional. 

OmniSport 2000 Swimming Menu Navigation 
 
Two methods for navigating through the OmniSport 2000 menus: 
 
The first method allows the operator to step through each of the menu levels. To use this method, press [MENU] and then use [], [], 
[], and [] to scroll through the menu’s. Press [ENTER] to select the menu displayed on the LCD. 

 
The second method is to go directly to a menu. Press [MENU] followed by the one to four digit number from the list below and the LCD 
will prompt you for the desired setting or action in that menu.  (Example 425 will prompt you to enter a new Arming Delay.) 
 

After you are done navigating through the menus, press [MENU] to return to the race in progress.  
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[1] SCBD MENU 
 [11] SCBD ON/OFF 
 [12] DIMMING 
 [13] TIME OF DAY 
[2] EDIT MENU 
 [21] TEAM SCORE 
 [22] EVENT ORDER 
  [221] EDIT ORDER 
  [222] INSERT EVENT 
  [223] DELETE EVENT 
  [224] CLEAR ORDER 

[23] CLEAR ORDER (A-D) 
 [24] DIVER ORDER 

[25] CLEAR TOTALS 
 [26] DIVER TOTALS 
[3] PRINT MENU 
 [31] DIVE RESULTS 
 [32] EVENT ORDER 
 [33] SETTINGS 
 [34] IND DIVE LIST 
 [35] ALL DIVE LIST 

 

[4] SETUP MENU 
 [41] TIMER 
  [411] NUMBER JUDGES 
  [412] POSITION CODE 
 [42] NUMERIC SCBD 
  [421] # OF LINES 
  [422] LEAD DIVER 
  [423] MULTISPORT SB 

[43] COMM PORTS 
  [431] SCBD OUTPUTS 
  [432] RTD PORT 
  [433] RESULTS PORT 

[44] PRINTER 
  [441] DIVE LOG 

[442] INTENSITY 
[45] TIME OF DAY 

[5] TEST MENU 
[51] BATTERY 

 [52] SCOREBOARD 
  [521] CYCLE ON/OFF 
  [522] DRIVER ADDRESS 

[523] DIGIT NUMBER 
[53] JUDGES CONSOLE 

 

OmniSport 2000 Diving Menu Navigation 
 
 
Two methods for navigating through the OmniSport 2000 menus. 
 
The first method allows the operator to step through each of the menu levels. To use this method press [MENU] and 
then use [], [], [], and [] to scroll through the menu’s. Press [ENTER] to select the menu displayed on the LCD. 

 
The second method is to go directly to a menu. Press [MENU] followed by the one to three digit number from the list 
below and the LCD will prompt you for the desired setting or action in that menu.  (Example: 32 will print the Event 
Order). 
 

After you are done navigating through the menus, press [MENU] to return to the race in progress.  

Special Functions 
 

Editing a Divers Total Score 
 Press [MENU]>[2]>[6]. Next, press [] and [] to display the diver number and their total score on the right LCD. 

Press [ENTER] and use [0]-[9] to input the correct total. Press [ENTER] to finish editing that diver. 

Clearing the Total Scores without clearing the Dive Order 
 Press [MENU]>[2]> [5]>[ENTER]. 

Printing the Total Scores for the current Dive Order 
 Press [PRINT> [1]>[ENTER]. 

Printing the Dive List for the current Diver 
 Press [MENU]>[2]>[ENTER]. 

Printing the Dive List for all divers in the current Dive Order 

 Press [MENU]>[3]>[ENTER]. 



         ED13584     PO Box 5128    201 Daktronics Dr.      Brookings, SD 57006 
         Rev 6     22 January 2009                Tel 605-697-4300 or 800-DAKTRONICS   Fax 605-697-4700  
         Page 4 of 8    www.daktronics.com  e-mail: helpdesk@daktronics.com  

 

 
Typical Diving Operation 

 

The diving program in the OmniSport 2000 console will allow up to 25 divers for four different dive orders  

(labeled A, B, C, and D). Each Dive Order can have up to 13 rounds. 

 

You can pre-program dive sheets for each diver, or you can enter them while the event is running. 

 

If you are using a programmed Event Order configured with Swimming and Diving event numbers, the first event  

that is set to diving will be Dive Order A, the second will be Dive Order B, the third Dive Order C and the  

fourth will be Dive Order D. If there are more than four Diving events, they will switch back to Dive Order A when selected. 

 

 
Step 1: 
Clear any old information from the Dive Orders A to D. 

 Press [SELECT ORDER]>[A] to set the current Diver Order to A. 

 Press [MENU]>[2]>[3]>[ENTER] to clear out Dive Order A. 

 Repeat this step selecting [B], [C], [D] to clear the remaining Dive Orders. 

 

Step 2: (Optional) 
Enter the Dive List for each of the divers in Dive Order A. 

 Press [SELECT ORDER]>[A] to set the current Diver Order to A. 

 Verify on the left LCD that the Diver # and Round are both set to 01. 

 Enter the first diver’s dive list by pressing [MENU]>[2]>[4]>[ ENTER]. 

 The LCD will prompt you to enter the Dive and Position. Use the numeric keypad to enter the four digit dive number 

and the [A], [B], [C], or [D] key to select the position. Press [ENTER] to accept the dive and position. Use the numeric 

keypad to enter the degree of difficulty (DD) for the dive selected. Press [ENTER] to accept the DD and increment 

the round by one. Repeat this sequence to enter the dive, position, and DD for each additional round for the 

selected diver. 

 After the first diver’s dive list is entered, press [] to increment the diver by one. Press [] as many times as 

necessary to decrement the round to one. Now repeat the above instructions for each diver’s dive list. 

 NOTE: When in the Editing Order menu, use [] to decrement the round by one, [] to increment the round by 

one, [] to decrement the diver by one, and [] to increment the diver by one.  

 Press [Print]>[3]> [ENTER] to print the dive list for all the divers in the selected dive order. 

 Repeat this step selecting [B], [C], [D] to pre-program each dive orders. 

 

Step 3: 
 Press [MENU]>[4]>[1] and enter [2], [3], [5], [7], or [9] to enter the correct number of judges. If seven or nine judges 

are selected, it will prompt you for the correct formula. 

 

Step 4: 
 Press [SELECT ORDER] and [A], [B], [C], or [D] to select the desired dive order. 

 Verify on the left LCD that the diver number and round are both set to 01. 

 

Step 5: 
 Select a diver, dive, position, and DD. 

 When the Dive Order is pre-programmed: (pre-programming is done in Step 2 of this list.) 

 Verify on the center LCD that the correct dive, position and DD are programmed. 

 If not, press [EDIT] and correct any mistakes. 

 Press [SCORE] and the left two LCDs will prompt you for the judge’s scores. 

When the Dive Order is not pre-programmed: 

 Press [SCORE] and the left two LCDs will prompt you to enter dive and position. Use the numeric keypad to enter 

the three or four digit dive number and [A], [B], [C], [D] for the position. Press [ENTER] to accept the dive and 

position. Use the number pad to enter the DD for the dive selected, then press [ENTER]. The left two LCDs will 

prompt you for the judge’s score. 

 Use [0], [.5] thru [10] on the insert to fill in the judge’s scores. Press [FAIL] or [BALK] if they apply. 

 When the correct judge’s scores have been filled in, press [SCORE] to accept the award score and advance to the 

next diver in that round and repeat Step 5. 

 If that was the last diver for that round, press [] to increment the round by one. Next, press  

[DIVER ]>[1]>[ENTER] then repeat Step 5. 
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OMNISPORT
®
 2000 TRACK QUICK REFERENCE 

 

1. Confirm that the timer is reset. 
Look at the right LCD, line 1 to verify that the running 
time is 00:00.0.  If it is not, press [RESET]>[ENTER]. 

Before  
Race 

2. Set the timer to the correct Event and Heat. 
The right LCD, line 2 displays E:(event) H:(heat)  

Press [EVENT/HEAT] and type in the correct event and 
heat numbers, or use [EVENT +1], [HEAT +1], [HEAT –1].  

 

3. Confirm that the timer is set correctly to time 
either a lane or non-lane event. 

Look at the right LCD; line 2 to verify which mode of 
timing the console is currently in. To change the mode 
of timing, press [LANE TIMING] or [NON-LANE TIMING]. 

During  
Race 1. Timer starts. 

Typically started automatically from the horn start, 
pushbutton or gun transducer. (Optional: [START] for 
manual start).  

 2. Turn off any unused lanes. 
Press [LANE ON/OFF (1-10)] to turn the desired lanes off. 
Press again to turn them back on. 

 1. Confirm that all lanes with an athlete have 
finished. 

Look at the left two LCDs to verify that the final time has 
been received. 

 2. DQ any disqualified athletes. Press [DQ]>[(1-10)]>[ENTER] for each appropriate lane. 

 3. Print the results. Press [STORE/PRINT] and review the printout. 

After 
Race 

4. Edit the race results. (For advanced operators 
only.) 

Press [EDIT] to get into this function. See the OmniSport 
2000 operator’s manual for complete instructions. 

 5. If any of the results were modified, print the 
results again. 

Press [STORE/PRINT]. 

 

6. Reset the timer and get ready for the next event. 
Press [RESET]>[ENTER]. The scoreboard will continue to 
display the results of the last race until the start of the 
next race. 

Lane Status Indicators: 

(Blank) Lane is Off. 

Timer is Reset. 

1-2 
(counting 

down) 

Arming delay. When there are numbers counting 
down, the timer will ignore any button presses. 

Lane is armed for finish. 

o Race is over for this lane. 

? There is a problem with the button interface. 

Special Timer Operations Action 

Always Ready Start 
 If a start was missed because the timer was 

not reset, or if the timer was reset following a 
valid start you can still recover the race.  It is 
important that this is completed before the 
timer receives the first finish times. 

After the timer has been reset, press [EDIT]. The timer prompts you for 
the time of day that the start was received. The time displayed on the 
LCD will be time of day from the last start received. If this is not the 
desired start time, you will find all of the start times received printed on 
the log printout.  Type in the correct start time of day and press [ENTER]. 

Entering Home, Guest 1, Guest 2, and Guest 3 
scores. 

Press [MENU]>[2]>[1] and then enter in the team scores using the 
numeric keypad, followed by [ENTER]. To return to the main track 
screen, press [MENU]. 

Entering a record time. Press [MENU]>[2]>[2] and then enter in the record time using the 
numeric keypad followed by [ENTER]. To return to the main track screen, 
press [MENU]. 

Printout Time Label Descriptions 

B (1-3) Buttons 1 through 3 

B or BK Backup time 

E Edited time 

M Manual time 
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[1] SCBD MENU 
 [11] SCBD ON/OFF 
 [12] DIMMING 
 [13] TIME OF DAY 
[2] EDIT MENU 
 [21] TEAM SCORE 

[22] RECORD TIME 
[3] PRINT MENU 

[31] RACE RESULTS 
[32] SETTINGS 

[4] SETUP MENU 
[41] TIMER 

[411] # OF LANES 
[412] START IN 
[413] PRINARY TIME 
[414] PRECISION 

[42] SCOREBOARD 
[421] NUMERIC 

[4211] # OF LINES 
[4212] FIN PAGE TIME 
[4213] RESULTS ORDER 
[4214] SHOW DQ 
[4215] FOOTBALL SCBD 
[4216] RUNNING TIME 

  
 

[432] RTD/MATRIX 
[4321] # OF LINES 
[4322] FIN PAGE TIME 
[4323] RESULTS ORDER 

[43] COMM PORTS 
  [431] SCBD OUTPUTS 

  [432] RTD PORT 
[433] RESULTS PORT 

[44] PRINTER 
[441] RACE LOG 
[442] RESULTS 
[443]BACKUPS 
[444] INTENSITY 

[45] TIME OF DAY 
[5] TEST MENU 

[51] BATTERY 
[52] LANE MODULES 
[53] SCOREBOARD 

[531] CYCLE ON/OFF 
[532] DRIVER ADDRESS 
[533] DIGIT NUMBER 

[54] SWITCH 

OmniSport 2000 Track Menu Navigation 
 
 Two methods for navigating through the OmniSport 2000 menus. 
 
The first method allows the operator to step through each of the menu levels. To use this 
method press [MENU] and then use [], [], [], and [] to scroll through the menu’s. Press 
[ENTER] to select the menu displayed on the LCD. 

 
The second method is to go directly to a menu. Press [MENU] followed by the one to four digit 
number from the list below and the LCD will prompt you for the desired setting or action in 
that menu. (Example: 4211 will ask you to enter the number of lines on the numeric display.) 
 
After you are done navigating through the menus, press [MENU] to return to the race  
in progress.  
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[1] SCBD MENU 
 [11] SCBD ON/OFF 
 [12] DIMMING 
 [13] TIME OF DAY 
[2] PAPER FEED 
[3] SETUP MENU 
 [31] TIMER 

[311] SET TIMES 
[3111] PERIOD TIME 
[3112] OVER TIME 
[3113] REST TIME 
[3114] WARNING TIME 
[3115] SHOT TIME 
[3116] TIME OUT TIME 
[3117] PENALTY TIME 

[312] AUTO RUN 
[313] SHOT =0 CONTROL 
[314] PENALTIES 
[315] TIME OUTS 
[316] HORN CONTROL 

 
 
 

  
 
 
 
 

[321] NUMERIC SCBD  
[3211] # OF LINES 

  [3212] SCORE MODULE 
[322] RTD/MATRIX 

[33] COMM PORTS 
  [331] SCBD OUTPUTS 

[332] RTD PORT 
[333] RESULTS PORT 

[34] PRINTER 
[341] GAME LOG 
[342] INTENSITY 

[35] TIME OF DAY 
[4] TEST MENU 

[41] BATTERY 
[42] SCOREBOARD 

  [421] CYCLE ON/OFF 
  [422] DRIVER ADDRESS 

[423] DIGIT NUMBER 

  

OmniSport 2000 Water Polo Menu Navigation 
 
Two methods for navigating through the OmniSport 2000 menus. 
 
The first method allows the operator to step through each of the menu levels. To use this 
method press the [MENU] key and then use [], [], [], and [] to scroll through the menu’s. 
Press [ENTER] to select the menu displayed on the LCD. 

 
The second method is to go directly to a menu. Press [MENU] followed by the one to three digit 
number from the list below and the LCD will prompt you for the desired setting or action in that 
menu. (Example 211 will prompt you to enter the period time.) 
 

After navigating through the menus, press [MENU] to return to the game in progress.  

Special Functions 
 
To view penalties 2 and 3 on the LCD’s 

 Press [] to scroll down, press [] to scroll up. 
Adding a penalty: 

 Press [PLAYER PENALTY +1] under Home or Guest. The penalty time will start counting 

immediately. You will then be prompted to enter the player number. Valid player numbers are 
from 1 to 13. If the player that is entered already has three penalties, the penalty will blank out 
and be disregarded. 

Deleting a penalty that is currently counting: 

 Press [DELETE PENALTY ] under Home or Guest. Notice the arrow [] next to the Player number. 

If this is not the desired penalty to be deleted press the [] or [] to select the desired penalty. 

When the [DELETE PENALTY ] is first pressed, the arrow will be next to the last penalty entered for 

that team. 
Editing the penalty totals for players 1-13: 

 Press [EDIT PLAYER ] under Home or Guest. Use the numeric keypad to enter the desired player 
number followed by [ENTER]. You will now be prompted to enter the correct number of penalties in 

a range from 0 to 3. 
To disable all penalty timers: 

  Press [DISABLE PENALTY TIMER] to keep the penalty times from counting when the game clock is 

counting. 
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[1] SCBD MENU 
 [11] SCBD ON/OFF 
 [12] DIMMING 
 [13] TIME OF DAY 
[2] EDIT MENU 
 [21] EDIT WORKOUT (followed by lane #) 

[211] EDIT STEP 
[212] INSERT STEP 
[213] DELETE STEP 
[214] COPY WORKOUT 
[215] CLEAR WORKOUT 

[3] PRINT MENU 
 [31] IND WORKOUT 

[32] ALL WORKOUTS 
[33] SETTINGS 

[4] SETUP MENU 
[41] TIMER 
[42] SCOREBOARD 

[421] # OF LINES 
[422] MATRIX SCBD MENU 

[43] COMM PORTS 
  [431] SCBD OUTPUTS 

  [432] RTD PORT 
[433] RESULTS PORT 

[44] PRINTER 
[441] INTENSITY 

[45] TIME OF DAY 
[5] TEST MENU 

[51] BATTERY 
[52] SCOREBOARD 

[521] CYCLE ON/OFF 
[522] DRIVER ADDRESS 
[523] DIGIT NUMBER 

OmniSport 2000 Pace Clock Menu Navigation 
 

Two methods for navigating through the OmniSport 2000 menus. 
 
The first method allows the operator to step through each of the menu levels. To use this 
method press [MENU] and then use [], [], [], and [] to scroll through the menus. Press [ENTER] 
to select the menu displayed on the LCD. 

 
The second method is to go directly to a menu. Press [MENU] followed by the one to four digit 
numbers from the list below and the LCD will prompt you for the desired setting or action in that 
menu. (Example 431 will prompt you for multiline or multidrop protocol on the numeric 
scoreboard comm. port output). 
 
After navigating through the menus, press [MENU] to return to the pace clock program operation.  

Special Functions 
 
Creating a Workout for a Lane. 

 Press [EDIT] for the desired lane that is to have a workout created or edited. 
 Use [] and [] to select the step # or enter the number and press [ENTER]. 
 Use [] and [] or 1 thru 6 to select the type of step and press [ENTER]. Keys are 1=STOP, 

2=BEGIN CIRCUIT, 3=END CIRCUIT, 4=SWIM, 5=REST, 6=PACE 
 Enter the time of the step for steps that are Swim, Rest or Pace. 
 Enter the repeat count for steps that are Swim, Rest, or Begin Circuit. 
 Repeat the above steps for each additional step. 

 
Insert or Delete a step in a Workout for a Lane. 

 Press [MENU]>[2]>[1] and the Lane number to modify and then press [ENTER]. 
 Press [2] for insert or [3] for delete, then use [] and [] to select the step number 

 or enter the step number and press [ENTER] to insert a new step or delete that step. 
 
Copy a Workout to Another Lane. 

 Press [MENU]>[2]>[1] and the Lane number to copy from and then press [ENTER]. 
 Press [4] to select the copy menu and enter the Lane # to copy and press [ENTER]. 

 
Clear a Workout for a Lane. 

 Press [MENU]>[2]>[1] and the Lane number to clear and then press [ENTER]. 
 Press [5] to select the workout to clear and press [ENTER] to clear it. 
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Introduction 

The OmniSport 2000 timer is tightly integrated with Hy-Tek’s MEET 
MANAGEMENT software. The timing console is also the link between the 
software and a Daktronics Venus 1500 or 7000 matrix controller. 

MEET MANAGER’s Timer Interface with the          
OmniSport 2000 Console 

1. Download Event Orders from MEET MANAGER to the 
OmniSport 2000 console. 
 

A. Events are programmed in the order that they are 
actually swum.  Example 2, 1, 4, 3. This might be used 
when distance events are swam at a different time than 
the main events. 

B. Up to 500 different events numbered from 1-999Z can be 
included into one Event Order. The letter following the 
event number can be used to identify different divisions, 
sex, age, etc.—example 25A, 25B, 122, 122Z 

C. Events include a Round designator to distinguish prelims 
from semi's from finals. 

D. The number one Record time in MEET MANAGER is 
included for display on a numeric Record Time 
scoreboard. This will eliminate the need for additional 
operator entry. 
 

2. Retrieve times from the OmniSport 2000 to MEET MANAGER. 
 

A. Touchpad times 
B. Button times 
C. Split times 
D. By Event and Heat number 
E. By Race number 
F. With touchpad and button times, MEET MANAGER can 

calculate backup times according to the official rule book. 
G. Start reactions 
H. Exchanges 

 
3. MEET MANAGER will send the current start list to the 

OmniSport 2000 Pro Swimming software. 

MEET MANAGER’s Alpha Scoreboard Interface with 
the OmniSport 2000 Console 

1. The OmniSport 2000 console is the link between MEET 
MANAGER and a Venus matrix controller. The following 
types of information are accessible from MEET MANAGER 
by the console for display onto a matrix scoreboard. 
 

A. Start list 
B. Results by Heat 
C. Results by Event 
D. Women’s scores 
E. Men’s scores 
F. Mixed scores 

 
2. The above 

information is 
requested in Real 
Time, this 
guarantees the 
latest lane 
assignments, 
results and scores 
are displayed on 
the matrix scoreboard. The possibility that  
a lane assignment was changed in MEET MANAGER  
and not on the scoreboard will not happen.  
 

3. This interface reduces the number of connections  
and cables by 33% enabling the MEET MANAGER to be 
operated on a laptop requiring only one (1) serial port.  
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In addition to connections and cables, the user friendliness 
 is also greatly improved making some operations work as  
if on autopilot.  

 Connections 

1. The cable between the OmniSport 2000 and MEET MANAGER is 

a straight through 9-pin DB male-to-female cable. Connect J6 on 

the console to the serial port on the MEET MANAGER computer. 

2. The cable between the OmniSport 2000 console and Venus 7000 

computer is a dedicated straight through 9-pin DB male-to-female 

cable. Connect J5 on the console to the serial port on the Venus 

computer. 

3. If using a Venus 1500 controller, the cable between the OmniSport 

2000 console and the display is a two-conductor copper 22-guage 

shielded cable. Connect to the M2 or M3 controller on the display. 

Refer to your display manual.  

 

 

Configuring the OmniSport 2000 Console 

OmniSport 2000 Console with MEET MANAGER Software 

To configure the console, press [Menu]>[4]>[4]>[3] from the main 
menu. Verify that the right LCD screen displays RSLT: OMNI 2000 on 
line 2. If it does not, press [→] until it  
appears then press [Enter]. Press [Menu]  
to return to the main menu. 

OmniSport 2000 Console with Venus Controller 

To configure the console, press [Menu]>[4]>[4]>[3] from the main 
menu. Verify that the right LCD screen display RTD PORT: RTD on 
line 2. If it does not, press [→] until it  
appears then press [Enter]. Press [Menu]  
to return to the main menu. 

OmniSport 2000 Console with Pro Swim Software 

From the main menu of the  
OmniSport 2000 Pro Swim software, 
select Options > Configure.  
 

In the Configure menu, select the Comm 

Ports tab. Next make sure the MEET 
MANAGER Port is set to  
OmniSport 2000  
and that the RTD 
Port is set to RTD.  
Click OK when 
finished. 
 
 
 
 
 
 

 

 

 

MENU-COMM PORTS 
RSLT: OMNI 2000 * 
 

MENU-COMM PORTS 
RTD PORT: RTD * 
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1. From the main menu of MEET MANAGER, select Set-up then 
Timing Console INTERFACE. 

 
2.  Next select Daktronics OmniSport 2000 from the list and  

click OK. 

Configuring MEET MANAGER Alpha Scoreboard 
INTERFACE to Daktronics 

1. From the main menu of MEET MANAGER, select Set-up the 
Alpha Scoreboard INTERFACE. 

 
2. Next select Daktronics from the list and click OK. 

 
 

Configuring MEET MANAGER to Communicate 
with the OmniSport 2000 Console 

1. From the Run Menu of MEET MANAGER, select  
Interface >Timer(Dak2) > Open/Close Serial Port for Dak2. 

 
 

 
 
 
 

 
2. The following menu will 

appear. Enter the Serial 
Com Port that will be 
used to connect MEET 
MANAGER to the 
OmniSport 2000. 
Typically this is 1. Next 
click OK. 
 

3. When all 
connections and 
configurations are 
correct,  
the menu shows 
Communications Passed with the version of firmware in the 
OmniSport 2000 console. Click OK. 
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Downloading an Event Order from MEET 
MANAGER to the OmniSport 2000 Console 

When downloading an Event 
Order, make sure that the 
OmniSport 2000 console is in 
swimming mode and that the 
running time is reset. From the 
Run Menu of MEET 
MANAGER, select  
Interfaces >Timer (Dak2).  

 
The following message will 
appear. Along as this is the 
correct Event Order,  
click Yes. 
 
After the Event Order has 
been successfully transferred, 
the following message will 
appear. Click OK. 
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The OmniSport 2000 Pro software works together with the OmniSport 2000 
timer and gives officials total control over dive meets through an easy-to-use, 
reliable, and convenient user interface. 

Registering the Software 

The registration window appears when the Pro Diving software is first 
opened. You may temporarily skip the registration by clicking Evaluate. 
After 30 days you will be required to register the software.  

Online Registration 

1. Enter the Customer ID and Password for the online registration 

account. This information will be provided after purchasing the 

software online at buy.daktronics.com. 

2. Click Register Online. 

3. Click OK in the registration confirmation box.  

Manual Registration 

1. Call 1-888-325-7828 or email DakStats@daktronics.com. 

2. Give the Serial Number to Daktronics. 

3. Type in the Code from Daktronics to unlock the software. 

Using the Splash Screen 

The splash screen is the first screen you will see after the registration 
window. This screen contains many frequently-used tasks and other 
options for setting up the program and meets. 

 

Communication Configuration 

If the Pro Diving software is unable to detect the OmniSport 2000 
console, ensure the cable is connected to a serial (COM) port on the 
computer and to the expansion port on the console. If they are, check 
the COM port settings in the Configure Communications menu.  
 

1. From the splash screen, 
click Connect to 

OmniSport. 
2. In the Select Com Port 

window, select the proper 
serial port that is connected 
to the OmniSport console.  

3. Click OK. 
4. The console’s LCD screen 

should then display Controlled by Pro Diving. 
 
 

 

 

http://buy.daktronics.com/
mailto:DakStats@daktronics.com
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Creating a New Meet 

Click Create A Meet to begin a setup wizard to add new meets.  

 

1. Type in a descriptive Meet Name.  
2. Choose a date on the calendar if different from the current date, and 

then click Next.  
 
Use this screen to add, delete, and edit all of the events for the meet: 

 

 
 
 
 

 

3. Click Add Event to insert a new event to the meet: 
 

 
 
o Type in a descriptive Title for the event, and then select 

the number of Rounds and the Gender.  
 
Note: Change the External settings if using the third-
party Hy-Tek® MEET MANAGER software. 
 

o Click Next to continue on to the next screen: 
 

 

o Select if the event will be Synchronized. 
o Select the number of Judges. 
o Select the Formula for calculating the scores. 
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o Select the Type of board. 
o Select the how the dive Position will be annotated. 
o Select the DD Table if different from FINA. 
o Click Next to continue on to the next screen.  

 
Use this screen to add/remove divers from the roster: 
 

 
 

o Fill in the information for the diver(s), and then click Add.  
o Add or Remove divers from the roster as needed, and then 

click Finish.  
 

4. Add more events as needed, or edit/delete existing events.  
5. Click Finish when all events for the meet have been set up. 

 

Opening A Meet 

After creating a meet, click Yes to 
open the new meet right away. 
Otherwise click No, and then click 
Open A Meet and select the meet 
from the drop-down list.  

 

Running A Meet 

Once a meet has been opened, the main application screen will 
appear. This screen is where you follow the action of the meet to 
record divers’ scores.  

 

1. In the Event Order tab, right-click on diver or diving team and 
select Make Active to allow their scores to be entered. 

2. Click the Next button in the Judge Scores section. 
3. Select the Dive# and Position and click OK. 
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4. If the judges are equipped with properly configured consoles, their 
scores will populate automatically. Otherwise, you can manually 
type in each judges’ score. 

 

 
 

5. After receiving or entering all of the judges’ scores, click Accept. 
6. Continue clicking Next and Accept to enter the scores for every 

diver/team in each round until the meet is finished. 

Other Meet Actions 

The Pro Diving software features several ways to perform common 
actions through onscreen buttons, right-clicking divers, the ribbon menu 
bar, and shortcut keys. Be sure to experiment with the software before 
running a meet to find the method that works best for you. 
 

 

Generating Reports 

The Pro Diving software offers the ability to quickly create printouts of 
many types of meet information.  
 

 Click Run Reports on the splash screen to open a window that 
allows you to generate many report types at a single time. 

 

 
 

 Alternately, click the Reports tab on the main application screen 
to create individual reports during a meet.  

 

 



Appendix C: Menu Navigation Shortcuts 

Swimming Menu Navigation 
1) SCOREBOARD MENU  

1-1) SCBD ON/OFF clears the display; yes or no 

1-2) DIMMING sets the brightness level of the display 

1-3) TIME-OF-DAY displays the Time-of-Day; yes or no 

2) EDIT MENU functions 

2-1) TEAM SCORE allows editing of team scores 

2-2) EVENT ORDER allows editing of event orders 
2-2-1) EDIT ORDER edits event order  
2-2-2) INSERT EVENT inserts an event into the order  
2-2-3) DELETE EVENT deletes an event  
2-2-4) CLEAR ORDER clears event order  

3) PRINT MENU  

3-1) RACE RESULTS prints the results of a specific race or a complete meet 

3-2) EVENT ORDER prints out the selected event orders 

3-3) SETTINGS prints out all configurations entered in the Setup Menu 

4) SETUP MENU functions 

4-1) POOL is for configuring the pool settings 
4-1-1) # OF LANES sets the number of lanes  
4-1-2) LANE ORDER selects the lane order  
4-1-3) LENGTH sets the pool length  
4-1-4) LANE LABEL selects lane labeling 

4-2) TIMER is used to configure the timer settings 
4-2-1) START IN selects the type of start input  
4-2-2) LM INPUT selects near and far end of pool  
4-2-3) PRIMARY TIME selects which input is the primary time: touchpads or buttons  
4-2-4) FLAG TIME selects the time period for flagging lane times  
4-2-5) ARMING TIME selects the time for arming touchpads after a touch  
4-2-6) PRECISION selects the timer precision; 1/100 or 1/1000 of a second  
4-2-7) RELAY TAKE-OFF sets timer to allow for relay results  

4-3) SCOREBOARD is used to set the scoreboard configurations 
4-3-1) NUMERIC sets output data for numeric scoreboards 

4-3-1-1) # OF LINES sets the number of lines on the display 
4-3-1-2) SPLT HOLD TIME sets the hold time for display of splits 
4-3-1-3) FIN PAGE TIME sets the hold time for finish page 
4-3-1-4) RESULTS ORDER selects for lane or place order 
4-3-1-5) SUBTRACTIVE SPLITS selects whether or not to page subtractive splits 
4-3-1-6) SHOW DQ chooses what data displays when there is a DQ 
4-3-1-7) SHOW START chooses whether or not to display the start reaction 

4-3-2) RTD/MATRIX sets output data for matrix displays  
4-3-2-1) # OF LINES sets the number of lines on the display 
4-3-2-2) SPLT HOLD TIME sets the hold time for display of splits 
4-3-2-3) FIN PAGE TIME sets the hold time for finish page 
4-3-2-4) RESULTS ORDER selects for lane or place order 
4-3-2-5) SUBTRACTIVE SPLITS selects whether or not to page subtractive splits 
4-3-2-6) SHOW DQ chooses what data displays when there is a DQ 
4-3-2-7) SHOW START determines whether or not to show the start reaction time 
4-3-2-8) SHOW PLACE determines whether or not to show split times with places 
4-3-2-9) RTD OFFSET chooses how data is sent to the display using multiple consoles 

4-4) COMM PORTS allows selection of communication ports 
4-4-1) SCBD OUTPUT selects Multicast, Multidrop, Multiline, or Omega display protocol  
4-4-2) RTD PORT selects RTD or CTS protocol  
4-4-3) RESULTS PORT selects OmniSport 2000, Omni 6000, or CTS Results protocol  

4-5) PRINTER is used to configure the printouts and printer 
4-5-1) RACE LOG turns race logs on/off 
4-5-2) PRINT ORDER selects lane or place order 
4-5-3) BACKUPS selects whether backup times are printed or not 
4-5-3) SPLITS selects if split times are printed  
4-5-4) INTENSITY selects printer intensity  

4-6) TIME-OF-DAY allows the setting of the time and day 



5) TESTING MENU  

5-1) BATTERY checks battery status 

5-2) LANE MODULES allows the testing of lane modules 

5-3) SCOREBOARD allows testing of the scoreboard 
5-2-1) CYCLE ON/OFF turns the display on and off 
5-2-2) DRIVER ADDRESS selects the driver address 
5-2-3) DIGIT NUMBER confirms digits are operational 

Diving Menu Navigation 
 

1) SCBD MENU  

1-1) SCBD ON/OFF clears the display; yes or no 

1-2) DIMMING sets the brightness level of the display 

1-3) TIME-OF-DAY displays the time-of-day; yes or no 

2) EDIT MENU  

2-1) TEAM SCORE allows editing of team scores 

2-2) EVENT ORDER allows editing of event orders 
2-2-1) EDIT ORDER edit event order 
2-2-2) INSERT EVENT inserts an event into the order 
2-2-3) DELETE EVENT deletes an event  
2-2-4) CLEAR ORDER clears event order 

2-3) CLEAR ORDER A (A-D) clears only one of the four dive orders 

2-4) DIVER ORDER allows editing of the diver order 

2-5) CLEAR TOTALS clears scoring totals 

2-6) DIVER TOTALS edits diver score totals 

3) PRINT MENU  

3-1) DIVE RESULTS prints the results of the dives or a complete meet 

3-2) EVENT ORDER prints out the selected event orders 

3-3) SETTINGS prints out all configurations entered in the Setup Menu 

3-4) IND DIVE LIST prints the individual dive list of a selected diver 

3-5) ALL DIVE LIST prints out the entire dive list 

4) SETUP MENU 

4-1) JUDGES sets the number of judges used in the meet 

4-2) NUMERIC SCBD sets output data for numeric scoreboards 
4-2-1) # OF LINES sets the number of lines on the display 
4-2-2) LEAD DIVER sets the lead diver 
4-2-3) MULTISPORT SB selects the type of numeric scoreboard 

4-3) COMM PORTS allows selection of communication ports 
4-3-1) SCBD OUTPUT selects Multicast, Multidrop, Multiline, or Omega display protocol 
4-3-2) RTD PORT selects between RTD or CTS protocol 
4-3-3) RESULTS PORT selects OmniSport 2000, Omni 6000, or CTS Results protocol 

4-4) PRINTER configures the printouts and printer. 
4-4-1) DIVE LOG turns dive log on/off 
4-4-2) INTENSITY selects printer intensity 

4-5) TIME-OF-DAY allows the setting of the time and day 

5) TEST MENU 

5-1) BATTERY checks battery status 

5-2) SCOREBOARD allows testing of scoreboard 
5-2-1) CYCLE ON/OFF turns the display on and off 
5-2-2) DRIVER ADDRESS selects the driver address 
5-2-3) DIGIT NUMBER confirms digits are operational 

5-3) JUDGE CONSOLE indicates proper connection of judge consoles 
 
 
 
 
 
 



Water Polo Menu Navigation 
 

1) SCOREBOARD MENU  

1-1) SCBD ON/OFF clears the display; yes or no 

1-2) DIMMING sets the brightness level of the display 

1-3) TIME-OF-DAY displays the Time-of-day; yes or no 

2) PRINT MENU  

2-1) PAPER FEED advances the printer paper 

3) SETUP MENU functions 

3-1) TIMER is for configuring the Track settings 
3-1-1) SET TIMES 

3-1-1-1) PERIOD TIME sets the timing length of the period 
3-1-1-2) OVERTIME sets the timing length of the overtime period 
3-1-1-3) REST TIME sets the timing length of the rest periods 
3-1-1-4) WARNING TIME sets the timing length of warning times 
3-1-1-5) SHOT TIME sets the timing length of the shot time 
3-1-1-6) TIMEOUT TIME sets the timing length of timeouts 
3-1-1-7) PENALTY TIME sets the timing length of the penalties 

3-1-2) AUTO SEQUENCE sets the automatic clock run 
3-1-3) SHOT = 0 CONTROL sets if the shot clock = 0 will stop the main clock 
3-1-4) PENALTIES sets the maximum amount of penalties, and reset of shot clock 
3-1-5) TIMEOUTS sets the maximum number of timeouts 
3-1-6) HORN CONTROL selects how the game clock and shot clock horns operate 

3-2-1) NUMERIC SCBD sets output data for numeric scoreboards 
3-2-1-1) # OF LINES sets the number of lines on the display 
3-2-1-2) SCORE MODULE sets the number of lines on the display 

3-2-2) RTD/MATRIX sets output data for matrix displays 

3-3) COMM PORTS allows selection of communication ports 
2-3-1) SCBD OUTPUT selects between RTD or CTS protocol 
2-3-2) RTD PORT selects between RTD or CTS protocol 
2-3-3) RESULTS PORT selects OmniSport 2000, Omni 6000, or CTS Results protocol 

3-4) TIME-OF-DAY allows the setting of the time and day 

4) TESTING MENU  

4-1) BATTERY checks battery status 

4-2) SCOREBOARD allows testing of scoreboard 
4-2-1) CYCLE ON/OFF tests the display by turning all digits on and off 
4-2-2) DRIVER ADDRESS displays which driver controls which digit 
4-2-3) DIGIT NUMBER displays the numerical address of each digit\ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Pace Clock Menu Navigation 
 

1) SCOREBOARD MENU  

1-1) SCBD ON/OFF clears the display; yes or no 

1-2) DIMMING sets the brightness level of the display 

1-3) TIME-OF-DAY displays the Time-of-day; yes or no 

2) EDIT MENU  

2-1) EDIT WORKOUT selects which lane’s workout to edit 
2-1-1) EDIT STEP edits a step within the order 
2-1-2) INSERT STEP inserts a step into the order 
2-1-3) DELETE STEP deletes a step 
2-1-4) COPY WORKOUT copies the workout from one lane to another 
2-1-5) CLEAR WORKOUT clears the workout from a lane 

3) PRINT MENU  

3-1) IND WORKOUT prints the entire workout for a specific lane 

3-2) ALL WORKOUTS prints all workouts for every lane 

3-3) SETTINGS prints out all configurations entered in the Setup Menu 

4) SETUP MENU 

4-1) TIMER is not activated 

4-2) SCOREBOARD sets output data for numeric scoreboards 
4-2-1) # OF LINES sets the number of lines on the display 
4-2-2) RTD/ MATRIX sets output data for matrix displays 

4-2-2-1) RTD OFFSET chooses how data is sent to the display using multiple consoles 

4-3) COMM PORTS allows selection of communication ports 
4-3-1) SCBD OUTPUTS selects Multicast, Multidrop, Multiline, or Omega display protocol 
4-3-2) RTD PORT selects between RTD or CTS protocol 
4-3-3) RESULTS PORT selects OmniSport 2000, Omni 6000, or CTS Results protocol 

4-4) PRINTER configures the printouts and printer 
4-4-1) INTENSITY selects printer intensity 

4-5) TIME-OF-DAY allows the setting of the time and day 

5) TESTING MENU  

5-1) BATTERY checks battery status 

5-2) SCOREBOARD allows testing of the scoreboard 
5-2-1) CYCLE ON/OFF turns the display completely on and off 
5-2-2) DRIVER ADDRESS displays the scoreboard address 
5-2-3) DIGIT NUMBER displays the digit number 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Track Menu Navigation 
 

1) SCOREBOARD MENU 

1-1) SCBD ON/OFF clears the display; yes or no 

1-2) DIMMING sets the brightness level of the display 

1-3) TIME-OF-DAY displays the time-of-day; yes or no 

2) EDIT MENU  

2-1) TEAM SCORE allows editing of team scores 

2-2) RECORD TIME allows editing of record times 

3) PRINT MENU 

3-1) RACE RESULTS prints the results of a specific race or a complete meet 

3-2) SETTINGS prints out all configurations entered in the Setup Menu 

4) SETUP MENU  

4-1) TIMER is used to configure the timer settings 
4-1-1) # OF LANES sets the number of lanes 
4-1-2) START IN selects the start input 
4-1-3) PRIMARY TIME sets the number of timing buttons used per lane 
4-1-4) PRECISION selects the timer precision; 1/100 or 1/1000 of a second 

4-2) SCOREBOARD is used to set the scoreboard configurations 
4-2-1) NUMERIC sets output data for numeric scoreboards  

4-2-1-1) # OF LINES sets the number of lines on the display 
4-2-1-2) FIN PAGE TIME sets the hold time for finish page 
4-2-1-3) RESULTS ORDER selects for lane or place order 
4-2-1-4) SHOW DQ chooses what data displays when there is a DQ 
4-2-1-5) FOOTBALL SCBD sets the timer output to a football display 
4-2-1-6) RUNNING TIME determines what data is shown in a single line numeric scoreboard 

4-3-2) RTD/MATRIX selects near and far end of pool 
4-3-2-1) # OF LINES sets the number of lines on the display 
4-3-2-2) FIN PAGE TIME sets the hold time for finish page 
4-3-2-3) RESULTS ORDER selects lane or place order 

4-3) COMM PORTS allows selection of communication ports 
4-3-1) SCBD OUTPUT selects between RTD or CTS protocol 
4-3-2) RTD PORT selects between RTD or CTS protocol 
4-3-3) RESULTS PORT selects OmniSport 2000, Omni 6000, or CTS Results protocol 

4-4) PRINTER is used to configure the printouts and printer 
4-4-1) RACE LOG turns race logs on/off 
4-4-2) RESULTS selects style in which race results are printed 
4-4-3) BACKUPS selects whether backup times are printed or not 
4-4-4) INTENSITY selects printer intensity 

4-5) TIME-OF-DAY allows the setting of the time and day 

5) TESTING MENU 

5-1) BATTERY checks battery status  

5-2) LANE MODULES allows the testing of lane modules 

5-3) SCOREBOARD allows testing of the scoreboard 
5-3-1) CYCLE ON/OFF tests the display by turning all digits on and off 
5-3-2) DRIVER ADDRESS displays which driver controls which digit 
5-3-3) DIGIT NUMBER displays the numerical address of each digit 

5-4) SWITCH tests push button inputs over port J7 

 





Appendix D: RTD Output Specifications  

This appendix contains Real-Time Data (RTD) output specifications for the OmniSport 2000/6000.  

 

Serial Port (COM) Transmission Specifications 

Baud Rate:               19,200 

Parity:                       None 

Data Bits:                  8 

Protocol:                   Enhanced 

Size:                          4096 

OmniSport 2000 Swim RTD Item Numbers (OS2-Swimming.itf) 

Field # Function Length Justification Item Number 

1 Running time 9 L 1 

2 Event title line 1 30 L 10 

3 Event title line 2 30 L 40 

4 Event title lines 1 & 2 30 L 70 

5 Event number 3 R 100 

6 Event number-Alpha 1 L 103 

7 Heat number 2 R 104 

8 Heat number-Alpha 20 L 106 

9 Round number 1 L 126 

10 Maximum lengths to complete 2 R 127 

11 Lengths completed 2 R 129 

12 Record 1 name 12 L 131 

13 Record 1 code 2 L 143 

14 Record 1 time 9 L 145 

15 Record 2 name 12 L 154 

16 Record 2 code 2 L 166 

17 Record 2 time 9 L 168 

18 Record 3 name 12 L 177 

19 Record 3 code 2 L 189 

20 Record 3 time 9 L 191 

21 Record 4 name 12 L 200 

22 Record 4 code 2 L 212 

23 Record 4 time 9 L 214 

24 Line 1 swimmer name 15 L 223 

25 Line 1 team name 5 L 238 

26 Line 1 lane number 2 R 243 

27 Line 1 place number 3 R 245 

28 Line 1 split/finish time 9 L 248 

29 Line 1 lengths completed 2 R 257 



Field # Function Length Justification Item Number 

30 Line 2 swimmer name 15 L 259 

31 Line 2 team name 5 L 274 

32 Line 2 lane number 2 R 279 

33 Line 2 place number 3 R 281 

34 Line 2 split/finish time 9 L 284 

35 Line 2 lengths completed 2 R 293 

36 Line 3 swimmer name 15 L 295 

37 Line 3 team name 5 L 310 

38 Line 3 lane number 2 R 315 

39 Line 3 place number 3 R 317 

40 Line 3 split/finish time 9 L 320 

41 Line 3 lengths completed 2 R 329 

42 Line 4 swimmer name 15 L 331 

43 Line 4 team name 5 L 346 

44 Line 4 lane number 2 R 351 

45 Line 4 place number 3 R 353 

46 Line 4 split/finish time 9 L 356 

47 Line 4 lengths completed 2 R 365 

48 Line 5 swimmer name 15 L 367 

49 Line 5 team name 5 L 382 

50 Line 5 lane number 2 R 387 

51 Line 5 place number 3 R 389 

52 Line 5 split/finish time 9 L 392 

53 Line 5 lengths completed 2 R 401 

54 Line 6 swimmer name 15 L 403 

55 Line 6 team name 5 L 418 

56 Line 6 lane number 2 R 423 

57 Line 6 place number 3 R 425 

58 Line 6 split/finish time 9 L 428 

59 Line 6 lengths completed 2 R 437 

60 Line 7 swimmer name 15 L 439 

61 Line 7 team name 5 L 454 

62 Line 7 lane number 2 R 459 

63 Line 7 place number 3 R 461 

64 Line 7 split/finish time 9 L 464 

65 Line 7 lengths completed 2 R 473 

66 Line 8 swimmer name 15 L 475 

67 Line 8 team name 5 L 490 

68 Line 8 lane number 2 R 495 

69 Line 8 place number 3 R 497 

70 Line 8 split/finish time 9 L 500 



Field # Function Length Justification Item Number 

71 Line 8 lengths completed 2 R 509 

72 Line 9 swimmer name 15 L 511 

73 Line 9 team name 5 L 526 

74 Line 9 lane number 2 R 531 

75 Line 9 place number 3 R 533 

76 Line 9 split/finish time 9 L 536 

77 Line 9 lengths completed 2 R 545 

78 Line 10 swimmer name 15 L 547 

79 Line 10 team name 5 L 562 

80 Line 10 lane number 2 R 567 

81 Line 10 place number 3 R 569 

82 Line 10 split/finish time 9 L 572 

83 Line 10 lengths completed 2 R 581 

84 Reserved 1 418 N 583 

85 Single line swimmer name 15 L 1001 

86 Single line team name 5 L 1016 

87 Single line lane number 2 R 1021 

88 Single line place number 3 R 1023 

89 Single line split/finish time 9 L 1026 

90 Single line lengths completed 2 R 1035 

91 Single line logo 30 L 1037 

92 Reserved 2 34 N 1067 

93 Line 1 subtractive time 9 L 1101 

94 Line 2 subtractive time 9 L 1110 

95 Line 3 subtractive time 9 L 1119 

96 Line 4 subtractive time 9 L 1128 

97 Line 5 subtractive time 9 L 1137 

98 Line 6 subtractive time 9 L 1146 

99 Line 7 subtractive time 9 L 1101 

100 Line 8 subtractive time 9 L 1101 

101 Line 9 subtractive time 9 L 1101 

102 Line 10 subtractive time 9 L 1101 

103 Reserved 3 310 N 1191 

104 Women's event title 20 L 1501 

105 Women's division name 15 L 1521 

106 Women's team 1 place 3 R 1536 

107 Women's team 1 name 20 L 1539 

108 Women's team 1 abbreviation 5 L 1559 

109 Women's team 1 score 6 R 1564 

110 Women's team 2 place 3 R 1570 

111 Women's team 2 name 20 L 1573 



Field # Function Length Justification Item Number 

112 Women's team 2 abbreviation 5 L 1593 

113 Women's team 2 score 6 R 1598 

114 Women's team 3 place 3 R 1604 

115 Women's team 3 name 20 L 1607 

116 Women's team 3 abbreviation 5 L 1627 

117 Women's team 3 score 6 R 1632 

118 Women's team 4 place 3 R 1638 

119 Women's team 4 name 20 L 1641 

120 Women's team 4 abbreviation 5 L 1661 

121 Women's team 4 score 6 R 1666 

122 Women's team 5 place 3 R 1672 

123 Women's team 5 name 20 L 1675 

124 Women's team 5 abbreviation 5 L 1695 

125 Women's team 5 score 6 R 1700 

126 Women's team 6 place 3 R 1706 

127 Women's team 6 name 20 L 1709 

128 Women's team 6 abbreviation 5 L 1729 

129 Women's team 6 score 6 R 1734 

130 Women's team 7 place 3 R 1740 

131 Women's team 7 name 20 L 1743 

132 Women's team 7 abbreviation 5 L 1763 

133 Women's team 7 score 6 R 1768 

134 Women's team 8 place 3 R 1774 

135 Women's team 8 name 20 L 1777 

136 Women's team 8 abbreviation 5 L 1797 

137 Women's team 8 score 6 R 1802 

138 Women's team 9 place 3 R 1808 

139 Women's team 9 name 20 L 1811 

140 Women's team 9 abbreviation 5 L 1831 

141 Women's team 9 score 6 R 1836 

142 Women's team 10 place 3 R 1842 

143 Women's team 10 name 20 L 1845 

144 Women's team 10 abbreviation 5 L 1865 

145 Women's team 10 score 6 R 1870 

146 Reserved 4  125 N 1876 

147 Men's event title 20 L 2001 

148 Men's division name 15 L 2021 

149 Men's team 1 place 3 R 2036 

150 Men's team 1 name 20 L 2039 

151 Men's team 1 abbreviation 5 L 2059 

152 Men's team 1 score 6 R 2064 



Field # Function Length Justification Item Number 

153 Men's team 2 place 3 R 2070 

154 Men's team 2 name 20 L 2073 

155 Men's team 2 abbreviation 5 L 2093 

156 Men's team 2 score 6 R 2098 

157 Men's team 3 place 3 R 2104 

158 Men's team 3 name 20 L 2107 

159 Men's team 3 abbreviation 5 L 2127 

160 Men's team 3 score 6 R 2132 

161 Men's team 4 place 3 R 2138 

162 Men's team 4 name 20 L 2141 

163 Men's team 4 abbreviation 5 L 2161 

164 Men's team 4 score 6 R 2166 

165 Men's team 5 place 3 R 2172 

166 Men's team 5 name 20 L 2175 

167 Men's team 5 abbreviation 5 L 2195 

168 Men's team 5 score 6 R 2200 

169 Men's team 6 place 3 R 2206 

170 Men's team 6 name 20 L 2209 

171 Men's team 6 abbreviation 5 L 2229 

172 Men's team 6 score 6 R 2234 

173 Men's team 7 place 3 R 2240 

174 Men's team 7 name 20 L 2243 

175 Men's team 7 abbreviation 5 L 2263 

176 Men's team 7 score 6 R 2268 

177 Men's team 8 place 3 R 2274 

178 Men's team 8 name 20 L 2277 

179 Men's team 8 abbreviation 5 L 2297 

180 Men's team 8 score 6 R 2302 

181 Men's team 9 place 3 R 2308 

182 Men's team 9 name 20 L 2311 

183 Men's team 9 abbreviation 5 L 2331 

184 Men's team 9 score 6 R 2336 

185 Men's team 10 place 3 R 2342 

186 Men's team 10 name 20 L 2345 

187 Men's team 10 abbreviation 5 L 2365 

188 Men's team 10 score 6 R 2370 

189 Reserved 4 125 N 2376 

190 Combined event title 20 L 2501 

191 Combined division name 15 L 2521 

192 Combined team 1 place 3 L 2536 

193 Combined team 1 name 20 L 2539 



Field # Function Length Justification Item Number 

194 Combined team 1 abbreviation 5 L 2559 

195 Combined team 1 score 6 R 2564 

196 Combined team 2 place 3 L 2570 

197 Combined team 2 name 20 L 2573 

198 Combined team 2 abbreviation 5 L 2593 

199 Combined team 2 score 6 R 2598 

200 Combined team 3 place 3 L 2604 

201 Combined team 3 name 20 L 2607 

202 Combined team 3 abbreviation 5 L 2627 

203 Combined team 3 score 6 R 2632 

204 Combined team 4 place 3 L 2638 

205 Combined team 4 name 20 L 2640 

206 Combined team 4 abbreviation 5 L 2661 

207 Combined team 4 score 6 R 2666 

208 Combined team 5 place 3 L 2672 

209 Combined team 5 name 20 L 2675 

210 Combined team 5 abbreviation 5 L 2695 

211 Combined team 5 score 6 R 2700 

212 Combined team 6 place 3 L 2706 

213 Combined team 6 name 20 L 2709 

214 Combined team 6 abbreviation 5 L 2729 

215 Combined team 6 score 6 R 2734 

216 Combined team 7 place 3 L 2740 

217 Combined team 7 name 20 L 2743 

218 Combined team 7 abbreviation 5 L 2763 

219 Combined team 7 score 6 R 2768 

220 Combined team 8 place 3 L 2774 

221 Combined team 8 name 20 L 2777 

222 Combined team 8 abbreviation 5 L 2797 

223 Combined team 8 score 6 R 2802 

224 Combined team 9 place 3 L 2808 

225 Combined team 9 name 20 L 2811 

226 Combined team 9 abbreviation 5 L 2831 

227 Combined team 9 score 6 R 2836 

228 Combined team 10 place 3 L 2842 

229 Combined team 10 name 20 L 2845 

230 Combined team 10 abbreviation 5 L 2865 

231 Combined team 10 score 6 R 2870 

 



OmniSport 6000 Swim RTD Item Numbers (os6000 swim.itf) 

Field # Function Length Justification Item Number 

1 Running time 9 R 1 

2 Event title line 1  30 L 10 

3 Event title line 2 30 L 40 

4 Event title lines 1 & 2 30 L 70 

5 Event number 3 R 100 

6 Heat number 2 R 103 

7 Maximum lengths to be completed 2 R 105 

8 Lengths completed 2 R 107 

9 Record 1 name 12 L 109 

10 Record 1 code 2 R 121 

11 Record 1 time 9 R 146 

12 Record 2 name 12 L 132 

13 Record 2 code 2 R 144 

14 Record 2 time 9 R 146 

15 Record 3 name 12 L 155 

16 Record 3 code 2 R 167 

17 Record 3 time 9 R 169 

18 Record 4 name 12 L 178 

19 Record 4 code 2 R 190 

20 Record 4 time 9 R 192 

21 Line 1 swimmer name 15 L 201 

22 Line 1 team name 5 L 216 

23 Line 1 lane number 2 R 221 

24 Line 1 place number 3 R 223 

25 Line 1 split/finish time 9 R 226 

26 Line 1 lengths completed 2 R 235 

27 Line 2 swimmer name 15 L 237 

28 Line 2 team name 5 L 252 

29 Line 2 lane number 2 R 257 

30 Line 2 place number 3 R 259 

31 Line 2 split/finish time 9 R 262 

32 Line 2 lengths completed 2 R 271 

33 Line 3 swimmer name 15 L 273 

34 Line 3 team name 5 L 288 

35 Line 3 lane number 2 R 293 

36 Line 3 place number 3 R 295 

37 Line 3 split/finish time 9 R 298 

38 Line 3 lengths completed 2 R 307 

39 Line 4 swimmer name 15 L 309 

40 Line 4 team name 5 L 324 



Field # Function Length Justification Item Number 

41 Line 4 lane number 2 R 329 

42 Line 4 place number 3 R 331 

43 Line 4 split/finish time 9 R 334 

44 Line 4 lengths completed 2 R 343 

45 Line 5 swimmer name 15 L 345 

46 Line 5 team name 5 L 360 

47 Line 5 lane number 2 R 365 

48 Line 5 place number 3 R 367 

49 Line 5 split/finish time 9 R 370 

50 Line 5 lengths completed 2 R 379 

51 Line 6 swimmer name 15 L 381 

52 Line 6 team name 5 L 396 

53 Line 6 lane number 2 R 401 

54 Line 6 place number 3 R 403 

55 Line 6 split/finish time 9 R 406 

56 Line 6 lengths completed 2 R 415 

57 Line 7 swimmer name 15 L 417 

58 Line 7 team name 5 L 432 

59 Line 7 lane number 2 R 437 

60 Line 7 place number 3 R 439 

61 Line 7 split/finish time 9 R 442 

62 Line 7 lengths completed 2 R 451 

63 Line 8 swimmer name 15 L 453 

64 Line 8 team name 5 L 468 

65 Line 8 lane number 2 R 473 

66 Line 8 place number 3 R 475 

67 Line 8 split/finish time 9 R 478 

68 Line 8 lengths completed 2 R 487 

69 Line 9 swimmer name 15 L 489 

70 Line 9 team name 5 L 504 

71 Line 9 lane number 2 R 509 

72 Line 9 place number 3 R 511 

73 Line 9 split/finish time 9 R 514 

74 Line 9 lengths completed 2 R 523 

75 Line 10 swimmer name 15 L 525 

76 Line 10 team name 5 L 540 

77 Line 10 lane number 2 R 545 

78 Line 10 place number 3 R 547 

79 Line 10 split/finish time 9 R 550 

80 Line 10 lengths completed 2 R 559 

81 Single line swimmer name 15 L 561 



Field # Function Length Justification Item Number 

82 Single line team name 5 L 576 

83 Single line lane number 2 R 581 

84 Single line place number 3 R 583 

85 Single line split/finish time 9 R 586 

86 Single line lengths completed 2 R 595 

87 Single line logo 30 L 597 

88 Women's event title 20 L 627 

89 Women's division name 15 L 647 

90 Women's team 1 place 3 R 662 

91 Women's team 1 name 20 L 665 

92 Women's team 1 abbreviation 5 L 685 

93 Women's team 1 score 8 R 690 

94 Women's team 2 place 3 R 698 

95 Women's team 2 name 20 L 701 

96 Women's team 2 abbreviation 5 L 721 

97 Women's team 2 score 8 R 726 

98 Women's team 3 place 3 R 724 

99 Women's team 3 name 20 L 727 

100 Women's team 3 abbreviation 5 L 757 

101 Women's team 3 score 8 R 762 

102 Women's team 4 place 3 R 770 

103 Women's team 4 name 20 L 773 

104 Women's team 4 abbreviation 5 L 793 

105 Women's team 4 score 8 R 798 

106 Women's team 5 place 3 R 806 

107 Women's team 5 name 20 L 809 

108 Women's team 5 abbreviation 5 L 829 

109 Women's team 5 score 8 R 834 

110 Women's team 6 place 3 R 842 

111 Women's team 6 name 20 L 845 

112 Women's team 6 abbreviation 5 L 865 

113 Women's team 6 score 8 R 870 

114 Women's team 7 place 3 R 878 

115 Women's team 7 name 20 L 881 

116 Women's team 7 abbreviation 5 L 901 

117 Women's team 7 score 8 R 906 

118 Women's team 8 place 3 R 914 

119 Women's team 8 name 20 L 917 

120 Women's team 8 abbreviation 5 L 937 

121 Women's team 8 score 8 R 942 

122 Women's team 9 place 3 R 950 



Field # Function Length Justification Item Number 

123 Women's team 9 name 20 L 953 

124 Women's team 9 abbreviation 5 L 973 

125 Women's team 9 score 8 R 978 

126 Women's team 10 place 3 R 986 

127 Women's team 10 name 20 L 989 

128 Women's team 10 abbreviation 5 L 1009 

129 Women's team 10 score 8 R 1014 

130 Men's event title 20 L 1022 

131 Men's division name 15 L 1042 

132 Men's team 1 place 3 R 1057 

133 Men's team 1 name 20 L 1060 

134 Men's team 1 abbreviation 5 L 1080 

135 Men's team 1 score 8 R 1085 

136 Men's team 2 place 3 R 1093 

137 Men's team 2 name 20 L 1096 

138 Men's team 2 abbreviation 5 L 1116 

139 Men's team 2 score 8 R 1121 

140 Men's team 3 place 3 R 1129 

141 Men's team 3 name 20 L 1132 

142 Men's team 3 abbreviation 5 L 1152 

143 Men's team 3 score 8 R 1157 

144 Men's team 4 place 3 R 1165 

145 Men's team 4 name 20 L 1168 

146 Men's team 4 abbreviation 5 L 1188 

147 Men's team 4 score 8 R 1193 

148 Men's team 5 place 3 R 1201 

149 Men's team 5 name 20 L 1204 

150 Men's team 5 abbreviation 5 L 1224 

151 Men's team 5 score 8 R 1229 

152 Men's team 6 place 3 R 1237 

153 Men's team 6 name 20 L 1240 

154 Men's team 6 abbreviation 5 L 1260 

155 Men's team 6 score 8 R 1265 

156 Men's team 7 place 3 R 1273 

157 Men's team 7 name 20 L 1276 

158 Men's team 7 abbreviation 5 L 1296 

159 Men's team 7 score 8 R 1301 

160 Men's team 8 place 3 R 1309 

161 Men's team 8 name 20 L 1312 

162 Men's team 8 abbreviation 5 L 1332 

163 Men's team 8 score 8 R 1337 



Field # Function Length Justification Item Number 

164 Men's team 9 place 3 R 1345 

165 Men's team 9 name 20 L 1348 

166 Men's team 9 abbreviation 5 L 1368 

167 Men's team 9 score 8 R 1373 

168 Men's team 10 place 3 R 1381 

169 Men's team 10 name 20 L 1384 

170 Men's team 10 abbreviation 5 L 1404 

171 Men's team 10 score 8 R 1409 

172 Mixed event title 20 L 1417 

173 Mixed division name 15 L 1437 

174 Mixed team 1 place 3 R 1452 

175 Mixed team 1 name 20 L 1455 

176 Mixed team 1 abbreviation 5 L 1475 

177 Mixed team 1 score 8 R 1480 

178 Mixed team 2 place 3 R 1488 

179 Mixed team 2 name 20 L 1491 

180 Mixed team 2 abbreviation 5 L 1511 

181 Mixed team 2 score 8 R 1516 

182 Mixed team 3 place 3 R 1524 

183 Mixed team 3 name 20 L 1527 

184 Mixed team 3 abbreviation 5 L 1547 

185 Mixed team 3 score 8 R 1552 

186 Mixed team 4 place 3 R 1560 

187 Mixed team 4 name 20 L 1563 

188 Mixed team 4 abbreviation 5 L 1583 

189 Mixed team 4 score 8 R 1588 

190 Mixed team 5 place 3 R 1596 

191 Mixed team 5 name 20 L 1599 

192 Mixed team 5 abbreviation 5 L 1619 

193 Mixed team 5 score 8 R 1624 

194 Mixed team 6 place 3 R 1632 

195 Mixed team 6 name 20 L 1635 

196 Mixed team 6 abbreviation 5 L 1655 

197 Mixed team 6 score 8 R 1660 

198 Mixed team 7 place 3 R 1668 

199 Mixed team 7 name 20 L 1671 

200 Mixed team 7 abbreviation 5 L 1691 

201 Mixed team 7 score 8 R 1696 

202 Mixed team 8 place 3 R 1704 

203 Mixed team 8 name 20 L 1707 

204 Mixed team 8 abbreviation 5 L 1727 



Field # Function Length Justification Item Number 

205 Mixed team 8 score 8 R 1732 

206 Mixed team 9 place 3 R 1740 

207 Mixed team 9 name 20 L 1743 

208 Mixed team 9 abbreviation 5 L 1763 

209 Mixed team 9 score 8 R 1768 

210 Mixed team 10 place 3 R 1776 

211 Mixed team 10 name 20 L 1779 

212 Mixed team 10 abbreviation 5 L 1799 

213 Mixed team 10 score 8 R 1804 

 

OmniSport 2000/6000 Diving RTD Item Numbers (os6000 dive.itf) 

Field # Function Length Justification Item # 

1 Current diver number 2 R 1 

2 Current diver's name 20 L 3 

3 Current diver's team 15 L 23 

4 Current diver's total score 6 R 38 

5 Current dive number 4 R 44 

6 Dive description 30 R 48 

7 Dive position 1 L 78 

8 Degree of difficulty 3 R 79 

9 Judge 1 Score 4 R 82 

10 Judge 2 Score 4 R 86 

11 Judge 3 Score 4 R 90 

12 Judge 4 Score 4 R 94 

13 Judge 5 Score 4 R 98 

14 Judge 6 Score 4 R 102 

15 Judge 7 Score 4 R 106 

16 Judge 8 Score 4 R 110 

17 Judge 9 Score 4 R 114 

18 Award for current round 6 R 118 

19 1st place diver's number 2 R 124 

20 1st place diver's name 20 L 126 

21 1st place diver's team 15 L 146 

22 1st place diver's total score 6 R 161 

23 2nd place diver's number 2 R 167 

24 2nd place diver's name 20 L 169 

25 2nd place diver's team 15 L 189 

26 2nd place diver's total score 6 R 204 

27 3rd place diver's number 20 R 210 

28 3rd place diver's name 20 L 212 



Field # Function Length Justification Item # 

29 3rd place diver's team 15 L 232 

30 3rd place diver's total score 6 R 247 

31 4th place diver's number 20 R 247 

32 4th place diver's name 20 L 255 

33 4th place diver's team 15 L 275 

34 4th place diver's total score 6 R 290 

35 5th place diver's number 2 R 296 

36 5th place diver's name 20 L 298 

37 5th place diver's team 15 L 318 

38 5th place diver's total score 6 R 333 

39 6th place diver's number 2 R 339 

40 6th place diver's name 20 L 341 

41 6th place diver's team 15 L 361 

42 6th place diver's total score 6 R 376 

43 7th place diver's number 2 R 382 

44 7th place diver's name 20 L 384 

45 7th place diver's team 15 L 404 

46 7th place diver's total score 6 R 419 

47 8th place diver's number 2 R 425 

48 8th place diver's name 20 L 427 

49 8th place diver's team 15 L 447 

50 8th place diver's total score 6 R 462 

51 9th place diver's number 2 R 468 

52 9th place diver's name 20 L 470 

53 9th place diver's team 15 L 490 

54 9th place diver's total score 6 R 505 

55 10th place diver's number 2 R 511 

56 10th place diver's name 20 L 513 

57 10th place diver's team 15 L 533 

58 10th place diver's total score 6 R 548 

59 Event name 26 L 554 

60 Platform event height 9 L 580 

61 Event current round 2 R 589 

 

 

 

 

 

 

 

 



OmniSport 2000/6000 Pace Clock RTD Item Numbers (os6000 pace 
clock.itf) 

Field # Function Length Justification Item Number 

1 Line 1 Lane Number 2 R 1 

 2 Line 1 Current Step Number 2 R 3 

 3 Line 1 Current Step Name 4 L 5 

 4 Line 1 Current Rep Number 3 R 9 

 5 Line 1 Time of Current Step 5 R 12 

 6 Line 2 Lane Number 2 R 17 

 7 Line 2 Current Step Number 2 R 19 

 8 Line 2 Current Step Name 4 L 21 

 9 Line 2 Current Rep Number3 3 R 25 

 10 Line 2 Time of Current Step 5 R 28 

 11 Line 3 Lane Number 2 R 33 

 12 Line 3 Current Step Number 2 R 35 

 13 Line 3 Current Step Name 4 L 37 

 14 Line 3 Current Rep Number 3 R 41 

 15 Line 3 Time of Current Step 5 R 44 

 16 Line 4 Lane Number 2 R 49 

 17 Line 4 Current Step Number 2 R 51 

 18 Line 4 Current Step Name 4 L 53 

 19 Line 4 Current Rep Number 3 R 57 

 20 Line 4 Time of Current Step 5 R 60 

 21 Line 5 Lane Number 2 R 65 

 22 Line 5 Current Step Number 2 R 67 

 23 Line 5 Current Step Name 4 L 69 

 24 Line 5 Current Rep Number 3 R 73 

 25 Line 5 Time of Current Step 5 R 76 

 26 Line 6 Lane Number 2 R 81 

 27 Line 6 Current Step Number 2 R 83 

 28 Line 6 Current Step Name 4 L 85 

 29 Line 6 Current Rep Number 3 R 89 

 30 Line 6 Time of Current Step 5 R 92 

 31 Line 7 Lane Number 2 R 97 

 32 Line 7 Current Step Number 2 R 99 

 33 Line 7 Current Step Name 4 L 101 

 34 Line 7 Current Rep Number 3 R 105 

 35 Line 7 Time of Current Step 5 R 108 

 36 Line 8 Lane Number 2 R 113 

 37 Line 8 Current Step Number 2 R 115 

 38 Line 8 Current Step Name 4 L 117 

 39 Line 8 Current Rep Number 3 R 121 

 40 Line 8 Time of Current Step 5 R 124 

 41 Line 9 Lane Number 2 R 129 

 42 Line 9 Current Step Number 2 R 131 

 43 Line 9 Current Step Name 4 L 133 

 44 Line 9 Current Rep Number 3 R 137 

 45 Line 9 Time of Current Step 5 R 140 



Field # Function Length Justification Item Number 

 46 Line 10 Lane Number 2 R 145 

 47 Line 10 Current Step Number 2 R 147 

 48 Line 10 Current Step Name 4 L 149 

 49 Line 10 Current Rep Number 3 R 153 

 50 Line 10 Time of Current Step 5 R 156 

 

OmniSport 2000/6000 Water Polo RTD Item Numbers (os6000 water 
polo.itf) 

Field # Function Length Justification Item Number 

1 Period Time 5 R 1 

2 Shot Time 5 R 6 

3 Time Out Time 5 R 11 

4 Home Score 2 R 16 

5 Guest Score 2 R 18 

6 Home Time Outs 1 R 20 

7 Guest Time Outs 1 R 21 

8 Period 1 R 22 

9 Home Penalty 1 Number 2 R 23 

10 Home Penalty 1 Time 5 R 25 

11 Home Penalty 2 Number 2 R 30 

12 Home Penalty 2 Time 5 R 32 

13 Home Penalty 3 Number 2 R 37 

14 Home Penalty 3 Time 5 R 39 

15 Guest Penalty 1 Number 2 R 44 

16 Guest Penalty 1 Time 5 R 46 

17 Guest Penalty 2 Number 2 R 51 

18 Guest Penalty 2 Time 5 R 53 

19 Guest Penalty 3 Number 2 R 58 

20 Guest Penalty 3 Time 5 R 60 

21 Home Player 1 Penalties 1 R 65 

22 Home Player 2 Penalties 1 R 66 

23 Home Player 3 Penalties 1 R 67 

24 Home Player 4 Penalties 1 R 68 

25 Home Player 5 Penalties 1 R 69 

26 Home Player 6 Penalties 1 R 70 

27 Home Player 7 Penalties 1 R 71 

28 Home Player 8 Penalties 1 R 72 

29 Home Player 9 Penalties 1 R 73 

30 Home Player 10 Penalties 1 R 74 

31 Home Player 11 Penalties 1 R 75 

32 Home Player 12 Penalties 1 R 76 

33 Home Player 13 Penalties 1 R 77 

34 Guest Player 1 Penalties 1 R 78 

35 Guest Player 2 Penalties 1 R 79 

36 Guest Player 3 Penalties 1 R 80 



Field # Function Length Justification Item Number 

37 Guest Player 4 Penalties 1 R 81 

38 Guest Player 5 Penalties 1 R 82 

39 Guest Player 6 Penalties 1 R 83 

40 Guest Player 7 Penalties 1 R 84 

41 Guest Player 8 Penalties 1 R 85 

42 Guest Player 9 Penalties 1 R 86 

43 Guest Player 10 Penalties 1 R 87 

44 Guest Player 11 Penalties 1 R 88 

45 Guest Player 12 Penalties 1 R 89 

46 Guest Player 13 Penalties 1 R 90 

 

OmniSport 2000 Track RTD Item Numbers (OS2-Track.itf) 

Field # Function Length Justification Item Number 

1 Running Time 9 L 1 

2 Cumulative Split 9 R 10 

3 Subtractive Split 9 R 19 

4 Event Title Line 1 30 L 28 

5 Event Title Line 2 30 L 58 

6 Event Title Lines 1 & 2 30 L 88 

7 Event Number 3 R 118 

8 Event Number - Alpha 1 L 121 

9 Heat Number 2 R 122 

10 Heat Number - Alpha 20 L 124 

11 Round Number 1 L 144 

12 Open - For Future Use 2 R 145 

13 Splits Completed 2 R 147 

14 Record 1 Name 12 L 149 

15 Record 1 Code 2 L 161 

16 Record 1 Time 9 L 163 

17 Record 2 Name 12 L 172 

18 Record 2 Code 2 L 184 

19 Record 2 Time 9 L 186 

20 Record 3 Name 12 L 195 

21 Record 3 Code 2 L 207 

22 Record 3 Time 9 L 209 

23 Record 4 Name 12 L 218 

24 Record 4 Code 2 L 230 

25 Record 4 Time 9 L 232 

26 Line 1 Runner Name 15 L 241 

27 Line 1 Team Name 5 L 256 

28 Line 1 Lane Number 2 R 261 

29 Line 1 Place Number 3 R 263 

30 Line 1 Split/Finish Time 9 L 266 

31 Line 1 Splits Completed 2 R 275 

32 Line 2 Runner Name 15 L 277 



Field # Function Length Justification Item Number 

33 Line 2 Team Name 5 L 292 

34 Line 2 Lane Number 2 R 297 

35 Line 2 Place Number 3 R 299 

36 Line 2 Split/Finish Time 9 L 302 

37 Line 2 Splits Completed 2 R 311 

38 Line 3 Runner Name 15 L 313 

39 Line 3 Team Name 5 L 328 

40 Line 3 Lane Number 2 R 333 

41 Line 3 Place Number 3 R 335 

42 Line 3 Split/Finish Time 9 L 338 

43 Line 3 Splits Completed 2 R 347 

44 Line 4 Runner Name 15 L 349 

45 Line 4 Team Name 5 L 364 

46 Line 4 Lane Number 2 R 369 

47 Line 4 Place Number 3 R 371 

48 Line 4 Split/Finish Time 9 L 374 

49 Line 4 Splits Completed 2 R 383 

50 Line 5 Runner Name 15 L 385 

51 Line 5 Team Name 5 L 400 

52 Line 5 Lane Number 2 R 405 

53 Line 5 Place Number 3 R 407 

54 Line 5 Split/Finish Time 9 L 410 

55 Line 5 Splits Completed 2 R 419 

56 Line 6 Runner Name 15 L 421 

57 Line 6 Team Name 5 L 436 

58 Line 6 Lane Number 2 R 441 

59 Line 6 Place Number 3 R 443 

60 Line 6 Split/Finish Time 9 L 446 

61 Line 6 Splits Completed 2 R 455 

62 Line 7 Runner Name 15 L 457 

63 Line 7 Team Name 5 L 472 

64 Line 7 Lane Number 2 R 477 

65 Line 7 Place Number 3 R 479 

66 Line 7 Split/Finish Time 9 L 482 

67 Line 7 Splits Completed 2 R 491 

68 Line 8 Runner Name 15 L 493 

69 Line 8 Team Name 5 L 508 

70 Line 8 Lane Number 2 R 513 

71 Line 8 Place Number 3 R 515 

72 Line 8 Split/Finish Time 9 L 518 

73 Line 8 Splits Completed 2 R 527 

74 Line 9 Runner Name 15 L 529 

75 Line 9 Team Name 5 L 544 

76 Line 9 Lane Number 2 R 549 

77 Line 9 Place Number 3 R 551 

78 Line 9 Split/Finish Time 9 L 554 

79 Line 9 Splits Completed 2 R 563 



Field # Function Length Justification Item Number 

80 Line 10 Runner Name 15 L 565 

81 Line 10 Team Name 5 L 580 

82 Line 10 Lane Number 2 R 585 

83 Line 10 Place Number 3 R 587 

84 Line 10 Split/Finish Time 9 L 590 

85 Line 10 Splits Completed 2 R 599 

86 Reserved 1 400 N 601 

87 Single Line Runner Name 15 L 1001 

88 Single Line Team Name 5 L 1016 

89 Single Line Lane Number 2 R 1021 

90 Single Line Place Number 3 R 1023 

91 Single Line Split/Finish Time 9 L 1026 

92 Single Line Splits Completed 2 R 1035 

93 Single Line Logo 30 L 1037 

 

OmniSport 2000 Synchronized Swimming RTD Item Numbers (OS2-Sync 
Swim.itf) 

Field # Function Length Justification Item Number 

1 Event Name 30 L 1 

2 Event Type 5 L 31 

3 Event Routine 9 L 36 

4 Current Swimmer-Rank 4 R 45 

5 Current Swimmer-Draw Order 4 R 49 

6 Current Swimmer-Name 20 L 53 

7 Current Swimmer-Affiliation 20 L 73 

8 Current Swimmer-Age Group 8 L 93 

9 Figures Code (Future) 4 R 101 

10 Figures Description (Future) 50 L 105 

11 Figures Degree of Difficulty (Future) 4 R 155 

12 Figures Panel Number (Future) 1 R 159 

13 Judge 1 Execution/Technical Merit 4 R 160 

14 Judge 2 Execution/Technical Merit 4 R 164 

15 Judge 3 Execution/Technical Merit 4 R 168 

16 Judge 4 Execution/Technical Merit 4 R 172 

17 Judge 5 Execution/Technical Merit 4 R 176 

18 Judge 6 Execution/Technical Merit 4 R 180 

19 Judge 7 Execution/Technical Merit 4 R 184 

20 Judge 8 Execution/Technical Merit 4 R 188 

21 Judge 9 Execution/Technical Merit 4 R 192 

22 Execution/Technical Merit Score 7 R 196 

23 Judge 1 Overall/Artistic Impression 4 R 203 

24 Judge 2 Overall/Artistic Impression 4 R 207 

25 Judge 3 Overall/Artistic Impression 4 R 211 

26 Judge 4 Overall/Artistic Impression 4 R 215 

27 Judge 5 Overall/Artistic Impression 4 R 219 



Field # Function Length Justification Item Number 

28 Judge 6 Overall/Artistic Impression 4 R 223 

29 Judge 7 Overall/Artistic Impression 4 R 227 

30 Judge 8 Overall/Artistic Impression 4 R 231 

31 Judge 9 Overall/Artistic Impression 4 R 235 

32 Overall/Artistic Impression Score 7 R 239 

33 Routine Penalty 4 R 246 

34 Routine Bonus 4 R 250 

35 Routine Result 7 R 254 

36 Figures Result 7 R 261 

37 Technical Routine Result 7 R 268 

38 Free Routine Result 7 R 275 

39 Total Result 7 R 282 

40 Next Swimmer-Rank 4 R 289 

41 Next Swimmer-Draw Order 4 R 293 

42 Next Swimmer-Name 20 L 297 

43 Next Swimmer-Affiliation 20 L 317 

44 Next Swimmer-Age Group 8 L 337 

45 1st Place Swimmer-Draw Order 4 R 345 

46 1st Place Swimmer-Name 20 L 349 

47 1st Place Swimmer-Affiliation 20 L 369 

48 1st Place Swimmer-Age Group 8 L 389 

49 1st Place Swimmer-Total Score 7 R 397 

50 2nd Place Swimmer-Draw Order 4 R 404 

51 2nd Place Swimmer-Name 20 L 408 

52 2nd Place Swimmer-Affiliation 20 L 428 

53 2nd Place Swimmer-Age Group 8 L 448 

54 2nd Place Swimmer-Total Score 7 R 456 

55 3rd Place Swimmer-Draw Order 4 R 463 

56 3rd Place Swimmer-Name 20 L 467 

57 3rd Place Swimmer-Affiliation 20 L 487 

58 3rd Place Swimmer-Age Group 8 L 507 

59 3rd Place Swimmer-Total Score 7 R 515 

60 4th Place Swimmer-Draw Order 4 R 522 

61 4th Place Swimmer-Name 20 L 526 

62 4th Place Swimmer-Affiliation 20 L 546 

63 4th Place Swimmer-Age Group 8 L 566 

64 4th Place Swimmer-Total Score 7 R 574 

65 5th Place Swimmer-Draw Order 4 R 581 

66 5th Place Swimmer-Name 20 L 585 

67 5th Place Swimmer-Affiliation 20 L 605 

68 5th Place Swimmer-Age Group 8 L 625 

69 5th Place Swimmer-Total Score 7 R 633 

70 6th Place Swimmer-Draw Order 4 R 640 

71 6th Place Swimmer-Name 20 L 644 

72 6th Place Swimmer-Affiliation 20 L 664 

73 6th Place Swimmer-Age Group 8 L 684 

74 6th Place Swimmer-Total Score 7 R 692 



Field # Function Length Justification Item Number 

75 7th Place Swimmer-Draw Order 4 R 699 

76 7th Place Swimmer-Name 20 L 703 

77 7th Place Swimmer-Affiliation 20 L 723 

78 7th Place Swimmer-Age Group 8 L 743 

79 7th Place Swimmer-Total Score 7 R 751 

80 8th Place Swimmer-Draw Order 4 R 758 

81 8th Place Swimmer-Name 20 L 762 

82 8th Place Swimmer-Affiliation 20 L 782 

83 8th Place Swimmer-Age Group 8 L 802 

84 8th Place Swimmer-Total Score 7 R 810 

85 9th Place Swimmer-Draw Order 4 R 817 

86 9th Place Swimmer-Name 20 L 821 

87 9th Place Swimmer-Affiliation 20 L 841 

88 9th Place Swimmer-Age Group 8 L 861 

89 9th Place Swimmer-Total Score 7 R 869 

90 10th Place Swimmer-Draw Order 4 R 876 

91 10th Place Swimmer-Name 20 L 880 

92 10th Place Swimmer-Affiliation 20 L 900 

93 10th Place Swimmer-Age Group 8 L 920 

94 10th Place Swimmer-Total Score 7 R 928 

 

OmniSport 6000 Synchronized Swimming RTD Item Numbers (os6000 
sync.itf) 

Field # Function Length Justification Item Number 

1 Event Number 2 R 1 

2 Event Type 14 R 3 

3 Age Group Type 8 L 17 

4 Swimmer/Routine Members ID Number 3 L 25 

5 Swimmer Name 20 L 28 

6 Swimmer/Routine Members Group Name 8 L 48 

7 Figure Code 4 R 56 

8 Figure Description 50 L 60 

9 Degree of Difficulty 4 R 110 

10 Panel Number 1 R 114 

11 Judge 1 Figures/Technical 4 R 115 

12 Judge 2 Figures/Technical 4 R 119 

13 Judge 3 Figures/Technical 4 R 123 

14 Judge 4 Figures/Technical 4 R 127 

15 Judge 5 Figures/Technical 4 R 131 

16 Judge 6 Figures/Technical 4 R 135 

17 Judge 7 Figures/Technical 4 R 139 

18 Judge 8 Figures/Technical 4 R 143 

19 Judge 9 Figures/Technical 4 R 147 

20 Figure Score/Routine Score Technical 6 R 151 

21 Figures Penalty/Judge 1 Artistic 4 R 157 



Field # Function Length Justification Item Number 

22 Judge 2 Artistic 7 R 161 

23 Judge 3 Artistic 4 R 165 

24 Judge 4 Artistic 4 R 169 

25 Judge 5 Artistic 4 R 173 

26 Judge 6 Artistic 4 R 177 

27 Judge 7 Artistic 4 R 181 

28 Judge 8 Artistic 4 R 185 

29 Judge 9 Artistic 4 R 189 

30 Routine Score Artistic 6 R 193 

31 Figures Result 6 R 199 

32 Routine Result 6 R 205 

33 Total Result 6 R 211 

34 Routine Penalty 4 R 217 

35 Current Ranking 3 R 221 

36 1st Place Swimmer/Routine Members ID 

Number 

3 R 224 

37 1st Place Swimmer Name 20 L 227 

38 1st Place Swimmer/Routine Members 

Group Name 

8 L 247 

39 1st Place Swimmer/Routine Members 

Total Score 

6 R 255 

40 2nd Place Swimmer/Routine Members ID 

Number 

3 R 261 

41 2nd Place Swimmer Name 20 L 264 

42 2nd Place Swimmer/Routine Members 

Group Name 

8 L 284 

43 2nd Place Swimmer/Routine Members 

Total Score 

6 R 292 

44 3rd Place Swimmer/Routine Members ID 

Number 

3 R 298 

45 3rd Place Swimmer Name 20 L 301 

46 3rd Place Swimmer/Routine Members 

Group Name 

8 L 321 

47 3rd Place Swimmer/Routine Members 

Total Score 

6 R 329 

48 4th Place Swimmer/Routine Members ID 

Number 

3 R 335 

49 4th Place Swimmer Name 20 L 338 

50 4th Place Swimmer/Routine Members 

Group Name 

8 L 358 

51 4th Place Swimmer/Routine Members 

Total Score 

6 R 366 

52 5th Place Swimmer/Routine Members ID 

Number 

3 R 372 

53 5th Place Swimmer Name 20 L 375 

54 5th Place Swimmer/Routine Members 

Group Name 

8 L 395 

55 5th Place Swimmer/Routine Members 6 R 403 



Field # Function Length Justification Item Number 

Total Score 

56 6th Place Swimmer/Routine Members ID 

Number 

3 R 409 

57 6th Place Swimmer Name 20 L 412 

58 6th Place Swimmer/Routine Members 

Group Name 

8 L 432 

59 6th Place Swimmer/Routine Members 

Total Score 

6 R 440 

60 7th Place Swimmer/Routine Members ID 

Number 

3 R 446 

61 7th Place Swimmer Name 20 L 449 

62 7th Place Swimmer/Routine Members 

Group Name 

8 L 469 

63 7th Place Swimmer/Routine Members 

Total Score 

6 R 477 

64 8th Place Swimmer/Routine Members ID 

Number 

3 R 483 

65 8th Place Swimmer Name 20 L 486 

66 8th Place Swimmer/Routine Members 

Group Name 

8 L 506 

67 8th Place Swimmer/Routine Members 

Total Score 

6 R 514 

68 9th Place Swimmer/Routine Members ID 

Number 

3 R 520 

69 9th Place Swimmer Name 20 L 523 

70 9th Place Swimmer/Routine Members 

Group Name 

8 L 543 

71 9th Place Swimmer/Routine Members 

Total Score 

6 R 551 

72 10th Place Swimmer/Routine Members ID 

Number 

3 R 557 

73 10th Place Swimmer Name 20 L 560 

74 10th Place Swimmer/Routine Members 

Group Name 

8 L 580 

75 10th Place Swimmer/Routine Members 

Total Score 

6 R 588 

 



Appendix E: Console and Software Revision History 

Timing Console Revision History 
Version 2.8.16 -Release date: 16 August 2002 

 

Swimming 

 Initial software release 

 

Version 2.8.19 -Release date: 19 August 2002 

 

Swimming 

 Moved the button and backup labels under the lengths label on the printouts so that 

the ‗*‘ stands out more for marked times. 

 Added extra spacing between the last backup/button time and the next lane on the 

printouts. 

 Added program version to the settings printout. 

 

Version 2.9.10 -Release date: 23 September 2002 

 

General 

 Corrected the ED number shown on the center LCD after power up. 

 Added a PAPER message to the right LCD to indicate when the printer is out of 

paper. 

 

Swimming 

 Allowed the maximum event number be 999. 

 Added a request for configuration data from the Pro software. 

 Updated the messages shown during the LCD test step of the product test. 

 

Version 2.9.27 -Release date: 2 October 2002 

 

Swimming 

 Added a set time-of-day command for the Pro software. 

 Added the ability to edit and print a diving event in the event order. 

 Corrected a problem with the multiline test code. 

 Corrected a printer problem of large spaces between characters. 

 

Version 2.10.11-Release date: 11 October 2002 

 

Swimming 

 Added a Start/Finish List request from the Pro software to be sent to the meet 

manager. 

 Corrected a printer problem with the paper status. 

 

Version 3.1.7 -Release date: 7 January 2003 

 

Swimming 

 Added the ability to receive the home, guest 1, guest 2, and guest 3 team scores from 

Hy-TekLTD MEET MANAGER. 

 Added a race transfer complete command from the Pro software. 



 Added ability to print the current running time for the +Touch operation when a lane 

is armed for finish. 

 Corrected miscellaneous small problems with the meet manager and Pro software 

interfaces when the OmniSport 2000 timer is configured to work as an OmniSport 

6000 console. 

 

Diving 

 Added first release of program with integration to swimming from the event order. 

 

Version 3.3.28 -Release date:  28 March 2003 

 

General 

 Added the first release of the water polo program. 

 Added the first release of the track program. 

 Added control of radios for the multidrop scoreboard protocol only. 

 Increased the number of multidrop nodes to include address 1 and 22 for all  

sports plus standard football scoreboards for track and water polo scoreboards  

for water polo. 

 

Swimming 

 Added display of subtractive splits on the numeric and matrix scoreboard outputs. 

 Added ―Daktronics‖ logo to matrix scoreboard output. 

 Corrected problem with subtractive splits configuration not being stored. 

 Corrected problem with home/guest 1 score module on CTS scoreboard outputs. 

 Corrected problem for cumulative and subtractive splits printing for lanes that were 

turned off. 

 Corrected problem with the lane and place being swapped on the single line of the 

matrix scoreboard output. 

 

Diving 

 Added capability to control the CAN (control area network) judge‘s consoles and a 

test function to the menu. 

 Added capability to edit the total score for current diver from the keyboard. 

 Corrected problem with total score being printed incorrectly on the dive log after 

reaching a certain value. 

 Corrected problem of a Failed dive not setting all judges to a score of ‗0.0‘. 

 

Water Polo 

 Added first release of program. 

 

Track 

 Added first release of program. 

 

Version 3.4.10 -Release date:  10 April 2003 

 

General 

 Corrected the printer and lane module tests for production testing. 

 

 

 

 



Water Polo 

 Added control of the horn on the multisport module for the multidrop scoreboard 

protocol. 

 

Version 3.4.18 -Release date:  18 April 2003 

 

Track 

 Added the Non-Lane timing mode. 

 

Version 3.4.23 Release date:  23 April 2003 

 

Track 

 Added Place timing mode. 

 Modified operation of multiline scoreboard outputs. 

 

Version 3.5.15 -Release date:  15 May 2003 

 

General 

 Changed from a 7 segment to an 8 segment font on the single line output for 

swimming, track and water polo. 

 

Version 3.6.18 -Release date:  18 June 2003 

 

Diving 

 Corrected a bug that would make the "Enter Judge Number" text not appear  

on consoles with recent CAN terminal software (any CAN terminal that auto 

arbitrates ID's) 

 

Version 3.7.18 -Release date: 18 July 2003 

 

General 

 Changed from a 7 segment to an 8 segment font on the game/shot clock and locker 

room address of the multidrop protocol for incandescent scoreboard compatibility in 

all of the programs. 

 

Diving 

 Completed an official release of the interface to the Diving Pro Windows application. 

 

Pace Clock 

 Added first release of program. 

 

Version 3.9.10 -Release date: 11 September 2003 

 

Swimming 

 Corrected problem of requests from the Swim/Dive application on a Venus 7000 and 

the ‗Scoreboards‘ tab of the OmniSport 2000 Pro swimming application not being 

transmitted to a Venus for display. 

 

Version 3.9.23 -Release date: 23 September 2003 

 

General 



 Modified the production test so that the default configurations will be set when the 

console is first run after this. 

 

Swimming 

 Corrected problem in the function that updates race information to the Pro software 

so that if lane 1 is turned off it will not send over back-up times. 

 

Version 3.10.30 -Release date: 30 October 2003 

 

Swimming 

 Added the address for the standard water polo board (13) and displayed the home 

and guest score on that board. 

 

Pace Clock 

 Fixed the display of ‗r‘ on the min x10 digit for rest time.  It was not clearing any old 

data that might have been on the digit. 

 

Water Polo 

 Changed where the shot clock was displayed. It was displayed on min x1 and sec x10 

digits and was moved to the sec x10 and sec x1digits. 

 Added the address for the MS-2013 (11) and displayed time, score, and period. 

 Added the display of clock and shot clock data to game/shot address (1). 

 

Version 4.1.12 -Release date: 12 January 2004 

 

Swimming 

 Added a configuration that allows blanking the place information for intermediate 

splits on the RTD Port. 

 Corrected the digit assignment for the event/heat and guest 2/guest 3 modules on 

the CTS output. 

 

Version 4.1.23 -Release date:  23 January 2004 

 

General 

 Added Channel, 0D and 13 to CTS scoreboard output for home and guest scores. 

 

Swimming 

 Eliminated timeout in Hy-Tek software waiting for button times from Results output 

when none were recorded on the lane modules. 

 

Water Polo 

 Added control of horn to CTS scoreboard output. 

 Corrected layouts of 1 to 10 line scoreboards on the Multidrop and CTS scoreboard 

outputs. 

 

Version 4.4.13 -Release date: 4 April 2004 

 

Diving 

 Added interface to dive results program on Results Port. 

 Added display of event number and round on the RTD Port. 

 Added judge‘s console status to LCD and transmission to Pro application. 



 Corrected periodic lockup problem with judge consoles. 

 

Pace Clock 

 Corrected problem of another edit key being pressed while editing step type  

(swim, rest, etc.). 

 

Version 4.10.28 -Release date: 28 October 2004 

 

General 

 Increased the maximum number of judge consoles from 9 to 18 for  

synchronized swimming. 

 Added support for control of wireless handheld judge‘s consoles. 

 

Swimming 

 Added tenths of a second to CTS output. 

 Corrected problem with the transfer of DQ‘s from the Pro application to the meet 

manager when the race number was greater than 255. 

 

Diving 

 Added support for synchronized diving in the Diving Pro application. 

 Corrected problem with the transfer of the dive order from meet manager to  

timing console. 

 

Pace Clock 

 Corrected problem with STOP being first step in workout. 

 

Synchronized Swimming 

 Added first release of program 

 

Track 

 Added tenths of a second to CTS output. 

 Added configuration for always showing the running time on a single line 

scoreboard for the non-lane timing mode. 

 

Version 5.1.4 -Release date: 4 January 2005 

 

Swimming 

 Added ability to record start reaction times on relay takeoff sensors. 

 Increased number of relay exchanges from 3 to 6. 

 Added ability to transfer start reaction and relay exchange times to meet manager. 

 Added ability to display start reaction times on Enhanced RTD output when the 

mode is set to Lane order. 

 Added ability to display the start list and reaction times on the RTD Port by lane 

when the mode is set to Place order. 

 Modified position of ‗F‘ and ‗*‘ on the printouts. 

 

Water Polo 

 Added address 15 and 16 to show up to three home/guest player-penalties on 

dedicated displays. 

 

Version 5.2.2 -Release date: 2 February 2005 



 

Swimming 

 Limited relay exchanges to Near end only. 

 

Version 5.2.23 -Release date: 23 February 2005 

 

Swimming 

 Added configuration for showing start reaction times on the RTD Port. 

 Modified configuration to show ‗BTN/DAKTRONICS‘ and ‗OMEGA PLATFORM‘ 

for Relay Take-Off in the Setup-Timer menu. 

 Limited function of relay platforms to relay events only when event order is 

downloaded from the Meet Manager or Pro application. 

 Decreased number of relay exchanges from 6 back to 3 and limited the active length 

numbers to 4x50, 4x100, etc. 

 

Water Polo 

 Added control of horn segment on 7-E of address 1. 

 Added additional columns for shot clock and control of horn segment on 5-H of 

address 2. 

 Increased priority of the update for the game clock, shot clock and horn. 

 

Version 5.3.15 -Release date: 15 March 2005 

 

Track 

 Added ability to page through all competitors into Non-Lane timing mode. 

 

Version 5.4.21 -Release date: 21 April 2005 

 

General 

 In die C3 of 80C390, the SMOD_1 bit for Serial Port 1 seems to be ignored and the 

baud rate is always doubled (WDCON.7=1) so the reload values of Timer 1 were 

adjusted. 

 

Version 5.5.19 -Release date: 19 May 2005 

 

General 

 Added a selection for Omega on the scoreboard output. 

 Implemented OSM6 protocol for swimming, diving, pace clock, water polo, and 

synchronized swimming. 

 Implemented OTR7 protocol for track. 

 

Version 5.9.30 -Release date: 30 September 2006 

 

Swimming 

 Changed the menu setting text for relay platforms from saying ―Arming Delay‖ to 

―Arm Time‖. 

 

Track 

 Changed the menu setting text for running time selection on a single line display 

from ―no splits‖ - ―splits‖ to ―continuous‖ - ―finish‖. 

 



Water Polo 

 Added a setting to control if the main clock stops when shot clock reaches zero. 

 Added a setting to select if the shot clock will reset when a penalty time is entered. 

 Added a setting to select if the main clock timing is automatic or manual. 

 Added new configured time settings for Rest 1, Rest 2, Warning, and Overtime. 

 Changed the Set Time key function so that it allows for selecting the type of time 

period to Enter.  Each press of the key goes to the next type of time period. 

 Added partial time out settings for number and time of partial time outs. 

 Added more players to player list, now can go to 99 players. 

 Changed RTD output from a fixed 1-13 players penalty numbers to 25 positions of 

variable player numbers and penalties sorted by those with most penalties at the top. 

 Fixed a bug with Set Time that added one second to the time if the Set Time was 

exited by pressing the clear key twice. 

 

Version 5.11.15 -Release date: 15 February 2006 

 

Swimming 

 Modified confirmation of a valid exchange time to be based upon a Daktronics or 

Omega RTOP. 

 

Version 6.2.16 -Release date: 16 February 2006 

 

Swimming 

 Added display of subtractive splits on dedicated item numbers on the RTD Port. 

 Corrected problem of DD x0.1 remaining on numeric scoreboards when returning 

from diving in the event order. 

 Added recording of Split Arm, Finish Arm, and other operations on the Pro software 

to the race log. 

 

Version 6.4.25 -Release date: 25 April 2006 

 

Diving 

 Included support for the additional RTD items in the ‗Set Scoreboard‘ packet. 

 

Water Polo 

 Enabled some menu items when controlled by Pro software. 

 

Version 6.12.7 -Release date: 12 December 2006 

 

Swimming 

 Completed remaining configuration and display control items on Pro application. 

 Added indication of an overly active input in the lane status and took measures to 

safeguard critical data transmitted to the Pro application when this problem occurs. 

 

Version 7.1.22 -Release date: 8 February 2007 

 

Swimming 

 Improved communications so that diving events cannot be selected from the event 

order using the Pro application (timer only operation). 

 Added ability in ―Minu Touch‖ to remove the corresponding relay exchange time for 

the given length. 



 Added indication in lane status for battery low signal from relay takeoff platform. 

 

Version 7.2.8 -Release date: 3 May 2007 

 

Swimming 

 Corrected problem where the middle button time was not always selected as the 

backup time for three button backup timing when using a Daktronics RTOP and a 

button in the same input. 

  

Version 7.11.20 -Release date: 30 November 2007 

 

Swimming 

 Changed from printing a true zero (0) character to a capital ‗O‘ character to avoid 

confusion with an eight ‗8‘ character. 

 Added a Number of Copies configuration for the results printout. 

 Added the ability to select an offset (0, 5k, 10k, 15k) for the RTD item number. 

 Added the DQ status to the PLACE digit of a numeric scoreboard controlled by the 

MULTIDROP protocol on the scoreboard outputs. 

Water Polo 

 Shifted the penalties for home and guest down a line on the 6 and 8 line setting for 

the Multidrop, Multiline, Omega, and CTS scoreboard outputs. 

 Added the ability to print a game log on the internal printer. 

 Corrected a minor bug in the starting of a guest partial timeout. 

 

Track 

 Added address 19 to drive the second driver of the new football and soccer 

scoreboards. 

 Added the DQ status to the PLACE digit of a numeric scoreboard controlled by the 

MULTIDROP protocol on the scoreboard outputs. 

 

 

Version 8.3.7 -Release date: 20 March 2008 

 

Swimming 

 Added ability to record relay exchanges on far end for a 4x50 relay in a 50 M pool. 

 

Version 8.3.27 -Release date: 27 March 2008 

 

Swimming 

 Added a numeric value (0 or 1) to indicate the status of the logo at offset 1067 in the 

RTD. 

 Added support for the ―Swap Order‖ button on the Current Race tab of the Pro 

interface. 

 

Track 

 Added a value (0 or 1) to indicate the status of the logo at offset 1067 in the RTD. 

 

 

 

 

 



Version 9.4.6 -Release date: 6 April 2009 

 

General 

 During the power up sequence of the timer, the proper format to enter the data is 

shown for the initial DATE (mm/dd/yy) and TIME (hh:mm:ss) entry screens. 

 Added support for a request from and transmission to the Pro application for the 

version number of the program in the timer to help ensure compatibility. 

 Added another check of the CTS pin in the write functions to the printer to prevent 

an overrun condition during the transmission of data to the printer's internal buffer. 

 Changed the print routines to send only a Line Feed (LF) character to terminate a line 

on the printer.  Sending a Carriage Return (CR) character prior to the LF was causing 

compatibility issues with the latest version of the printer firmware (5.65 / 5.75). 

 Added the ability to transmit Multicast protocol on the Scoreboard Outputs to 

support the next generation of numeric scoreboards. 

 Increased the levels of dimming from 3 to 9 for the Multidrop and Multicast 

protocols. 

 Added an Automatic/Manual dimming mode for the Multicast protocol. 

 Added the ability to select 12 hour or 24 hour format when displaying the Time of 

Day on the numeric scoreboards. 

 Added the ability to send the Home, Guest 1, Guest 2, and Guest 3 team scores on the 

RTD port for swimming, diving, and track. 

 Added the ability to send RTD at an offset (5K, 10K, 15K) other than 0 for the 

remaining sports. 

 Corrected a small problem in Scoreboard On/Off operation where the blanking of 

the RTD was done at an offset of 0 only (ignored the RTD Offset setting). 

 Made a slight modification to the method for updating a CTS output to ensure better 

compatibility with a Colorado Time matrix controller. 

 

Swimming 

 Changed the criteria for setting the initial arming delays on the near end and far end 

touchpad inputs for a normal start by an external starting device, Always Ready Start 

operation for a missed start signal, and if the operator manually edits the start time. 

 Reduced the default arm time for the RTOP window from 1.0 to 0.8 seconds. 

 Made a correction to the ARM TIME window for the RTOP. Positive relay exchanges 

at or near to the value ARM TIME were not being recorded. 

 Added the ability to determine the source (main or store/print dialogue) of the Lane 

On/Off command from the Pro application so that the correct operation is performed 

on the timer. 

 Added the ability to automatically force another Store/Print operation upon reset of 

the timer when various operations (such as Edit, DQ, etc.) are performed after the 

initial Store/Print. This helps assure that the current race information is properly 

stored in memory and available for retrieval by the Meet Manager application. 

 Corrected a problem with a negative lane number being generated for REVERSE 

ORDER setting on extra lane modules connected to the timer and invalid data being 

sent to the Pro Swim application. 

 Added a selection for showing the Start Reaction times on the Numeric scoreboards. 

 Added a selection for showing the DQ status only or the DQ status along with the 

split/finish times on the Numeric and RTD/Matrix scoreboards. 

 Added the ability to resume the paging of finish times for all of the lanes that have a 

valid finish time upon reset of the timer. Previously, the paging would stop if all of 

the unused lanes were not turned off 



 Added the ability to show '0.00' for the running time on single line scoreboards upon 

reset of the timer when the Finish Page Time is set to a value of zero (0). Before, the 

scoreboard would show the first place swimmer until the start of the next race. 

 Added an "Official Results" field to the Enhanced RTD that is set when the Swap 

Order button is selected on the Pro Swim application. 

 

Diving 

 Corrected a problem of the Total Score not printing properly when the judge scores 

were accepted on the Pro application and the value exceeded 255 points  

 Added receive of the RTD Offset and Display Dimming settings from the Pro Dive 

application.  

 

Pace Clock 

 Corrected a problem with all lines of the scoreboard not being updated properly on a 

Reset All operation.  

 

Synchronized Swimming 

 Added receive of the RTD Offset and Display Dimming packets from the Pro 

Synchronized Swimming application. 

 

Water Polo 

 Made a correction in the Reset operation not setting the step back to TIME from a 

REST step. Also, set the game time to an OVER value when the period number was 

greater than 4 instead of a PERIOD value. 

 Made an addition to the PERIOD and PERIOD +1 operations so that they were 

invalid during a REST step. 

  Changed the title in the Timer Menu from AUTO RUN to AUTO SEQUENCE to 

better indicate the operation of the timer.  

 Added a Print Menu and a selection to print the current settings from the menu.  

 

Track 

 Added the ability to transmit the finish times to a Meet Manager application for heats 

that were timed using the Lane, Place, and Non-Lane timing modes of the timer. 

 Added the ability to automatically force another Store/Print operation upon reset of 

the timer when various operations (such as Edit, DQ, etc.) are performed after the 

initial Store/Print.  This helps assure that the current race information is properly 

stored in memory and available for retrieval by the Meet Manager application. 

 Added a selection for showing the DQ status only or the DQ status along with the 

split/finish times on the Numeric and RTD/Matrix scoreboards. 

 Added the ability to resume the paging of finish times for all of the lanes that have a 

valid finish time upon reset of the timer. Previously, the paging would stop if all of 

the unused lanes were not turned off. 

 Added the ability to show '0.00' for the running time on single line scoreboards upon 

reset of the timer when the Finish Page Time is set to a value of zero (0). Before, the 

scoreboard would show the first place runner until the start of the next race. 

Pro Swimming Software Revision History 
 

Version 1.0.0 -Release date: 25 October 2002 

 

 Initial Swimming release. 



 

Version 1.10 (Beta) -Release Date: 1 November 2002 

 

 Added functionality for Event Order printouts. 

 Added code to stop console from sending a race with bad/incomplete data in an 

infinite loop. 

 Added some functionality to the scoreboards property page. 

 

Version 1.11 (Beta) -Release Date: 14 November 2002 

 

 Fixed registrations issues with Windows® XP. 

 Fixed problem where Omni 6000 style database files weren‘t getting added to the list 

of files sent to the meet manager software. 

 

Version 1.12 (Beta) -Release Date: 5 December 2002 

 

 Added code to notify the console when requested race data was done being sent. 

 Reset heat number to 1 when the user changes the event number. 

 

Version 1.13 -Release Date: 3 January 2003 

 

 Changed Title edit box to combo box on main dialog.  This allows the user to switch 

between events by title. 

 Added code to check if multiple events exist with the same event & heat.  If that heat 

is requested, the newest data is returned to Hy-Tek MEET MANAGER. 

 Fixed code so that up and down arrows work correctly, especially in combo boxes. 

 Changed label on test property page from T1 to TP. 

 

Version 1.14 -Release Date: 3 February 2003 

 

 Fixed problems with the race requests by event and heat numbers from  

Hy-Tek not returning data. 

 

Version 1.15 -Release Date: 29 July 2003 

 

 Fixed the software that wouldn't store race information if a swimmer didn't get a 

touchpad time or a backup time on the final length. The console wouldn't send data 

for that length, but the software was looking for that data. 

 Fixed the code that was supposed to catch when the same stored race data was being 

sent over and over again by the console and tell the console to stop sending. The 

software was sending the response too quickly, and the console was throwing it 

away. Software now sends the response after any stored race data is received more 

than five times, not just the race configuration packet. 

 Fixed problems related to printing stored race results while a race is in progress. Also 

fixed were printing a stored race information from the current event database would 

print blanks. 

 Added auto-configuration of the user edited times as the user is editing them. 

 Added code to print backup times for a lane, even if no touchpad time was received. 

 

 

 



Version 1.16 -Release Date: 23 September 2003 

 

 Fixed the swimmer's name and affiliation that would get removed from the current 

race results if a minus touch was pressed. 

 Updated the DakAboutD1g and the location of the license agreement. 

 Fixed the names stored in the database that were not correct if a race was reset before 

it was completed. 

 Fixed the database files that were not showing up in the list in the stored races tab. 

 Fixed the swimmer's lane number that was sometimes wrong in the stored data. 

 

Version 1.17 -Release Date: 19 November 2003 

 

 Converted to DLStreams communications library. 

 Fixed bug that caused software to close if the unlock level is the software wasn't the 

highest level. 

 Fixed where resources were being leaked because the running time wasn't being 

drawn on the screen correctly. 

 Removed use of the CDLRegistry class because it was throwing  

debug assertions. 

 Combined the installs for swimming, diving, and synchronized swimming into a 

single install using Install Shield 8. 

 Made the software conform with new Microsoft Windows® standards by writing all 

application data to the Documents and Settings folder rather than locally in the 

Program Files folder. 

 

Version 1.18 -Release Date: 3 March 2004 

 

 Switched back to using separate installs for each PRO software application. 

 Added code for the new standard DakAboutDlg, which includes system information. 

Version 1.19 Release Date: 6 July 2004 

 

 Fixed bug that was introduced in version 1.17 where old database files were not 

being correctly located when a timer requested for race information. 

 

Version 1.1.10 -Release Date: 6 October 2004 

 

 Fixed bug that was causing the Hy-Tek software to have problems getting results 

from the current database file. 

 

Version 1.1.11 -Release Date: 16 November 2004 

 

 Added functionality for Start Reaction times and Relay Exchanges. 

 Fixed bug where power transitions were not being logged correctly in the log file. 

 

Version 1.1.12 -Release Date: 4 January 2005 

 

 Added support for multiple languages. 

 Added support for German. 

 

Version 1.1.13 -Release Date: 2 February 2005 

 



 Added support for Chinese (Traditional) 

 Added Exchange printout. 

 Fixed bug with the ―Use Missed Start At:‖ dialog, which was introduced in version 

1.1.12. 

 Changed the log file so that Touchpad-Close events were logged rather than 

Touchpad-Open. 

 

Version 1.1.14 -Release Date: 23 February 2005 

 

 Added code to dump stored race data to a text file if it appears the data being sent 

from the console is invalid. 

 Modified how the certain items are logged in the log file. 

 Removed relays 4-6. 

 

Version 1.1.1.6 –Release Date: 12 May 2006 

 

 Corrected issues with Event Order Editing. 

 Added Relay Exchange information to the Current Race tab. 

 

Version 1.1.1.7–Release Date: 16 June 2006 

 

 Added/Updated support for other languages (non-English). 

 

Version 1.1.1.8–Release Date: 19 January 2007 

 

 Changed way Event Order Files are stored. 

 Added Relay-Takeoff Arm Time configuration. 

 Added Team Scores. 

 Added test patterns for scoreboards. 

 Updated some reports to include both subtractive and cumulative splits. 

 Automatically change place orders when times are edited in Stored Races. 

 Added visual feedback information for communications with console and the 

console‘s printer. 

 Added new configurations for Matrix and Fixed-Digit displays. 

 Added Start/Exchange times in Stored Races. 

Pro Diving Software Revision History 
 

Version 1.0.2.0 -Release Date: 9 November 2003 

 

 Initial Diving release with minor fixes to improve usability. 

 

Version 1.0.3.0 -Release Date 4 December 2003 

 

 Fixed bug where the high and low scores were not being dropped properly in some 

scoring modes. 

 Added XML output for the event order and scores. 

 Removed the RXThread function, all functionality is now in OnReceiveData. 

 Added the event number fields to the database, and added output of total scores 

when requested by the console. 

 Added starting scores, including the dialog and custom gridlistctrl. 



 Fixed a bug that didn‘t allow changing the score calculation in the event setup. 

 Added ability to auto-update database if new versions use database field additions. 

 Added password protection to the database. 

 

Version 1.0.3.1-Release Date: 17 December 2003 

 

 Added a packet sender function for debug mode only. This tests the Hy-tek interface 

to the console. 

 Removed history comment blocks from files. 

 Removed Critical Sections. 

 Cleaned dead code and fixed bug with the raking not adding in the starting scores. 

 

Version 1.0.3.2 -Release Date: 26 February 2004 

 

 Added logging functionality for output to the timer. 

 Removed dead thread function code. 

 Fixed bug with 7 or 9 judges sometimes outputting the wrong score. 

 Fixed install to use new DLStreams merge module, so it works on WINNT 4.0. 

 

Version 1.0.3.3 -Release Date: 16 March 2004 

 

 Added ability to output the full team name or the abbreviation. 

 Added ability to configure diver name output, F-L, L-F, L-FI. 

 Added a final results printout. 

 Modified the dialog to hide judges cells that aren‘t used, instead of just disabling. 

 Added shortcut, Ctrl-S, to resend the last scored packet to the timer. 

 

Version 1.0.5.0 -Release Date: 23 May 2004 

 

 Added Synchronized Diving. 

 Updated graphical skins for all dialogs. 

 Added the ability to import and export DD Tables and events. 

 

Version 1.0.5.1 Release Date: 2 December 2005 

 

 Fixed bug where invalid event ID caused crash. 

 Fixed bug where importing an xml file said save, not open. 

 

Version 1.0.5.2 Release Date: 15 December 2005 

 

 Fixed bug where an invalid event could be set as active. 

 Fixed bug in the database where no default value was set for a team name. 

 Fixed bug where the judge‘s status bars would not update correctly. 

 

Version 2.0.0.0 Release Date: 11 January 2009 

 

 Initial release for beta testing. 

 

Version 2.0.1Release Date:  May 6, 2009 

 Changed database location to better work with vista and win7  

 Small bug fixes in database tables 



 Updated copyright protection services to work under newer operating systems. 

 New installation icon and shortcuts. 

 Fixed bug with coloring schemes under vista. 

 Updated FINA Table 

 Added several voice configuration options. 

 Removed ―Microsoft Sam‖ from the default speaking voice. 

 

Version 2.0.2Release Date:  October 9, 2010 

 Small graphical fixes when resizing.  

 Fixed an issue where in some situations packets were being sent too fast to the timer. 

 

Version 2.0.3Release Date:  May 1, 2010 

 Fixed an issue with large packets when sending to-take place scores. 

 Changed the splash screen so that you must resume or exit. Previously it could be 

minimized and the main interface would appear suspended. 

 Added the ability to set the default DD table 

 Fixed an issue with editing the capitalization of affiliation abbreviations. 

 Added support for synchro diving, 7-9-11 judges. 

 Added reports for synchro diving 

 Minor fixes to report graphics. 

 Added check to ensure the proper console version is being used. 

 Fixed a bug that in rare circumstances caused the wrong low score to be dropped. 

 Added ability to page through divers in the edit dive list form. 

 Consolidated dive orders reports. 

 Fixed bug that did not allow .0 to be a valid score, before it forced entry of 0.0. Same 

with .5 

 Added ability to go back to the splash screen through the menu. 

 Made the main form invisible until the splash screen is closed. Some people were 

minimizing and becoming lost. 

 Restricted non-printable characters from diver names and affiliations. 

 Adjusted speech settings to account for synchro events. 

Re-factored web scoreboard and press monitor to account for 11 judges.
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DAKTRONICS

WARRANTY AND LIMITATION OF LIABILITY 

 

This Warranty and Limitation of Liability (the “Warranty”) sets forth the warranty provided by Daktronics with respect to the Equipment. By accepting 

delivery of the Equipment, Purchaser agrees to be bound by and accept these terms and conditions.  All defined terms within the Warranty shall have the 

same meaning and definition as provided elsewhere in the Agreement. 

 

DAKTRONICS WILL ONLY BE OBLIGATED TO HONOR THE WARRANTY SET FORTH IN THESE TERMS AND CONDITIONS UPON RECEIPT OF FULL 

PAYMENT FOR THE EQUIPMENT.   

 

1. Warranty Coverage 

  

A.  Daktronics warrants to the original end-user that the Equipment will be free from Defects (as defined below) in materials and      

workmanship for a period of one (1) year (the “Warranty Period”).  The warranty period shall commence on the earlier of: (i) four weeks from 

the date that the equipment leaves Daktronics’ facility; or (ii) Substantial Completion as defined herein. The warranty period shall expire on the 

first anniversary of the commencement date.   

 

“Substantial Completion” means the operational availability of the Equipment to the Purchaser in accordance with the Equipment’s 

specifications, without regard to punch-list items, or other non-substantial items which do not affect the operation of the Equipment.   

 

B.  Daktronics’ obligation under this Warranty is limited to, at Daktronics’ option, replacing or repairing, any Equipment or part thereof that is 

found by Daktronics not to conform to the Equipment’s specifications.   Unless otherwise directed by Daktronics, any defective part or 

component shall be returned to Daktronics for repair or replacement.  Daktronics may, at its option, provide on-site warranty service.  

Daktronics shall have a reasonable period of time to make such replacements or repairs and all labor associated therewith shall be performed 

during regular working hours.  Regular working hours are Monday through Friday between 8:00 a.m. and 5:00 p.m. at the location where 

labor is performed, excluding any holidays observed by either Purchaser or Daktronics.    

 

C.  Daktronics shall pay ground transportation charges for the return of any defective component of the Equipment. If returned Equipment is 

repaired or replaced under the terms of this warranty, Daktronics will prepay ground transportation charges back to Purchaser; otherwise, 

Purchaser shall pay transportation charges to return the Equipment back to the Purchaser.  All returns must be pre-approved by Daktronics 

before shipment.  Daktronics shall not be obligated to pay freight for any unapproved return.  Purchaser shall pay any upgraded or expedited 

transportation charges. 

 

D.  Any replacement parts or Equipment will be new or serviceably used, comparable in function and performance to the original part or 

Equipment, and warranted for the remainder of the Warranty Period.  Purchasing additional parts or Equipment from the Seller does not 

extend this Warranty Period. 

 

E.  Defects shall be defined as follows.  With regard to the Equipment (excepting LEDs), a “Defect” shall refer to a material variance from the 

design specifications that prohibit the Equipment from operating for its intended use.  With respect to LEDs, “Defects” are defined as LED pixels 

that cease to emit light.   The limited warranty provided by Daktronics does not impose any duty or liability upon Daktronics for partial LED 

pixel degradation.  Nor does the limited warranty provide for the replacement or installation of communication methods including but not 

limited to, wire, fiber optic cable, conduit, trenching, or for the purpose of overcoming local site interference radio equipment substitutions. 

 

THIS LIMITED WARRANTY IS THE ONLY WARRANTY APPLICABLE TO THE EQUIPMENT AND REPLACES ALL OTHER WARRANTIES OR 

CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR CONDITIONS OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  SPECIFICALLY, EXCEPT AS PROVIDED HEREIN, THE SELLER UNDERTAKES 

NO RESPONSIBILITY FOR THE QUALITY OF THE EQUIPMENT OR THAT THE EQUIPMENT WILL BE FIT FOR ANY PARTICULAR PURPOSE FOR 

WHICH PURCHASER MAY BE BUYING THE EQUIPMENT.  ANY IMPLIED WARRANTY IS LIMITED IN DURATION TO THE WARRANTY PERIOD.  

NO ORAL OR WRITTEN INFORMATION, OR ADVICE GIVEN BY THE COMPANY, ITS AGENTS OR EMPLOYEES, SHALL CREATE A WARRANTY 

OR IN ANY WAY INCREASE THE SCOPE OF THIS LIMITED WARRANTY. 

 

THIS LIMITED WARRANTY IS NOT TRANSFERABLE.   

 

2. Exclusion from Warranty Coverage 

 

 The limited warranty provided by Daktronics does not impose any duty or liability upon Daktronics for:  

A  Any damage occurring, at any time, during shipment of Equipment unless otherwise provided for in the Agreement. When returning 

Equipment to Daktronics for repair or replacement, Purchaser assumes all risk of loss or damage, and agrees to use any shipping containers 

that might be provided by Daktronics and to ship the Equipment in the manner prescribed by Daktronics;  

 

B.  Any damage caused by the unauthorized adjustment, repair or service of the Equipment by anyone other than personnel of Daktronics or 

its authorized repair agents;  

 

C.  Damage caused by the failure to provide a continuously suitable environment, including, but not limited to: (i) neglect or misuse, (ii) a 

failure or sudden surge of electrical power, (iii) improper air conditioning or humidity control, or (iv) any other cause other than ordinary use;  
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D.  Damage caused by fire, flood, earthquake, water, wind, lightning or other natural disaster, strike, inability to obtain materials or utilities, 

war, terrorism, civil disturbance or any other cause beyond Daktronics’ reasonable control;  

 

E.  Failure to adjust, repair or replace any item of Equipment if it would be impractical for Daktronics personnel to do so because of 

connection of the Equipment by mechanical or electrical means to another device not supplied by Daktronics, or the existence of general 

environmental conditions at the site that pose a danger to Daktronics personnel;  

 

F.  Any statements made about the product by salesmen, dealers, distributors or agents, unless such statements are in a written document 

signed by an officer of Daktronics. Such statements as are not included in a signed writing do not constitute warranties, shall not be relied 

upon by Purchaser and are not part of the contract of sale;  

 

G.  Any damage arising from the use of Daktronics products in any application other than the commercial and industrial applications for 

which they are intended, unless, upon request, such use is specifically approved in writing by Daktronics; or  

 

 H.  Any performance of preventive maintenance. 

 

3. Limitation of Liability 

  

Daktronics shall be under no obligation to furnish continued service under this Warranty if alterations are made to the Equipment without the 

prior written approval of Daktronics.   

 

 

It is specifically agreed that the price of the Equipment is based upon the following limitation of liability.  In no event shall Daktronics (including 

its subsidiaries, affiliates, officers, directors, employees, or agents) be liable for any special, consequential, incidental or exemplary damages 

arising out of or in any way connected with the Equipment or otherwise, including but not limited to damages for lost profits, cost of substitute 

or replacement equipment, down time, lost data, injury to property or any damages or sums paid by Purchaser to third parties, even if 

Daktronics has been advised of the possibility of such damages.  The foregoing limitation of liability shall apply whether any claim is based 

upon principles of contract, tort or statutory duty, principles of indemnity or contribution, or otherwise.   

 

In no event shall Daktronics be liable to Purchaser or any other party for loss, damage, or injury of any kind or nature arising out of or in 

connection with this Warranty in excess of the purchase price of the Equipment actually delivered to and paid for by the Purchaser.  The 

Purchaser’s remedy in any dispute under this Warranty shall be ultimately limited to the Purchase Price of the Equipment to the extent the 

Purchase Price has been paid. 

 

4. Assignment of Rights 

 

The Warranty contained herein extends only to the original end-user (which may be the Purchaser) of the Equipment and no attempt to extend 

the Warranty to any subsequent user-transferee of the Equipment shall be valid or enforceable without the express written consent of 

Daktronics. 

 

              

5. Dispute Resolution 

  

Any dispute between the parties will be resolved exclusively and finally by arbitration administered by the American Arbitration Association 

(“AAA”) and conducted under its rules, except as otherwise provided below.  The arbitration will be conducted before a single arbitrator.  The 

arbitration shall be held in Brookings, South Dakota.  Any decision rendered in such arbitration proceedings will be final and binding on each 

of the parties, and judgment may be entered thereon in any court of competent jurisdiction.  This arbitration agreement is made pursuant to a 

transaction involving interstate commerce, and shall be governed by the Federal Arbitration Act. 

 

6.  Governing Law 

 

The rights and obligations of the parties under this warranty shall not be governed by the provisions of the United Nations Convention on 

Contracts for the International Sales of Goods of 1980.  Both parties consent to the application of the laws of the State of South Dakota to 

govern, interpret, and enforce all of Purchaser and Daktronics rights, duties, and obligations arising from, or relating in any manner to, the 

subject matter of this Warranty, without regard to conflict of law principles. 

 

7. Availability of Extended Service Agreement 

For Purchaser’s protection, in addition to that afforded by the warranties set forth herein, Purchaser may purchase extended warranty services 

to cover the Equipment. The Extended Service Agreement, available from Daktronics, provides for electronic parts repair and/or on-site labor 

for an extended period from the date of expiration of this warranty.  Alternatively, an Extended Service Agreement may be purchased in 

conjunction with this warranty for extended additional services.  For further information, contact Daktronics Customer Service at 1-877-605-

1116. 
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